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Welcome to Creative DRAWings

Chapter I

Creative DRAWings® is an embroidery software which will excite your creativity because it’s easy to learn
and easy to use! With only a few minutes of hands-on instruction, it’s possible for anyone -- regardless of
skill level -- to produce a high-quality design. It’ll be clean of wild stitches and ready to be sewn out on your
embroidery machine.

Creative DRAWings® is an embroidery software that contains a wide variety of amazing features and
functionality. Besides from embroidery functionality, it includes cutting of various materials, stencil lines
creation, crystals template creation and paint functionality.

Rhinestones in a variety of sizes can now be added to sewing and crafting projects like never before. Any
shape, including logos, clip art, or imported graphics, can be easily designed for rhinestones. The software
then sends the design to a digital cutter for template creation. You'll also find a powerful monogram feature -
insert 3 characters for monogramming, freely edit monogram shapes with a Node Editor, and create a
monogram from any True Type font.

Almost any clipart or photo can be imported and be instantly converted into a flawless embroidery file. That’s
because Creative DRAWings® is not static software which just converts images to stitches. The
revolutionary and professional DRAWstitch® technology has been incorporated into Creative DRAWings® to
work the miracles that you’ll see it perform – almost as fast as the blink of an eye. 

Creative DRAWings® is much more than a digitizing software. It’s an interactive product which almost
“thinks” for you and helps release your creativity. A big plus for Creative DRAWings® is that it doesn’t require
you to keep buying expensive add-on digitizing packages as you advance in skill. 

Instead of having to learn complicated production techniques, Creative DRAWings® does most of the work
for you – almost instantly! That’s because Creative DRAWings® is a wonderful new embroidery software
created for home use at a very reasonable price, yet powerful enough for the professional shop. Creative
DRAWings® will allow you to file your digitized images in most of the world’s most popular embroidery
formats. 

We want you to enjoy embroidering and not agonize over perplexing software programs that plague the
sewing market today. We want you to really USE Creative DRAWings®. Many embroidery programs are so
frustrating because of their “steep-learning curve.”  The learning is almost endless, and you almost drown in
the need for more software! 

Online resources

More information about Creative DRAWings including tutorials, demos and frequently asked questions are
at the official site of Creative DRAWings: 

DRAWstitch  - Artistic Creative Products

http://www.drawstitch.com
http://www.artisticcreativeproducts.com/
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Creative DRAWings help

Need more instructions? Help is at hand! Comprehensive information about the features in the software is
displayed in the Help viewer provided by your operating system: Microsoft HTML Help. You can access
information in any of the following four ways from the Help menu or by pressing F1 shortcut key:

1. The table of contents enables you to see all of the information organized by subject. Click top-level
entries to view subtopics.

2. The index allows you to look up specific terms or concepts in alphabetical order. Type is a word or
phrase.

3. Search allows you to find any character string or word anywhere in the text of the Help system.

4. Show help on is another way to access help for a specific tool, area, or function in Creative
DRAWings®. 

Show help on can be activated from the Help menu, or by clicking on the  icon in the standard toolbar or
by pressing the Shift+F1 shortcut key. When you activate Show help on, the mouse pointer turns to a
pointer with a question mark. Click on any function you want in Show help on and the subject will be
displayed.    

Creative DRAWings and Wing's modular

Here’s why Creative DRAWings® is so powerful: It includes a portion of Wings modular, one of the world’s
leading professional digitizing embroidery software programs. The two programs communicate to give you
professional results – even on the first try. You can export Creative DRAWings® designs for further editing
into Wings’ modular or open existing embroidery designs such as .dst. Wings' modular is a fully working
Professional embroidery software split into modules. The full package of Wings' modular is consisted of 14
modules which are purchased separately. 

When you have created an embroidery design in Creative DRAWings®, you can instantly call up Wings'
modular from the menu File>Export>To Editor ** or by pressing the shortcut key Ctrl+E and make any
modifications you like. The original design in Creative DRAWings® will remain unchanged for future use. (**
The > means “then click on” as in click mouse on File, then click on Export, then click on To Editor. This
shortened version using > will be used in giving directions in this manual.)

For more information about what exciting things you can do with the Wings software, refer: 
www.wingsmodular.com

In the purchased package some of the modules are included.

· If you have purchased Artistic Suite V7, the included modules are Basic, Editing and Venere. 

· if you have purchased Artistic Suite Premium V7, the included modules are Basic, Editing, Venere,
Text, Digitizing, Artistic Digitizing and Node editing. 

Information about the modules 

· Basic module is the first and most important module because it contains the basic parts of the software.
Basic module includes the standard interface,  design scaling capabilities, simple design editing, fully
functional stitch editor, image database management and all supported floppy formats. It also includes

http://www.wingsmodular.com/
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many connection abilities that allow you to connect the software with your embroidery machine. You can
read more about Wings’ modular Basic module inside the Basic module manual that is also included or
from the Help > Contents menu in the Basic module Contents tab book. 

· Editing module adds editing abilities to Wings' modular®. You can edit selected objects by using the
mouse, change the order of the objects and create an array of a selected object or design. Also you can
adjust the density of the objects and change the Satin width. In addition you can convert Step objects to
Satin objects, edit Step pattern, smooth and split stitch data objects and many more features. Editing
module completes the editing functionality of modular giving you the power to transform any embroidery
design easily, while keeping the embroidery quality high with the AI (Artificial Intelligence) that the software
has.These editing capabilities can reduce the embroidery design production and help you create high
quality embroidery designs with fewer stitches.

· With Venere module you can make Venere cuts in the fabric. You can design the area you want to be cut
with “Venere cutting” like creating an outline with Running stitch. Your embroidery machine will process the
information and will cut the area you have designed accordingly.The Venere tool increases embroidery
quality by creating accurate cuts in the fabric with the best possible way. Using this tool you can create
unique designs combining embroidery with fabric cuts.

· The Text module contains all the required functionality for creating high quality text embroidery designs
including 255 pre-digitized fonts for Satin, Piping, Zig Zag! You can create Text embroidery designs with
any True Type font installed in your computer! Also, a new feature named “Name Drop” is added, which is
an easy way of creating multiple designs with different names! 

· Digitizing module, gives you the ability to make embroidery designs from scratch. Contains seven
possible stitch types which are: Running, Satin, Satin Serial, Piping, Step Zig-Zag and Manual. It includes
basic node editing, automatic underlay, Reference copy, Drag and drop sewing Re-sequence and node
editing. This module also adds extra options in the stitch types that can be accessed from the "Object
properties" Toolbar. In addition includes Join and Break apart functionality between the objects, erase
outline tool, step pattern editing, automatic border insertion, object copy from one design to another and
multiple section digitizing (Auto-Branches). 

· Artistic Digitizing module, with this module you get extra artistic digitizing abilities that can increase your
embroidery designs quality and production. It adds extra options in the stitch types, advanced "Envelope"
effects and useful artistic functionalities such as "Vector fill", "Block fill" and "Form fill" that you can use to
create unique embroidery designs by adding different shape fills. Using your imagination, your creativity and
the combination of these tools you can create embroidery designs that you never thought that was possible
to produce. 

· Node Editing module, With this module you get more node editing abilities that can help you make more
accurate adjustments on the design and decrease the production time. This module helps you to modify
the objects of the embroidery designs more accurately and create the exact shapes you want to design. It
includes multi node editing selection, connection with straight lines of two or more nodes, join ability of
nodes, splitting ability of a node in two sections and transformation of objects in "Node editing" mode.

Creative DRAWings Samples

Creative DRAWings® includes sample designs for you to work with and produce embroidery designs while
you are learning the software. After installing the software, the designs will be copied into your hard disk so
you have direct access to them. To find the designs, click on Start button, then position the mouse over
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Programs menu to open it, expand Creative DRAWings subfolder and select Creative DRAWings samples to
open the samples folder. You will find 200 vector file designs with .cmx extensions that can be imported into
Creative DRAWings and converted to stitches. Also, you will find 204 embroidery file designs with .ngs
extensions that can be imported into Creative DRAWings® and create new ones based on them. The stitch
folders in .ngs files can be opened with the Wings’ modular 5 software included in Creative DRAWings®. The
designs in .ngs files contain readymade embroidery designs. After saving them to the file format which your
machine supports, you can embroider them directly with your embroidery machine. You can save them to the
file format you want through Creative DRAWings® or Wings’ modular 5 software. 

There are more designs in .ngs file format but they are located in the installations CD of Wings’ modular
software inside the Designs folder. There you will find nearly 3000 embroidery designs ready to sew out.
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Quick start

Chapter II

In this chapter we will present the basic principles of Creative DRAWings functionality. All the design tools
and options are described thoroughly in the following chapters. In this chapter we will only provide some step
by step examples to have a jump start to the basic functionality of the program.

By the end of this chapter you will be able to create a sample design, use an old stitch file to create a new
embroidery design, convert a bitmap image (picture) to an outline design and create a new design from
scratch by using the available tools. In addition, you will become familiar with the working space of Creative
DRAWings.

Start up wizard
By default when starting the Creative DRAWings the application window loads and the new design startup
wizard will appear. Using the wizard you can create a new design or load an existing. This dialog appears
only in program startup, when using New design or Open design options of File menu a different portion of
the wizard is started.

Open  a design

In order to open a design select Open existing and then press Browse to locate your design. You can also
open with a single click one from the list with recently used designs.

Start-up wizard load existing design
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Create new design 

The first step of the wizard prompts you to select which of the available Techniques will be enabled for this
new design. Creative DRAWings workspace available components are dynamically altered according to the
enabled techniques. For example if we Enable only embroidery technique in case that we want to create an
embroidery design only the design tools and stitch types will be available in the workspace. If we want to
create a paint design with stitches together we will enable both techniques (Embroidery and Paint). In this
case the tools for embroidery and Paint will be available in our workspace. More information available in a
separate topic.Techniques

When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog will
appear. Using this dialog you must select a fabric type and a color that is as close as possible to the one you
are going to produce the design on. Expand any of the fabric categories, by clicking on the + icon next to it, to
select a fabric and-or a color for the fabric. After selecting the Fabric, choose the color from the list at the
middle of the dialog. The Fabric selection is not just an issue of previewing the design on the fabric. The
software automatically adjusts, according to the selected fabric, various embroidery parameters. Embroidery
quality depends on some of these parameters. The software suggests the appropriate backing materials for
every fabric, in the printout of each design. In case that you don’t want to preview the design on any fabric you
can select the none option that exists in any of the fabric categories. In this case only the color that is select
in fabric dialog will appear in the background of the created design. More information about Fabric selection is
provided into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.
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·
Select fabric dialog

When creating a new design using the start-up wizard we can use many types of artwork source to base
the new design on. In Artwork source wizard step select any of the available sources of artwork to base the
created design on.

Artwork source dialog

More detailed information on the usage of and options of any artwork source will be provided in the following
chapter.
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Create and stitch design modes

This new version of DRAWings implements design modes instead of design tabs.

v Create mode, is a build-in designer workspace. Using Create mode you can create and edit
embroidery or vector designs with the complete set of design and editing tools. Create mode contains
everything you need to create new designs from scratch or edit your old “.DRAW” files. Create mode is
the default design mode.. 

v Stitch mode, we activate this mode when we want to see the stitches and like a preview of how the
embroidery will look like.

Creating your first embroidery

This is a step-by-step tutorial to guide you in creating your first design with Creative DRAWings®. 

1. Start Creative DRAWings application by double clicking on shortcut icon  that you will find on

your Desktop. 

2. Creative DRAWings application will open and the starting dialog named New Design will appear.

Starting dialog

3. Use Create new option and click Next> button.

4. From the next dialog select which techniques you want to be enabled. Make sure that Embroidery

technique is enabled.
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Select the Techniques that you want to be enabled

5. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog
will appear. Using this dialog you must select a fabric type and a color that is as close as possible to
the one you are going to produce the design on. Expand any of the fabric categories, by clicking on
the + icon next to it, to select a fabric and-or a color for the fabric. After selecting the Fabric, choose
the color from the list at the middle of the dialog. The Fabric selection is not just an issue of
previewing the design on the fabric. The software automatically adjusts, according to the selected
fabric, various embroidery parameters. Embroidery quality depends on some of these parameters.
The software suggests the appropriate backing materials for every fabric, in the printout of each
design. In case that you don’t want to preview the design on any fabric you can select the none option
that exists in any of the fabric categories. In this case only the color that is select in fabric dialog will
appear in the background of the created design. More information about Fabric selection is provided
into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.
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·
Select fabric dialog

6. The Artwork source dialog will appear. Select the From File option. Click on the browse button 

at the right to import the design you want to embroider. 

Artwork source dialog

7. The Open dialog box will appear from where you can find the design you want to embroider.



23Quick start

© 2017 DRAWstitch Ltd.

Open design dialog

8. Click on My documents folder at left side of the dialog.

9. Then find and double click on the Embroidery designs folder 

10.  Inside Embroidery designs folder you will find another folder called Creative DRAWings samples.

Double click on it.

11. Inside the Creative DRAWings samples folder you will find ready-made Vector (clipart) designs that

you can import into Creative DRAWings® and convert them to stitches. You can select to embroider

any of them but for our example we will use the ASC_00179.cmx file as it is shown in figure above. 

12. Select it and click the Open button. 

13. The Artwork source dialog will appear once more with the design you have selected under From file

field. 

14. At the Hoop section of the same dialog, you can select the hoop which you will embroider your design

on. If the hoop your machine supports does not exist in the list select one with similar dimensions.

You can create your custom hoops easily inside Creative DRAWings®. (Information on adding

specific hoops will be covered later in the manual.)

15. After selecting the hoop, click Next> to continue.

16. The Color reduction (number of threads) dialog will appear where you can select the Thread

palette. 
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17. Click on the arrow of Palette and the drop-down menu will show the threads available.

18. Select the brand-name threads you want to use by clicking on the list. For example, select Gunold

Poly thread.

19. The colors of the design you are importing will automatically be assigned to the closest thread color of

the Gunold Poly thread palette. 

Color reduction dialog

20. In Color reduction dialog you can see that the design has 7 colors in Threads to use. You can

reduce the number of colors in the design by moving the arrow to the left.  Click Finish to end the

process and convert the imported design to stitches. 

21. The design will appear in the working area filled with stitches.
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The imported design converted to stitches

22. The 3D design will be positioned at the center of the hoop which you selected from the starting

dialog. 

23. There are many available changes to do on the artwork or on the stitches of the design inside

Creative DRAWings® but we will not explain them now in this section. The design which was

produced here can be embroidered as is without any problem. The important thing right now is that

you can see what this fantastic software can do by sewing out your first embroidery design.

24. Before embroidering, save your design to the embroidery file format which your machine supports.

Select File menu, Save as option. 

25. The Save As dialog will appear. Select a location to save all your embroidery files. For example, file to

My documents> Embroidery designs. You can also save designs directly to a floppy disk or to your

memory card.
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Save As dialog box

26. In the File name field, give your design a name. For example, type    My first Embroidery.

27. Then click on the arrow of Save as type drop-down menu to view the available file-type options.

Select any that your embroidery machine reads. For example, if you have “Brother” embroidery

machine you have to select the .pes or .pec embroidery file format. Always remember to save your

design in .draw file format before saving it to any embroidery machine’s file format. This file format

holds all design information that is necessary to re-use this design without any loss. 

28. Once you are ready, click Save. The design will be saved in the location you chose with the name

you gave to it. If you have saved the design directly to a floppy disk, a thumb drive, or to your hard

drive, you are ready to download it to your embroidery machine’s memory card and sew it out.

Otherwise you have to:

A. Open Windows Explorer, 

B. Browse to the location you saved it, 

C. Right click on the file and from the right click menu expand the Send to submenu 

D. Save to a 3.5 Floppy disk (A:) or to a thumb drive

E. Then the design can be downloaded to your embroidery machine’s memory card to be sewn out.
(Note: in big commercial machines, the file can be downloaded directly to the machine’s memory.

29. After saving the design, make a printout so you can set the functions of the embroidery machine

correctly and sew it out without any problem.

30. To do that, from File menu select Print option. 
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Printout of the design

31. The Print preview dialog of the design will appear where all the information you need is listed to

embroider the design correctly. If you have a printer you can press OK button and make a Printout of

the design. If you do not have a printer or don’t want to print it, you can save it as an image file and

view it with the standard image viewer of Windows. 

32. To save the Printout as image file, you have to click on the Save to JPG button.

33. The Save printout as dialog will appear where you have to: 

A. Specify the location you want the image to be saved.

B. Type the File name you want the image to have 

C. Click on Save button.

D. You can view the saved image by double clicking on it. 

34. All the information you need in order to embroider a design is listed in the Printout, including the

embroidery design’s sequence (1-2-3 order of sewing out), the color changes, the number of stitches,

and much more useful information.

35. You are ready -- Download the file to your embroidery machine, use the Printout as your guide to set

up your machine, and embroider the design you have just created.

Scan a design and embroider it

Sometimes we may find a design in a magazine or a flyer which you would like to embroider but don’t realize
how easy it is to acquire the image. If your computer has a scanner installed, you can scan and import
almost any design you want to embroider.

Important: The design which you want to convert to stitches must be compatible for
embroidery and must be able to be filled with stitches. Photos from your camera cannot
be easily filled with stitches. Later, you’ll learn to Trace your photos and then fill with
stitches.
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Follow these steps to convert a Bitmap (picture) images to an embroidery design with your scanner:

1. Turn on the scanner and place the image in it.

2. Open Creative DRAWings by double clicking on the desktop icon 

3. Creative DRAWings® application will open and the starting dialog New Design will appear.

Starting dialog

4. Select the Create new option and click Next> button.

5. From the next dialog select which techniques you want to be enabled. Make sure that Embroidery

technique is enabled.
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Select the Techniques that you want to be enabled

6. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog
will appear. Using this dialog you must select a fabric type and a color that is as close as possible to
the one you are going to produce the design on. Expand any of the fabric categories, by clicking on
the + icon next to it, to select a fabric and-or a color for the fabric. After selecting the Fabric, choose
the color from the list at the middle of the dialog. The Fabric selection is not just an issue of
previewing the design on the fabric. The software automatically adjusts, according to the selected
fabric, various embroidery parameters. Embroidery quality depends on some of these parameters.
The software suggests the appropriate backing materials for every fabric, in the printout of each
design. In case that you don’t want to preview the design on any fabric you can select the none option
that exists in any of the fabric categories. In this case only the color that is select in fabric dialog will
appear in the background of the created design. More information about Fabric selection is provided
into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.
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·
Select fabric dialog

7. The Artwork source dialog will appear.

Starting dialog - 2nd page 

8. Select the Get image from scanner.
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9. At the Hoop section of the same dialog, you can select the hoop that you will embroider your design

on. If the hoop your machine supports don’t exist in the list, select one with similar dimensions. You

can create your custom hoops easily inside Creative DRAWings® later.

10. Click Next> button to continue.

11. The Image Scan dialog appears. 

Image scan dialog

12. The Image Scan dialog helps you scan the image you want to embroider and import it into Creative

DRAWings®. If your scanner is correctly installed, all you have to do is press the Preview button. 

13. The design will be scanned and the image will appear in Preview. You can specify the exact image to

want to embroider in Preview by drawing a rectangle with your cursor. Only the area inside the

rectangle will be embroidered. 

14. If the design in the Preview is what you want to embroider, press the Scan button to continue. 

15. Then you will be asked to save the design on your hard disk. The Save As dialog will appear.
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Save as dialog

16. Select My documents icon from the left side and then double click on the Embroidery designs

folder.

17. In the File name field, type a name for your image.

18. Select Save button to save the scanned image. The scanned image is saved as bitmap image (like

photo) with .jpg file extension.  

Artwork image dialog

19. The Artwork Image dialog will appear providing four conversion options.

a. Open as Backdrop: This option can import the image into Creative DRAWings® without any
changes. The image is used as a reference to create an embroidery design from scratch. You
select and draw freehand what objects you want in your design.

b. Trace (convert to outlines): This option will guide you to convert the Bitmap (picture) image that
you are importing to a Vector (clipart) based image which will be filled with standard embroidery
(Satin, Step, Satin serial or Running stitches). Tracing a Bitmap image is not an easy procedure;
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therefore you must be careful with the images which you are tracing. They must be clear so that
they can be actually embroidered. (Such image is the one that it is shown in the following figure)

c. The Open as Photo paint option can convert the bitmap file directly into photo paint design.

d. Open as Cross stitch: This option imports the image as it is and fills it with cross-stitches (X’s).
This is the easiest way to fill a Bitmap (picture) image with stitches and it is the best choice for
images which cannot be embroidered with standard embroidery stitches. 

e. Open as Photo stitch: This option will convert the imported image from scanner into a Photo
stitch design.

20. In our example we will select Trace option and press the Next> button. 

Trace image dialog

21. Trace Image dialog will appear with the scanned image. In the Preview area you can see how the

result of the traced picture will look like. The Vector (clipart) design from tracing the scanned image is

the same image you see in the Preview of the Trace Image dialog. What you see is what you get.

And with Creative DRAWings® it’s what will be . . . when sewn out. 

22. You can also adjust the traced result by changing the available options which are listed at the left side

of the dialog. 

a. You can change the size of the Trace result by adjusting the Scale image option.

b. You can set how exact the traced image will be to the scanned image by adjusting the Accuracy
value.

c. You can select the number of colors for your traced image by adjusting the Color limit value.

d. And you can remove the background color that the scanned Bitmap images usually have by using
the Use background option.

e. Any changes you make to these options are automatically adjusted by Creative DRAWings® and
shown in Preview. We will learn of these options more in the next chapter.

23. Use the default options for this example and press the Trace button.
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24. The Color reduction dialog will appear where you can select the Thread palette you will use. 

25. Click on the arrow of the Palette drop-down menu and the available thread manufacturers will

appear.

26. Select the brand-name thread you want by choosing it from the list. For example, select Gunold poly.

27. The colors of the design you are importing will automatically be assigned to the closest thread color of

the Gunold poly in the Thread palette 

Color reduction dialog

28. In the same dialog you can see that your design has 38 different colors of thread. The number of

colors can be reduced now by sliding the Threads to Use arrow to the left. Color reduction can also

be applied later inside the software. The reduction of colors from 38 to let’s say 11 won’t affect the

design much, but the embroidery time will be reduced. Take some time and use the slider of Threads

to use. Finally click Finish to end the process and convert the imported design to stitches. 

29. The design will appear in the working area filled with stitches.
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The traced image converted to stitches

30. The design will be positioned at the center of the hoop you selected in the starting dialog. 

31. Many changes can be made in the design which was produced by scanning the Fish image. We will

not take the time here to explain them, but we must say that the Traced design must be edited to

increase its quality and to prepare it for embroidery. By increasing the quality of the Vector artwork

you automatically increase the quality of the embroidery design. 

32. When finished editing your design, you can proceed to the embroidering process. Save the design to

any embroidery file format that your machine can read. Select from File menu the option Save As. 

33. The Save As dialog will appear. Select a location to save all your embroidery files. For example, file to

My documents> Embroidery designs. You can also save designs directly to a floppy disk or to your

memory card.
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Save As dialog box

34. In the File name field, name your design file. For example, type My second Embroidery.

35. In the Save as type box, click on the drop-down arrow to select an embroidery format for the saved

design. You must always use the ones that are suitable for your embroidery machine. For example, if

you have “Brother” embroidery machine you have to select the .pes or .pec embroidery file format. 

Tip: Always remember to save the design in .draw file format before saving it to any
embroidery machine's format. This format holds all design information and can be used
easily again and again to reproduce for any embroidery machine file.

36. When finished with the design, click Save. The design will be saved in the location you chose with the

name you gave to it. If you have saved the design directly to a floppy disk, a thumb drive, or to your

hard drive, you are ready to download it to your embroidery machine’s memory card and sew it out.

Otherwise you have to:

A. Open Windows Explorer, 

B. Browse to the location you saved it, 

C. Right click on the file and from the right click menu expand the Send to submenu 

D. Save to a 3.5 Floppy disk (A:) or to a thumb drive.

E. The design can be downloaded to your embroidery machine’s memory card to be sewn
out. (Note: in big commercial machines, the file can be downloaded directly to the
machine’s memory).

37. After saving the design, make a printout so you can set the functions on the embroidery machine

correctly and then sew it out without any problem.

38. To do that, from File menu select Print option. 
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39. The Print preview dialog of the design will appear with all the listed information you need to

embroidery the design correctly. If you have a printer you can press OK button and make a Printout

of the design. If you do not have a printer or you do not want to print it, you can save it as an image file

and view it with an image viewer.

40. To save the Printout to as image file, you have to click on the Save to JPG button.

41. The Save printout as dialog will appear where you have to 

a) Specify the location you want the image to be saved, 

b) Type the File name you want the image to have 

c) Click Save button.You can view the saved image simply by double clicking on it. 

42. All the information you need is listed in the Printout, including the embroidery design’s sequence (1-

2-3 order of sewing out), the color changes, the number of stitches, and much more useful

information.

43. You are ready -- Download the file to your embroidery machine, use the printout as your guide to set

up your machine, and embroider the design you have just created.

Get image from camera

Another way to acquire an image from a magazine or a flyer or from a drawing you have created on a page is
by using any camera that is attached on your pc. If your computer has a camera installed (most modern
laptops have a camera already installed), you can capture a snapshot image and import almost any design
you want to embroider.

Important: The design which you desire to convert to stitches must be suitable for
embroidery in order to be filled correctly with stitches. 

Follow these steps to convert a Bitmap (picture) images to an embroidery design with your camera:

1. Start Creative DRAWings application by double clicking on shortcut icon  that you will find on

your Desktop. 

2. Creative DRAWings application will open and the starting dialog named New Design will appear.
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Starting dialog

3. Select the Create new option and click Next> button.

4. From the next dialog select which techniques you want to be enabled. Make sure that Embroidery

technique is enabled.

Select the Techniques that you want to be enabled

5. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog
will appear. Using this dialog you must select a fabric type and a color that is as close as possible to
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the one you are going to produce the design on. Expand any of the fabric categories, by clicking on the
+ icon next to it, to select a fabric and-or a color for the fabric. After selecting the Fabric, choose the
color from the list at the middle of the dialog. The Fabric selection is not just an issue of previewing
the design on the fabric. The software automatically adjusts, according to the selected fabric, various
embroidery parameters. Embroidery quality depends on some of these parameters. The software
suggests the appropriate backing materials for every fabric, in the printout of each design. In case that
you don’t want to preview the design on any fabric you can select the none option that exists in any of
the fabric categories. In this case only the color that is select in fabric dialog will appear in the
background of the created design. More information about Fabric selection is provided into a separate
topic. After selecting a Fabric and a color for the fabric click on Next to proceed.

·
Select fabric dialog

6. The Artwork source dialog will appear.

7. Select the Get image from camera option.

8. At the bottom of the dialog you can select a Hoop to be used for the design. If you can find any Hoop

that is compatible to your machine select one with similar dimensions. You can also create custom

hoops easily. 
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Starting dialog - 2nd page 

9. Click Next> button to continue.

10. The camera Preview dialog appears. 

Image scan dialog

11. The camera Preview dialog helps you capture the image you want to embroider and import it into

Creative DRAWings. If your camera is correctly installed, all you have to do is press the Capture

button and take a snapshot of the design you want. 

12. The design will be captured and the image will appear in Preview area. You can specify the exact

image to want to embroider (crop image) in Preview by drawing a rectangle with your cursor. Only

the area inside the rectangle will be embroidered. We will leave it as it is.
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Image scan dialog

13. If you are not satisfied with the image you captured you can click on the Capture new button and take

a new snapshot.

14. If the design in the Preview is what you want to convert, press the Save button to continue. 

15. Then you will be asked to save the design on your hard disk. The Save As dialog will appear.

Save as dialog

16. Select Documents icon from the left side and then double click on the Embroidery designs folder.

17. In the File name field type a name for your image.

18. Select Save button to save the scanned image. The captured image is saved as bitmap image (like

photo) with .jpg file extension.  
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Artwork image dialog

19. The Artwork Image dialog will appear providing four options.

a. Open as Backdrop: This option imports the image into Creative DRAWings without any

changes. The image is used as a reference to create an embroidery design from scratch. You

select and draw freehand what objects you want in your design.

b. Trace: This option will guide you to convert the Bitmap image that you are importing into a

Vector design that will be filled with stitches. Tracing a Bitmap image is not an easy procedure;

therefore you must be careful with the images which you are tracing. They must be clear and

ones that can be actually embroidered.

c. The Open as Photo paint option can convert the bitmap file directly into photo paint design. 

d. Open as Cross-stitch, this option will convert the camera snapshot into a cross stitch design.

e. Open as Photo stitch, using this option you can convert the design into Photo stitch design.

20. In our example we will select the Trace option and press the Next> button. 
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Trace image dialog

21. The Trace Image dialog will appear with the captured image imported. In the Preview on the right

you can see what the traced result of the Bitmap (picture) image will look like. The Vector (clipart)

design from tracing the scanned image is the same image you see in the Preview of the Trace

Image dialog. What you see is what you get. And with Creative DRAWings it’s what will be

embroidered. 

22. You can also adjust the traced result by changing the available options which are listed at the left side

of the dialog. 

a. You can change the size of the Trace result by adjusting the Scale image option.

b. You can set how exact the traced image will be to the scanned image by adjusting the Accuracy
value.

c. You can select the number of colors for your traced image by adjusting the Color limit value.

d. And you can remove the background color that the scanned Bitmap images usually have by using
the Use background option.

Any changes you make to these options are automatically applied and shown in the Preview
area. We will refer to these option in more detail in the next chapter.

23. Change the Color limit to 15, and press the Trace button.

24. The Color reduction dialog will appear to select a Thread palette to be used for the design. 

25. Use Palette drop-down menu to review the available thread manufacturers and select one that you

prefer. For example, select Gunold Poly.

26. The colors of the converted design will be automatically assigned to the closest thread color of the 

Gunold Poly in the Thread palette. 
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Color reduction dialog

27. In the same dialog you can see that your design has 10 colors of thread. You can reduce the available

colors, using the Threads to use slider. Click Finish to end the process and convert the imported

design into stitches. 

28. The design will appear in the working area filled with stitches.

    

The traced image filled with stitches

29. The design will be positioned at the center of the selected hoop. 

30. We can use the option Backdrop -> Hide from View menu to hide the backdrop that has been also

imported, in order to work easier with the actual design.
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Remove unneeded objects and hide backdrop image

31. Now we are ready to edit and save the design. 

32. You can make a printout so that you can set the functions on the embroidery machine correctly and

then sew it out without any problem.

33. To do that, from File menu select Print option. 

34. The Print preview dialog of the design will appear with all the listed information you need to

embroider the design correctly. If you have a printer you can press OK button and make a Printout of

the design. If you do not have a printer or you do not want to print it, you can save it as an image file

and view it with an image viewer. 

Printout dialog box

35. To save the Printout to as image file, you have to click on the Save to JPG button.
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36. The Save printout as dialog will appear where you have to 

A. Specify the location you want the image to be saved,

B. Type a File name you want the image to have 

C. Click on Save button.

D. You can view the image you have saved by double clicking on it. 

37. All the information you need is listed in the Printout, including the embroidery  sequence the color

changes, the number of stitches, and much more useful information.

38. You are ready – Load the file to your embroidery machine, use the printout as your guide to set up

your machine, and embroider the design you have just created.

Import a stitch file and embroider it

Creative DRAWings® gives you the ability to import stitch files (.dst, .pes, .hus, .M3, .ngs, etc.) and work
with them. You can change colors, move and slant stitch objects, add new embroidery objects by designing
them from scratch, or copying and pasting them from a different source. You can also convert the Stitch
objects into Vector (clipart) objects which will allow you to change their stitch types and shapes. 

This is a step-by-step tutorial to guide you on importing a Stitch file inside Creative DRAWings®, change
colors, add text and produce a new embroidery design based on an old design. 

1. Start Creative DRAWings application by double clicking on this shortcut icon  on your

Desktop. 

2. Creative DRAWings® will open with the starting dialog of New Design.

Starting dialog

3. Select the Create new option and click Next> button.
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4. From the next dialog select which techniques you want to be enabled. Make sure that Embroidery

technique is enabled.

Select the Techniques that you want to be enabled

5. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog
will appear. Using this dialog you must select a fabric type and a color that is as close as possible to
the one you are going to produce the design on. Expand any of the fabric categories, by clicking on
the + icon next to it, to select a fabric and-or a color for the fabric. After selecting the Fabric, choose
the color from the list at the middle of the dialog. The Fabric selection is not just an issue of
previewing the design on the fabric. The software automatically adjusts, according to the selected
fabric, various embroidery parameters. Embroidery quality depends on some of these parameters.
The software suggests the appropriate backing materials for every fabric, in the printout of each
design. In case that you don’t want to preview the design on any fabric you can select the none option
that exists in any of the fabric categories. In this case only the color that is select in fabric dialog will
appear in the background of the created design. More information about Fabric selection is provided
into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.
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·
Select fabric dialog

6. The Artwork source dialog will appear.

7. Select the From Embroidery option at the top of the dialog.

8. Click on the browse button  at the right to import the Stitch file design you want to embroider. 
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Starting dialog - 2nd page 

9. The Open dialog box will appear and you can find the design you want to embroider.

Open design dialog

10. Click on My documents folder at left side of the dialog.

11. Find and double click on the Embroidery designs folder. 

12. Inside Embroidery designs folder, you will find another folder called Creative DRAWings samples.

Double click to open it.

13. Inside the Creative DRAWings samples folder you will find .ngs stitch files which you can import into

Creative DRAWings®. You can import any of them, but for our example we will use the

CDW0004.ngs file.  

14. Select it and click the Open button.

15. The Artwork source dialog will appear once more with the design you selected under From

Embroidery field. 

16. At the Hoop section of the same dialog, you can select the hoop that you will embroider your design

on. If no hoop that your machine supports exists in the list, select one with similar dimensions. You

can create your custom hoops easily (Information on adding specific hoops will be covered later in

this manual.)

17. After selecting the Hoop, click Next> to continue.
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18. The Color reduction (number of threads) dialog will appear where you can select your Thread

palette. Use Palette drop-down menu to select any of the available thread manufactures palette. For

example, select Gunold Poly thread.

19. The colors of the design you are importing will automatically be assigned to the closest thread color of

the Gunold Poly in the Thread palette. 

Color reduction dialog

20. In the same dialog you can also reduce the number of the design colors. Our design has 5 different

colors of thread. The number of colors can be reduced now, or later inside the software. Click Finish

to end the process and convert the imported design into stitches. 

21. The design will appear in the working area filled with stitches.
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The imported design converted to stitches

22. We can change the colors of the hearts and add some text to the imported design. You can make

many changes to the embroidery design, but we will not cover that in this tutorial. The available tools

that Creative DRAWings® includes are presented thoroughly in following chapters. 

23. To change the color of each heart, select a heart by clicking on it and then clicking on the bottom right

corner of the color you want from the Thread palette bar at the bottom of the screen. The Thread

palette is split to two parts; the part on top where all the available colors of the Gunold Poly thread

colors are listed and the bottom part where the 5 currently used colors on the design are listed.

24. Change the objects colors by following the steps above, and then produce the design.

25. Now we will add some text to the design.

26. Activate the Text tool by left clicking on the  icon located on the Tools toolbar at the left side of

the screen.

27. Left click on the position you want the text to be placed and a blinking line will appear which allows you

to insert your text.

We changed the colors of the imported stitch file

28. Type “I love you.”  You can change the Font by selecting a different one from the Font name drop-

down menu on top of the screen. You can also change the Font size by typing its dimensions. If you

want the text to be Bold or Italic, click on one.

Tool options bar – Text options
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29. For this tutorial, the options were made as shown in previous figure. If you’ve been following this

tutorial on your screen, left click on the Rectangle selection tool  from Tools toolbar to confirm

our changes.

30. Select the Text object by clicking on it.

31. Change its Fill color by clicking on the bottom right corner of the yellow color and set its Pen (outline)

color to None by left clicking on the top left corner of None color icon. The None color icon will

change to this  and the Pen color will be removed from the Text object. 

32. The design should look like in the following figure. 

The design with some text added.

33. Now we are ready to embroider the design. 

34. To proceed to the embroidery process you have to save the file to the embroidery file format your

machine can read. To do that you have to select the File menu and then the Save as option. 
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Save As dialog box

35. Use Save as type drop down menu to select one of the available embroidery type files to export the

design. For example, if you have Brother Embroidery machine you have to select the .pes or .pec

embroidery file format.

36. In the File name field that is located at the bottom of the dialog type the name you want the design to

have. For example, type MyEmbroiderydesign.

37. Remember to save your design in .draw file format before saving it to any embroidery machine’s

format, because this is the file format which Creative DRAWings® uses to store all design

information.

38. When finished with the design, click Save. The design will be saved in the location you chose with the

name you gave to it. If you have saved the design directly to a floppy disk, a thumb drive, or to your

hard drive, you are ready to download it to your embroidery machine’s memory card and sew it out.

Otherwise you have to:

a) Open a windows explorer, 

b) Browse to the location you have save it, 

c) Right click on it and from the right click menu expand the Send to submenu 

d) Save to a 3.5 Floppy disk (A:) or to a thumb drive 

e) Then your design can be downloaded to your embroidery machine’s memory card to be sewn out.

(Note: in big commercial machines, the file can be downloaded directly to the machine’s

memory).
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39. After saving the design, make a printout so you can set the functions on the embroidery machine

correctly and then sew it out without any problem.

40. To do that, from File menu select Print option. 

41. The Print preview dialog offer all the information that is needed in order to embroider the design

correctly. Press OK button to create the Printout of the design. If you do not have a printer or you do

not want to print it, you can save it as an image file and view it with an image viewer. 

Printout of the design

42. To save the Printout to as image file, you have to click on the Save to .jpg button.

43. The Save printout as dialog will appear where you have to specify the location you want the image to

be saved,

A. Specify the location you want the image to be saved 

B. Type the File name you want the image to have

C. Click on Save button

D. You can view the image you have saved by double clicking on it. 

44. All the information you need is listed in the Printout, including the embroidery sequence of the design

(1-2-3 order of sewing out), the color changes, the number of stitches, and much more useful

information.

45. You are ready. Download the file to your embroidery machine, use the printout as your guide to set up

your machine, and then sew out the design you have just created.

Create monogram design

This is a step-by-step tutorial to guide you in creating a Monogram design. 
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1. Start Creative DRAWings application by double clicking on shortcut icon  that you will find on

your Desktop. 

2. Creative DRAWings® application will open and the starting dialog named New Design will appear.

Starting dialog

3. Use Create new option and click Next > button.

4. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog
will appear. Using this dialog you must select a fabric type and a color that is as close as possible to
the one you are going to produce the design on. Expand any of the fabric categories, by clicking on
the + icon next to it, to select a fabric and-or a color for the fabric. After selecting the Fabric, choose
the color from the list at the middle of the dialog. The Fabric selection is not just an issue of
previewing the design on the fabric. The software automatically adjusts, according to the selected
fabric, various embroidery parameters. Embroidery quality depends on some of these parameters.
The software suggests the appropriate backing materials for every fabric, in the printout of each
design. In case that you don’t want to preview the design on any fabric you can select the none option
that exists in any of the fabric categories. In this case only the color that is select in fabric dialog will
appear in the background of the created design. More information about Fabric selection is provided
into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.
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·
Select fabric dialog

5. The Artwork source dialog will appear 

6. Select the New monogram option and Click on Next button 

Starting dialog - 2nd page 

7. In the next wizard step we must define the parameters of the monogram.
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Open design dialog

8. First we must define the size of the monogram. Define the width and the height of the area that the

monogram will be placed and if the monogram dimensions will be sized proportionally or not.

9. Select the monogram frame, there are various types of frames (Borders, Sides, Corners). 

The monogram frame is fitted into the specified dimensions. There are various types of
monogram frames, some of them are rectangular and some of them parallelogram. If
proportional is  enabled the program tries to make the best fit of one dimension of the
frame and changes the other dimension accordingly. If it is  not enabled. the frame is
stretched in order to fit into the specified dimensions.
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After the frame is selected a rectangular area inside the frame is kept for the monogram
characters. 

10. Add the 3 characters of the monogram and select a font.

11. Select one of the available monogram templates.

12. Finally, you can specify stretch value. if stretch value is 100% the monogram will take the whole

place that remains inside the borders in order to add the monogram chars. Using 120 %  the

monogram characters will be stretched and take more space inside the frame.

 

13.  Click Next> to continue.

14. The Color reduction dialog will appear where you can select your Thread palette. Use Thread

Palette drop-down menu to select any of the available thread manufactures palette. For example,

select Gunold Poly thread.

15. The colors of the design you are importing will automatically be assigned to the closest thread color of

the Gunold Poly in the Thread palette.
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16. In the same dialog you can also reduce the number of the design colors. Our design has 3 different
colors of thread. The number of colors can be reduced now, or later inside the software. Click Finish
to end the process and convert the imported design into stitches. 

17. At this point the monogram is almost ready. You can click Finish to terminate the wizard and place

the monogram design inside the design area. 

If you move the wizard dialog you can see the created monogram in the design area
previewed.

18. Now we can edit - change the monogram template, the placement of the characters and much

more. All these editing options are described in detail in Monograming section of Designing tools

chapter.
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Create your first Cut design
This is a step-by-step tutorial to guide you in importing an artwork file and convert automatically into Cut lines.

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.

2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.

Starting dialog

3. Select the Create new option and click Next> button to proceed.

4. In the appearing dialog you must select which Techniques you want to be enabled for the created
design. For the purposes of this sample we will enable only Cut technique. Then click on Next
button to proceed.
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Select Techniques

5. The Artwork source dialog will appear.

6. Select the From artwork file option and click on the Browse button , to import the design you
want to convert to Cut. Since we have enabled only Cut technique all the parts of the design will be
converted into Cut lines. 

Artwork source 

7. The Open dialog box will appear to locate the design that you want to embroider.
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Open design dialog

8. On My documents folder there is an Embroidery designs folder. 

9. Inside Embroidery designs folder you will find another folder called Creative DRAWings samples.

10. For the purposes of this example we will select one of the files that are located Cutting samples
folder.

11. Select any sample, in our example we will use the cloud_thunder.svg file.

12. Left click to select any sample, take a look on the preview to confirm that it is as you like and then
click the Open button to confirm the selection.

13. The Artwork source dialog will appear once more with the design you selected under From file
field.
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Artwork source 

14. You can also select the cutting mat to preview the design on.

15. Click Finish to end the process and convert the imported design to Cut lines.

16. The design will appear in the working area previewed on a matte surface.

The imported artwork converted into cut lines

17. There are many changes that you can do on the artwork or create new parts, but we will not present
them now in this Quick Start topic. We will only present the procedure of producing this Cut design
with a digital cutter.

At this point we must mention that any design part - artwork can be converted into a cut

line s imply by selecting the desired part and click on the Cut outline type . You can

use the design tools to add new parts on this design and by selecting cut outline type 
you can easily changes created parts into Cut lines

18. Let's suppose that we are done with the design and we are ready to Cut the parts using our digital
cutter.

19. From File menu, Export sub-menu activate Export to Cutters option.
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20. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

21. The Export to Cutter dialog will appear, using this dialog you can Cut any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog. 

Before proceeding you must have loaded the cutting mat with the cutting material into
the Cutter. 

22. First select the design parts that you want to cut from the Templates area.

23. Then you should select an origin. This is the point that you want the cutter to begin from. 

24. If you have never used this material on your Cutter you should first perform a Test cut to verify that
the material is Cut properly with the current settings. Using the arrow buttons move the Blade to a
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position that will not be used for the actual Cut and press Test button. The cutter will perform a test
Cut of the material, peel the cut part in order to verify if it was correctly Cut. if it was not adequate
adjust the cutter options until you are satisfied by the result.

25. Now you must position the Blade for the actual Cutting of the material. In our case we must move
the Blade close to the edge of the upper left part of the material according to the origin we have
selected. Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the
position of the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

26. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

27. Finally press Cut in order to start the actual cutting process. 

28. After the cutting process remove the cutting mat with the material and peel the cut Cloud and
Thunder parts. That's all for now, if you have followed the guide you should now have on hands the
Cut thunder and the Cloud parts.

Create your first stencil design
This is a step-by-step tutorial to guide you in importing an artwork file and convert automatically into Stencil
lines.
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1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.

2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.

Starting dialog

3. Select the Create new option and click Next> button to proceed.

4. In the appearing dialog you must select which Techniques you want to be enabled for the created
design. For the purposes of this sample we will enable only Stencil technique. Then click on Next
button to proceed.
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Select Techniques

5. The Artwork source dialog will appear.

6. Select the New graphic option, select the Cutting mat that you will use from the drop down menu
and click Finish. 

New graphic - Select Cutting mat

7. The dialog will finish and the working area will apear empty, showing only the cutting mat that you
you have selected to use. If the cutting mat is not visible, from View menu select Cutting mat  and it
will become visible.

New empty design with cutting mat

8. From Tools menu select Insert Symbol option.
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Tools - Insert Symbol

9. Select the Windings font from the font list and select the symbol shown below.Click Insert to insert
it on the cutting mat.

Select the Symbol you want

10. Click and drag on the cutting mat to draw the symbol on the cutting mat. Release the mouse to
insert it. 
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Insert Symbol on the working area

11. The symbol will inserted without fill type (Artwork fill) and with Stencil  outline/pen type.

Stencil outline/pen type

12. Set fill color to none  by clicking on the none fill  icon.
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Set fill type to none 

13. The design is a closed shape and the Stencil cutting area is not visible. To convert it to a proper
stencil design you have to convert it to an open shape by adding stencil bridges. To do that you have

to click on the edit shape nodes  from the options toolbar.

Edit Shape nodes of the symbol 

14. To add stencil bridges you have to right click on the location where the bridges will be added and
select the respective option from the pop-up menu.
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Add stencil bridge on the symbol 

15. Continue adding Stencil bridges in generally close distances to make the stencil more stable. 
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Add more stencil bridges on the symbol 

16. The outline of the symbol is correctly converted to stencil and can be send to the cutter. If you want
also convert the inner part of the symbol to stencil you can add stencil bridges to this object tool 

Add stencil bridges at the shape inside 

17. The stencil design is ready and you can send it to your cutter. 

18. From File menu, Export sub-menu activate Export to Cutters option.
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File > Export > To Cutters

19. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

20. The Export to Cutter dialog will appear, using this dialog you can cut the Stencil design with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog. 
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Ready to send the design to the cutter

Before proceeding you must have loaded the Cutting mat with the cutting material into
the Cutter. 

21. First select the design parts that you want to cut from the Templates area.

22. Then you should select an origin. This is the point that you want the cutter to begin from. 

23. If you have never used this material on your Cutter you should first perform a Test cut to verify that
the material is cut properly with the current settings. Using the arrow buttons move the Blade to a
position that will not be used for the actual Cut and press Test button. 

24. The Test Cut dialog will appear listing all the cutter settings that you can adjust. Make the
adjustments you prefer or select any cutter preset from the available ones. Click Test to cut the
test design, which will be made based on the specific settings. Peel the cut part in order to verify if it
was correctly Cut. If you are satisfied with the specific settings you can click Apply. The settings will
be updated on the Object properties toolbar.
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send the design to the cutter

25. Now you must position the Blade for the actual Cutting of the material. In our case we must move
the Blade close to the edge of the upper left part of the material according to the origin we have
selected. Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the
position of the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

26. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

27. Finally press Cut in order to start the actual cutting process. 
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Export to Cutter

28. After the cutting process remove the Cutting mat with the material and peel the cut shapes to
produce the final stencil design. That's all for now if you have followed the guide you should now
have your first stencil design created.

Create design using Crystals

This is a step-by-step tutorial to guide you in creating a design using Crystals in order to fill objects.

1. Start Creative DRAWings application by double clicking on shortcut icon  that you will find on

your Desktop. 

2. Creative DRAWings application will open and the starting dialog will appear.
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Starting dialog

3. Select Create new option and click Next button.

4. From the next dialog select which techniques you want to be enabled. Make sure that Crystals

technique is enabled.

Select the Crystal Technique that you want to be enabled
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5. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog
will appear. Using this dialog you must select a fabric type and a color that is as close as possible to
the one you are going to produce the design on. Expand any of the fabric categories, by clicking on
the + icon next to it, to select a fabric and-or a color for the fabric. After selecting the Fabric, choose
the color from the list at the middle of the dialog. The Fabric selection is not just an issue of
previewing the design on the fabric. The software automatically adjusts, according to the selected
fabric, various embroidery parameters. Embroidery quality depends on some of these parameters.
The software suggests the appropriate backing materials for every fabric, in the printout of each
design. In case that you don’t want to preview the design on any fabric you can select the none option
that exists in any of the fabric categories. In this case only the color that is select in fabric dialog will
appear in the background of the created design. More information about Fabric selection is provided
into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.

·
Select fabric dialog

6. The New design dialog will appear.

7. Select the New graphic option that is located at the bottom of the dialog.
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Starting dialog - 2nd page 

8. At the Cutting mat section of the same dialog, you can select the Cutting mat that you will use to cut

the design on. If the cutting mat your machine supports does not exist in the list, select one with

similar dimensions and you can customize the dimensions later. You can create your custom cutting

mat easily inside Creative DRAWings.

9. After selecting the Cutting mat Click Next> button to continue.

10. The workspace will appear with the selected hoop at the center but without any design in it.

11. We will add a Girl symbol we will fill it using Crystal fill and then we will present a way to edit and

change this Crystal fill. 

12. From Tools menu use Insert symbol option. The following dialog will appear.
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13. Click on the highlighted girl symbol and then press insert button. The cursor will turn into a cross

waiting to specify a reference line. 

14. Click and drag to specify the reference line that the symbol will be placed on. Click and drag towards

the direction that is shown by the red arrow into the following image.

Click and Drag to define the size and rotation of the symbol The symbol is added and filled with step

15.  The symbol has been added to the design and it is by default filled with step stitches . 

16. Remove the outline from the design by setting the pen color to empty  .

17. Select the entire design and click on the Crystal fill  icon from the Object properties

toolbar.
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Girl symbol filled with crystals

18. The symbol is filled with crystals automatically. At first look the result is not attractive, but Creative

DRAWings gives you all the tools to change it in any way you like.

19. From the Object properties toolbar select the Palette of crystals you are using. Currently there are

three palettes available. The Default Palette, the Swarovski Round and the Preciosa VIVA12. 

Select palette

20. Each crystals' creator palette contains only the crystals that are included in the specific collection.

After selecting, for example Swarovski Round palette the crystals that includes appear on the

Color/Shape list from where you can select any crystal by simply clicking on it. 
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Color/Shape

21. If you do not have any of the available palettes your only alternative is to use the Default palette. The

Default palette contains only one crystal. You can use this crystal to fill all your crystal designs and

change its color by simply changing the color of the shape where crystal was placed. Therefore with

only one crystal you can apply any color you like by changing the color of the shape. 

22. In our example with will select the Swarovski Round palette and apply the Topaz crystal. 

Apply Topaz color/shape

23. At the bottom of Object properties toolbar you will find the Cutter options for the selected crystal

object. Select a Cutter Preset from the available ones ore set the cutter options according your

preferences.  
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Cutter Presets

24. Use Separate to Crystals button to convert the selected object into individual Crystals. Then you are

able to delete, move or manually add Crystals.

Separate to crystals

25. It is very useful when you want to create a shape filled with crystals and then assign different crystal 

Color/Shape to parts of the design. For example select all the crystals of the girl's skirt and press on

any of the available crystal colors. In this example we have selected Fuchsia. 

Selected Skirt crystals Applies fucshia Crystal color

Keep in mind though that you cannot group the separated crystals back to an crystal fill
object. Therefore keep the Separate to crystals option as your last choice or keep a
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duplicate object of the one that you will Separate to crystals in order to be able to go back
and edit it again

26. In the same way we can create a shirt for the girl symbol.

Draw an oblong shape

27. For the purposes of this example, now we will only present how to export the Crystal design. 

28. From File menu use Export submenu and To Crystals / Cutters option. This option will appear only

if there is a design on the working area. Otherwise will be disabled.

29. From the appearing dialog you have the ability to export the design in various ways. We can export as

HPGL file - SVG file - DXF file - FMC file or directly sent the created design to a specific cutting

machine. The machine will create the crystal holes, cut the outline of the shape you have created.



85Quick start

© 2017 DRAWstitch Ltd.

Sent design to Artistic Edge cutting machine

30. Select your machine from the list and click Connect. 

31. The Export To Cutter dialog will appear. Based on the Cutting machine you can adjust the Speed,

the Pressure, the Cutter Offset to all cut templates or adjust more cutter parameters for each

template through the Test dialog. If the fields are enabled then you can edit this options, otherwise

you will have to do it manual from the machine's panel. The values that you will see in the fields are

the default values that we recommend you to use with the specific machine.

32. In the dialog you can also adjust the design's Origin. At the Origin area you can specify the position

from where you want the machine to start creating the design. This option helps you to position the

material that will be cut at the correct position. You can change the Origin by simply clicking on the

respective green cross. 
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33. Before clicking the Cut, make sure that you have inserted the cutting Mat with the cutting material in

the Cutter and you have positioned the cutter header (use the arrows from the dialog) at the location

where you want the design to be cut. 

34. Select a template you want to cut from the Templates list (If you want to cut one one set of holes) or

select all/more than one and then click Cut button to begin cutting the design.  

Create your first Paint design
This is a step-by-step tutorial to guide you in creating your first Paint design.

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.

2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.

Starting dialog

3. Select the Create new option and click Next> button to proceed.

4. In the next step you must select which Techniques you want to be enabled for the created design.
For the purposes of this sample we will enable only Paint technique. Then click on Next button to
proceed.
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Select Techniques

5. When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric
dialog will appear. Using this dialog you must select a fabric type and a color that is as close as
possible to the one you are going to produce the design on. Expand any of the fabric categories, by
clicking on the + icon next to it, to select a fabric and-or a color for the fabric. After selecting the
Fabric, choose the color from the list at the middle of the dialog. The Fabric selection is not just an
issue of previewing the design on the fabric. The software automatically adjusts, according to the
selected fabric, various embroidery parameters. Embroidery quality depends on some of these
parameters. The software suggests the appropriate backing materials for every fabric, in the printout
of each design. In case that you don’t want to preview the design on any fabric you can select the 
none option that exists in any of the fabric categories. In this case only the color that is select in
fabric dialog will appear in the background of the created design. More information about Fabric
selection is provided into a separate topic. After selecting a Fabric and a color for the fabric click on
Next to proceed.
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·
Select fabric dialog

6. The Artwork source dialog will appear.

7. Select the From artwork file option and Click on the browse button  at the right to select a
design.

Starting dialog - 2nd page 

8. The Open dialog box will appear from where you can browse to find any bitmap or Vector image to
be used as artwork for the new design.
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Open design dialog

9. Click on My documents folder at left side of the dialog.

10. Then find and double click on the Embroidery designs folder 

11.  Inside Embroidery designs folder you will find another folder called Creative DRAWings
samples. Double click on it.

12. Inside the samples folder you will find ready-made Vector (clipart) designs that you can import and
convert to a Paint design. Select any of them, in our example we will use the ASC-00340.cmx file.
Select it and click the Open button. 

13. The Artwork source dialog will appear once more with the design you selected under From file
field. Click on Next to proceed.

14. The Color reduction (number of Brushes) dialog will appear where you can select the Brushes
palette. Since only the Paint technique is enabled, the software will convert the imported design
using paint types and paint colors.
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Color reduction dialog

15. Click on the arrow under the Brushes Palette and the drop-down menu will show the available
ones.

16. Select the brand-name brush palette you want to use by clicking on the list. For example, select the 
MARABU TEXTIL PAINTER brush palette.

17. The colors of the design you are importing will automatically be assigned to the closest brush color
of the MARABU TEXTIL PAINTER palette. 

18. In the Color reduction dialog you can see that the design has 6 different colors but the design is
automatically reduced to 4 colors since the palette has only 4 brushes.

19. You can reduce the number of colors in the design by moving the arrow to the left.  Click Finish to
end the process and convert the imported design to a Paint design.

20. The design will appear in the working area filled with the available Paint types. You can have a better
preview of the paint effect by activating Realistic paint 

The imported design converted to Paint Realistic paint view

21. Select any of the design parts and see on Object properties, Paint fill or outline types have been
automatically applied. Every time you select a Paint object its properties appear on the Object
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properties Toolbar. You can select multiple object by holding the Shift key pressed and clicking on
the objects you want to add it to the selection.

22. For example select the heart, as you can see Paint fill is the automatically select Paint type. You
can easily change the fill type by clicking on any other fill type for example Row-fill.

23. We can  use all editing tools and perform various transformation on the artwork. At this point we will
only mention something about object properties. There are various properties for any of the paint
types. For example for the Paint Row fill of the previous figure we can adjust the Density and or use
Short/long movements.

Initial object Disable short/long Increased density

24.  At this point we should mention about Cutter settings, let's suppose that we own Artistic Edge
digital cutter and our design has only paint objects. We will select all objects and from Cutter
presets we will select the preset Edge - Paint. The selected set of cutting options (Cutter speed,
pressure, passes) will be applied to all selected objects. This cutter settings are suitable for Paint
objects.

Paint preset - Cutter settings 

25. Let's suppose that we are done with the design and we are ready to Paint the parts using our Digital
cutter (the cutter must support placing of a Brush instead of the Blade).
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You should always save the design to .draw file format, in order to have it for later
reference.

26. From File menu, Export sub-menu activate Export to Cutters option.

27. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

28. The Export to Cutter dialog will appear, using this dialog you can DRAW any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog. At this point that we must mention
that on the preview you can see the actual colors of the Brush palette that you have selected for the
design. Some colors have been substituted by their closest one from the Brush palette. For
example the Pink  color was substituted by this number 029 color called Flesh Color.
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Before proceeding you must have loaded the cutting mat with the material to Draw into
the Cutter. 

29. We will now proceed and Draw the design parts onto any paper like material or onto a Fabric.
Select all items from the Templates area.

30. Then you should select an origin. This is the point that you want the cutter to begin Drawing from. 

31. If you have never used this material or the Pen on your Cutter you should first perform a Test to
verify that the Pen/Brush Draws as you wish on the current material. More information about Test
functionality setting is provided into separate topic.

32. Place the respective Pen on the pen holder and now you must position the head of Cutter with the
first Pen / Brush at the position on top of the area the you want to Draw. More specifically we need
to place the head close to the edge of the upper left part of the material according to the origin we
have selected. Use the arrow buttons to move the Head to a desired position. If you need to fine tune
the position of the Head you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

33. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

34. Finally press Draw in order to start the actual cutting process. When the part of the first Pen is
complete the Cutter will stop and you will be prompted to place the next Pen/Brush onto the pen
holder.
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Create a design from scratch
Creative DRAWings provides the ability to create an embroidery design from scratch by using all  available
designing tools and your creativity. With the designing tools that the software includes you can create any
embroidery design you want easily and quickly. In this section we will show you how to create a design step
by step. 

1. Start Creative DRAWings application by double clicking on shortcut icon  that you will find on

your Desktop. 

2. Creative DRAWings application will open and the starting dialog will appear.

Starting dialog

3. Select Create new option and click Next button.

4. From the next dialog select which techniques you want to be enabled. Make sure that Embroidery

technique is enabled
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Select the Techniques that you want to be enabled

5. The Select Fabric dialog will appear. Expand the Embroidery normal category from the list at the
left by clicking on the + icon next to it.

6. Select the fabric that is similar with the one you will actually use to embroider the design. For example

select Craft Fleece fabric. 

Select fabric dialog
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7. Select a color for the fabric that your fabric has from the color list at the middle of the dialog. For

example select gray color. 

8. Click Next> button to continue.

9. The New design dialog will appear.

10. Select the New graphic option that is located at the bottom of the dialog.

Starting dialog - 2nd page 

11. At the Hoop section of the same dialog, you can select the hoop that you will embroider your design

on. If the hoop your machine supports does not exist in the list select one with similar dimensions.

You can create your custom hoops easily inside Creative DRAWings.

12. After selecting the hoop you want Click Next> button to continue.

13. The workspace will appear with the selected hoop at the center but without any design in it.

14. We will create a flower by using the available designing tools of Creative DRAWings. From the Tools

toolbar that is located at the left side of the working space, and holds all the designing tools select the 

ellipse tool . The ellipse tool is above the Text tool . If a different shape is visible at that

position, click on the small arrow at the bottom right of the icon to expand it and then select the ellipse

tool that will appear.
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15. With the ellipse tool selected, draw an oblong shape like a petal, by click and dragging with the

mouse on the working area.The oblong shape that you create will automatically be filed with Satin

stitches and have a running outline. If the shape you created is big, it will be filled with Step stitches. 

16. The shape will be filled with the default Fill color and the default Outline/Pen color. To change the Fill

color you have to select the shape/object and Left click on the color you want from the Thread

palette toolbar at the bottom of the screen. To change the outline/Pen color you have to hold the

Shift key pressed from the keyboard and then left click on the color you want. 

Draw an oblong shape

17. In our case we do not want the shape to have any outline/pen color. We will hold Shift key pressed

and then click on the None color icon . The outline will be removed from the shape and the None

color icon will change to  icon, which means that our shape does not have any outline color.

18. Select the shape by clicking on it. 

19. At the middle of the selected shape you will see a small cross. This is the rotation center of the

design. Click and drag it to the bottom of the shape and position it outside of the shape. This will allow

us to rotate the shape based on a different rotation center.

  Select shape – Move Rotation center– Rotate from top-right corner and duplicate
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20. Position the mouse on the top right corner until you see the rotation icon, which is a curved arrow. 

21. Click and drag the clockwise and the object will start rotating. At the point that the original shape ends,

Right click once while keeping the Left click pressed, to activate the Duplicate function. The cursor

will change to this icon . When you are ready release the left click to Duplicate the object. The

duplicated object will appear at the position you rotated. 

22. To avoid doing that again and again until you draw all petals of the flower, you can simply select the 

Repeat last transform option from the Edit menu. This option will redo your last transformation,

based on the last inserted petal, as many time you want. 

Apply Repeat last transform option

23. Now we will design the center of the flower. 

24. Select the Ellipse tool , once more, from the Tools toolbar.

25. By click and dragging on the center of the petals, draw a circle. If you hold the Ctrl key pressed while

dragging with the mouse diagonally, guidelines will appear that help you draw the shape based on

them. By dragging based on the diagonal guideline you can draw a perfect circle.

  

Draw a circle – remove outline - change color
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26. If the circle you created is not exactly at the center of the petals you can move it by click and dragging

it to the position you want. 

27. Select the circle you created, change its color to Yellow and remove its outline by following the

same procedure we described on 15 and 16 steps.

28. Your flower is ready to be embroidered. 

29. To avoid losing you work you have to save the design in .draw file format that makes it fully editable

inside Creative DRAWings. To do that you have to select the File menu and then the Save as option. 

Save As dialog box

30. The Save As dialog will appear. Find the location you want the file to be saved. For example, inside

the Embroidery designs folder that is located inside My documents folder. If you want you can save

the design directly to your floppy disk or your memory card that your machine reads.

31. In the File name field that is located at the bottom of the dialog type the name you want the design to

have. For example, type Mydesign.

32. Then click on the Save as type drop down menu arrow to view the available file type options. Select

the .DRAW type which is the first on the list. The .DRAW file format is the file format that Creative

DRAWings supports and holds your artwork together with your stitches. Click Save button to

continue. 

33. If you want to embroider the design you have to save it also to the file format your embroidery

machine reads. For example, if you have Huqsvarna embroidery machine you have to select the .Hus

or .Vip embroidery file format. 
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34. After saving the design, make a printout so you can set the functions on the embroidery machine

correctly and then sew it out without any problem.

35. To do that, from File menu select Print option. 

36. In appearing Print preview dialog we can find all necessary information in order to embroider the

created design correctly. If you have a printer you can press OK button and make a Printout of the

design. If you do not have a printer or you do not want to print it, you can save it as an image file and

view it with an image viewer program. 

Printout of the design

37. To save the Printout as image file you have to click on the Save to JPG… button.

38. The Save printout as dialog will appear where you have tο: 

· Specify the location to save the file.

· Type a filename for the file.

· Click on Save button

· In order to view the saved image you have to simply double click on the created file.

39. All the information you need is provided in the Printout including the Embroidery sequence of the

design, the color changes the number of stitches and many more useful information.

You are ready. Load the file to your embroidery machine, use the printout as your guide to setup your
machine and embroider the design you have just created.
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Working with files

Chapter III

In this chapter you will learn how to import and convert almost any type of artwork that you wish to import.
The secret of the powerful Creative DRAWings is that it can import any clipart or photo and quickly convert it
into a design.

You can easily import vector and bitmap pictures and directly convert the artwork into a design. Images can
be imported in 3 ways. You can import from a file, get image from scanner or take a snapshot from camera.
Imported bitmap images can be traced and converted into vector artwork.

You can also import an embroidery design created in another embroidery program. This is a fantastic feature,
we can import any stitch design and add new design objects to this old design and reproduce a newer and
improved version. 

After learning the available ways to create a design, you will learn all the available tools to review the design
and get it ready for production by the embroidery machine. (Print preview, Save and Export).

Vector and Bitmap designs

Creative DRAWings can import Vector designs and directly convert them into a design. Additionally Bitmap
graphics can be imported and handled in 2 ways. The graphic can be opened As backdrop to be used for
creating the design you want based on the image or to be Traced (Convert into vector outline). 

Vector graphics: Vector designs are created as collections of lines. Vector designs are
images/drawings generated from mathematical descriptions that determine the position
length and direction in which lines are drawn. 

The vector files types that can be recognized and used by Creative DRAWings are: 

· Corel Graphics (*.CMX)

· Encapsulated Postscript (*.EPS) 

· Enhanced windows metafile (*.EMF)

· Scalable vector graphics (*.SVG) 

· Adobe Illustrator (*.AI)

· AutoCAD (*.DXF)  

· Windows metafile (*.WMF)

· HP GL file (.PLT)

All these types of files can be directly imported into Creative DRAWings, which recognizes and visualizes all

mathematical descriptions that determine the position, length and direction in which lines-shapes are drawn.

The imported artwork is converted directly into outline design.
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Bitmap graphics, which are mainly photographs, are saved in .bmp, .jpeg, .gif, or .jpg)
files formats. Bitmap graphics (Images) are made of patterns of individual dots or pixels.
The shapes that they contain cannot be easily resized. 

The bitmap file formats that Creative DRAWings supports are as follows:

· Bitmap files (*.BMP,*.DIB,*.RLE)

· Jpeg file (*.JPG, *JPEG, *JPE,*JFIF)

· Gif file (*.GIF)

· Tiff file (*.TIF,*.TIFF)

· Png file (*.PNG)

· Icon file (*.ICO)

Bitmap graphics can be traced or used as Backdrop. Trace process turns the bitmap into a Vector design
so it can be embroidered. We can also use it as a backdrop and design o top of it.

Now that you’ve learned that Vector means clipart and that Bitmap means a photograph or picture, we’ll use
the graphics terms of Vector and Bitmap as you familiarize yourselves with them.

There are various file formats which can include Vector and Bitmap graphics but you can only import by
copying and pasting them or by importing them from the application you are using. This process of acquiring
files from different graphics software will be described later on. 

Creating designs

As we have already mentioned in workspace tour Creative DRAWings starts with a wizard to help you
create new designs, using various sources of artwork. 

Startup wizard

We can create and handle many files at the same time. Every created or opened design opens in a new tab.
When opening a new design, a new tab appears next to the previous and you can switch between them by
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clicking on their filename. You can also use Ctrl+Tab keyboard combination in order to move to the next tab
or Ctrl+Shift+Tab to move to previous tab.  

Design tabs

When you have already created a design and you are inside the application window, you can create a new
design in 3 ways. First you can use New design option of File menu. In addition you can press Ctrl+N

keyboard shortcut or the new design icon of standard toolbar. A wizard will start-up to select which
techniques to be available for the new design. Select the techniques that you want to be available and click on
next to proceed.

When you have enabled any of the Embroidery, Crystals or Paint techniques then the Fabric dialog will
appear. Using this dialog you must select a fabric type and a color that is as close as possible to the one you
are going to produce the design on. Expand any of the fabric categories, by clicking on the + icon next to it, to
select a fabric and-or a color for the fabric. After selecting the Fabric, choose the color from the list at the
middle of the dialog. The Fabric selection is not just an issue of previewing the design on the fabric. The
software automatically adjusts, according to the selected fabric, various embroidery parameters. Embroidery
quality depends on some of these parameters. The software suggests the appropriate backing materials for
every fabric, in the printout of each design. In case that you don’t want to preview the design on any fabric you
can select the none option that exists in any of the fabric categories. In this case only the color that is select
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in fabric dialog will appear in the background of the created design. More information about Fabric selection is
provided into a separate topic. After selecting a Fabric and a color for the fabric click on Next to proceed.

·
Select fabric dialog

Click Next > and the Artwork source dialog appears. In this dialog you have six possible options to acquire
artwork.

Artwork source dialog
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First select an artwork source and at the end of the dialog you can select a Hoop to preview you design on.
You can leave it as it is, or if you decide later you need another size of hoop, click on Tool >Change hoop to
select the correct size. If you do not want a hoop, click None hoop. After you select a source of artwork, a
hoop and the desired design mode you are ready to proceed. 

Artwork sources

There are several sources that can be used to import artwork.

· From File, use any Vector or Bitmap file as artwork for a new or an existing design. 

· From Embroidery, import an embroidery file.  

· From scanner, get image from scanner.

· From camera, get snapshot from camera.

· New monogram, create a new monogram design

· From scratch, use your inspiration to create a design from scratch.

From file (Vector or Bitmap)

Use this option to Browse inside your computer and locate a bitmap or a Vector  file to convert into

embroidery design. Click on the Browse  icon to select the file. The Open dialog box will appear, only the
supported Bitmap or Vector files can be selected. A complete list of supported file formats exists Vector and
Bitmap designs section. Locate a file and and click Next >.  According to the selected file type (Bitmap -
Vector) there are various conversion options.

Bitmap file

If the selected file is a Bitmap, a dialog will appear providing various conversion options. There are four
options as shown in the figure below: Open as Backdrop, Trace (convert  to outlines), Open as Cross
stitch and Open as photo stitch. We will just refer to these options and we will describe them in detail later
in this chapter. 

· The Open as backdrop option will import the Bitmap image as a backdrop on which you can manually
draw the embroidery design on top of it.

· The Trace option will convert the Bitmap to a Vector outline design that can be filled with normal outline
stitches (Running, Satin Serial).

· The Open as Photo paint option can convert the bitmap file directly into photo paint design.

· The Open as Cross stitch option will convert the Bitmap design to a perfect Cross stitch embroidery
design. 

· The Open as Photo stitch option can convert the bitmap file directly into photo stitch design.
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Artwork image dialog

Select one of the conversion options and click Next. If you select the Open as Backdrop option the software
will place the image as backdrop directly without the Color reduction dialog. If you selected Open as Cross
stitch or Open as Photo stitch the Color reduction dialog will appear immediately.

Color reduction dialog

You can reduce the number of threads from 6 to 5, for example, without changing the hue of the design
drastically. Experiment by clicking on the arrow and moving it to different numbers of color threads. This
dialog allows a complicated design of many threads to be reduced for easier sew-outs on a single-needle
machine. Click on Palette and the dropdown menu offers a variety of thread manufacturers. Select Madeira
Classic, for example, and you’ll see the Gunold Poly thread number listed. Your supplier stocks the Madeira
thread by this number. Click Finish to continue. The design are will appear blank having only the selected
image as a background in order to work as guideline for creating the new design. 

 If you select the Trace (convert to outlines) option, then you must customize the Trace of the selected
image and then the Color reduction dialog will appear after tracing the bitmap image. After customizing the
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design colors click Finish to continue. The Traced bitmap will appear in the design area. Now you can modify
any part of the created embroidery design using all available design tools.

Trace image dialog

Vector file

In case that you select a Vector file when using From file option, the selected Vector artwork will be
converted automatically into an outline design. The only thing you have to do is to select a Thread
manufacturer palette and the number of used colors.

 

Click on Finish and the design will appear in the design area ready to be edited. Select any object and use
any of the available design tools to edit the design part.
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From embroidery

Using Import embroidery files option you can import a stitch file format (like “.exp”, “.ngs”, “.dsz”, “.pes”…)
inside Creative DRAWings unchanged. The procedure is very simple, from Artwork source dialog select

From embroidery option and browse  to locate any embroidery file you like. You’ll see the selected file
listed under From embroidery field.  Click Next to proceed.

Import from embroidery file

Color reduction dialog is the next step, select a Thread manufacturer palette and the number of
threads to use. Now you’re ready to import, click on the Next to proceed. 
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Click Finish to view the imported embroidery file. The select embroidery file is imported as  is in the design
area. 

The embroidery design is imported as is. You can not edit the artwork or the stitch types of the imported
design. You can create new parts and reproduce the updated design. There is also an option to convert any
design part into Outline design, using Convert to curves option. The stitches of this object are removed
and it is converted into vector outline in order to be edited as any object that is created by Creative

DRAWings. 

Stitch files can only be imported from the startup wizard and not from any internal menu -
option.

You can read more about how to Import embroidery files  and if you want Convert it to vector artwork later in
this chapter.

From scanner

Using Get image from scanner option, you can scan an image and import it to Creative DRAWings as a
bitmap image. From Artwork source dialog, select Get image from scanner option, place your image in the
scanner and click next to proceed. The image scan dialog will appear with several options. Through the 
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Image scan dialog you can scan the design you want and make some adjustments. In the following figure
you can take a first look at the available scan options. You can read more about what Image Scan option
does later in this chapter.

Image scan dialog

You can press Preview  to review the image on the scanner before scan operation. Each time you change
an option from the Image scan dialog, you can preview it by clicking the Preview button. When you’re
satisfied with the image, click the Scan button. Your image will appear with a Save as dialog, asking where
you want to save it -- in your files or on a disk. When the scanned image is saved, the wizard will proceed
prompting you to select how to handle the bitmap image. Select to open as Backdrop  or Trace to convert
into Vector design. From this point you are handling the scanned image as any imported bitmap file. The
imported bitmap image can be used as a Backdrop, opened in Trace and filled with normal outline stitches
and opened as Cross stitch or as Photo stitch.  

Artwork image dialog
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In case that you need more information about the following wizard steps, about handling the imported bitmap,
review following section about Importing bitmap files. 

Note: You can find more information about scanning Scanning images into a separate
section.

From camera

With the Get image from camera option, you can take a snapshot with your camera and import it to Creative
DRAWings as a bitmap image. The imported bitmap image can be used as a Backdrop or opened in Trace
and filled with normal outline stitches (Running, Satin Serial) , opened as cross stitch or photo stitch design. 

The basic steps in order to take a camera snapshot and import the captured image are as follows: 

1. Make sure that your camera is plugged in to your Computer. 

2. From Artwork source dialog select the option Get image from camera.

3. The camera Preview dialog will appear with several options.

4. Through the camera Preview dialog you can take snapshots of anything you want and make some
adjustments to the image. 

Image scan dialog

5. In the Preview area you will view live the picture of your camera. 

6. You can make the adjustments on the camera until you capture the snapshot image you want. Each
time you change image Resolution or Properties the live image changes accordingly. When you’re
satisfied with the image, click the Capture button. The image you captured will appear in the preview
area showing you the result of your capture. If you do not like the snapshot you can take a new one by
clicking once more on the Capture New button. The previous taken image will be lost and the camera
will become live again, ready for a new snapshot. Once you are ready click again on Capture to take
the picture. 

7. If you are satisfied click on the Save… button to save the image on your hard disk. When the design is
saved, the image is automatically loaded inside Creative DRAWings prompting you to the import
dialog. You’ll be asked how you want the image to be opened: as a Backdrop, converted to a Vector
design in Trace, open as Photostitch or open as Cross stitch.  

8. From this point you are handling the scanned image as any imported bitmap file. 
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Artwork image

In case that you need more information about the following wizard steps, about handling the imported bitmap,
review the following section  about Importing bitmap files. 

Note : You can find more information about Capturing from camera into a separate
section.

New monogram

Using New monogram option of Artwork source dialog we can create a monogram design.  In the following

wizard steps we can customize the monogram design. More information about monogram designs will be

provided in monogram section of Design Tools chapter. At this point we will only demonstrate the usage of

New monogram option in order to create a monogram design from scratch. 

Select “New monogram” option of Artwork source
dialog and click Next to continue.
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Customize the newly created monogram design. 

Adjust the dimensions. The dimensions that we
provide define a rectangle that the monogram will be
placed inside. 
Stretch option can be used t define the percentage of
the dimension rectangle that will be used for the
monogram. For example if we define 90% as stretch
the wizard will apply the monogram on the 90% of the
dimension rectangle. If we define 130% the
monogram then the monogram will be applied into a
rectangle 30% larger than the defined dimensions. 
Type the characters the will be used for the
monogram and select a Font.

Select a monogram template.

Select a frame motif for the monogram.

There are three types of motifs. Borders, Corners and Side motifs. On the drop down list that we select

Frame next to the icon of the frame and before the name of the Frame there is a label that defines the type

of the frame. The 3  available labels are Borders, Corners, Sides. For the Corner motifs we can select

the corners that the frame will be visible. For the Side motifs we can select the Sides that the border will be

visible.
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Corner frames

When we select a Corner frame, this rectangle

appears with these handles on the corners. 

By default all corners are Visible. Click on any corner

handle to make not visible. Click once more to alter the

status. 

In the next figure you can see that upper left corner is

not visible. 

Side Frames

When we select a side Frame, this rectangle appears

with these handles on the sides.

By default all sides are Visible. Click on any Side to

make not visible. Click once more to alter the status

once more.

In the next figure you can see the left side is not visible.
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1. We can always see a preview of the created monogram on the design area behind the wizard. 
Customize the monogram and press Next to proceed.  

2. In Color reduction dialog, Select Thread manufacturer palette, adjust number of colors and press
finish. The monogram design has been created. Now we can edit the created monogram as any
normal design.

New graphic

New graphic allows you to manually draw a design and edit it using Create mode. Click on
Finish, Creative DRAWings window will open in Create mode where you can manually create the design
you want. Use the existing designing tools to create the embroidery design you want.

Loading designs

The program allows you to open only .draw file designs. All the other vector / bitmap files have to be imported
from the From file option that you will find in the starting dialog of the software or by copy and pasting it inside
the Create mode of the software.

You can load an existing design in many ways. First by using Open existing option of Create new design
dialog of the start-up wizard. We can also press Ctrl+O keyboard shortcut once the main application window

is loaded, and finally by pressing Open icon  in main toolbar. We have already discussed Create New
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dialog, using this dialog we can select whether we will load a design or if we will open an existing. In Open
Existing, you also get two options:  Browse your files and disks for a design or you can click on a List of
recently opened files. When you click on an existing Creative DRAWings® file (.draw) it will open in a new
design tab inside Creative DRAWings window. 

New design dialog

When you choose Open Existing, here’s the step-by-step procedure to follow: You can either Browse your
files and disks by clicking on Next > or open a List of recently opened designs by clicking on Finish. When
you Browse a file, you will see it in Preview at the bottom of the dialog. You can open one or more files by
selecting multiple designs. You can select multiple designs by using the Ctrl or Shift keys from the keyboard
or by making a rectangle selection with the mouse. Once you are ready click on Open button and the
design(s) will appear in a new design tab (separate tabs for multiple designs). 

In the starting dialog’s List, you can view the last several Creative DRAWings® files you have saved or
recently opened. To open one of these files, double click on it or click the Finish tab. If the file name you want
is not listed, select Browse > Finish and an Open dialog box will appear. After locating your file, click the
Open tab and a new window will appear where you can modify your design, and then save it.

Notice: If a Data Loss Warning appears, this means that you are trying to open a .draw file that was created
from a previous version of Creative DRAWings.

Data Loss Warning
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If you attempt to open the design Creative DRAWings will try to open it inside Create mode but you might
lose some information of the .draw artwork (that existed inside the old DRAW mode). Therefore, every time
you want to open a .draw file from a previous version of Creative DRAWings, you should save it with a new
file name so the original file to remain unchanged. By following this procedure, you will be able to work with
different versions of Creative DRAWings and avoid losing your artwork.  

Open dialog box

Using Open dialog, you can load an embroidery design from your .draw file or import from a disk or the
internet. This Open dialog -- a normal Microsoft Windows Explorer function – appears in any way we try to
load a .draw design. The same dialog appears when selecting other sources of artwork. The same dialog
appears but different files are supported in every operation. 

When Open dialog appears on the top line you can see Look in: which has a drop-down menu of files to
open any .draw file or a Vector design supported in your computer (in artwork source dialog). Click on the
downward arrow to expand your selection. Every time you return to the Open dialog, the program will show
the folder you last opened.  To find a design, you have to select its location in Look In. If you have your files
on a CD, click on the drive and you can bring in your .draw designs or even supported Vector designs. 

 Important: All new imported designs are brought into Creative DRAWings® through the
Look in field. 

Example:

Say you want to load a design in C:\Designs\Women directory.

1. Click on the Look in field and click on the C: hard-disk drive. 

2. The Look in field shows C: <Name of the disk> and the File list will show the contents of the hard disk
C:.

3. In the file list, double click on the folder Designs. The Look in field shows Designs and the file list will
show the contents of the C:\Designs folder.

4. In the file list double click on the folder Women. The Look in field shows Women and the file list will show
the contents of the C:\Designs\Women folder.

5. Double click on the design you want to load. On the right side of the Look in field are two more buttons
that help you change which folder you are searching through.

When you click on any file design, an image of the file will be displayed as a Preview at the bottom of the
dialog box. This image helps you select the design you want without having to recall the file name or number.
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Open dialog

Go to last folder visited

When you want to see previous files that you have opened, click on the back arrow, which is the left-facing
icon on the right of Look in. Keep clicking until you return to the design you want. In the given example, when
you are in the C:\Designs\Women and you press the back button, in the File list you will view the contents of
the C:\Designs folder. The second time you will press the back button you will view the contents of the hard
disk C: and the third time you will see the contents of your designs directory. 

Up one level

Clicking on this Up One Level icon will take you back to the folder preceding the sub-folder that your saved
design opened in. 

Example: Say your file open dialog shows the C:\Creative DRAWings\designs directory and you want to
find a design which is in C:\Creative DRAWings\men.

Press the Up one level button and the Look in field will show the C:\Creative DRAWings directory.

In the File list, double click on C:\Creative DRAWings\men. The list shows the designs or the sub-folders
that the current folder contains. Where you select your designs depends upon where you have saved them.

 Create new folder

With this button you can create a new sub-folder in the current folder. When this button is pressed, a folder
named New Folder appears in the File list area. The name of the folder remains highlighted allowing you to
rename it by writing in a new title.

 View options
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With this button you can specify the way that the sub-folders and the designs will be viewed in the File list.
The possible options are:

Thumbnails, Tiles, Icons, List, and Details.

On every design you select from the File list, the name or number is written in the File name field. In the
Preview box, you’ll see your image. If you can’t find the design you specifically wanted but know the name,
just type it in and press the Open button.

In the Files of type’s field you can select specific embroidery files names like .jpeg for example, and only
those files will be visible in the File List area. If you want to see all the files, no matter the file type, you can
select the All Files option. Click on the down arrow and you’ll see the big list of files that Creative
DRAWings® will accept besides the default .draw files.

Saving designs

When you create a design in Creative DRAWings® you can save it in many different file formats. The
standard saving format is .draw and it is the only format that Creative DRAWings can read and load and all
design information is kept all other formats aren’t lossless. The other file formats which Creative
DRAWings® can open and convert to .draw are:

· Wings Systems (".ngs")

· Tajima (".dst", ".dsz", ".dsb")

· Tajima TBF (".tbf")

· SEF xp (".sef")

· SWF (".sst")

· Pfaff (".ksm",".pcs", ".pcm")

· Singer (".xxx")

· Happy (".tap")

· Melco expanded (".exp")

· Brother/Baby Lock/Bernina (".pec", ".pes")

· Husqvarna (".hus")

· Husqvarna Viking (".vip")

· Husqvarna Viking/Pfaff (".vp3")

· Viking Designer 1(".shv")

· Janome (".jef", ".sew",".jpx") 

· Janome JEF+ (".jef+")

· Juki(".M3")

· Toyota(".10O")

· Laesser (".mst")

· QuiltCAD (".hqf")

· PC Quilter (".txt")

· Statler Stitcher(".qli")

· CompuQuilter (".cqp/", ".cmd")
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· Mitshubishi HD (".1??")

· Barudan FDR (".U??")

· ZSK TC(".Z??")

Except from .ngs, these are mainly embroidery machine file formats. You can load them from any digitizing
software that supports them or from the embroidery machine which will embroider your design. The .ngs is a
powerful file format that can be processed from some of the leading digitizing software packets in the market
(eXPerience®, Wings’ modular®). Also all the formats can be opened with the powerful Wings’ modular,
which is included in this copy of Creative DRAWings®.

With the ability to save designs in several formats, you can easily put them on a floppy disk or CD and then
download them to your embroidery machine.

When selecting to save a design in any of the supported embroidery machine formats then Macro selection
dialog appears. In this dialog we can select any of the available macros. Some of the macros are specifically
for some embroidery machines, select if any is suitable, otherwise use a generic macro that fits most
embroidery machines. Inside the Macro dialog you can now view the limits of the selected Macro. This is very
helpful for making the correct selection.

 

Save As dialog box

The Save As dialog box is similar with the Open dialog box that we described previously. If you need more
information about how to find your files through the Save As dialog box, refer to Open dialog box description.
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To save a new Creative DRAWings® design you must follow these steps:

1. Choose File > Save As or click on the Save  icon or click on the shortcut key Ctrl+S. The Save
As dialog box appears. Click on the arrow in Save in to choose a location on your hard drive, or to a
disk. 

2. Give your design a File name and then choose Type of File, such as .draw. (Note: If you want to
have access and edit your designs with Creative DRAWings®, always save them in .draw format.)

3. Then click on Save. Any additional modifications you make to the design can be saved by simply
clicking on Save or Ctrl+S. Your design will be added to the File list in the folder you selected to save
it in, plus you can see the names of previous designs. 

The File list area shows the designs that the current folder contains. If you click on a design, its name will
appear in the File name field and information about that design can be viewed at the bottom of the Save as
dialog.

Janome file manager
Using the respective options of File menu you can access Janome file manager for Janome MC12000 -
MC15000.  For example if i have Janome MC1500 connected into any USB port of my computer and i use 
MC15000 File manager option of File menu, the following dialog will appear to help us transfer files between
our computer and the connected Janome MC15000 machine.
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Now using this dialog we can transfer any file from our PC to the Sewing Machine. Use the left part of the
dialog to navigate to any folder / file on your computer  and then select a destination place from the right area.
Now by pressing the arrow that is pointed to Sewing machine area the design is transferred to the connected 
Janome MC12000 or MC15000. 

Please keep in mind that you must select the respective option according to the machine that is connected to
your computer, otherwise the following message will appear prompting you to connect you machine. 
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Export design
You can export any design you create in many embroidery formats, in embroidery image, to quilt, to a
vector file to be used by another program. Another very powerful capability is that we can export the design
to the provided editor. 

Export to editor

A portion Wings’ modular is included together with Creative DRAWings to provide more editing and exporting
capabilities. You can export your embroidery designs from Creative DRAWings® to Wings’ modular to make
some simple modifications on the designs. Click on File> Export> To editor or use the Ctrl+E shortcut
keys. Wings’ modular will open automatically with the exported design inside. There you can do more editing
on the design and see how it will look embroidered. The options and capabilities of Wings’ modular are
presented thoroughly in the manual that accompanies the software.

Export to Dropbox (Ctrl + D)

Creative DRAWings, includes a mechanism that can be used to export designs to Dropbox. This is not just
an export procedure, the exported designs can be synchronized with AcuDesign iOS application for iPad /
iPhone. The uploaded designs are organized into packages. 
You can access this mechanism from File menu – Export option – To Dropbox. You can also use Ctrl+D

keyboard shortcut. 

In order to Export to Dropbox you must first authorize Creative DRAWings to create an Embroidery folder
into Apps folder of your Dropbox account. The appearing dialog is informing you about the authorization
process. 

1. Your default internet browser will load the Dropbox authorization page.
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2. Sign-in by using your Dropbox account credentials and/or authorize the application by pressing Allow.

3. A message confirming the success of the authorization. Now the application is connected to your Dropbox
account. 

4. A folder called Embroidery has been created into Apps folder of your Dropbox account. The exported
designs are placed into that folder.
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Creative DRAWings, has read and write access to this folder only. Any designs that are exported can be
added / synchronized with the designs on Artistic Snap IOS application.

Notice: In order to have your files synchronized please make sure that Enable Dropbox
option of Artistic Snap options in ON state.

5. Let’s see how it works. We will switch back to Creative DRAWings. If the Authorization was successful
we must press OK and we are ready to start using the Dropbox Upload dialog.
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If the authorization is not successful the message of the following figure will appear. If something went wrong
and the authorization failed you must start over again, using the Export to Dropbox option of File menu. 

6. After the successful authorization the Dropbox Upload dialog is grayed out. The only option that is
available is the plus sign in packages section. In order to upload a design we must first select a package
for the design. As we have already mentioned the uploaded designs are organized into packages. A
package is a collection of designs. Using the plus sign you can create as many packages you like, the
only thing that you must define is the package name. 

7. We have created a package called Summer collection. 
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8. The Uploaded design will be a part of Summer collection. 

First we must select a package for the design. In
our case we only have one package. 

Type a name for the design.

Author name the dialog automatically detects the
user name of the computer but we can change it
in anything you like. 

Type Keywords, comma separated, that may help
you in case that we search for a design. 

Select a category that the design will belong to.

We can add a short description about the design
and if there are things that we must remember
about it's production or anything else.
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Finally, we must press Upload to send the design
to Dropbox.

9. A confirmation message about the upload success appears. Using Export to Dropbox option of Creative
DRAWings we have uploaded a design into Dropbox. In the same way we can upload as many designs
we like. As we can see on the following figures in our Dropbox account in Apps - Embroidery, a folder
called Summer collection (package name) was created (Upper part of the following figure) and the
uploaded designs were placed into that folder (as we can see on the lower part of the following figure).

10. From now on we can create packages and upload designs to Dropbox with just a few clicks. Let's switch
to Artistic Snap to see how these designs are synchronized to the design collection of Artistic Snap. Make
sure that Enable Dropbox option of settings area is set to ON state. 

In Artistic Snap category view, the uploaded designs are placed into a special section called Imported. You
can tell which designs are imported from Dropbox by the respective icon that is on the design preview.

In package browser we can see the created package and the designs that belong to it.
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Export embroidery image

In this chapter we will analyze the way that you can export the embroidery image of the design you have
created. You can export the design you are viewing as viewed in 3D preview of Stitch mode to four different
image file formats. The embroidery images that will be produced can be used for graphics designing, envelop
decoration, creation of birthday cards, brochure creation and generally advertising material that are based on
embroidery or not.   

In order to export the embroidery design to bitmap file you have to follow the steps below:

1. From File > Export select To image… option or press Ctrl, Shift and E shortcut keys (Ctrl+Shift+E)

together from the keyboard.

2. The dialog that will appear is a standard Save as windows dialog from which you can browse and find

the location you want to save the design,

3. Find the location you want the file with the embroidery effect to be saved,

4. Type the name you want the exported file to have in the File name field

5. Select the file you want to save the design from Save as type drop down menu. The options you

have are Tiff (*.tif), PNG (*.Png), Jpeg (*.jpg, *.jpeg) and Bitmap (*.Bmp).

6. Click Save button and you are ready.
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There are some more adjustments that you can do on the dialog window before exporting the design that will
be described below. After making the adjustments you want (DPI, Fabric and Backdrop options), you can
click the save button that will export the file in the location you have specified with the name you wanted.

Change image resolution

You can adjust the resolution of the produced image by changing the DPI (Dot Per Inch) value.

Set DPI value

Dots per inch: measurement of the scanning resolution of an image or the quality of an
output device. DPI expresses the number of dots a printer can print per inch, or that a
monitor can display, both horizontally and vertically.

The resolution of an image is measured by the number of dots per Inch that it consists of when it is printed. 
The DPI value that you will choose affects the image quality. The DPI value that you can enter in the DPI field
can vary from 60 to 600. Generally images that are created only to be displayed on computer monitors are 72
or 96 dpi and images that are created for the internet are 72 dpi. In addition images created for printing on
desktop printers are between 150 to 300 dpi, while images for professional printers are usually 300 dpi or
higher. 

You can produce images with embroidery effect with the dpi resolution you prefer by simply adding the DPI
value in the field. We propose for better embroidery effect results to set the dpi value more than 150 dpi. With
resolution near to 160 dpi you will be close to the real dimensions of the design and you will get a proper
representation of the embroidery effect by avoiding re-sampling the original image. For textile printing it is
better to use the highest possible resolution of 600 dpi for more realistic results. 

Include fabric option

With the Include fabric option you can decide whether you want the exported image from Creative
DRAWings to have fabric background or not. With a fabric background you could have a realistic preview of
the design with the selected fabric. The preview will look very much alike to how the design will be
embroidered on the actual fabric.

Include fabric option

If Include fabric option is selected, the fabric that was selected in the creation of the embroidery design will
be added as a background in the exported image. The color and type of the fabric is the same with the one
that was set in the embroidery design. According your fabric selection from the Select Fabric option of the
standard toolbar you will get the respective fabric as background in your image. If none fabric is selected
then only the color of the fabric will appear, without any actual fabric. 

If they Include fabric option is not selected, the embroidery effect image will not have a fabric background.
For Bitmap, Jpeg and Tiff files the background will be a solid black color and for PNG files will be
transparent. 

Include backdrop option
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In some cases that we are digitizing based on a backdrop it would be very useful to export the design with the
used backdrop. This way we can review the design in comparison to the design source in order to improve
any aspect of the design we like. 

Include backdrop option

If this option is selected the Backdrop that is included in the design will be exported to the image as seen on
screen. In order to be able to export the backdrop, the desired backdrop must be visible in 3D preview. In any
design we may have one or backdrops if we want to export the design to image we any of them we must first
enable "Use in 3D preview" option of Backdrop properties dialog.

Exported images

The images that will be exported from Creative DRAWings can be used as artwork in various graphics
designing projects. The embroidery image artwork can be used from embroiderers to present their work or
promote it. They can print it on any fabric to visualize the actual size of their work or create brochures with
their designs. It can be also used to make combinations of printed embroidery effect on a T-shirt together
with actual embroidery. This is a new trend in the market that combines both embroidery and printing on
garments.

In addition, embroidery images can be used also for decoration of envelops, birthday cards, business cards
or any other graphics creation that could have embroidery look images on (view figures below).

Envelop decoration Birthday card decoration

Use your imagination and create the artwork you want with embroidery images that Creative DRAWings
exports. Embroidery images of Creative DRAWings will enhance your work.

Export Vector file

When you create a Vector design in the Create mode of Creative DRAWings® you have the option to export
it to a special folder and keep it as a Vector file. You can also save it as an embroidery file and to sew it out.
The exported Vector file can be used for printing purposes or for creating combinations of embroidery and
textile printing on garments.

To save your design as a Vector, you will save it in Scalable Vector Graphics -- SVG -- file by following
these steps:

1. Select File menu,
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2. Expand Export submenu,

3. Select the To SVG option. Another way to activate To SVG option directly is by pressing Alt and E
shortcut keys (Alt+E) together from the keyboard.

4. The Save As dialog will appear 

5. Type the name of the file in the File name field 

6. Find the location you want the design to be saved

7. Click the Save button to save the design in SVG file format.

Once the SVG file is saved, you can edit it in any Vector design editor. The design can also be imported
back into Creative DRAWings® and edited in the Create mode a second time. By keeping the artwork
separately, it’s ready to use again if you need to create a similar embroidery design. 

Note: Inside SVG files, only vector designs can be stored and not bitmap design. If you
use a Bitmap backdrop to create the Vector design and try to export the bitmap to SVG,
the Bitmap will be lost. Only Vector artwork will be saved.  

Export to Quilt

Creative DRAWings software has the ability to save files for Quilt Frame machines. You can create a
design for quilting and once you are ready you can export it to Quilt data file that you can load and use to
your Quilt Frame machine. 

To Save the file do the following:

1. Select File menu

2. Expand Export submenu

3. Select the To Quilt… option. The Quilt Save as dialog will appear.

4. From Save as type area select the most suitable file type .

Select location for Quilt data 

5. Type the name of the file in the File name field 
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6. Find the location you want the design to be saved

7. Click the Save button to save the design in the selected file format.

Now you can load the file to your Quilt Frame machine and start Quilting.

Using this export tool you can export your design to various formats. The DXF (AutoCAD) format is a vector
format that can be used for presentations or used in Laser cutters or Quilt machines. To export a design to
(DXF) file format you have to follow the steps listed above but in Save as type section you must select Dxf
file. 

In the same way you can exprot into any of the available file formats.

Export to Happy Lan machine

Using this option we can export a design to one or more Happy Lan embroidery machines that are
connected to the same Local area network (LAN). If you have configured correctly you Happy Lan machine(s)
and the computer that is running Creative DRAWings to belong to the same logical network, then you can
directly produce the same design to one or more Happy Lan machines. When using this option you must first
select a macro that is suitable for your embroidery machine.

Select a macro and click on OK to proceed. At this point we must notice that the program tries to make a
network connection to the Happy Lan machine and you may see a firewall warning as in the following figure.
In order for the connection to work correctly you must allow access, so that the program can connect to the
embroidery machine. 
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In the appearing dialog you must select one or more of the available discovered Happy Lan machines and by
pressing Send the design is send to the selected machines.

Export to Janome MC12000 / MC15000

Using these options of File - Export menu we can send the current design directly to Janome MC12000 or
MC 15000 sewing machine. Use File -Export - Export to MC1500 (This is the machine i have connected to
my computer USB port) and the following dialog will appear to help you send the currently loaded design to
Janome MC15000. 
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Select a destination from Sewing machine area and  press on the arrow pointing the Sewing machine area
and the file is send to the selected destination on the connected embroidery machine.

Please make sure that you are using the correct option of File - Export menu according to the connected
Janome sewing machine otherwise the following message will appear prompting you to connect the
embroidery machine and then retry. 
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Export to Cutters

All the designs that contain Crystals, Cuts, Stencil, Applique or Paint objects need special care in order to
send them to the digital cutter for production. Creative DRAWings includes the ability to export designs
directly on specific cutting machines or as files that can be used for the same purpose. In order to export
such a design you need to:

1. From File menu, Export sub-menu activate To Cutters option.

2. From the appearing dialog we must select one of the Cutters to connect directly to, or a File
format  (HPGL file ,SVG file, DXF , FCM file) if we want to export to a file and import to our cutter in
a manual way. If you select a cutter to connect directly then after selecting the cutter press connect
button.

Select a Cutter or Export to a file
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The Windows Security Alert may appear the first time you will open the dialog. Click
Allow access to allow the communication of the software with the Artistic Edge cutter
(Wireless).

Cutter connection configuration

Under the list of the Cutters you can adjust the connection settings with the cutting machine. There are
various types of connections, Serial connection(Com), Printer connection(USB), Direct USB connection or
Wireless connection. After selecting any of the available cutters, you can see in the area bellow a Printer, a

Com selection drop-down menu or a Wireless configuration icon .  

Com selection Printer selection

· Serial connection

For Zing, eCraft, Foison, REDSail, you can change the selected Com port (serial port that the
machine is connected) using the drop-down list. The software always tries to auto detect the correct
port, but in some cases it may not succeed. If you send a design to the machine and it does not start
then try to change the COM port from the menu item and try again. If none of the available ports work,
then you have to check if the machine is correctly installed on the PC.

· Printer connection

For Silhouette SD, Silhouette CAMEO, Silhouette Portrait, GCC, you can select from the Printer
drop down menu, to specify the printer driver for the respective machine. The software tries to auto
detect the correct printer, but in some cases it may not always succeed. If there is not a printer
available in the list, you have to check if the machine is properly installed on your PC.



Creative DRAWings® 7.1 manual138

© 2017 DRAWstitch Ltd.

· Direct USB connection

Artistic Edge USB and eClips 2 USB create a direct USB connection. if they are connected to the
computer correctly and powered on, the connection to them is automatic. In case that you can not
communicate correctly to any of these cutters, close the dialog, power off and then ON the cutter and
then use Export to cutter once more.

· Wireless connection

For Artistic Edge Wireless cutter the software tries to make a direct wireless connection to the cutter. If
the connection is successful then the Cutter name will appear. Next to the cutter name there is a button
that is used in order to configure the wireless connection. For more information please refer to chapter 
Artistic Edge wireless configuration. If the cutter name is not available make sure the that you are
connected to the Edge-xx-xx-xx access point or to the access point of your home-business (In case
that you switched the Cutter to Client mode). More information in chapter Artistic Edge wireless
configuration.

Export to file

1. Select the HPGL fIle (. plt) or SVG file (.svg) or DXF file (.dxf) or FCM file (.fcm) option and

press Export button to proceed.

File section of export dialog

2. At the Origin area you can specify the position from where you want the machine to start creating
the design. This option helps you to position the material that will be cut at the correct position. You

can change the Origin by simply clicking on the respective green cross . The .plt or .svg or
.dxf file that will be produced will have the design positioned near the button you have selected.

3. Navigate to the location that you want to save the templates and  type a name 

4. If you want existing designs to be overwritten you can check the Overwrite existing files option
underneath. After typing the file name you can see on lower left part the names of the template files
will be created. Finally press Save button to write the template files to the disk.
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Settings area

There are also some other useful options on the export dialog: 

§ Cut Frame: This option adds a  rectangle around the design that will be cut after cutting the main
object. In order to apply it on the design you have to simply check the Cut Frame checkbox. At the
Origin area you will see a rectangle to be added around the design you have created. This is the Cut
Frame that will force the cutter to cut the material and produce a portable version of the Cut design you
have created. 

Cut Frame

§ Print...: This option allows you to make a printout of the design and be able to view the cutting
sequence of the objects. More details about the Print dialog you can find here.

Print

Direct connection to cutter

When using Export to Cutters option from File menu you must select one of the available cutters and press
connect in order to connect directly to the cutter.
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Select cutter/type

The Export to Cutter dialog will appear, using this dialog you can send any design part (Paint, Cut, Stencil,
Applique, Crystals ), to the Cutter that you are already connected, for production. If the Digital Cutter is
properly connected and powered ON, then at this point you should be able to directly communicate with the
Cutter through this dialog.

Select a Cutter or Export to a file

The Export to Cutter dialog is generally the same for all cutters, the only deference is that some options
may not be available for any cutter that does not support their usage. In this topic we will present the various
parts of this dialog and the usage. 

Templates area

When you export a design to a cutter, then the program automatically converts all the design parts, that
should be send to the cutter, into separate templates. A separate template is created for each object type
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(Cut, Paint, Stencil, Crystal, Applique) and for each color if multiple objects of the same type exist. For
example, for the design of our sample there is Stencil, Applique, Pen, Cut and Crystal template. In this
area you can select one or more templates to send to the cutter. You can hold the Ctrl key from the keyboard
pressed and select the templates you want to send to the cutter, by clicking on them. Those that where
clicked will be highlighted showing you that are selected. To deselect any of the selected you can again hold
the Ctrl key pressed and click on them. Another way to select multiple templates that are sequential, is by
holding the Shift key pressed by clicking on the first template you want to select and then the last one. All the
templates that are in between the selected template will be selected. If you select multiple templates and
press Cut(For knife parts) or Draw(For pen parts) they will be send to the cutter in the sequence that you can
see. When a template is completed the cutter stops and instructions about the next template are provided in
the lower part of the dialog. For example, in the figure bellow the first template is a Stencil template so you
must place the cutting mat with the material to cut into your cutter and on the information area you are
instructed to place a knife/blade into your cutter head. After you press Cut and produce the stencil template
the cutter will stop and provide you instructions for the next template. The procedure goes on for all selected
templates you are instructed to place the cutting mat with the material for each template and the Pen or
Knife on the cutter head.

If you want to Select all templates that are listed you can simply click on the respective button underneath
the templates area and all of them will become selected. By default, whenever you Export to Cutters dialog
all templates are selected.  Any page selection you make in the Templates list is previewed in the Origin
area. You can also Print the templates all together with useful information about the production.

Origin - Preview 

In this area you can see a preview of the selected template(s) and there are also various cross signs. You
can select any of these points to be the origin of your design. Not all cutters support all origin points that you
can see on the following figure, in some cutters there may be only one or few origin points available. The
cutter will start producing the design according to the selected origin point. For example, in the following
figure, the upper left origin is selected and this is the point that the cutter will begin from. This option helps you
to start the cutter operation according to the material that you have placed and the position of the cutter head.
You can change the Origin, simply clicking on any cross icon. 

The Silhouette SD, Silhouette CAMEO  do not support this option and therefore you
cannot change the designs origin.
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Next to the origin name you will see the origin definition tool that each machine uses to specify from where it
will start to cut the design. For example the Zing machine uses a Laser dot to define the origin and the other
machines are using the actual cutter head (Blade - Pen). Therefore keep in mind to check the way that your
machine uses to set the starting position from where is will start cutting the material.

  

Cutter options 

In this area you can adjust various parameters of the cutter's operation (Speed, Pressure), add additional
offset and Cut frame. 

Speed - Pressure

For any created object Paint, Cut, Stencil, Applique, Crystals, we can set the speed and the
pressure, using the respective options of object properties. Any of the objects-templates may have
varying speed or pressure.  Using the Speed  and the Pressure track bar you can increase or decrease
the speed and the pressure that will be applied to all templates that are available on the dialog. Generally,
we are using these track-bars when we have created a complex design and during production we see
that we may need more speed or pressure, then we increase the speed or pressure for all design
templates without going to all design objects and change their cutting options. In case that these values
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are grayed-out (disabled) this means that the cutter does not support their usage. You must have in mind
that these track bars keep the previous settings that you have selected, so if you start a new design and
send to the cutter, you will see that previously selected speed and pressure are kept, so if you need to
use initial selected speed then you should return the track bar to zero. 

Cutter offset

Using this value, if it is enabled, you can specify the offset that the cutter will add to each shape in order to
be produced properly and keep its shape. This value varies from cutting machine to cutting machine and
some machines do not allow you to change this value at all through our software. You can make
adjustments through the machine's panel. Feel free to change the Cutter Offset setting based on the
offset you want to be added to each Cut that the machine will make. To make it more clear, consider that
the machine in order to cut the material uses a knife that has a specific size. When the machine cuts the
material creates a shape that might be smaller that the one you have specified inside the software,
because of the knifes dimensions. To overcome that we add some offset that will force the machine to
create the design slightly larger and match the size we want it to be. 

Cut Frame: 

This option adds a  rectangle around the design that will be cut after cutting the main object. In order to
apply it on the design you have to simply check the Cut Frame checkbox. At the Origin area you will see a
rectangle to be added around the design you have created. This is the Cut Frame that will force the cutter
to cut the material and produce a portable version of the Cut design you have created. 

Cut Frame

Cutter operations

Using the controls that are visible on the following figure we communicate directly to the cutter and perform
various Cut - Paint operations. 

Arrow buttons

Using the Arrow buttons you can move the head of the cutter to a position that you want the head to be.
This may be necessary in 2 cases, first in order to position the cutter head above the area of the cutting
mat that we want to cut-paint (position the head according to the selected origin) and second in order to
move the cutter head to a position that we want to perform a Test operation of the cutter settings.

For example if you have selected an origin on the upper left corner of the template, you must move the
head to the upper left corner of the area, that you want to perform the Cut-Paint operation.

If you need to fine tune the position of the cutters head you can use Ctrl , Shift keys on your keyboard to
adjust the step of the movement.
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· Hold Shift key  in order to make the movement small.

· Hold Ctrl key  in order to have a large movement step.

· Use Ctrl and Shift keys together (  + ) to make a very small movement step.

Trace: 

When we have placed the cutter head above the part that we want to cut-paint we may want to check out
if the design fits in the area we have specified. If we press Trace button then the cutter head will start
moving around the area that is necessary according to the design size. This way we can see if the design
fits according to the position of the head.

Abort:

Using the abort button we can stop the send to the cutter operation, if the data have not been
transmitted yet. In case that we find out that something is wrong, we may abort, in order to correct our
design or settings and re-send to cutter.

Test 

There are many cases, such as if we have never used a material, or a Pen/Brush to a Cutter, that we
may need to perform a Test in order to verify the results of the operation with the current template
settings. We can use Test button in order to perform such a test. The test must be performed for each
template separately, select a Template and press Test button. The Test dialog will appear, if you have
multiple templates selected then the test will be performed with the settings of the first template. In the
appearing dialog you can see the cutter settings that were selected for the objects of the template (Using
Object properties). By pressing Test the cutter will perform a test job with the current settings on the
material that you have placed. It will just produce a simple shape in order to verify that it is produced
correctly.
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There are 3 types of tests as you can see on the following figure, one for Cut, Applique, Stencil objects,
one for Paint objects and one for Crystal objects. A different pattern is used that is better suitable for
each type of object.

Crystals test pattern Cut, Applique, Stencil test pattern Paint test pattern

After the test is complete, if the result is not as desired, you can edit Cutting options (Speed, Pressure,
Passes), move the head of the cutter to another point  and test once more. if the results are as desired
then you can press Apply and the current settings will be applied to the object of the template. In order to
adjust the current settings there is also a list of preset settings that you may use in order to give you set
of pre-configured settings according to the production material.

Calibrate

This option is only enabled for Zing, eClips 2 USB and Artistic Edge cutters that have a laser pointer.
Using the calibrate button you can define  the distance between the laser pointer and the cutter head.

Cut 
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Once you are ready, click the Cut - Draw button to send the design to the machine. Once you have
started the process the software locks the connection with the machine and you are not able to select a
different template until the process is done.

If the design has multiple groups of crystals or multiple outline objects or multiple applique objects, the
software will send each design separately informing you which one is sending every time. Therefore, for
crystal designs, first one group of crystals will be send and cut, then a second group will be send and cut
on a different cutting material, then the third and so on. Each time the software will ask for confirmation
(Press "OK" to Send next page or "Cancel" to abort.). The crystal design will be made with layers of
different hole groups based on the design. Designs with Outlines or Applique will be handled accordingly.

Print & Cut

This option is enabled only for cutters that can support this function. Zing, eClips 2 USB and Artistic
Edge cutter that have a laser pointer, support Print & Cut and there is also a Calibrate option available.
Using the calibrate button you can define the distance between the laser pointer and the cutting blade. For
Silhouette CAMEO and Silhouette SD that have a special optical recognition mechanism Print & Cut
option is also enabled. Print & Cut option is a special mechanism that can be used to print the outlines of
a design to a printer and then place the print on the cutting mat and cut the printed artwork using the
cutter. The printed paper has some special marks: 

for Zing, eClips 2 USB and Artistic Edge that have a laser pointer we must point with the laser pointer
these special marks during the procedure so the print and the cut are properly aligned.

For Silhouette CAMEO that has a special optical recognition mechanism we must place the printed paper
to the cutter and the Cutter will recognize the special marks using optical recognition.

Instructions 

In this area you can see information about the currently produced template. You can see the cutting
properties that were selected for this template and you are instructed to place the correct production head.
For Cut, Stencil, Applique objects you are prompted to place the proper knife/blade to the cutter head and
for Paint objects you are prompted to place the proper  

Artistic Edge wireless configuration

Artistic Edge cutter comes with an optional Wireless module. The following information-instructions apply
only for those who have purchased the version with the Wireless module. 

The cutter has 2 Wireless operating modes.

· Access point mode: The cutter is not connected to a router but it implements a Wireless access point
and the computer connects directly to this access point. The access point is called Edge-xx-xx-xx. 

· Client mode: The cutter is connected to a router and the computer communicates with the Cutter through
the network connection. 

By default when starting the cutter for the first time the Access point mode is enabled. This means that in
order to connect to the cutter you must first connect to the Edge-xx-xx-xx access point. If you are connected
to the Edge-xx-xx-xx access point then the cutter name will appear as on the following figure in Export to
Crystal/Cutters dialog. If you can not see the Cutter name then you should first check if Wireless
functionality is enabled on the Cutter, the Wireless/Light button should be highlighted. If it is not highlighted
please read the following instruction in order to Turn on the Wireless functionality.
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Turn on and off Wireless module

Artistic edge Cutter with Wireless dongle included has a wireless button next to power button (On-Off).
When the Wireless is enabled this button is ON with a white light otherwise it looks turned off. If Wireless is
Off then in order to turn it on, press and keep pressed the Wireless button for about 5 seconds until it is
highlighted with a white light. At this point if we search  through the available wireless networks we should be
able to locate the Edge-xx-xx-xx wireless access point and we should be able to connect to it. In the same
way by holding the Wireless button pressed we can disable Wireless functionality. 

Notice: In order to be able to send a design via Wireless to the cutter the Wireless should be enabled and
highlighted and we should be connected to its access point, if it is in Access point mode or connected to the
network that the cutter is connected when switched to Client mode. 

Connect to Artistic Edge access point 

First of all we must mention that the you should ensure if the wireless function is activated. if it is not please 
Push and hold down Light/wireless button for three seconds. The button will light up once the wireless
function is activated. Wireless access point to become ready and then search again for the Edge access
point.

1. In order to connect to the Edge cutter you must press on the network icon on your system in order to

view available networks.

Windows 8 Windows 7/Vista Windows XP

2. From the available networks select the one called Edge-xx-xx-xx and press Connect to join the

network.
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Windows 8 Windows 7/Vista Windows XP

3. You will be prompted for a security key, please enter 12345678 click Next and wait for a while for the

connection to be initialized.  It is very important to ensure that you're entering the password correctly,

because sometimes, if the password is incorrect, it may look like you're connected to a network, but

no actual file transfer will happen. 

Windows 8 Windows 7/Vista Windows XP

4. Now you are connected with the Edge cutter directly. To send a Cut design to it, do the following:

Note: While you are directly connected with the Edge cutter, the Internet will not be available. To connect

your PC back to the internet you have to close your cutter or repeat steps 2-3 but this time connect to Your

Wireless network.

Select Wireless operation mode

If you are connected to Edge-xx-xx-xx access point and you can see the Cutter name on Export to Cutters
dialog then you are successfully connected to the Cutter. On the area below the available cutters and when
Edge wireless is selected  you can see a wireless icon  that can be used in order to manage Wireless
operation mode, see on the following figure.
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Click on the Wireless button and the Cutter configuration dialog will appear. As you can see on the
following dialog the Access point mode is grayed out, this means that this mode is already active and we
can not change into that mode. 

You can now add Artistic Edge cutter to your Wireless network permanently and have it available every time you
need it.  In order to do that we must switch the Cutter into Client mode. From the Cutter configuration dialog
select any of the available Wireless networks and then type the security key for the selected network. You
can check the field show characters in order to make sure that we have typed the correct security key.
Finally press OK to apply. 

A warning dialog will appear informing you that at this point both the Power button and the Wireless button
will start blinking for about 30 seconds until the Cutter is connected successfully to the wireless network.
Please wait for a minute while the auto-configuration of the cutter with the network takes place. Have in mind
that you may have to re-connect to the network that you connected the cutter in order to be able to
communicate with the cutter wireless.

Switch into access point mode

At any point and for any reason if you like to connect directly to the cutter you must use Export to
Crystal/Cutter dialog in  order to manage Wireless operation mode as described in previous part. Now when
entering the dialog (following figure) the option to switch to Access point mode is now enabled and you can
select it. Check Access point mode and press OK to proceed, wait for the cutter to re-initialize until the
buttons become steady ON and finally connect to the Edge-xx-xx-xx access point again.
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Emergency reset to Access point mode

In case that you can not connect to the cutter or any miss-configuration has happened and you can not
access the cutter you must reset the cutter to the default Access point mode and then re-connect to any
wireless network in Client mode again. In order to reset the cutter you must keep pressed the Wireless
button and Right limit button together, for 3 seconds. When the power button and the Wireless button
turn off then release the button. At this point the Wireless button will start blinking until the network
initialization is completed, when blinking stops you are ready to connect to Edge-xx-xx-xx access point in
order to use the cutter. 

Print templates

Creative DRAWings® provides extensive options for printing your designs with Cut, Stencil, Applique,
Crystals and Paint  before sending them to the cutter. You can print the design parts-templates together with
much information that are useful for the production process. The printout of the design provides information
needed to evaluate before sending a design to the cutter. This is a special print that you can only use from
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Export to cutter dilaog, under the templates are there is a print button. The following dialog will appear, you
can see a preview of the printout of a design.

Cutter Printout

In print preview window, we can see a preview of the Cut design together with provided information. On the

right part we can see various customization of the printout. These customizations are:

· We can use Setup button in order to select and customize the properties of the printer that we are

going to use. 

· We can also use Save to JPG option in case that we don’t want to print it, but we want to save it for

later reference or to review on our computer monitor. 

· In section Print we can select which parts we want to be visible. Click on any of the checkboxes in

order to enable/disable visible items. 

· If you want this selection of visible items to be the default for any Cut design, you can use save

defaults button. Use the Restore defaults button to use the default values that you have already

saved. 

· Also, there is a Design only button. Press this button in case that you want to print only the actual

design (stitches).

· Finally in Tiled printout section we can customize some aspects of the print, number of pages,

orientation, and scale. We can also set number of stitches that we want to be visible on the print

preview.

Print: In this section of the printing dialog you can specify which information you want your printout to include.
Every item of the printout can be enabled or disabled by clicking on the square on the left of its description. If
the item is enabled the changes can be viewed on the preview area.
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· Header
The header is at the top of the page, showing the size, color/crystal changes, number of crystals,

Crystal types that are used, the crystal colors and their names.

Header

· Object order
The box shows the sequence of the crystal/color changes. These information is really useful in order

to know the order the objects will be send to the cutter. 

Crystal/Color changes

· Sequence icons

The sequence icons are at the bottom of the page. They show parts of the design split by color/crystal
change. Also, in the bottom of the icon you can view the name of the color/crystal that should be
used, plus comments.

Sequence icons

· Information
Information is at the bottom of the page. The information area lists any extra information you want to

view on the printout. These information can be added at File > Design Properties > General tab.

· Orientation
The orientation is the icon shown with the "R" character at the top right corner of the printout. This is
important because it shows how the printed page should be put on the cutter to identify the starting
point of the design.
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Orientation

· Company name

The company name, which is at the top of the printout, can be changed from the Printing tab of the
Tools > Options dialog.

Company name

· Binder space

This option makes the necessary margin (on the left side of the page) in case you want to put the
printout in a folder.

· Object count

The number of objects in your design can be viewed at the header of the printout. 

Crystal count location

· Fabric
Hides or Shows the fabric behind the design.

 

Without fabric – With fabric

· Design date

The date that the design was created can be viewed at the top left of the printout. 
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 Design date location

Tiled printout

This section manages the way that your design will be printed. When the printout dialog is called up, the first
two fields indicate the number of pages needed for printing: 'X' for horizontal and 'Y' for vertical; the number
of designs printed on each page can be changed by using the arrows on the right hand side or with the
mouse wheel. The changes you make can be viewed on the print preview as you make them.

Tiled printout

The Portrait option specifies how the design is positioned on the page. If it is enabled, then the design is
printed vertically as a portrait. If disabled, then the design is printed horizontally as a landscape. 

The Scale field shows if the design will be depicted smaller than its actual size and the percentage of the
reduction. The first time that the printing dialog is used, the software finds the best way to show the design in
actual size with the least number of pages. 

To automatically restore the parameters indicated at the beginning of this process you could click on the 
AutoFit tab. If your design is previewed in more than one page, you can print them, cut the border of the
page, which is already marked, and tape them to have your design complete. 

Scanning images

Previously in the chapter we presented that we can import artwork through a connected scanner using Get
image from scanner option of artwork source dialog. In this section we will analyze the options and
capabilities of Image scan dialog. Select the Get image from scanner option and click Next> button. The
Image scan dialog will appear that allows you to scan an image. 
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Image scan dialog

In the Image Scan dialog you can scan the design you want and make some adjustments from the options in
the dialog or by checking preferences in the scanning software. The options that are available in the Image
scan dialog are the following:

Select scanner button  

With the Select scanner button, you can select the scanner you want to use. By clicking the Select
scanner tab the Select source dialog appears where all the available scanners are listed. Select one and
then click Select to continue or Cancel if you do not want to make any change. If there is no scanner
installed or currently active, you will not see any scanner listed in the Select source window. 

Preview button  

By clicking Preview, you can see the image you want to scan. Place your design in the scanner and press
Preview. When the scan is finished, your design will appear in Preview. If you like what you see, press
Scan tab to import your design. If you want to correct the design, then you can adjust the image in the
options available. Press Preview again before you Scan. 

Type of image 

Type of image
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With the Type of Image option, you can scan and import images in your choice of hues and shades: Color,
Gray scale, or Black & White. By scanning in the Color option, the final image will look like the original
design.  

Your scanner will easily convert a color design into a Gray Scale or a Black & White design that can be
imported by clicking on your choice.  The Gray Scale will be filled with different tones of grays. By selecting
the Black & White option the image will be scanned with more contrast.  When you select any of the three
scanning options, you can see what the scanned image will look like by clicking Preview.

Scan quality

Scan quality

With the Scan quality option you can select the characteristics that you want your image to have. The Scan
option is a drop-down menu with three different image options: High, Medium and Low. The three options
mean exactly what they signify: 

· High quality has the highest quality and the file size of the image will be the largest.

· Low quality has the lowest quality (but still very useable) and the file size is the smallest. 

· Medium will produce an image quality between the other two.

Every time you select a different option you can see how it affects the scanned image by clicking the 
Preview button. 

Brightness

Brightness

With the Brightness option you can brighten the image, you can click and drag the track-bar to the right you
can increase the brightness of the scan. Dragging the mark to the left decreases the brightness. You can
also make fine adjustments in Brightness by using the arrow keys on your keyboard. 

Contrast

Contrast

With the Contrast option you can change the contrast of the image by clicking on and dragging the track-
bar. Dragging the mark to the right increases the contrast and dragging it to the left decreases the contrast
in the scan. You can also make fine contrast adjustments by using the arrow keys on your keyboard. 

Image size
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Image size

With the Image size option you can enlarge or reduce the image you are scanning. The initial value of the
image size is 100%, which is its original size. You can enlarge the scanned image by typing a larger value
(more than 100) to the Image size field or shrink it by typing a smaller value (less than 100) to the Image
size field. You can also use the up and down arrows in the box to change the image value by 1% each time
an arrow is clicked. Hold down on the arrow to change values faster. The enlargement or shrinkage of the
image will be made in the final output of the scanned image.

Original size in mm

Original size in mm

With the Original size in mm you can view the actual size of the image measured in millimeters. This
option is not editable and its value changes automatically. The dimensions of the image are shown as Width
X Height (e.g. 150 x 180). This value changes if you select to scan a specific area of the image you are
previewing. The selected area on the Preview area will be the new size of the image. 

Advanced Scan button 

With the Advanced Scan tab you can use the default software of your scanner to import the image instead
of using the scanner in Creative DRAWings. If you are accustomed to scanning with your printer’s software,
you can normally use it. To activate the default scanning software of your scanner, click on the Advanced
Scan tab. Every time you scan from now on, your own scanner dialog will appear. Make your adjustments
and press the Scan tab. Then you will be asked to save the image to a file on your hard disk, which will allow
the software to import it and automatically create a design inside Creative DRAWings. If you decide not to
use the default scanning software, you can press the Cancel tab to exit and return to Image scan dialog. 

Preview area

By pressing the Preview you can decide if the image needs any adjustments prior to scanning it. Another
useful feature of Preview is its ability to zero in on a specific portion of the image that you want to scan.
This way you only scan the portion of the image you want to embroider. Select the portion you want to scan
by making a rectangle selection on the Preview area. Click and drag the rectangle and this portion will
automatically be prepared for scanning. If you want to deselect the rectangle you have selected, simply click
once in Preview. Once you’re satisfied with the image, press Scan. 

Scan button  

Pressing the Scan tab starts the scanning process, which will import the selected image into Creative
DRAWings®.  The scanning will include the adjustments you have made on the Image Scan dialog. When
completed, you will be asked to save the image to Creative DRAWings®.  

Exit button  

With the Exit tab you can close the Image Scan dialog and return to the Artwork source dialog and choose
a different way to create an embroidery design. 
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Some of the above options might not be available to your scanner. If you see an option
disabled, this means that this option is not supported from the driver of the scanner. 

After scanning the image you will be prompted to save it as bitmap file on your hard disk. The image will be
imported automatically inside Creative DRAWings prompting you for more actions. 

Capturing from camera
Creative DRAWings software gives you the ability to capture snapshots from your camera and convert them

into embroidery. This is a unique and flexible feature that allows you to capture any image you want from the

camera of your PC and convert it in embroidery design. We have previously presented the whole procedure,

at this point we will analyze in detail the options of the dialog that is used to get images from camera.

Plug your camera on the PC (if it is external), select the Get image from camera option and click Next>.
The camera Preview dialog will appear with several options. Through the camera Preview dialog you can
take snapshots of anything you want and make some adjustments to the image. 

Image scan dialog

In the Preview area you will view live the picture of your camera. You can make the adjustments on the
camera until you capture the snapshot image you want.

The options you can adjust are the following:

Device 

From the Devise drop down menu you can select the camera of your PC. You might have more than one
cameras attached on your PC and you want to switch between them. To do that you have to click on the drop
down menu and select the camera Device you want to use.

Resolution
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From the Resolution drop down menu you can select the image size that your camera will capture. You can
switch between the available resolutions by clicking on the drop down menu and selecting the one that meat
your preferences. Higher resolution images include more details; therefore it is better to select the highest
resolution from the dropdown menu to capture your images.

Properties

By clicking on the Properties… button you can adjust the properties of you camera. The properties of every
camera are not the same, therefore the option that you will see after clicking on the Properties… button, are
based on your camera’s features. Please refer to the manual of your camera for more information about
adjusting these options. Usually the options that you can adjust are Brightness, Contrast, Saturation,
Sharpness, White Balance and many more. 

Capture

By clicking the Capture button you can take a snapshot of the image that you are viewing in the preview of
the camera. The image will freeze allowing you to decide if you want to save it or not. If you do not like the
captured image and you want to capture a new one you have to click on the Capture New button that will
discard the previous snapshot and will allow you to take a new one. Once you are ready to make a new
capture click once more on the Capture button and a new snapshot will be made.

Save…

If you are satisfied with the image you have captured, you can save it by clicking on the Save… button. You
will be prompt to a Save as dialog(this is a standard Save as dialog of windows), where you can find a
preferred location to save the captured image. The saved image will be automatically imported to the
software ready to be converted.  

Close

By clicking on the Close button you can close the camera Preview dialog and select a different way to
import a design into the software. The Close button closes the dialog and returns to the Artwork source
dialog.

Info
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Every time you are making an action in the camera Preview dialog the Info box shows useful information
about the action that is taking place. It also shows information about extra actions that you can make in the
dialog such as cropping the image you have captured.

The camera Preview dialog gives you the ability to make the needed adjustments on the captured image and
produce the result you prefer. If you are satisfied with the captured image click on the Save… button to save
the image on your hard disk. When the design is saved, the image is automatically loaded inside Creative
DRAWings prompting you to the import dialog. You’ll be asked how you want the image to be opened: as a
Backdrop or converted to a Vector design in Trace.

Cropping the captured image

In the camera Preview dialog you have also the ability to crop the captured image and use only a part of it.
This is very easy to do it by following the steps below:

1. From the camera preview dialog make the appropriate adjustments and prepare the scene you will

capture. 

2. Once you are ready click on the Capture button to take a snapshot.

3. To Crop the captured image you can simply draw a rectangle area on the captured image by

covering the area you want to keep. To draw the rectangle area you have to click and drag with the

mouse on the captured image diagonally. While dragging you will view a rectangle to be drawn on the

image with a light blue color. 

Crop area of captured image
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This will be the area of the image that will be kept if you save the design. The rest of the image will be
discarded. If you want to define a different crop area you can draw a new rectangle that will be the
new Crop area (The previous defined crop area will be automatically canceled).

4. If you are satisfied with crop area you can click on the Save… button to save the cropped image

5. After saving the cropped image it will be automatically imported in Creative DRAWings to be

converted to stitches. 

With the cropping option you do not need to straggle capturing exactly the area you want to convert to
stitches but you have the ability to capture a general image and then keep only the area you need by simply
cropping it. 

Importing bitmaps
Bitmap files can be imported into Creative DRAWings® four different ways: They can be imported as
backdrop, can be traced and imported as a Vector design, can be converted to Cross stitch or Photo stitch
design. All four ways are accessible from the starting dialog of Creative DRAWings® software. 

1. Select Create new design option from the starting dialog and click Next button, 

2. Select a Fabric and proceed to Artwork source dialog.

3. Use From file option and click on the  icon to locate the bitmap design you want to import.

4. Press Next and  the dialog of the following figure will appear providing four image handling options.

Artwork Image dialog

In this section we will describe the conversion options of bitmap files. 

Open as Backdrop

Using Open as backdrop option, you can import a bitmap image and use it as guideline to draw a design on
top of it. It is very useful for complex bitmap images that cannot be easily traced or you want to embroider
only a part of them. Using this technique to create the design on top of an image you can create the design
exactly in the way you want to be embroidered. Professional digitizers find this functionality very useful. Once
you press Finish on the startup wizard the selected bitmap file will appear in the design area as a backdrop
(You can not edit it). You can only import one bitmap backdrop, in case that you want to import multiple
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backdrops you will have to use an image editor and make the multiple images a single image by combining
them and then import the combined image as a backdrop. 

Once an image has been added as backdrop, there are some options that can be used to handle the
imported backdrop. These options can be located under the Backdrop submenu of View menu and they are
the following:

Hide (Alt + 1)

By clicking on Hide – or press Alt + 1 shortcut key – you can hide the imported backdrop. The Hide option
can help you view the embroidery design you have created without confusing it with the backdrop image at
the back.

Below embroidery (Alt +2)

With this option checked you can make the backdrop visible and position it below the design you are creating.
Whenever you import a Bitmap image as backdrop, Creative DRAWings® automatically positions the image
under the embroidery design. Also, another way to enable this option is by pressing the Alt + 2 shortcut keys
from the keyboard.

Washed-out (Alt +3)

With this option checked you can make the backdrop colors appear Washed-out. This means that the colors
of the backdrop will have lighter tones. This is very helpful when you are trying to draw a shape that will have
the same color with the backdrop image. Also, another way to enable this option is by pressing the Alt +3
shortcut keys from the keyboard.

Above embroidery (Alt + 4)

With this option checked you can position the backdrop image to appear above the design you have created.
This is very helpful. You’ll be able to view the backdrop image and be able to design the objects that will be on
top of larger objects you have already designed.  Also, another way to enable this option is by pressing the Alt
+ 4 shortcut keys from the keyboard.

Properties

The Properties option is available only if you have inserted a backdrop Bitmap in the working area. By
selecting the Properties option from the View menu a 3D pop-up dialog appears on the working area with
various options related with the already inserted backdrop. 
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Backdrop properties 

The Backdrop Properties dialog includes the following options:

· Straighten, using this useful option you can straighten a scanned bitmap. Select the Straighten

option and view the cursor changing shape. To straighten your Bitmap, click the mouse twice to

make two points which will become a virtual straight line that your design will adjust to. For example, if

you make a diagonal straight line on the Bitmap, Creative DRAWings® will rotate the Bitmap and turn

the diagonal straight line into a horizontal straight line. You can apply the Straighten bitmap option as

many times as needed to bring the backdrop bitmap to the straight position.

· Scale bitmap, using Scale track-bar you can change your Backdrop Bitmap proportionally. Drag the

track-bar to the left to reduce the image and drag it to the right to enlarge the Backdrop. 

Scale backdrop

You can reduce the image to a minimum 50% from its initial size and enlarge the image with a
maximum 300%. The scale tool is very useful in helping you change the size of the Backdrop image
without the interference of any other software. Therefore, you do not need editing software for 
Bitmaps to adjust the size of your Backdrops. 

· Rotate bitmap, using this tool you can rotate your image freely by clicking and dragging the indicator

either way. This tool helps to straighten your backdrop image before starting to draw the embroidery

design. The rotation circle always opens up at the zero position. 

Rotate backdrop

This tool can help you straighter your backdrop image before starting drawing the embroidery design
based on it. 
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· Below embroidery: By pressing this button you can make the backdrop visible and position it Below

the embroidery you are creating. This option is enabled by default whenever you import a Bitmap

image as backdrop and positions the image under the embroidery design. Also, another way to apply

this option is by pressing the Alt + 2 shortcut keys from the keyboard.

· Washed-out: By pressing this button you can make the backdrop colors appear Washed-out. This

means that the colors of the backdrop will have lighter tones. This is very helpful when you are trying

to draw a shape (with any of the available drawing tools) that will have the same color with the

backdrop image. Also, another way to apply this option is by pressing the Alt +3 shortcut keys from

the keyboard.

· Above embroidery: By pressing this button you can position the backdrop image to appear above the
embroidery design you have created. This is very helpful in order to view the backdrop image and be
able to design the objects that will be on top of larger objects you have already designed.  Also,
another way to apply this option is by pressing the Alt + 4 shortcut keys from the keyboard.

· Remove backdrop: Press this button to remove the imported bitmap backdrop. 

After adjusting your backdrop and you do not need the Backdrop Properties window to appear you can
close the dialog by clicking on the close icon  or minimize it by clicking on the minimize icon . The
minimize icon will make Backdrop properties to disappear and leave the title bar to float on the working area. 

Minimize backdrop properties dialog

If you need the Backdrop properties window again, click once on the minimized title bar and you’re ready to
make more adjustments.

Trace (convert to outlines)

Creative DRAWings® includes a powerful tool called Trace which allows you to convert Bitmap artwork into
a Vector design. The Vector can then be converted into a normal embroidery design. Very important: Before
converting the Bitmap into a Vector, save and rename the original for future use. By selecting the Trace
option and clicking Next> the Trace Image dialog will appear. 
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Trace Image

The Trace Image dialog box can be enlarged so the adjustments will be easier to observe. Click on box, hold
down on the bottom right corner of it and pull diagonally to fill up the screen, or make as large as you want it.
The Trace tab has some options that can help you produce the results you want. Those are:

Scale image:

Scale image

The Vector design in Trace Image will always open at the default 100% -- the original size of the Bitmap. To
enlarge or reduce the Vector size, click first on Scale Image, then type in a new value above or below the
100% option. You can also change the Vector image size by clicking on up-or-down arrows (hold down for a
speedy change). No matter how you do it, the scaling will always be proportional to all dimensions of the
design: A 35mm x 60mm design will become a 70mm x 120mm design while you’re adjusting it in Trace
Image. Any change in values is automatically changed in Preview.

Accuracy: 

Accuracy 

The Accuracy option lets you choose how much detail of the original artwork will be in your final embroidery
design. Click on the box to edit this option, which will open with a default Value 5. If you want your
embroidered design to appear as the artwork, click up to Value 8 – the highest degree of accuracy. A Note of
Caution:  Depending upon your design, a Value 8 may not produce results best for embroidering because of
excessive details. On the other end of the Accuracy scale, a Value 1 option may not have enough details to
please you. You will find that the Accuracy value varies greatly among bitmap images, so you must try
different Accuracy values to get the preferred result. Each time you change a value, you can see it in
Preview.
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Color limit: 

Color limit

The Color limit box gives you a choice of how many threat colors you want in your Traced image. Click on
the box. It always opens with a value of the maximum number of colors, but there are several factors to be
considered. If you have a 6-needle embroidery machine, you may want to change the Value 6 with six
threads. The number of threads affects the way the Bitmap image will be converted to Vector design. In the
Preview, you can view any value changes. Another Option: You can go ahead and create your vector design
with 20 colors and then reduce the number inside Creative DRAWings®. Having a file of all 20 colors gives
you the option of later sewing your design commercially. Or . . . when you step up to your own big-time
machine, you will have the files ready!

Use background: 

Use background

With Use background option you can make the color/object that you will choose from the Preview area
transparent. This is an easy way to remove a specific color/object from the Bitmap image. To edit this option,
click the checkbox next to it. Move the mouse cursor over the Preview and it will automatically change to an
eyedropper tool. The color that you will select from the preview area with the eyedropper tool will
automatically become transparent and will fill the color tab next to the Use background option. Only one
color object will become transparent from the design. You can make a different color transparent by selecting
a different color with eyedropper tool from the design. 

Open as Cross-stitch

By selecting the Open as Cross stitch option, you can convert the bitmap image to a perfect Cross stitch
design. The conversion is made automatically by clicking the Next> button in the dialog. The Cross-stitch
will be created inside the design area, where you can make the adjustments. 

In the Create mode of Creative DRAWings you cannot edit the actual bitmap image but you can resize and
change the position of the Cross-stitch design. If you want to edit the actual bitmap image you have to use a
Bitmap editing software and then import the edited bitmap back to Creative DRAWings to view the results. By
editing the bitmap you can increase the quality of the embroidery result.

In the Create mode you can increase the detail of the cross-stitch design by increasing the size of the bitmap
or decreasing the size of crosses. This will result in a high detailed cross-stitch design that will be closer to
the actual image view. To increase the size of the bitmap inside Creative DRAWings you have to select the
Cross-stitch design, and then resize it by click and dragging the corner handles of the bitmap or the handles
at the middles of each side. The bitmap will be resized and the cross-stitches will be recalculated. By
increasing the size of the bitmap you automatically increase the number of cross-stitches that will be placed
on it; therefore the quality of the embroidery design.

You can also move the cross-stitch design and position it exactly in the location you want it to be. To do that
you have to select the cross-stitch design and by click and dragging on it move it to the position you want it to
be. 
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Photos to Cross-stitch

In the stitch mode of Creative DRAWings you can edit the cross-stitches by setting the Cell size of each
cross-stitch, changing the number of times each cross-stitch will be embroidered and selecting which parts
of the design you want to embroider and which not. All this options are located on the Object properties
toolbar that appears at the right side of the application window. The same options are available in the Create
mode, if Stitches, 3D preview and Object properties options from View menu are enabled.

More about how to edit Cross-stitch designs you will find in the Embroidery transformations chapter.

Important: Creative DRAWings can import only Bitmap images that have been created
with RGB (Red, Green, and Blue) colors. Any Bitmap that was created with CMYK (Cyan,
Magenta, Yellow, and Black) will not convert properly.

Open as Photo stitch

By selecting the Open as Photo stitch option, you can convert the bitmap image to a perfect Photo stitch
design. The conversion is made automatically by clicking the Next> button in the dialog. The Photo-stitch
will open inside Creative DRAWings® where you can make the adjustments. 

Photo-stitch is another alternative you have when it comes to filling bitmap images with stitches.  It consists
of 4 stitch layers that have different colors. Each thread color layer is one of the CMYK(Cyan, Magenta,
Yellow and Black) color model. First the Magenta color is embroidered, then the Cyan color, the Yellow color
follows and finally comes the Black color. These colors cannot be changed and you must use them exactly
as they are embroidered, if you want to produce accurate Photo-stitch results. 

In the Create mode of Creative DRAWings you cannot edit the actual bitmap image but you can resize and
change the position of the Photo-stitch design. If you want to edit the actual bitmap image you have to use a
Bitmap editing software and then import the edited bitmap back to Creative DRAWings to view the results. By
editing the bitmap you can increase the quality of the embroidery result.
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Image to Photo-stitch

You can increase the embroidery result of the Photo-stitch design by adjusting the image contrast. By
increasing the contrast of the image you will get thicker satin bars in the darker areas of the photos and add
detail to the final embroidery. Also, some adjustments to the image size might needed to get more detail to
your photo-stitch. To increase the size of the bitmap inside Creative DRAWings you have to select the Photo-
stitch design, and then resize it by click and dragging the corner handles of the bitmap or the handles at the
middles of each side. The bitmap will be resized and the Photo-stitch will be recalculated. By increasing the
size of the bitmap you automatically increase the area that will be covered from the satin bars that will lead to
detail increase. 

The photo-stitch object gives you the ability to adjust the satin bars’ Width and the Density of each satin bar
for more accurate results. With the Width value you can set the distance that two satin bars will have
between them and with the Density value you can set the density that each satin bar will have when it
passes over dark areas. By adjusting those two values you can get more detailed photo-stitch results. 

Also, you have the ability to create Monochrome Photo-stitch by checking the respective option from the
Object properties toolbar. The Photo-stitch will become monochrome created from only one color (black).
This is a great effect that can give an artistic feeling to your photo-stitch.  
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Monochrome Photo-stitch

Important: Creative DRAWings can import only Bitmap images that have been created with RGB (Red,
Green, and Blue) colors. Any Bitmap that was created with CMYK (Cyan, Magenta, Yellow, and Black) will
not convert properly.

Open as Photo Paint

By selecting the Open as Photo Paint option, you can convert the bitmap image to a perfect Photo paint
design. The conversion is made automatically by clicking the Next> button in the dialog. The Photo-paint will
open inside Creative DRAWings® where you can make the adjustments. 

Photo-paint is another alternative you have when it comes to filling bitmap images with CMYK(Cyan,
Magenta, Yellow and Black) paint colors.  It consists of 4 paint layers that have different colors. Each thread
color layer is one of the CMYK(Cyan, Magenta, Yellow and Black) color model. First the Magenta color is
embroidered, then the Cyan color, the Yellow color follows and finally comes the Black color. These colors
cannot be changed and you must use them exactly as they are applied, if you want to produce accurate
Photo-paint results. 

In Creative DRAWings you cannot edit the actual bitmap image but you can re-size and change the position
of the Photo paint design. If you want to edit the actual bitmap image you have to use a Bitmap editing
software and then import the edited bitmap back to Creative DRAWings to view the results. By editing the
bitmap you can increase the quality of the paint result.

image to Photo-paint

You can improve the painted result of the Photo-paint design by adjusting the image contrast. By increasing
the contrast of the image you will get thicker satin bars in the darker areas of the photos and add detail to the
final painting. Also, some adjustments to the image size might needed to get more detail to your photo-paint.
To increase the size of the bitmap inside Creative DRAWings you have to select the Photo paint design, and
then re-size it by click and dragging the corner handles of the bitmap or the handles at the middles of each
side. The bitmap will be re-sized and the Photo paint will be recalculated. By increasing the size of the bitmap
you automatically increase the area that will be covered from the satin bars that will lead to detail increase. 

The photo paint object gives you the ability to adjust the satin bars’ Width and the density (St. density) of
each satin bar for more accurate results. With the Width value you can set the distance that two satin bars
will have between them and with the St. density value you can set the density that each satin bar will have
when it passes over dark areas. By adjusting those two values you can get more detailed photo-paint
results. 
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Also, you have the ability to create Monochrome Photo paint by checking the respective option from the
Object properties toolbar. The Photo paint will become monochrome created from only one color (black).
This is a great effect that can give an artistic feeling to your photo-paint.  

In addition you have the ability to adjust the cutter parameters that will allow you to get a better painted result.
The parameters that you can adjust are the following:

Cutter presets

All the paint objects are produced by placing a Brush/Pen to your digital cutter and then exporting the
design to the cutter. When exporting Paint designs, the cutter must be instructed to use lower speed and
less pressure in order to achieve best results. These are some settings that you must adjust either for each
object, here in object properties, using the following properties (Cutter pressure, Speed, Passes) or at the
Export to Cutter dialog. In order to assist you in selecting the proper settings according to the material and
the type of the operation we have prepared various operation presets. Click on the Cutter presets button
and from the drop down menu, select any of the available presets for your Cutter and the material that you
are going to use. This preset selection affects only the selected objects. For example for painting tasks for
users that own Artistic Edge cutter  you can select the preset Edge , Paint. After selecting the preset you
will see the values of the following properties change (Cutter pressure, Speed, Passes). 

Cutter speed

With this value, you can specify the speed that the digital cutter will produce the design. This value takes
values from 0 - 100, 100 is the max speed that each digital cutter can support. Some digital cutters may not
allow you to adjust this value at all through our software, you can make adjustments though through the
machine's panel. So the selection of speed though this property may not be applied during production.

Cutter pressure 

With this value, you can specify the pressure (force) that the digital cutter will use on its head. In our case,
we will use a Brush/Pen to our digital cutter in order to paint a design the pressure must be less than when
we actually use a Blade. This value takes values from 0 - 100, 100 is the max pressure that each digital
cutter can support. Some digital cutters may not allow you to adjust this value at all through our software, you
can make adjustments though through the machine's panel. So the value that you have selected may be
ignored. The value of Pressure varies from material to material, thicker material need more pressure and
thinner less.

Cuter Passes

You can specify the number of Passes you want the design to be made with. It actually defines how many

times each shape will be made by the machine. 

Important: Creative DRAWings can import only Bitmap images that have been created with RGB (Red,
Green, and Blue) colors. Any Bitmap that was created with CMYK (Cyan, Magenta, Yellow, and Black) will
not convert properly.
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Import embroidery files

One of the importing abilities, as we have already mentioned, is that we can import any embroidery design
we like. Creative DRAWings® will convert Stitch file formats like .ngs or .dsz or .pes into Vector designs.
Using this ability you can import your ready-made embroidery designs, convert them to Vector designs,
make any changes you desire, and embroider them again. 

Import from embroidery dialog

In order to use this ability we must select From embroidery option, from the artwork source dialog of

startup wizard. Select this option use browse   icon to select an embroidery file to import.

you can import any supported embroidery file into Creative DRAWings®. You can save it without changes, or
you can create a new .draw file. You will be able to make some limited adjustments on the imported
embroidery files, like adding new objects or text, and then save it as a new embroidery design. 

You can only import an embroidery design from the opening dialog of Create new in Creative DRAWings®.
Make sure Browse is highlighted, then click Next>. In the next dialog Artwork source, select From

embroidery option, and then click on the browse  icon to reach the embroidery file you want to import.

From the standard Open dialog that appears, you can find the Stitch file you want to import and click the
Open tab. You can import one of the following files:

· Wings Systems (“.ngs”)

· Milestone (".mls")

· Tajima (“.dst”, “.dsz”, “.dsb”)

· Tajima TBF (*.tbf)

· SEF xp (".sef")

· SWF (“.sst”)

· Saurer (*.SAS)

· Pfaff (“.ksm”,”.pcs”, “.pcm”)
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· Singer (*.xxx)

· Happy (“.tap”)

· bernina / Melco expanded (“.exp”)

· Brother/Baby Lock/Bernina (“.pec”, “.pes”)

· Husqvarna (“.hus”)

· Husqvarna Viking (“.vip”)

· Husqvarna Viking/Pfaff (".vp3")

· Viking Designer 1(“.shv”)

· Janome (“.jef”, “.sew”, ".Jpx")

· Janome JEF+ (“.jef+”)

· Juki(“.M3”)

· Toyota(“.10O”)

· Artista(*.art)

· QuiltCAD (*.hqf)

· PC Quilter (*.txt)

· Statler Stitcher(*.qli)

· CompuQuilter (".cqp/", ".cmd")

· Mitshubishi HD (“.1??”)

· Barudan FDR (“.U??”)

· ZSK TC(*.Z??)

The Stitch file you have selected will appear in the From embroidery import field. Click Next> to import your
file in the Create mode. Creative DRAWings® will prompt you to the next dialog to select the Fabric and
Color for your design.  Click Finish and view the imported embroidery design. If you want another file, click
on the browse icon and select another Stitch file. 

To the imported embroidery design you can change the colors of the objects, and make some simple
transformations such as rotation, skew, move and delete objects. 

Auto density adjust

To apply Auto density adjust option you have to select the stitch object you want to resize (Auto density
adjust will appear at the bottom of Object Properties toolbar), make sure that the checkbox of the option is
checked and then resize the stitch object by dragging any corner handle. While dragging with the mouse, on
the Status bar (is located at the bottom of the application) you can view the percentage of resize that you are
making.  

To be able to have full editing abilities you have to convert the stitch objects to vector objects that will give you
the ability to make any changes you want on the design.

Convert to Vector design

As we have already mentioned you can import your old embroidery files and convert them to vector designs.
You can convert the entire embroidery designs or a part of them. In this case after their conversion you can
use them as a normal design and edit in Create mode of Creative DRAWings.

To convert the imported embroidery artwork to Vector design, select the entire design with Ctrl+A keys.
Right click on the design and from the pop-up menu select the Convert to Curves option or press Ctrl+Q at
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the same time. Another way that you can convert it, is by clicking on the Convert to curves button that will
appear on the Object properties toolbar. 

Convert to curves

The embroidery design will be automatically converted to fully editable Vector artwork which can be edited.
You can also convert only an object or two. Creative DRAWings® takes you one giant step beyond the
normal Convert to Curves of software programs. Its new approach to imported embroidery allows you to
have Stitch objects together with Vector objects in the same file. You can convert specific parts of the
embroidery design to Vector artwork, make the changes in those objects, and then embroider them and
keep the rest of the embroidery design unchanged. Choose Stitch objects in a design and convert them to
Vector artwork. Select the artwork and from the right click menu, select the Convert to Curves option. This
combination allows you to have Stitch and Vector objects in the same file. 

  
Embroidery file to Vector file

In such cases you may don’t want to view both stitch and vector objects. You can disable Stitches option of
View menu to temporary hide all stitch objects. You can also hide all vector artwork by disabling Outline
design option of View menu. In this case if stitches option is enabled you can only see the available stitch
objects. Using these View options you will be able to edit your Stitch and Vector objects easier. 

The new produced Vector design is fully editable, which means you can make as many changes as you
want on the design. You can add or remove objects or designs and give them stitches by clicking on the 
Stitch mode. The former Vector design will be filled with stitches ready to be embroidered again. By editing
your imported embroidery files you can give life to your old designs. 
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Import ngs embroidery file

The reason Creative DRAWings® is so powerful: the default ngs embroidery files of Wings’ modular
software is at your fingertips. The designer included much of the professional Wings’ program into Creative
DRAWings®. 

Besides stitch data, ngs files contain the outline data of the design. The most powerful embroidery file
formats such as .dst, .sst, .exp, etc. can hold only stitch data and not outline data. This is important because
outline data allow you to change the artwork and recalculate the embroidery result. 

If you import an embroidery file inside Creative DRAWings, it will not have any outline data imported unless
the file has an .ngs extension. The outline data of the imported ngs file will be automatically recognized from
the software and will be imported as Vector data. Therefore, the Vector artwork of the embroidery design will
be directly editable in the Create mode of Creative DRAWings.  Some ngs files may only contain stitch data.
 This can happen if you open a .dst file for, example, which holds only stitch data and then save it as .ngs file
format. For the ngs file to hold the outline data, it must be either saved directly from Creative DRAWings or 
Wings’ modular as a ngs file or it must be created inside Wings’ modular from scratch.

Printing
Creative DRAWings® provides extensive options for printing your designs. You can print the design together
with much information that are useful for the embroidery process or Print the artwork of the design in order
see clearly the artwork without any other information.

Print design Print artwork

Print design

The printout of the design provides information needed to evaluate before sending a design for production or

to a customer to see if this is what he likes. To print a design from your screen, press the print  icon on
the standard toolbar or from the menu File > Print option or press the Ctrl + P shortcut keys from the
keyboard. The following dialog will appear, you can see a preview of the printout of a design.
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Creative DRAWings Printout

In print preview window, we can see a preview of the design together with provided information. On the right

part we can see various customization of the printout. These customizations are:

· We can use Setup button in order to select and customize the properties of the printer that we are

going to use. 

· We can also use Save to JPG option in case that we don’t want to print it, but we want to save it for

later reference or to review on our computer monitor. 

· In section Print we can select which parts we want to be visible. Click on any of the checkboxes in

order to enable/disable visible items. 

· If you want this selection of visible items to be the default for any design, you can use save defaults

button. 

· Finally in tiled printout section we can customize some aspects of the print, number of pages,

orientation, and scale. We can also set number of stitches that we want to be visible on the print

preview.

Print items

In this section of the printing dialog you can specify which information you want your printout to include. Every
item of the printout can be enabled or disabled by clicking on the square on the left of its description. If the
item is enabled the changes can be viewed on the preview area.

· Header
The header is at the top of the page, showing the size, color changes, number of stitches, quantity of

thread needed, the colors of the design, and their position.

Header
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· Color changes
The box shows the sequence of the color changes. This information is really useful in case the design

will be saved in a file format which uses “stop” instead of color-change command.

Color changes

· Sequence icons

The sequence icons are at the bottom of the page. They show parts of the design split with a special
function like color change, appliqué , or stop. Also in the bottom of the icon you can view the name of
the color that should be used, plus comments.

Sequence icons

· Information
Information is at the bottom of the page. The information area lists and describes the components of

your embroidery design. The information is sent from the program to the component presets you have

selected.

Information

· Company name

The company name, which is at the top of the printout, can be changed by using the Printing tab of
the Tools > Options dialog.

Company name

· Orientation
The orientation is the icon shown with the "R" character at the top right corner of the printout. This is

important because it shows how the printed page should be put on the embroidery machine to identify

the starting point of the design.

Orientation
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· Binder space

This option makes the necessary margin (on the left side of the page) in case you want to put the
printout in a folder.

· Stitch count

The number of stitches in your design can be viewed at the header of the printout. This Stitch count
is important for commercial use when the number of stitches is used to calculate the embroidery
price.

Stitch count location

· Start point

This option shows or hides the starting point of the design, marked with the  icon.

· 3D-preview
Displays the stitch design in 3D-preview mode. 

 

3D-preview Enabled                           3D-preview disabled

· Fabric
Hides or Shows the fabric behind the design.
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Without fabric – With fabric

· Design date

The date that the design was created can be viewed at the top left of the printout. 

 Design date location

· Hoop

Hides or Shows the embroidering area (doted line) of the selected hoop with a dashed line around the
design. If your design is position outside this line you will have problems embroidering the design on a
hoop that has the same dimensions (You might damage your machine).

Tiled printout

This section manages the way that your design will be printed. When the printout dialog is called up, the first
two fields indicate the number of pages needed for printing: 'X' for horizontal and 'Y' for vertical; the number
of designs printed on each page can be changed by using the arrows on the right hand side or with the
mouse wheel. The changes you make can be viewed on the print preview as you make them.

Tiled printout

The Portrait option specifies how the design is positioned on the page. If it is enabled, then the design is
printed vertically as a portrait. If disabled, then the design is printed horizontally as a landscape. 
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The Scale field shows if the design will be depicted smaller than its actual size and the percentage of the
reduction. The first time that the printing dialog is used, Creative DRAWings® finds the best way to show the
design in actual size with the least number of pages. 

To automatically restore the parameters indicated at the beginning of this process you could click on the 
AutoFit tab. If your design is previewed in more than one page, you can print them, cut the border of the
page, which is already marked, and tape them to have your design complete. 

Finally at the bottom of the right area of Print preview dialog there is a control that you can use in order to set
the number of stitches that you want to be viewable in the respective area of the printout. Click on the editable
area and type the value you want to appear in Printout.

Print Artwork

With Creative DRAWings you have the ability to print any artwork you want on a special paper for textile
printing. Then you can iron the paper on the fabric and apply the design on the fabric. You can also combine
textile printing with redwork embroidery and create unique and stylish designs on garments. 

To print the artwork of the design you have created or imported inside Creative DRAWings you have to select
the Print Artwork option from File menu. The Print Preview dialog will appear that includes all the options
that you can adjust to prior printing the artwork.

Print artwork preview 

As we have described in previous section the printout and the visible items can be customized. 

· Select a printer

· Save into JPG file 

· Select printed items

· Customize orientation and number of pages.

The only addition is that you can create Mirrored printouts easily. Mirrored option allows you to make
a Mirror of the artwork you want to print in order to make it proper for textile printing or any demonstration
purpose. 
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Normal Printout                           Mirrored Printout.

Send design

With this option you can send a .draw file of Creative DRAWings by e-mail. Click on File > Send. When the
Send option is selected, Creative DRAWings  finds the default program that you use for e-mails and opens a
new window. It saves the current design in the .draw format in your temporary directory, and inserts this
.draw file as attached. Type in the e-mail address, add any text, and send it.

Recent files

Click on File to find the list of designs that you recently opened. The lower half of the dropdown menu
contains links to your last-accessed files. If you click on a link, the design will open in a new Creative
DRAWings® window and the opened file will be placed on the top of the recently used File list.

Auto-backup mechanism

Creative DRAWings® software has two security features to help you avoid losing your work from a possible
systems crash.  The first is the Failure Recovery feature and the second is the Auto-backup feature of the
embroidery designs. 

· Failure Recovery: This feature is activated automatically when an illegal operation is made in the

software. Immediately the Failure Recovery tool is activated to baffle the termination of the program. 

Failure Recovery dialog

When this Failure Recovery dialog box appears, click Yes and the software will continue
functioning. If you click No, the Creative DRAWings® software will be terminated immediately without
asking you to save your design. If the Failure Recovery box appears while designing, it is better to
save your design by clicking Yes, then restart Creative DRAWings®. This mechanism secures your
work.  
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· Auto-backup: Another feature that Creative DRAWings® has to protect your valuable work is the

Auto-backup feature. Creative DRAWings® automatically saves your designs after every change.

The Auto-backup works even if you have not saved your design at all. If the software locks up for

whatever reason, your work will not be lost in most cases. When you open the software again, the

designs before the lock-up will be recovered. This mechanism will protect you from losing your work. 

Note: As another safety feature, always keep in mind the importance of saving your designs frequently. 
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Workspace tour

Chapter IV

The main application window consists of a variety of menus, toolbars, wizards and dialog windows. All
these together with the design tabs are called a workspace. A workspace is any combination of the above
components. The way that the workspace components and windows are placed is fully customizable. When
opening the application for the first time all these tools are placed by default in a way to help you focus on
your task (creating, editing and viewing designs). Make any arrangement on workspace components in order
to have a workspace that matches your personal preferences. More information about customizing
workspace will be provided later on this chapter. Some of the workspace components are available only in 
Create mode and some of them change inside stitch mode because they have dynamic contents. 

Take some time using all the available workspace components. As you are getting more familiar with the
tools and their usage you will improve your productivity. Let’s take a look at the tools and their default
placement. This is the main application window of Creative DRAWings.

While creating a design you are prompted to select which Techniques you should enable, according to the
enabled techniques the available workspace components are altered, so always have in mind that a tool or
an option may not be available with some of the enabled techniques while it may be in other techniques.

Creative DRAWings application window
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Workspace components
We will now describe the available workspace components and the ways to customize them. On the top
area of the application window you can see the Title bar, the Main Menu bar, the Standard toolbar, Draw-
Stitch toolbar and Tool options pane. On the left side of the application window you can see Tools toolbar.
You can also see the Thread palette and the Status bar at the bottom area of the window. On the right side
of the design area you can see Object properties pane.  Object properties toolbar is a context sensitive
bar because it provides properties for the object you have selected. Each object might have different
properties depending on its size and shape. While using the application there are also some transparent
dialogs that appear on top of the design area. Let’s take a closer look at all these components.

Workspace components

Title bar

This bar is located on the top of the application window. Most windows applications provide file information
and window handling controls via this bar. The default location is on the top of any application window. By
double clicking on the title bar the application changes from maximized state to custom window state. 

Title bar

Main menu bar

Under the title bar is located the Main menu bar. This bar provides access to most of the commands that
control the main functionality Creative DRAWings. It consists of several menus, click on any of them (for
example, File, Edit, View, Tools) to see the included menu commands.
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Main menu bar

Design area 

The heart of Creative DRAWings software is the design area. All the tools, menus and functions exist to
provide functionality useful during designing process. The design area is the rectangular area inside Creative
DRAWings application window. This area is used for creating and editing designs. Any tool you are using
from any toolbar affects the creation inside the design area. You can have many loaded designs in the same
window. Every design has its own design area. Multiple designs are can be loaded in different tabs. By
pressing on any of these tabs you can select which design you want to be visible. At the top and left side of
the working area you will find the Ruler that can help you make precise changes to your design. 

Design tabs

Design area and Design tabs

Window handling 

By pressing on the top of any tab you can select the active tab. Another way to select the design that you
want to be active is by selecting from the dropdown list that exist on the right side of the design area. From
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the appearing list, select using your mouse one of the designs. Click on the design you like, the selected
design will appear inside the design area.

Select active design from list

Context menus 

The term context menu (shortcut menu or pop-up menu) is commonly used for menus which pop up when
right clicking on an item inside the design area, offering a list of options. The available options vary depending
on the context of the action and the item selected. For example different options appear when right clicking on
a design object than when clicking on the same object in Edit shape nodes mode. The available context
menus of Creative DRAWings are hierarchically organized, allowing navigation through different levels of the
menu structure.

Context menus

The context menu of the previous figure is available only when right clicking on an object in object editing
mode. Some of the applications functionality can only be revealed by specific context menus that are
available inside the Creative DRAWings design area. This kind of logic separates the available actions for
each type of object. Select any object, right click on it and select a function from the appearing menu, just
like that you can perform a number of designing tasks.

Thread palette 

At the bottom of the screen we have the onscreen Thread palette bar from where you can select and set
colors on the designs. You can either have RGB colors or colors from thread manufacturers’ color palettes.
The Thread palette is divided to two parts: available colors on the top area and the colors that are currently
used in the bottom area. Thread palette is available only when using Create mode.
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Thread palette

Status bar 

The status bar displays information about selected objects (such as Width, Height, and Number of
stitches). It also displays information while transforming objects about angle etc, information that assist in
more accurate transformations.

Status bar

Floating dialogs

There are various dialogs that contain tools or visual assistance to be used while designing.

1. Object properties

The object properties pane contains all the properties that can be customized in the embroidery aspect

of the design. It is consisted of two tabs Fill  and Outline . You can view the Object properties

pane both in Create and in stitch  mode of Creative DRAWings. Using the provided options you
can change the stitch type of the design easily by just clicking on it. The Object properties pane
contains all available parameters for each stitch type. You can see and change the parameters of
selected objects. Just click on a parameter to change its value. When selecting an object the object
properties pane, shows the properties of the selected object. Every stitch type has a different set of
parameters. The available parameters and the proper way of affecting them will be described later on
this manual, in a different section. If object properties window isn’t visible you can activate it by selecting
from View menu -> Toolbars item and then sub item Object properties. You can also use the shortcut
key Alt + Enter to show-hide the pane.

2. Sequence manager

This tool provides a graphical representation of the embroidery sequence. There are signs to separate

the different types of objects (Embroidery, appliqué ). It is often needed to change this sequence, in order

to improve embroidery quality. Any item you select on sequence manager gets selected on the working

area. Sequence floating dialog can be opened in case that it is closed using Sequence manager option

from the View menu. The extra ability of this tool is that you can re-arrange the sewing order for the

current design, and select an object. Therefore you can organize the sequence of embroidery production

in the way you prefer.

There are also some floating dialogs that appear only to help us during design process. These dialogs are 
Apply array, Set light source, Slow redraw. More information about the usage of Object properties,
Sequence manager and all other floating dialogs will be provided into separate sections.

Toolbars
In any windows application there are usually a number of icon toolbars. They have shortcuts to dialog boxes
or actions. Click on any icon of the program’s toolbars to see the performed action. You can also pause your
mouse over any of the icons and a popup containing information about the action will appear. 
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Icon toolbars (Standard, Align and DRAW-Stitch bar)

These 3 bars that are highlighted on the above figure are the Standard, the Align and the Draw-Stitch bar. In
case that any of these bars is not visible you bring it up using the respective options of menu View ->
Toolbars section.  This way you can select which toolbars will appear on workspace and which will not. On
above figure you can see all the icons toolbars enabled and appearing on the workspace.

1. Standard toolbar, this toolbar is a collection of buttons that serve as shortcuts for the basic

functionality of the application. Most of these icons implement the same functionality in the majority of

windows applications. If you are familiar to any windows application, you have used many times, tools

such as new design, open design, Save, Cut or Paste. Besides these basic file operations, in

Standard toolbar, you can select zoom preset, use shaping tools (Weld, Trim, and Intersect),

Select Fabric and Thread manufacturer palette. 

Standard toolbar

2. Align bar, this icon toolbar is located at the top area of the applications workspace and contains

aligning, distributing and auto-sizing tools. 

Align bar

3. DrawStitch bar,  using this toolbar you can toggle between the available design modes. Creative

DRAWings software has two important working modes, the Create and the Stitch mode. We can

design anything we like in Create mode and Convert the design into stitches in Stitch mode. The

Create mode is mainly for creating and editing the artwork. In Stitch mode you can convert the

artwork to stitches and make the final adjustments. Different controls and options are available in any
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of the two modes. By pressing DRAW icon  or by using Ctrl+1 keyboard shortcut you enable

Create mode. In order to switch to Stitch mode you must press Stitch icon  or Ctrl+2 keyboard

combination.

4. Tool options pane is a context sensitive toolbar. Depending on the tool you have selected from the

toolbox the property bar changes accordingly. It also contains controls that you can use to change

the properties of the selected object. Some of the available tools have extra parameters that appear

on the Tool options toolbar, every time you select them.

Tool options pane

5. Tools toolbar, this toolbar contains shortcuts for most of the viewing and designing tools. Selection

modes (Rectangle and Lasso), Edit shape nodes mode, View port presets (Zoom in, Zoom back,

Zoom all, Pan), Slow redraw, create Freehand shapes or insert Shapes, use Text, Array tool

(Circular, Rectangular), auto border tool and Auto-sequence. The tools and their usage will be

described later on a separate section each.
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Tools toolbar

Customizing DRAWings workspace
We have described the workspace components and the purposes that they serve. Spend some time using
them in order to understand how they work. At first you must be trying to sort out which tools are important to
you, in order to have them in first sight. You can rearrange workspace components in order to serve your
personal preferences and make a version of the perfect working environment for you. 

Tip: Creative DRAWings will remember the position that you last placed any workspace
component.

Take in consideration that the screen space depends on the screen resolution. If you have a large resolution
it means more available space. So first of all set the best resolution that fits to your screen. Start Creative
DRAWings software, make a few shapes, use some properties, add more shapes, and view the design
objects in sequence manager. If the design space is not enough and the tools are crowded you must
organize available tools. 

To give you complete control over the size and position of the elements in the workspace, Creative
DRAWings lets you move, resize, dock and auto hide most of the workspace components and make
visible only the elements that you want to view. You can attach or dock tool windows to make more space
visible. You can also partially conceal tools as tabbed documents along the edge of the workspace and then
switch back. The exact size and shape of the tools and windows depend on how you have configured your
designing environment to look like.

Using Tool windows

Once a tool window is floating it has a title bar like the one in the following figure. By double clicking on its title
bar, it gets docked in the last position that it was docked. You can also close this tool window by pressing the

close  button in the upper right corner of the window. Double click on the title bar to undock the pane. You
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can also close it by pressing the Close  button in the upper-right corner of the window. You can set the

window in auto hide mode by pressing this pushpin . Finally by right clicking on the title bar you can select
a state for the dialog (Floating, Docking, Auto hide, Hide).You can always open any closed window again later
by selecting the appropriate command on the View menu.

   

Object properties window handling

Moving tool windows 

To move one of the tool windows, simply click the title bar and drag it to a new location. 

Move Object Properties tool window:

1. If the Object properties pane isn’t visible, select from View menu, Toolbars item, Object Properties

sub-menu item. Object properties pane will appear.

2. Double-click the title bar of Object Properties pane to display the pane as a floating (undocked)

window.

3. Using Object Properties title bar, drag the pane to a new location inside the application window, but

don’t dock it. See how easily you can affect the position of the available tools.

Resize tool windows 

If you want to see more of a tool window, simply drag one of its borders to view more content.

Resize Object Properties pane:

Resize the Object Properties pane to have a better view of the available parameters. Point your mouse to
the lower-right corner of the Object Properties window until the pointer changes to a double-headed arrow
(the resizing pointer). Drag the lower-right border of the window down and to the right to enlarge the window.
The same way, you can resize any tool window from any of its edges. You can work more quickly and with
more clarity of purpose in a bigger window. Feel free to move or resize any tool window when you need to
see more of its contents.

Docking Tool Windows

Dockable windows are advantageous because they always remain visible. (They don’t become hidden
behind other windows.) If a tool window is floating over the design area, you can return it to its original docked
position by double-clicking the window’s title bar. (Notice that you can use the same technique to undock a
docked window. Double-clicking a title bar works like a toggle, a state that switches back and forth between
two standard positions). You can also attach or dock a floating tool in a different place. 

You can dock windows by using docking guides, as shown in the figure below. Docking guides are icons
that appear on the surface of the application window when you move a window or tool from a docked position
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to a new location. Because the docking guides are associated with shaded, rectangular areas of the
application window, you can preview the results of your docking maneuver before you actually make it.

Docking handles

In case that you want to dock into a place where there other tools docked while you point over this control you
can see how the control will be docked. Only then extra docking guides appear to help you decide how to
place the window relative to the other docked window.

Dock to the upper part Dock to the right side
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Dock on the left side Dock on the bottom area

Dock the Object Properties window

1. Verify that the Object Properties window (or another tool that you want to dock) is floating over the

design area in an undocked position.

2. Drag the title bar of the Object Properties tool window to the top, bottom, right, or left edge of the design

area. While dragging, take care to drag the mouse pointer over one of the docking guides (small arrows)

on the edges of the Creative DRAWings window or the collection of four docking guides (called a 

diamond guide) in the center. As you move the mouse over a docking guide, the Properties window

snaps into place, and a blue shaded rectangle indicates how your window will appear when you release

the mouse button. There are several valid docking locations for tool windows, so you might want to try

two or three different spots until you find the one that looks right to you. 

3. Release the mouse button to dock the Object Properties window. The window snaps into place in its

new home.

4. Try docking the object Properties window several more times in different places to get the feel of how

docking works. 

You can always adjust the size of docked windows by simply dragging one of its borders to view more
content.

Hiding Tool Windows (Auto hide) 

If you want an option somewhere between docking and closing a window, you might try auto hiding a tool
window at a side of the application window by clicking the tiny Auto Hide pushpin button on the right side of
the tool’s title bar. When you auto hide a window, you’ll notice that the tool window remains visible as long
as you keep the mouse pointer in the area of the window. When you move the mouse to another part of
application window, the rollup slides out of view. To restore a window that you have auto hidden, click the
tool tab at the edge of the application window or hold your mouse over the tab (You can recognize a window
that is auto hidden because the pushpin in its title bar is pointing sideways.) 

The benefit of enabling auto hide, of course, is that the process frees up additional design area while the
hidden window is also quickly accessible.
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Press the pushpin to go into Auto hide
mode

Object properties pane is hidden on the
side of the window and becomes visible
only when you place the mouse over it.

Object properties rollup is viewable, you
can press the pushpin once more to turn
into docked mode again

Use the Auto Hide feature (Hide Object Properties tool window)

1. Locate the Auto Hide pushpin button  on the title bar of the Object Properties pane. The pushpin

is currently in the down, or pushed in, position, meaning that the window is pinned open (Auto hide

is disabled).

2. Click the Auto Hide button, Object Properties tool window slides off the screen and is replaced by a

small tab named Object Properties at the edge of the application window. You can also use a right-

click on the title bar and select Auto Hide in order to auto hide a tool window.

3. Hold the mouse pointer over this Object Properties tab (You can also click the tab if you like) and

the Object Properties tool window immediately slides back into view.

4. Click elsewhere inside the application window and it will disappear again.

5. Finally, bring out the object Properties window again and then click the pushpin button  on the

title bar. Object Properties returns to its familiar docked position and you can use it without worrying

about it sliding away.

Tool windows that have Auto Hide enabled temporarily slide into view when the window has focus. To hide
the window again, select an item outside of the current window. Once the window loses focus, it slides
back out of view.

Techniques
The available components dynamically change according to the Techniques that we enable for this design. 
For example in the following figure, in the upper part we have only selected Embroidery technique and as
you can see on the right part only Embroidery types are available. In the lower part we have also enabled
Cut technique and the Cut type has been added to the available outline types. 
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Enabled techniques Available Outline properties

There are 5 techniques available Stencil, Embroidery, Cut, Crystals, Paint.

Stencil:
When enabling Stencil technique, Stencil  outline
type is enabled. Using this outline type you can convert any
open outline automatically into a Stencil design. 

Embroidery When enabling Embroidery technique we can apply

various embroidery fill types (Satin , Step , Row

fill , Applique , Net fill ) and various outline

embroidery types (Running , Satin serial )
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Cut
When enabling Cut technique, the Cut outline type is
enabled and visible in available outline types. Using this
outline type we can Cut any design part using your
cutter.Create a design you want to cut and you can easily
send it to your cutting machine. 

Crystals
Crystals technique enables the Crystal fill  type and

Crystals outline  type. Using Crystal fill or Crystals
you can automatically add crystals to any portion of your
design using various crystal/rhinestone shapes and sizes.

Paint Paint technique enables various Paint fill types (Zig zag

, Fill , Row fill , Paint net fill ) and

various Outline paint types (Line , Zig zag paint

). Using any of the previously mentioned paint types
any portions of your designs can be painted precisely.

Using the Start up wizard to create a new design you are prompted to select which techniques you want to
be enabled for the created design so that only the tools that you need are available on the workspace. In case
that you change your mind and you want to use additional tools that are not included in the enabled

techniques you enable additional techniques using the Techniques  icon of Standard toolbar. Select any
technique that you would like to enable by clicking on  its icon. At this point we must mention, techniques that

are already and actively used on the design have this red bulb  on their upper left corner and we can not
disable them until there is no usage of their tools on the design. 

The enabled techniques that are not already actively used on the design have this green bulb   and the

techniques that are not enabled have this black bulb . Click on any technique that you may want to
enable, its lamp will get Green. The workspace will be updated and the tools of the newly enabled designs will
appear for this design.
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Selections

Chapter V

In this chapter we will learn how to select objects in a design and how to modify them. To make changes in
your embroidery design, select an object by clicking on it, and then applying the stitch type you prefer. The
standard selection tools in are rectangle selection and the lasso selection. You can use the selection
tools from Tools toolbar, using the mouse (click) and the functions in the edit menu.

Select with mouse (click)

Complex designs may consist of many objects, that may have different stitch types and colors. In order to
make changes in one or more objects you must first select them. The easiest way to select any object is by 
simply clicking on it using your mouse. A highlight rectangle appears around the object to reveal the
currently selected object, as you can see on the following figure. This is helpful for not losing your current
selection when you have to work on a complex design. Also, whenever you pass the cursor over the selected
object, the dimensions of the selection rectangle appear on each side.

Selection information rectangle

You can also make multiple selections using the mouse click combined with holding Shift or Ctrl keys. 
Hold the Shift key and click on more than one objects in order to make a multiple object selection. In the
same way you can Hold Ctrl key and click on the object that you want to select. The difference of selections
using Ctrl key is that using Ctrl in reality you invert the selection status of any object. If it is selected it gets
unselected and the opposite. Just like that using Ctrl you can easily add/remove objects to a selection simply
by holding Ctrl and clicking on any object. 

Rectangle selection
The Rectangle selection is a working mode that you can form a rectangle on the design area and all the

object(s) that are in this rectangle become selected. Click on the Rectangle selection icon  in order to



197Selections

© 2017 DRAWstitch Ltd.

enter this working mode, now click and drag over the design area in order to create a rectangle around the
objects that you want to select. The objects that are entirely inside the rectangle are automatically selected. 

We can hold Alt key while forming the rectangle area and in this case the objects that are
partially inside the selection are also selected. This is an easier way to select objects
which are large and have irregular shape.

The Rectangle selection icon is the top icon of Tools toolbar that is by default located on the left side of
the application window. In this icon place we can also find Lasso selection icon. Click and hold on the icon
that exist in this top icon place of Tools toolbar and a fly-out toolbar will appear showing both (Rectangle and
Lasso) selection icons, place the mouse on top of the one that you want to use, until it becomes  highlighted.
Release the mouse and the selected icon becomes visible on the toolbar and it is automatically activated.
The last used selection tool is visible on the toolbar. In case that Rectangle selection is not visible you can
follow the above instructions to make it visible.If the Rectangle selection tool is your default selection tool,
you can activate it by pressing the Space bar.

 

Just like that you can make multi-object selections by specifying a rectangular area. You can draw a
rectangle around your entire design and all the objects that are completely within this rectangle will be
selected. 

Note: You can change the default selection tool from the Tools tab of the Options dialog
box that is located under the Tools menu. You can set the Lasso tool as the default
selection tool. By default the Rectangle selection tool is  the default selection tool.

Lasso selection
The Lasso selection is a working mode that you can form an irregular shape on the design area and all the

object(s) that are in this shape will become selected. Click on the Lasso selection icon  in order to enter
this working mode, now click and drag over the design area in order to draw a freehand selection line
around the objects that you want to select. Right click to confirm the selection. The objects that are entirely
inside the shape are automatically selected. 

We can hold Alt key while forming the lasso selection and in this case the objects that are
partially inside the selection are also selected. This is an easier way to select objects
which are large and have irregular shape.

There is an option Allow polygon selection with lasso in Options dialog, Tools tab. When this option is
enabled you can click while forming the Lasso selection and by specifying the nodes of a shape you can
create a polygon shape selection with lasso.

The Lasso selection icon is the top icon of Tools toolbar that is by default located on the left side of the
application window. In this icon place we can also find Rectangle selection icon, that is the default slection
tool. Click and hold on the icon that exists in this top icon place of Tools toolbar and a fly-out toolbar will
appear showing both (Rectangle and Lasso) selection icons, place the mouse on top of the one that you
want to use, until it becomes highlighted. Release the mouse and the selected icon becomes visible on the
toolbar and it is automatically activated. The last used selection tool is visible on the toolbar. In case that 
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Lasso selection is not visible you can follow the above instructions to make it visible.If the Lasso selection
tool is your default selection tool, you can activate it by pressing the Space bar.

 

Just like that you can make multi-object selections by specifying an irregular selection shape.  

Note: You can change the default selection tool from the Tools tab of the Options dialog
box that is located under the Tools menu. You can set the Lasso tool as the default
selection tool. By default the Rectangle selection tool is  the default selection tool.

Invert selection

Using this option from the Edit menu (Ctrl+Shift+i), you can invert the object selection, select all unselected
objects, and vice versa. 

Selection  Invert Selection

This option is useful when you want to select a larger portion of a design. Select a small object or group of
what you don’t want, then choose Invert selection to capture the larger portion. You’ve selected the portion
you want in this reverse process.

Select all
Using this option from the Edit menu, or by clicking the shortcut key Ctrl+A, you can select all the objects in
the design. 
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None selected Select all

This option is useful when you want to modify all the objects of your design at the same time. Any change will
be applied on all selected objects at the same time. 

Select none
There are various ways to de-select everything. First you can click with your mouse on the fabric, at any point
outside of the created design and everything will become unselected. We can also use Select none option
of Edit menu and nothing is selected. This function is the opposite of Select all function where you are
selecting all the designs in the working area. It is useful when you want to clear your current design
selections to make a new selection 

Select by stitch type
Sometimes it is very useful to select all the objects, of the same stitch type and apply a color change or any
other transformation. Right click on any icon of the available stitch or embroidery types on object properties
toolbar and from appearing menu use Add to selection option. In case that there are some objects that are
already selected, the objects of the selected stitch type are added to the current selection. In the same way
we can remove the object of a selected stitch type from a selection. Right click on the stitch type that you
want to be removed and use Remove from selection option.

When no object is selected (Object properties does not sow anything), you can access select by stitch

type options by right clicking on Fill or Border/Pen  tab icons of Object properties toolbar. From
appearing menu use Add to selection option and click on any stitch type you want to select. When right
clicking on the Pen tab icon only the available pen types appear and when clicking on the Fill tab icon only
the fill types appear. After making the selection you want, you can make any embroidery adjustments to your
entire selection. All changes that you will make will be applied in all selected objects.

With this option you can make selections according to stitch types. Click on Fill or Border/Pen

icon of Object properties toolbar and Add to your selection all embroidery objects of a specific stitch type.
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After making the selection you want, you can make any embroidery adjustments to your entire selection. All

the changes that you will make will be applied in all selected objects.

Select by stitch type

In the same way, it is also possible to Remove from the selection all the objects of a specific stitch type, by

right clicking on Fill or Border/Pen  tab icons and then select the stitch type you want to be
removed. All the objects of the selected stitch type will be automatically removed from your selection. 

This selection tool will help you to make selections easier, especially to a big complicated object, and apply
your embroidery changes to your entire selection. 

Select / View overlapping order of vector design
Creative DRAWings provides an easy way to navigate through the design objects. Using keyboard
combinations you can view the design order of the Vector design. The sequence that the objects are
embroidered is the same as they were designed. If you have imported a ready-made Vector design, the
order will be the same with the order the designer created the design. If you have created the design from
scratch, the order will be the same as the order of creation. 

Using Ctrl+Home, Ctrl+End, Tab and Shift + Tab shortcut keys, you can navigate between the objects of
the design. The shortcut key has the following functionality:

· Ctrl+Home: By pressing the Ctrl+Home key on the keyboard, the first object of the design will be selected.
This object is the first of the vector design. 

· Ctrl+End: By pressing the Ctrl+End key on the keyboard, the last object of the design will be selected.
This object is the last of the vector design.

· Tab: By pressing the Tab key on the keyboard the next object of the design will be selected. If we have not
made any selection, the first object of the design will be selected. Each time we press the Tab key a
different object will be selected, which is the next in the designing order of the vector design. If we continue
pressing the Tab key, we will continue changing objects, until we reach the last object of the design.

· Shift + Tab: By pressing the Shift + Tab keys on the keyboard the previous object of the design will be
selected. If we have not made any selection, the last object of the design will be selected. Each time we
press the Shift + Tab key a different object will be selected, which is the previous in the designing order of
the vector design. If we continue pressing the Shift + Tab key, we will continue changing objects, until we
reach the last object of the design.
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This selection/viewing ability is very useful when you want to know how the vector design was created and
make the needed adjustments to produce the embroidery sequence you prefer.

Selections by color
Thread palette toolbar includes the ability to select objects by color. This option is very useful when you want
to make a change to all objects that have the same color. You can select them and then make the change
you want. You can change colors or stitch types to all objects, apply a different style or apply any other option
you want. You can select object by Fill color, by Pen (outline) color or simply by color. 

To select the objects by color you have to right click on the color you want from those that are listed on the
currently used area and from the right click menu, expand the Select by submenu, select one of the three
available selection options: Fill color, Pen color and Any color.

Select by color right click menu

· If you select Fill color option, all objects that have the fill color you right clicked on will be selected. 

· If you select Pen color option, all objects that have the Pen (outline) color you right clicked on will be
selected. 

· If you select Any color option all objects that have Fill or Pen (outline) color you right clicked on will be
selected. 

Any change you make on the selected objects, affects all objects.

Selections in sequence manager
Sequence manager is a visual assistance tool that provides a graphical representation of the design's
vertical order. The functionality and capabilities of sequence manager are described later in this manual. At
this point we will mention only the selection capabilities that it implements. 

Place the mouse anywhere over any item of the Sequence manager, you can see an highlighted outline
appearing around this item. The highlighted item looks like on top of the other items, revealing that it is
currently selected. Click on any item and it gets selected.  You can see the specific item selected in the
design area with a highlight rectangle around it. We can also select multiple sequence items by holding Ctrl
and clicking on the items to be selected. 
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1 sequence item selected Multiple sequence items selected

Selection by Crystal

With this option you can make selections based on specific crystal types or add groups of crystals to your

selection. The Crystals Technique needs to be enabled(  at the Techniques selection dialog) in order the

Crystal tool to be available. 

Select separate crystals of the same type

If you have many different separate crystals in your design you have the ability to select all crystals of the
same type and apply changes to all of them.

Select a single crystal from the design. On the Object properties toolbar the Crystal options will appear. 

From the Color/Shape section you will find the selected crystal highlighted with light blue color . To
select all crystals of this specific Color/Shape, right click on it and select Add to selection option.
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All crystals of the same Shape/Color will be added to the selection.
(Notice: Crystals of the same type that are inside an Array fill-Outline or inside a Crystal fill-Outline object
 would not be added to the selection because they are considered to be in a different fill/outline type and they
have different options in the object properties toolbar.)

You can apply a different Shape/Color on the selected Crystals by simply clicking on a different one from the
list or if you want you can add more crystals in your current selection.

To add more crystals to your selection you have to right click on another crystal that you know that exists in
the design and select Add to selection option. All separate crystals with this Color/Shape that exist in the
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design will be added to the current selection.  Now, if you want you can change the properties of all selected
crystals. For example change the crystal Size or the crystal Color/Shape. 

Also, you can remove crystals from your selection. Right click on the the crystal you want to remove from
the Color/Shape list and select the Remove from selection option. All crystals that had the same
Color/Shape will be removed from the selection. By following the same steps you can remove separate
crystals from your selection. 

Select crystal fills of the same type

If you have many different crystal fill shapes in your design you have the ability to select all crystals of the
same type and apply changes to all of them.
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Select a crystal fill object from the design. On the Object properties toolbar the Crystal fill options will
appear. 

From the Color/Shape section you will find the selected crystal highlighted with light blue color. To select all
crystals of this specific Color/Shape, right click on it and select Add to selection option.

All crystals of the same Shape/Color will be added to the selection.
(Notice: Crystals of the same type that are inside a Crystal fill-Outline object or separate crystals would not
be added to the selection because they are considered to be in a different fill/outline type and they have
different options in the object properties toolbar.)

You can apply a different Shape/Color on the selected Crystal fill objects by simply clicking on a different
crystal from the list or if you want you can add more crystals in your current selection.

To add more crystals fills to your selection you have to right click on another crystal that you know that
exists in the design and select Add to selection option. All crystal fill objects with this Color/Shape that exist
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in the design will be added to the current selection.  Now, if you want you can change the properties of all
selected crystals. For example change the crystal Size or the crystal Color/Shape. 

Also, you can remove crystals fill objects from your selection. Right click on the the crystal you want to
remove from the Color/Shape list and select the Remove from selection option. All crystals fill objects that
had the same Color/Shape will be removed from the selection. By following the same steps you can remove
more crystal fill objects from your selection. 

Select crystals placed on the outline

If you have many different crystal outline shapes in your design you have the ability to select all crystals of the
same type and apply changes to all of them.

Select a crystal outline object from the design. On the Object properties toolbar the Crystals options in the
Pen tab will appear. 

From the Color/Shape section you will find the selected crystal highlighted with light blue color. To select all
crystals of this specific Color/Shape, right click on it and select Add to selection option.

All crystals of the same Shape/Color will be added to the selection.
(Notice: Crystals of the same type that are inside a Crystal fill objects or separate crystals would not be
added to the selection because they are considered to be in a different fill/outline type and they have different
options in the object properties toolbar.)
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To add more crystals outline objects to your selection you have to right click on another crystal that you
know that exists in the design and select Add to selection option. All crystal outline objects with this
Color/Shape that exist in the design will be added to the current selection.  Now, if you want you can change
the properties of all selected crystals. For example change the crystal Size or the crystal Color/Shape.

You can apply a different Shape/Color on the selected Crystal outline objects by simply clicking on a
different crystal from the list. Also, you can specify different crystal sizes and add more spacing between
them from the respective options.
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Also, you can remove crystals outline objects from your selection. Right click on the the crystal you want to
remove from the Color/Shape list and select the Remove from selection option. All crystals outline
objects that had the same Color/Shape will be removed from the selection. By following the same steps you
can remove more crystal outline objects from your selection. 

This selection tool will help you to make selections easier, especially to a big complicated crystal objects, and
apply your changes to the entire selection. 
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View your designs

Chapter VI

In this chapter you will learn the different ways to view your designs. You will learn how to Zoom your designs,
Measure them or Move them around the design area. Also, you will learn how to change View modes in your
designs. The default view mode is 3D preview, but you can unclick 3D and you’ll see only the stitches of the
embroidery design or the outline of the Vector objects. In addition, you will learn how to add hoop and
guidelines in the design together with how to enable and disable the Grid and the Ruler of the working area. 

Zoom in

By using this tool you can enlarge the portion of your design to check on details. Select the Zoom tool from
the Tools toolbar and the cursor will become a magnifying glass. Then, click at the point from where you
want the new view port to start and drag the mouse holding the left button. The area you marked will be the
new view port. Also, you can activate the Zoom from the menu View > Zoom >In or by clicking the shortcut Z.
Either way, the cursor will turn into a magnifying glass. 

Rectangle Zoom area                          New view port
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Rectangle Zoom area New view port

Zoom out

To Zoom out your design, use your mouse wheel . If you click anywhere on the screen and rotate the

mouse wheel backwards , you will see your design zooming out (getting smaller).While zooming out
with the mouse wheel the inertia / kinetic scrolling is activated automatically. This is an Interactive smooth

scrolling (Zoom in – Zoom out) to the design that gives a more flowing feeling to the working space..

Zoom previous
Using this option you can get the previous Zoom view of your design. The new view port will be the same as it

was before the last zoom-in. You can activate Zoom previous from the Tools toolbar by click and drag on

the Zoom In tool  and selecting the Zoom Previous  option. By doing that the

Zoom Previous tool will become the current on Tools Toolbar and you can change it by following the same

procedure. Another way that you can activate the Zoom Previous option is by selecting the View > Zoom

>Previous option from the menu or by clicking the shortcut key F3. Another way to Zoom previous your

design is to  Zoom out.

Zoom all

Using this option you can view the whole design fitted into the visible screen. You can activate the zoom-all 

 function from the Tools toolbar , from the menu View > Zoom >All or by using
key F4. If you have a multi-functional keyboard, make sure that F keys are not locked. 

Actual size zoom 100%

Clicking on this button in the standard toolbar, you can view the current design in actual size. Also by clicking
on the arrow at the right of this icon, you can select one of the zoom presets. The zoom presets that you can
choose from are 25%, 50%, 75%, 100%, 125%, 150%, 200%, 250%, 300%, 400%, 500% and 600%. 
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If you set the exact size of your monitor, from the Monitor tab of the Options  dialog box under the Tools
menu, every time that you will select the 100% of the zoom presets you will view the design in its actual size.
You can also activate the 100% zoom by pressing the Shift + 1 shortcut keys. 

Hand tool (pan)

This tool lets you move a design around your screen like you would move a paper around on a desk with your
hand. You can activate the Hand tool (pan) function in Create or stitch mode from the Tools toolbar or by
pressing the H shortcut key. The cursor will change to a hand like the one on the icon and you can use it by
clicking and dragging on the screen. While dragging with the working area the inertia / kinetic scrolling is
activated automatically. This is an Interactive smooth panning of the design that gives a more flowing feeling
to the working space.

Pan tool

Another way to Pan the working area is by pressing the middle click of the mouse (or the mouse wheel). The

mouse cursor will change to a four directional arrow  that shows that you can move the working area to
all directions. To move the working area you have to move the mouse slowly to the direction you want. The
view port will move, showing you the design to the direction that you are moving the mouse. To close the
mouse pan tool, press once more on the middle mouse wheel.

Measure

The measure tool calculates the distance between any two points in the work area. You can activate the

measure tool function from the Tools toolbar icon or by pressing the F9 shortcut key. With this tool you
will be able to measure any time you need to know the size of your embroidery design, or any portion of it.

3D preview
You can enable 3D preview option from View menu or by pressing P key on your keyboard. If the 3D preview
selection is checked, the design will be visible in 3D. By enabling 3D preview, you can have a realistic 3D
preview of how the design will look like when it will be embroidered on the selected Fabric. The stitching style,
the color of stitches and the way which the design will be sewed give you the perception of a real
embroidered result. In the 3D preview the threads are much thicker than in the stitches view. The 3D
preview of the design can be enabled-disabled both in DRAW or Stitch modes.  
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Normal view 3D preview mode

If you are working in a close-up zoom, the stitches and the gaps between them may be displayed larger on
the screen, but in reality the gaps are too fine to view them. In the Preview area, the Fabric and its Color

can be changed from the Select fabric  button on the standard Toolbar or from the menu Tools > Select
fabric option. The only option that is not available in 3D mode is stitch points view.

View Outline design

You can access Outline Design from View menu. With this option enabled, you can view the outline in the
Preview when you deactivate 3D preview.

Outline preview

With the 3D preview option enabled, the outline will not be clearly visible because it will be located behind the
embroidery design. The Outline View is useful when you want to change the Vector artwork of the design.
This view also makes it easier to see all of the parts in the design and to make adjustments. 

View Stitches
When Stitches option of View menu is enabled we can see the actual stitches. If 3D preview is disabled we
can see the stitches in normal view and if 3D preview is enabled we can see stitches in realistic 3D preview.
You can access stitches option from View menu or by pressing G key from the keyboard. When the option
is enabled we can see the stitches of the whole design. Any change on the design has an impact on the way
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that the stitches will be placed. All the recalculations are automated, which means that no further action is
required on your part. You can view the stitches of the design and edit the shape of the object at the same
time.

Stitches disabled Normal view stitches 3D preview stitches

View Stitch points

You can enable Stitch points from View menu. While Stitch points is active, 3D preview will be disabled. To
activate this option you have to disable 3D preview option first. 

Thread penetration point view

Stitch points are the points where the machine’s needle bores the fabric. With this view, you can distinguish
the stitch length, density, and bore points. 

Thickness view

This option is very useful in order to create professional looking designs. Stitches that fall on top of other
stitches don’t create nice embroidery. We may intentionally want to let this happen in order to create a
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special effect. But in the majority of cases we want to know if more than one layer of stitches fall, one on top
of the other, in order to prevent this. 

You can enable this option by using the respective option of View menu. When this option is enabled 3D
preview is disabled. In order to return to the previous view of the design you must disable this option. 

In Thickness view we can see the design items painted in various colors according to the embroidery that is
placed on top of it. When only a layer of embroidery falls on a part, we can see this part with green color, 2
layers of embroidery-yellow color, 3 layers of embroidery-orange color and too many layers of embroidery-red
color. This way we can easily find and correct all the areas that have too much overlapping stitches.

Overlapping objects                            Thickness View

Overlapping Crystals
This option is very useful when you are creating designs with crystals. You can enable this option from View
menu by selecting Overlapping crystals or by pressing the O shortcut key. By enabling this view all crystals
that overlapping will be marked with an 'X' in order to be easily recognizable.

If the overlapping between the crystals is limited on the outline of the crystals the 'X' will be yellow. 

Crystals outline overlapping

If the overlapping between the crystals is on the actual crystals the 'X' will be red. 
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Actual crystals overlapping

Every time you finish a design with crystals it is a good practice to enable the Overlapping crystals option in
order to check if there is any overlapping in your crystals that you have not noticed and needs to be fixed.

Notice: It is  advisable not to leave the Overlapping Crystals always on because it might
slow down your PC. 

Set light source
You can activate Set light source from View menu. The Adjust light dialog will appear from where you can
change the light source of the embroidery’s 3D preview. The option of Set light source becomes available
only if you are working in 3D preview mode (View->Preview 3D). It is a 3D tool that gives you the ability to
illuminate your design from different angles.

Light source globe

If you activate the Set light source, the Adjust light dialog will appear with a 3D ball in it. The light source
changes by moving the crossed lines to the position you want the light to come from or by click and dragging
on the ball to the position you want the light to be. The yellow crossed lines show where the new light source
will be and the blue their initial position. 

Another option that you can adjust in the dialog is the Intensity of the light that illuminates the threads. By
click and dragging the Intensity bar to the left the light decreases and to the right the light increases. Select
the amount of light you want to illuminate your embroidery designs and click OK button to apply the changes
you have made to the dialog. 

The best way to make the adjustment accurately is by having an embroidery design loaded prior activating
the Set light source option. Any change you are making inside the Adjust light dialog it is immediately
previewed on the design allowing you to make accurate adjustments.

We can also use Save as default option in order to save current light source as the default for every design.
Once a default value is selected and saved as default it will be used for every new design. You can also use
Reset to default in order to reset the light source to the default value.
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View Ruler

You can enable/disable Ruler from View menu. Check the Ruler selection in order for the Ruler to become
visible around the working area. 

Ruler

The Ruler appears at the left and top sides of the working area. It is transparent and becomes solid only if
you place the mouse on it. The ruler shows the values of virtual X and Y axes based on centimeter or on inch
values. The 0 on X axis and the 0 on Y axis in the starting point of the axes. The values on the ruler are
changing based on the zoom you are using to view the design. 

The ruler can help you draw, size and align the objects precisely and create the design you want. In case you
select "US" measurement system, from Tool¸Options¸General tab the ruler will show information in
US(inches) and not Metric.

View Grid

You can enable-disable Grid from View menu. Check the Grid selection and it’ll appear in the working area.
The Grid appears as small symmetrical dots across the working area in vertical and horizontal lines. If you
have the Ruler option enabled from the View menu, the horizontal lines will be aligned on the ruler values
allowing you to draw, size, and align the objects precisely. 

Grid

The values of the Grid changes with the values of the Ruler and both change with Zoom in or Zoom out.
Therefore, it is better to have the Ruler option enabled while working with the Grid. Also, it is good practice to
use Zoom presets (100%, 200%, etc.) while designing based on a Grid to create precise adjustments.

View Hoop
In many cases it is very useful to preview a created design on a machine hoop. You can enable - disable the
view of the hoop using Hoop option of View menu. When enabled you can view the design on the specified
hoop. If Hoop option is disabled on View menu, then this means that no hoop has been selected for the
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design. You can easily select a Hoop for the design using Change Hoop dialog. This dialog can be

accessed in 3 ways, by pressing Change Hoop  icon on Standard toolbar, using Change hoop option
of Tools menu and by using Ctrl+H keyboard combination. 

The Hoop in Creative DRAWings is very useful because it will make sure that the design which you are
creating will fit on your embroidery machine hoop. There is a variety of hoops from which you can select and
you can even add your own. More information about how to work with hoops in Change hoop section.

View Cutting mat

This option is available in all techniques except the Embroidery technique. 

You can enable-disable the Cutting mat option from View menu. The Cutting mat appears as one inch grid
behind the design you have created. 

cutting mat

It simulates the cutting mat that you will use in your cutter and allows you to accurately position the design
you want to send to the cutter on the cutting mat. 

You can change the size of the cutting mat by clicking on the Cutting mat  icon from the standard toolbar.
The following dialog will appear:
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Select cutting mat dialog

From the Cutting mat dialog you can select any preset cutting mat from the available ones, or set the
dimensions of your cutting mat at the respective fields. You can set the Width and Height of your cutting mat
in inches. Each square of the cutting mat, has 1 inch height and 1 inch width. Therefore it is very easy to
measure your cutting mat and set its dimensions in the dialog. Click OK to apply the changes or Cancel to
cancel them.

View active designs (Windows)
Windows tool, is a supportive tool, located under Window menu, where you can view all the designs that are
currently loaded. Some extra window handling and file saving functionality is also provided. By selecting
Windows option of Window menu you activate the dialog that is shown in the following figure.

  

Windows dialog

In section Select window you can select any window that you like to be active. Highlight workspace.draw
and then you have a number of choices provided. Make this design active by pressing activate. The dialog
closes and the selected design is the active design in the design area. 

You can also save loaded designs. Select any design from select window list, then press Save button. If the
selected design has been previously saved, it will be saved into the same location, otherwise it will prompt
you for a location to save. 



219View your designs

© 2017 DRAWstitch Ltd.

Finally you can select to close designs. Select a design and by pressing Close you close the selected
design. If the design hasn’t been saved previously you will be prompted to Save or Discard the design. 

In any of the above operation you can select more than one designs by pressing Ctrl and then by clicking one
by one the designs that you want to select. 

Slow redraw (Shift+F11)

This tool is  available only if Embroidery technique  is  enabled.

A very valuable step before turning on your embroidery machine in order to embroider for first time, any of
your designs is a simulation like process. Slow redraw provides an automated way to simulate the
embroidery process. Move through objects stitches and preview the placement of every stitch. It’s a good
chance to correct any detail on your design. You can enter slow redraw mode by using Shift+F11 keyboard

shortcut or by pressing slow redraw icon  on tools toolbar. While using Stitch mode, you can also use
the arrow keys on your keyboard in order to navigate through objects-stitches. The Right and Left arrow
keys are simulating the design stitch by stitch and the Up and Down keys object by object. 

Slow redraw dialog

In order to start Slow redraw, press its icon  on Tools toolbar. The following dialog appears on top of the
design area. 

Slow redraw dialog consists of 5 parts

· Title bar, provides window handles

· Simulation speed track bar, adjust simulation speed

· Start-Stop simulation

· Move through objects or stitches - paint lines

· Simulation view options

We will describe each part and its description on the following sections.

Title bar

On the top of the dialog you can see its title bar. 
The title bar contains some controls to help manage the position and the size of the dialog. Click and drag
on the title bar in order to move the dialog in any place you like.



Creative DRAWings® 7.1 manual220

© 2017 DRAWstitch Ltd.

Help , click on this icon the cursor turns into a question mark. Click on any of the components of the dialog
and the available help about the control will appear. 

Minimize , Press this icon to minimize the dialog. It stays at the same place but in minimized state. Press
it again in order to view the dialog in full mode.

Close , Press on this icon to close the current dialog.

Simulation speed

On this part you can see and adjust the simulation speed. Click and drag this track bar to select the speed of
the simulation.

The machine speed that you select on the track bar shown in
numeric format.

Simulation speed track bar, Select the speed of the simulation. It
looks like you are selecting your embroidery machines speed.
Simulation speed can between 100 and  9900 RPM

Start-Stop simulation 

Start the simulation, if simulation has been stopped you can resume from
where you have stopped.

Stop the simulation.

Move through objects-stitches 

In this part you can move through object-stitches using the navigation buttons      .
These buttons help you to select the object or the stitch that you want. 

Design start, go to the first stitch of the design.

Previous object, go to the first stitch of the design.

Previous stitch, move to previous stitch.

Next stitch, go to next stitch 

Next object, move to the first stitch of the next object 

Design end, go to last stitch of design 

Simulation view options 

At the bottom part of the dialog you can select the view mode of slow redraw

Preview simulation with the frame moving, as it is in real embroidery
process.
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Preview simulation with the head of the embroidery machine moving.

Using Slow redraw

Press Start button to begin the visual simulation. In case that no object-stitch is selected, the simulation will
start from the start of the design. You can stop the simulation by pressing Stop button or press Esc key on
your keyboard. After stopping the simulation, you can always start over and continue from the stitch you left
the simulation. 

Use the track-bar on the upper part of the dialog to adjust simulation speed. While using the track-bar you
can see the selected speed above the track bar.  

You can always use move through object-stitches buttons together with slow redraw tool in order to
navigate through object/stitches. 

Finally with the button at the bottom the dialog you can switch between Move head or Move frame mode.
By default the dialog starts in Move head mode. When move head is pressed you can see the head of the
embroidery machine moving along the design simulating the embroidery process. In case you select Move
frame, the head stays at the same place and the design (Frame/hoop) moves in such a way in order to pass
under the head to be embroidered.  

Add Guidelines
When you are creating a design sometimes it is very useful to add a guideline to help in aligning the objects.
The three types of guidelines are Vertical, Horizontal, or Diagonal. In case that guidelines are not visible make
sure that Guidelines option of View menu is enabled. Most of guideline options can be accessed through
guidelines menu, right click on any point of the ruler and the menu of the following figure will appear. Using
this menu you can easily add any type of guideline. We can also access Guideline editor dialog that helps
manage the guidelines of the design. Finally through Guideline options you customize some options of
guidelines appearance and state.

Guidelines menu

Horizontal Guidelines

To add a Horizontal Guideline, left click on the Horizontal ruler and drag a dotted line down to the position
you want in your working area. You can also get a Horizontal line with a right click on the Vertical Ruler>
Add new guide> Horizontal Guideline.  If you right click on the Vertical part of the ruler then Horizontal
Guideline will be inserted exactly in the position you right clicked on the Ruler. You can reposition your
inserted Horizontal Guideline by clicking and dragging it to where you want it, or you can delete it by
dragging  back behind the Ruler.

Add Horizontal Guideline
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Vertical Guidelines

You can add a Vertical Guideline, simply by left clicking on the Vertical Ruler and drag a dotted line over to
the position you want. You can also get Vertical Guideline by right clicking on Ruler> Add new guide>
Vertical. If you have click on the horizontal part of the ruler the guideline will be inserted exactly in the position
where you right clicked on the Ruler. If you click on the vertical part it is placed under the vertical ruler. You
can reposition the inserted Vertical Guideline by clicking and dragging it to the position you want, or you can
delete it by dragging it on top of the Vertical Ruler until you see a delete icon.

Add Vertical Guideline

Diagonal Guidelines

To add a Diagonal Guideline, right click on the Ruler and when the pop-up Add new Guide appears,
select Diagonal option. The Diagonal Guideline will be inserted exactly in the position where you right
clicked on the Ruler. You can reposition the inserter Diagonal guideline by clicking and dragging it from the
middle to the position you want. If you position the mouse over the diagonal guideline far from its center, the
cursor will change to rotation icon allowing you to rotate the diagonal guideline by clicking and dragging it. The
guideline will rotate by displaying the current angle next to the cursor. 

Move diagonal guideline Rotate diagonal guideline

If you hold the Crtl key pressed while rotating the guideline, it will snap on every 22.5o to make precise
rotation of the guideline.

Guideline options

Guidelines have some options which are useful in creating and editing embroidery designs. You can adjust
the Guideline options before or after adding lines on the working area. Right click on the Ruler and from
Guideline options dialog enable - disable the available options (Guidelines visible, Snap enabled, Lock
guidelines). 
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Guideline options dialog

From the Guideline options dialog, you can set the following options:

Guidelines visible: With this option, you can choose to have the guidelines visible or not. To make the
guidelines visible, click View> Guidelines visible. To confirm the changes, press the OK button and the
changes will be applied immediately. 

Snap enabled: With this option, the objects of a design will align automatically to a guideline. To make your
objects snap to the guidelines, check the Snap enabled option. By default the Snap enabled option is
disabled. To confirm the changes you made press the OK button and the changes will be applied
immediately.

Lock guidelines: With the Lock guidelines option, you can lock the guidelines. The accidental movements
of guidelines will be avoided. If you keep the Lock guidelines option unchecked, you will be able to move or
add guidelines on the working area. To confirm the changes you made press the OK button and the changes
will be applied immediately.

Hoop guidelines are permanently locked and cannot be unlocked. 

We can change the color of the guidelines using Colors-Sizes tab of Tools -> Options dialog. 

Guideline editor

Using guideline editor we can edit used guidelines of any design. 

Inside guidelines editor you will find advanced options for making precise changed to the guidelines you have
already added in the design you are working on. If you have no guidelines inserted the dialog will be empty. If
you have inserted guidelines in your design the editor gives you the ability to edit the following:

· Edit the position of the guideline’s using numeric values

· Specify the Y and X axis distance for Horizontal and Vertical guidelines.

· Specify the Angle for diagonal guidelines.

· Lock and-or hide guidelines 
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In this dialog we can edit the guidelines that

have been added to the design.

Select any of the guideline and only then the

available parameters of the specific guideline

are enabled.

We can edit the parameters of the selected

guideline. 

· Locked: If this option is checked then you will not be able to change the position of the guideline in the
working area. This is very helpful when you want to avoid accidental movements of guidelines while you are
creating your design. 

· Hidden: If this option is checked, then this guideline will not be visible in the working area. this is very useful
when you have finished your design and you want to hide the guidelines and view the design without the
distraction of guidelines. 

· X: This option is available only on Vertical and Diagonal guidelines. With this option you can specify the
distance of the guideline from the X axis. The values that you can insert in the respective field can be
negative or positive.

· Y:  This option is available only on horizontal and Diagonal guidelines. With this option you can specify the
distance of the guideline from the Y axis. The values that you can insert in the respective field can be
negative or positive.

· Angle: This option is available only on Diagonal guidelines. With this option you can specify the angle of the
guideline from the X axis. The values that you can insert in the respective field can be negative or positive. 

· Delete: With the delete option you can delete the selected guideline. 

Working with guidelines

All inserted guidelines inside the software have snapping and aligning abilities that can be found very useful

when you are designing inside Creative DRAWings. All objects can snap on Horizontal and Vertical

guidelines that you have placed on the working area while moving the objects towards them. This is very

useful when you want to align the objects of the design to specific position and makes you life easier while
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designing. Also, it is possible to do the opposite and move the Horizontal and Vertical guidelines towards

the objects and be able to snap on its edges/sides. Finally, the guidelines have snapping abilities based on

the Grid of the working are that allows you to position them exactly where you want them. 

The snapping and aligning abilities of the Guidelines are the following:

If you click and drag any Horizontal/ Vertical and Diagonal guidelines towards a selected object, they will

snap on every control handle that the object has on its selection rectangle.

 
Guidelines Snap on Handles

If you hold the Alt key from the keyboard pressed while dragging Horizontal and Vertical guidelines, they will

snap on every step of the Grid(if the Grid is enabled from View>Grid menu option). 

 
Guidelines will snap on every step of the Grid

If you hold the Ctrl key from the keyboard pressed while dragging Horizontal and Vertical guidelines, they

will snap on every one millimeter movement.

 
Guidelines snap on every one millimeter movement

Also, if you hold the Ctrl key from the keyboard pressed while rotating Diagonal guidelines, they will snap on

every 22.5o degrees.
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Diagonal Guidelines snap on every 22.5o

Finally If you hold the Shift key from the keyboard pressed while dragging Horizontal and Vertical

guidelines, all snapping abilities will be canceled. The guidelines will not snap at all and you will be able to

move them freely.

All this snapping and aligning abilities can help you create perfect designs.
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Designing tools

Chapter VII

In this chapter we will learn about the Designing tools of Creative DRAWings® and how to use them to

create Vector designs which can be converted into stitches. The designing tools can be found only inside

Create mode of Creative DRAWings®. The available Designing tools are the Freehand tool, the Bezier

tool, the Outline shape tool (digitizing tool), the Create shapes tool, the Text tool and the Insert symbol -

Insert Clipart tools. By combining these powerful designing tools you can create outstanding designs.

Tools toolbar

 Drawing tools

 Insert shapes

Designing tools’ options

Add new objects as clones

Array 

Autoborder

Working with text

Monograming

Insert symbol

Clipart Library

Tools toolbar
The most important designing elements in Creative DRAWings® are in the Tools toolbar at the left side of
your screen. You can change the toolbar’s location by clicking and dragging it to a location you prefer.

All the designing tools of Creative DRAWings® are found in these Tool icons. Several tools have fly-outs

which are activated by click and Hold on the little black arrows on lower right corner of the icons. The tool

which you click on will become active and will replace the previous option in the Tools toolbar. Five of the

tools have extra icons on the fly-outs of the Tools toolbar.
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Tools toolbar

The Tools toolbar changes according which design mode you are currently viewing. The Tools toolbar in the

Create mode include all tools that are available in the Stitch mode and some designing tools (only inside

Create to stitch mode combination). Some tools appear only if the Stitches (option Stitches form View

menu is enabled) are visible on the design.  

The available tool categories that exist on Tools toolbar are the following:

v Selection tools

v Shape editing tool 

v Zoom tools

v Stitch editing tools

v Measure tool

v Designing tools

v Shape insertion

v Text insertion

v Array tool 

v Auto border

In this section we will analyze only the designing tools that are available in the Tools toolbar such as 

Designing and Shape insertion tools.  

Drawing tools

On Tools toolbar there are three available designing tools. These are Create Freehand shapes, Create

Bezier shapes and Create Outline shapes. Only one of the 3 tools can be active on the toolbar each time.

Click and hold on the current tool icon  in order to view all items. While holding left
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key pressed, you can move the cursor on top of the tool that you want to select. Release the mouse and it is

selected. The tool is now active; use it to design any shape you like. The selected tool has become the

current one and you can use it to create the shape you want.

· Create Freehand shapes

· Create Bezier shapes

· Create Outline shapes

· Magic Wand shapes

By using the available designing tools you can draw the embroidery designs you want, based on a backdrop
bitmap or on your designing abilities.

Create Freehand shapes

With the Freehand tool  you can design simple lines or complete shapes. In order to create simple

lines, select the freehand tool  or press the F5 key. Now that the tool is active, click once on the working

area. This is the starting point of the line. Click once more to define the end of the line. By following the same

steps you can add more lines and create the design you want. 

If you want you can continue the straight line you have created by inserting another straight line that will start

from the start/end of the existing line. To do that you have to position the cursor over the ending/starting point

of the existing line and see the cursor image changing. This change of the cursor informs you that you can

continue designing a line from that point. Click to set the starting point of the line to be the same with the

starting/ending point of the current line and then click on the position you want the line to end. By following the

same steps you can continue entering straight lines at the end of the same shape and if you want make it a

closed shape by connecting the last node with the first node. 

Connected lines - Freehand curve - Straight line - Closed shape

Using the Freehand tool you can also make freehand designs like those you are drawing on a piece of

paper. To do that you have to click and drag with the mouse on the working area until you have created the

shape you want. You can create a closed shape by click and dragging with the freehand tool and end at the

same point you have started. A closed shape will be created with fill and outline color. If the design you have

created does not have a fill color this means that it is an open shape (line art design) or its fill color property in

Thread palette toolbar is set to none. 

When you have finished one object you can continue creating the second one and so forth, but all of them will

be part of the same object (all object will be joined/combined). This means that every shape you are creating

without ending the designing process (by right clicking once) of the object will be member of the same object

even if those objects are totally different. If you do not want them to be joined/combined you can select the
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objects with any selection tool and from the right click menu select Break apart option that will separate the

designed objects.

If you want to create objects as different entities you have to create the first object with the Freehand tool and

then right click once to end the creation of the first object. The created object will be highlighted and you will

be able to continue by designing the second object. Important to remember is that whenever you want to end

the creation of an object you have to right click once. To completely end the designing process with the 

Freehand tool you have to select any selection tool from the Tools toolbar. In same way as with lines you

can continue with another part on previous item by placing the mouse over the start-end point of the previous

one. The cursor changes somehow to reveal that you can continue the shape. 

The way that the Freehand tool works it is helpful to create holes inside the shapes you are creating. For

example if you want to create a wheel shape you have to draw the outer circle and then draw the inner

smaller circle.

   Closed shape              Design hole             freehand hole created

When the designing of the inner circle is finished, a hole will be created inside the bigger circle. This

functionality is very helpful when you are drawing shapes over a bitmap backdrop. 

While using Freehand tool to create a freehand shape you can hold the Shift key down to make the curves

you are drawing smoother. This ability helps to make the design easier.

If you hold the Ctrl key pressed while drawing with Freehand tool, guidelines will appear on every 22.5

degrees of the X and Y axes. When you press the Ctrl key the object automatically moves/snaps on the

closest guideline. While drawing, the object it will snap on the guidelines, allowing you to draw the curve

object along the guidelines. The guidelines that appear have as center the point from where the freehand

curve you are drawing starts.

If you hold the Alt key pressed while drawing with Freehand tool, vertical and horizontal guidelines will appear

on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. While drawing the curve

object it will snap on the guidelines, allowing you to draw straight lines along the guidelines. When you press

the Alt key the object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler.

From that point you can draw a line to the position you want based on the ruler. The Alt key will work even if

the ruler is disabled.  

Also, when you select the Freehand tool, the smoothness level option appears on Tools options bar.

With this tool you can set the smoothness level of the freehand artwork that you will create. The scale of

smoothness level option is from 0 to 10 and can be adjusted by entering the value you want on the respective
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field or by using the increase/decrease arrows next to the field. If you set the smoothness level value to 0 the

freehand curves that you will draw will have a lot of nodes and its curvature will not be so smooth. 

Freehand – Smoothness Level

On the other hand if you set the smoothness level value to 10 the freehand curves that you will draw will have

the minimum nodes needed and its curvature will be smooth. Middle range values have average smoothing

effect on the drawn curves. The Smoothness level options must be set before the creation of the curve you

want to use.

Finally, while drawing a shape and you make a mistake, you can press the Backspace button from the
keyboard and delete the last inserted section until the previous node. If you want you can delete more of the
design by pressing the Backspace button again. You can continue drawing the shape from that point and
finish the shape you want to create.

Create Bezier shapes

With the Bezier designing tool  you can create shapes where you can handle better the curvature of each

segment easier by adjusting the control handles of each inserted node. 

To draw a curve you have to select the Bezier tool from tools toolbar or by pressing the Shift + F5 shortcut

keys from the keyboard, define the first node by clicking on the working area once, move the mouse to the

position you want the second node to be placed and by click and dragging at that position you can define the

second node and adjust the curvature of the segment by moving the control handles of the node. Release the

mouse button to confirm the segment you have added and continue with the next one by following the same

procedure. 

Bezier tool
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If you want to add a straight line you have to define the first node or continue from an existing one and then

the second node by clicking once more to the position you want. A straight line will be inserted connecting the

two nodes. You can continue the shape by either inserting straight lines or curves.

You can create a closed shape by connecting the last node with the first node you have inserted. 

While creating a shape you can end the design by right clicking once and continue with the next shape that

will belong to the same object. This means that the first shape you have created together with the second

shape that you will create will belong to the same object. This ability is very useful when you want to create

embroidery designs, because it is really easy to create holes in any shape that will not be filled with stitches.

For example if you want to create a wheel shape you have to draw the outer circle and then draw the inner

smaller circle. When the designing of the inner circle is finished, a hole will be created inside the bigger circle.

This effect is very useful also when you want to create a design based on bitmap backdrop. 

If you have created such an object and you want to separate it to its sub-shapes you have to select it with any

selection tool and from the right click menu select Break apart option. The complex object will be separated

to its sub-objects and you will be able to edit them separately.

In addition, if you want each closed shape or line art shape you are creating to be a separate object you have

to right click once to end the designing process of the closed shapes and twice for the line art shapes. After

ending the first shape you can continue with inserting the second that will be a separate object. You can

continue the same process and add more objects that will shape your design.

While inserting nodes with Bezier tool and you think you made a mistake you can delete as many nodes as

you think you need to by pressing the Backspace form the Keyboard. Each time the Backspace is pressed

the last node that was inserted is deleted. You can continue designing the object from the node you want. 

Another useful ability that Bezier tool has is that you can move the position of the last inserted node during

designing.  To do that you have to hold the Shift key down after inserting the last node and while you are

moving the control handles of the node, you can move the node to the position you prefer. By releasing the

shift key you will be able to adjust the control handles of the node once more from its new position. All the

adjustments must be made by keeping the left mouse click continually pressed.

If you hold the Ctrl key pressed while drawing with Bezier tool, guidelines will appear on every 22.5 degrees

of the X and Y axes. When you press the Ctrl key the object automatically moves/snaps on the closest

guideline. While drawing, the object it will snap on the guidelines, allowing you to draw the curve object along

the guidelines. The guidelines that appear have as center the point from where the Bezier curve you are

drawing starts.

If you hold the Alt key pressed while drawing with Bezier tool, vertical and horizontal guidelines will appear on

X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. While drawing the curve

object it will snap on the guidelines, allowing you to draw straight lines along the guidelines. When you press

the Alt key the object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler.

From that point you can draw a line to the position you want based on the ruler. The Alt key will work even if

the ruler is disabled.
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Finally, with the Bezier tool you can continue the line art you are creating from the first or last node. You can

do that when you have created a line art/curve shape and you have right clicked once to end the creation of

the shape (If you right click twice you end the designing process of the object, and you cannot continue the

line art shape). To do that you have to position the cursor over the ending/starting point of the existing curve

and see the cursor image changing. 

First part - Second Part – Closing shape - Filled with color - Fill stitches 

This change of the cursor informs you that you can continue designing a curve from that point. Click to set

the starting point of the curve to be the same with the starting/ending point of the current line/curve and then

click on the position you want the line/curve to end. By following the same steps you can continue entering

lines/curves at the end of the same line art shape and if you want make it a closed shape by connecting the

last node with the first node. 

Create Outline shapes

The create Outline tool  (Digitizing tool) is based on the Bezier tool with the difference that the lines that

you are creating are by default curve based. With the outline tool you can draw lines and curves by specifying

their nodes and altering the curvature of their segments by adjusting their control handles.

Outline tool

To draw a curve you have to select the Outline tool   from the Tools toolbar or by pressing the Ctrl + F5

shortcut keys, define the first node by clicking on the working area once, move the mouse to the position you

want the second node to be placed and by click and dragging at that position you can define the second node

and adjust the curvature of the segment by moving the control handles of the node. Release the mouse

button to confirm the segment you have added and continue with the next one by following the same

procedure. 

If you want to add a straight line you have to define the first node or continue from an existing one and then

by holding the Shift key down, the second node by clicking once more to the position you want. A straight line

will be inserted connecting the two nodes. You can continue the shape by either inserting straight lines or

curves.
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To draw straight lines hold Shift key pressed

You can create a closed shape by connecting the last node with the first node you have inserted. 

While creating a shape you can end the design by right clicking once and continue with the next shape that

will belong to the same object. This means that the first shape you have created together with the second

shape that you will create will belong to the same object. This ability is very useful when you want to create

embroidery designs, because it is really easy to create holes in any shape that will not be filled with stitches. 

Closed shape - Design hole     -    Close hole shape  -        Hole created

For example if you want to create a wheel shape you have to draw the outer circle and then draw the inner

smaller circle. When the designing of the inner circle is finished, a hole will be created inside the bigger circle.

This effect is very useful also when you want to create a design based on bitmap backdrop. 

If you have created such an object and you want to separate it to its sub-shapes you have to select it with any

selection tool and from the right click menu select Break apart option. The complex object will be separated

to its sub-objects and you will be able to edit them separately.

In addition, if you want each closed shape or line art shape you are creating to be a separate object you have

to right click once to end the designing process of the closed shapes and twice for the line art shapes. After

ending the first shape you can continue with inserting the second that will be a separate object. You can

continue the same process and add more objects that will shape your design.

While inserting nodes with Outline tool and you think you made a mistake you can delete as many nodes as

you think you need to by pressing the Backspace form the Keyboard. Each time the Backspace is pressed

the last node that was inserted is deleted. You can continue designing the object from the node you want. 

Another useful ability that Outline tool has is that you can move the position of the last inserted node during

designing.  To do that you have to hold the Shift key down after inserting the last node (If you press the Shift

key before inserting the last node it will insert a Cusp node and draw a straight line) and while you are moving

the control handles of the node, you can move the node to the position you prefer. By releasing the shift key

you will be able to adjust the control handles of the node once more from its new position. All the adjustments

must be made by keeping the left mouse click continually pressed.
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If you hold the Ctrl key pressed while drawing with Outline tool, guidelines will appear on every 22.5 degrees

of the X and Y axes. When you press the Ctrl key the object automatically moves/snaps on the closest

guideline. While drawing, the object it will snap on the guidelines, allowing you to draw the curve object along

the guidelines. The guidelines that appear have as center the point from where the Outline curve you are

drawing starts.

If you hold the Alt key pressed while drawing with Outline tool, vertical and horizontal guidelines will appear

on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. While drawing the curve

object it will snap on the guidelines, allowing you to draw straight lines along the guidelines. When you press

the Alt key the object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler.

From that point you can draw a line to the position you want based on the ruler. The Alt key will work even if

the ruler is disabled.

Finally, with the Outline tool you can continue the line art you are creating from the first or last node. You can

do that when you have created a line art shape and you have right clicked once to end the creation of the

shape (If you right click twice you can end the designing process of the object, and you cannot continue the

line art shape). To do that you have to position the cursor over the ending/starting point of the existing curve

and see the cursor image changing. This change of the cursor informs you that you can continue designing a

line from that point. Click to set the starting point of the line to be the same with the starting/ending point of the

current line/curve and then click on the position you want the line/curve to end. By following the same steps

you can continue entering lines/curves at the end of the same line art shape and if you want make it a closed

shape by connecting the last node with the first node.

By using the available designing tools you can draw the embroidery designs you want, based on a backdrop

bitmap or on your designing abilities. 

Magic Wand shapes

The Magic Wand tool creates any shape that consists of the intersection of two or more other shapes. It is a
very useful tool that can help you create strange shapes easily. 

In order to use this tool you have to have already created some designs that are overlapping. Then you
activate the Magic Wand tool by selecting it from the Tools toolbar, position it over the area where the
objects are intersecting/overlapping and click on it to create it. The tool will create an object identical with the
intersection area of the overlapping objects that you can move elsewhere by click an dragging it. If you want
you can continue creating shapes by clicking on the area you want to be converted to an object. All the object
that you are creating remain selected in order to be easier from you to move them, change their stitch type or
make any other modification. To stop using the Magic Wand tool you have to simply right click with the
mouse and the software will switch to the Selection rectangle mode. 
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Select the Magic wand tool -> Click on the area you want to produce -> Drag the created object out

Another functionality of this tool is that you can fill holes of a design with the shapes that these holes are
forming. The only thing you have to do is to select the Magic Wand tool and click in  the hole. The software
will automatically create a new object that fills the hole.

Select the Magic wand tool -> Click in the holes -> Create new objects that will fill the holes

Insert Crystals

With the Insert crystal shapes  designing tool you can insert crystals anywhere in the design by simply
selecting the tool and and left clicking once in the position you want each crystal to be added. If you want to
end the insertion of crystals you have to right click once or to select a different tool from the Tools toolbar
like the Rectangle selection tool.

When you select the Insert crystal shapes designing tool, relevant options appear on the Tools options
toolbar. These options allow you to select the Palette of the crystals you want to add crystals from, specify
the Color/Shape you want to use and the Size of the crystal you want to add.

Crystal options
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Make the adjustment you want on the Tool options toolbar and you can start inserting single crystals on the
design by simply clicking on the position you want to add them. You can change the Palette, the
Color/Shape and the Size after the crystal insertion from the Object Properties toolbar. Select the crystal
you want and you will be able change its properties from the Object Properties toolbar. Also, you can make
multiple selection of crystals and make changes to all of them at the same time. 

Insert shapes
From the tools toolbar you can select and insert shapes that will help you create embroidery designs easier.
The available shape tools are Create Ellipses, Create rectangles, Create Pies, Create Stars, Create
Polygons and Create Trapezoids/Parallelograms. 

Shapes fly out

From the available tools only one can be active on the Tools toolbar each time. To view all the available

shape tools click on the current shape tool and hold while moving the mouse over all available shape tools.

The selected designing tool will become the current one and you can use it to insert the specific shape on the

working area. 

Create Ellipses

The Create Ellipse tool  allows you to design ellipses that will be filled with stitches. You can create any

ellipse shape but also circles and complex shapes by combining elliptic shapes. To create an ellipse shape

you have to select the Ellipse tool  from the Tools toolbar or by pressing the F7 shortcut key from the

keyboard and by click and dragging diagonally on the working space, draw the ellipse shape you want. By

releasing the mouse click the shape will be placed on the position you have designed it. 

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 degrees of the X

and Y axes, with center the point you click and dragged to draw the circle. By click and dragging diagonally

you can draw a Circle. Also, by click and dragging with the mouse based on the guidelines you can draw

perfect oblong ellipses. While drawing the object, it will snap on the guidelines, allowing you to draw the

shape along the guidelines. 

Hold Ctrl key and guidelines will appear on every 22.5 degrees

By holding the Alt key pressed while drawing an ellipse, vertical and horizontal guidelines will appear on X and
Y axes that will snap on the lineation of the Ruler when the Grid is enabled. When you press the Alt key the
object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that point
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you can draw the object to the position you want based on the ruler. The Alt key will work even if the ruler is
disabled.  

Hold Alt key - Horizontal and Vertical guidelines appear

By holding the Shift key pressed while drawing an ellipse the center of the ellipse will change and become

the point from where you started drawing the ellipse. 

You can also use combination of keys that will have combined effect. For example, by holding both Ctrl and

Shift key pressed while drawing an ellipse, the center of the shape will be the point from where you started

drawing the shape (as well as the center of the guidelines) and the shape will be a Circle. This is helpful

when you know the center of the design and you want to add a Circle that will have as center specific point. 

There are some more editing abilities that ellipse tool has and they are available in Node editing mode .

You can change an ellipse shape you have created by selecting it and then selecting the Edit shape nodes

option  from the Tools toolbar, to change to node editing mode. On the outline of the selected ellipse will

appear two handles, one positioned on the middle of the ellipse and the second one on the top right border of

the shape.

Hold Alt key - Horizontal and Vertical guidelines appear

By click and dragging the handle of the top right part of the ellipse you can change the size of the ellipse

shape freely to all dimensions or based on guidelines by using the Ctrl, Alt or Shift keys (Ctrl, Alt or Shift

keys has the same functionally that we described previously in this section). Also, by click and dragging the

handle from the center of the shape you can change the position of the ellipse freely or based on guideline by

using the Ctrl and Alt keys. 

Notice: If you have converted the ellipse shape to curves by selecting the respective option of the right click

menu, the Vertical and Horizontal handles will not be available in Node editing mode.  
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Create Pies

The Create Pie tool  allows you to design ellipses and pie shapes that will be filled with stitches. You can

create any ellipse/circle shapes, pie shapes and complex shapes by combining them. To create an ellipse

you have to select the Pie tool from the Tools toolbar or by pressing the Shift+F7 shortcut keys from the

keyboard and by click and dragging diagonally on the working space, draw the Pie shape you want. By

releasing the mouse click the shape will be placed on the position you have designed it. 

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 degrees of the X

and Y axes, with center the point you click and dragged to draw the Pie. By click and dragging diagonally you

can draw a Circle based Pie. Also, by click and dragging with the mouse based on the guidelines you can

draw perfect oblong pie shapes. While drawing the object, it will snap on the guidelines, allowing you to draw

the shape along the guidelines. 

Hold Ctrl key and guidelines will appear on every 22.5 degrees

By holding the Alt key pressed while drawing a pie, vertical and horizontal guidelines will appear on X and Y
axes that will snap on the lineation of the Ruler when the Grid is enabled. When you press the Alt key the
object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that point
you can draw the object to the position you want based on the ruler. The Alt key will work even if the ruler is
disabled.  

Hold Alt key - Horizontal and Vertical guidelines appear

You can also use combination of keys that will have combined effect. For example, by holding the Shift key

pressed while drawing a pie the center of the ellipse will change and become the point from where you

started drawing the ellipse. 
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By holding both Ctrl and Shift key pressed while drawing a pie, the center of the shape will be the point from

where you started drawing the shape and the shape will be a Circle based pie. This is helpful when you know

the center of the design and you want to add a Pie shape that will have as center a specific point. 

You can change the shape of a pie object you have created by selecting it and then selecting the Edit shape

nodes option  from the Tools toolbar, to change to node editing mode. On the outline of the selected pie,

four handles will appear, one positioned at the center of the design, one on the Vertical axis, one on the

Horizontal axis and the other on the top right corner of the object. 

Three Pie Handles

By click and dragging the handle of the Vertical or Horizontal axes you can change the shape of the Pie. By

dragging the handles to the right or to the left you can increase or decrease the opening of the Pie. You can

use any of the two handles to do that. If you hold the Ctrl key while dragging a handle, the mouse will snap on

every 22.5o degrees allowing you to make precise changes on the Pie shape.  

           

Drag to left to close Pie shape  -  Drag to right to open shape

By click and dragging the handle of the corner you can change the size of the Pie shape freely or based on

guidelines by using the Ctrl or Alt keys (Ctrl, Alt keys has the same functionally that we described previously

in this section). If you hold the Shift Key pressed during the resizing process the Pie will be resized

proportionally and become a Circle or Pie based on a circle. 

By changing the position of those three handles you can make precise changes on the size and shape of the

pie you have created.
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By click and dragging the handle that is located at the center of the design you can move the object to the

position you want. 

You can also define the starting and ending position of the Pie’s angle by specifying them on the Tool

options toolbar. If you select the Ellipse/Pie object in Node editing mode or in object editing mode, two

options will appear on the Tool options toolbar related with the Pie object. Those options are the Start angle

and the Stop angle.

With the Start angle you can define the starting position of the angle that the Pie is

making based on virtual X and Y axes. The value of the Start angle is in degrees; therefore, if the Start angle

value is 90 the starting position of the angle will be the top point of the pie, which is also the initial position of

the Vertical handle (the same with 90o degrees on X and Y axes). You can change the value of the filed by

selecting the current value and typing a new one. Then press the Enter key from the keyboard to confirm the

new value. The change will be applied immediately on the shape. Also, you can increase or decrease the

value by pressing the arrow buttons next to the field respectively. 

With the Stop angle you can define the ending position of the angle that the Pie is

making based on virtual X and Y axes. The value of the Stop angle is in degrees; therefore, if the End angle

value is 360 the starting position of the angle will be the top point of the ellipse, which is also the initial position

of the handle (the same with 360o degrees on X and Y axes). The Stop Angle value changes, while changing

the position of the Horizontal handle. You can change the value of the filed by selecting the current value and

typing a new one. Then press the Enter key from the keyboard to confirm the new value. The change will be

applied immediately on the shape. Also you can increase or decrease the value by pressing the arrow

buttons next to the field respectively.

Notice: If you have converted the pie shape to curves by selecting the respective option of the right click

menu, the handles will not be available in Node editing mode.

Create Trapezoids and Parallelograms

The Create Trapezoids/Parallelograms tool allows you to design rectangles and

Trapezoid/Parallelogram shapes that will be filled with stitches. You can create rectangle/square shapes,

Trapezoid/Parallelogram shapes and complex shapes by combining them. To create a

Trapezoid/Parallelogram shape you have to create a rectangle shape first, on which the

Trapezoid/Parallelogram will be based. To create a rectangle you have to select the

Trapezoids/Parallelograms tool  from the Tools toolbar or by pressing the Shift + F6 shortcut keys

from the keyboard and by click and dragging diagonally on the working space, draw the rectangle shape you

want. By releasing the mouse click the shape will be placed on the position you have designed it. 

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 degrees of the X

and Y axes, with center the point you click and dragged to draw the rectangle. By click and dragging

diagonally you can draw a Square. Also, by click and dragging with the mouse based on the guidelines you

can draw perfect parallelepiped that you can convert to Trapezoid/Parallelogram shapes later. While

drawing the object, it will snap on the guidelines, allowing you to draw the shape along the guidelines. 
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Hold Ctrl key and guidelines will appear on every 22.5 degrees

By holding the Alt key pressed while drawing a rectangle, vertical and horizontal guidelines will appear on X
and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. When you press the Alt key
the object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that
point you can draw the object to the position you want based on the ruler. The Alt key will work even if the
ruler is disabled. The Alt key will work even if the ruler is disabled.  

Hold Alt key - Horizontal and Vertical guidelines appear

By holding the Shift key pressed while drawing a rectangle the center of the rectangle will change and

become the point from where you started drawing the rectangle. 

By holding both Ctrl and Shift key pressed while drawing a rectangle, the center of the shape will be the point

from where you started drawing the shape and the shape will be a square. This is helpful when you know the

center of the design and you want to add a Trapezoid/Parallelogram shape that will have as center a specific

point. 

 Node editing 

There are some more editing abilities that Trapezoid/Parallelogram tool has and they are available in Node

editing mode . You can change a rectangle shape you have created to Trapezoid/Parallelogram by

selecting it and then selecting the Edit shape nodes option  from the Tools toolbar, to change to node

editing mode. On the outline of the selected rectangle will appear four handles, one positioned at the center

of the design, one on the top left corner of the object, one on the top right corner of the object and one on

the bottom left corner of the object. 
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Four handles of Trapezoids/Parallelograms

By click and dragging the handle of the top left corner to the right, you can transform the rectangle to a

Trapezoid shape. While dragging both top corners are moving towards to the center of the top side, creating

a perfect Trapezoid. If you drag the top left handle until the middle of the top side you will create a triangle.

Therefore with this tool you can create also triangle shapes. 

     

Drag top left corner handle to the right to create Trapezoid

You can also change the rectangle to Trapezoid by adjusting the Slant value from the Tool options toolbar.

If you select the rectangle object in Node editing mode the Slant options will appear on
the Tool options toolbar. Also, the same option will appear if you select the rectangle object in Object editing
mode (when you make a rectangle\lasso selection) together with some other useful sizing and positioning
options. By changing the slant value you can specify the percentage of distance that the top left corner will
have from its starting position. The Slant is a percentage value that can take values from 0 to 100. The 0
value will have as result the rectangle to remain unchanged. The 100 value will have as result a triangle
because the two corner handle will be positioned at the middle of the top side. Therefore, to create a
Trapezoid you have to insert values from 0 to 100. Also you can increase or decrease the value by pressing
the arrow buttons next to the field respectively.

By click and dragging the handle of the bottom left corner to the right, you can transform the rectangle to a

Parallelogram. While dragging the handle both bottom left and top right corners are moving towards the

opposite corners creating a perfect Parallelogram. 
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Drag bottom left corner handle to the right to create Trapezoid

You can switch between Trapezoid and Parallelogram by checking Trapezoid checkbox  from
the Tool options toolbar and the opposite to switch back to Parallelogram. If you select the Trapezoid

object in Node editing mode the Trapezoid option  will appear on the Tool options toolbar. Also,
the same option will appear if you select the rectangle object in Object editing mode (when you make a
rectangle\lasso selection) together with some other useful sizing and positioning options. 

By click and dragging the handle of the top right corner you can change the size of the

Rectangle/Trapezoid/Parallelogram shape freely or based on guidelines by using the Ctrl, Alt or Shift keys

(Ctrl, Alt or Shift keys has the same functionally that we described previously in this section). If you hold the

Shift key pressed during the resizing process and shape is a rectangle, will be resized proportionally and

become a square. If you hold the Shift key pressed during the resizing process the Trapezoid/Parallelogram

will be resized proportionally based on the initial shape. 

By click and dragging the handle that is located at the middle of the design you can move the object to the

position you want. 

Notice: If you have converted the Rectangle/Trapezoid/Parallelogram shape to curves by selecting the

respective option of the right click menu, the handles will not be available in Node editing mode but you will be

able to edit the nodes of the shape directly.

Create Stars

The Create Star tool  allows you to design Star shapes that will be filled with stitches. You can create any

star shapes, complex shapes by combining them. To create a star you have to select the Create Star tool

 from the Tools toolbar or by pressing the ‘S’ shortcut key from the keyboard and by click and dragging

diagonally on the working space, draw the star shape you want. By releasing the mouse click the shape will

be placed on the position you have designed it. 

By holding the Ctrl key pressed while drawing a star, guidelines will appear on every 22.5 degrees of the X

and Y axes, with center the point you click and dragged to draw the star. By click and dragging diagonally you

can draw a Star with equal dimensions to all its rays. Also, by click and dragging with the mouse based on

the guidelines you can draw stars with various shapes. While drawing the object, it will snap on the

guidelines, allowing you to draw the shape along the guidelines. 
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Hold Ctrl key and guidelines will appear on every 22.5 degrees

By holding the Alt key pressed while drawing a star, vertical and horizontal guidelines will appear on X and Y
axes that will snap on the lineation of the Ruler when the Grid is enabled. When you press the Alt key the
object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that point
you can draw the object to the position you want based on the ruler. The Alt key will work even if the ruler is
disabled.  

Hold Alt key - Horizontal and Vertical guidelines appear

By holding the Shift key pressed while drawing a Star the center of the star will change and become the point

from where you started drawing the star. 

By holding both Ctrl and Shift key pressed while drawing a star, the center of the shape will be the point from

where you started drawing the shape and the shape will be a perfect star. This is helpful when you know the

center of the design and you want to add a Star shape that will have as center a specific point. 

There are some more editing abilities that Star tool has and they are available in Node editing mode .

You can change a star shape you have created by selecting it and then selecting the Edit shape nodes

option  from the Tools toolbar, to change to node editing mode. On the outline of the selected star will

appear four handles, one positioned at the center of the design, one on the Vertical axis, one on the top

right corner of the object and one between two rays at the top left quarter of the shape. 
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Four handles of Star objects

By click and dragging the handle of the Vertical axis you can change the angle of the star by rotating it

clockwise (CC) or anti-clockwise (ACC). By dragging the handle to the right you can rotate the Star shape

clockwise. On the other hand by dragging the handle to the left you can rotate the shape anti-clockwise. If you

hold the Shift key while dragging, the mouse will snap on every 22.5o degrees allowing you to make precise

rotations.  

CC Rotation      –           ACC Rotation           –  Shift 22.5o snap Rotation

By click and dragging the handle of the corner you can change the size of the star shape freely. If you hold

the Shift Key pressed during the resizing process the star will be resized proportionally and become a

perfect star. 

By click and dragging diagonally the handle between the two rays at the top left quarter of the shape you can

change the size of all rays at the same time. Mainly you can change the distance of the ray (the base) from

the center of the design. 
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Change size of rays Increase depth – Decrease depth

By changing the position of those three handles you can make precise changes on the size and shape of the

star you have created.

By click and dragging the handle that is located at the middle of the design you can move the object to the

position you want. 

You can also define the size of ray, the number of rays and the starting angle of the Star from the Tool

options toolbar. If you select the star object in Node editing mode three options will appear on the Tool

options toolbar related with the Star object. Also, the same option will appear if you select the star object in

Object editing mode (when you make a rectangle\lasso selection) together with some other useful sizing and

positioning options. Those options are the Number of rays, the Ray size and the Start angle.

Tool options - Number of rays, Ray size, Start angle

With the Number of ray’s  value you can set the number of rays you want the

selected star object to have. The default value of rays is 6; therefore when you insert a star shape on the

working area, it always comes with 6 rays. 

3 Rays    –        9 Rays            –           5 Rays         –         16 Rays

The minimum value of Number of ray’s option is 3, because with less than 3 rays we cannot create a star

object, and the maximum value is 16. You can change the value of the filed by selecting the current value and

typing a new one. Then press the Enter key from the keyboard to confirm the new value. The change will be
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applied immediately on the shape. Also you can increase or decrease the value by pressing the arrow

buttons next to the field respectively. 

With the Ray size  you can define the percentage distance between the center of the

Star shape and the line that connects two sequential ray vertexes of the star. Therefore the 0 value is the

center of the Star and the 100 value will be on the line that connects two sequential ray vertexes. If you set

the Ray value to 100 the star will become a polygon. You can change the value of the filed by selecting the

current value and typing a new one. Then press the Enter key from the keyboard to confirm the new value.

The change will be applied immediately on the shape. Also you can increase or decrease the value by

pressing the arrow buttons next to the field respectively. By adjusting this value you can set the exact

dimensions you want the star object to have. 

With the Start angle  you can define the starting position of the angle that the star is

making based on virtual X and Y axes. The value of the Start angle is in degrees; therefore, if the Start angle

value is 90 the starting position of the angle will be the top point of the ellipse, which is also the initial position

of the handle (the same with 90o degrees on X and Y axes). You can change the value of the filed by

selecting the current value and typing a new one. Then press the Enter key from the keyboard to confirm the

new value. The change will be applied immediately on the shape. Also you can increase or decrease the

value by pressing the arrow buttons next to the field respectively.

Notice: If you have converted the star shape to curves by selecting the respective option of the right click

menu, the handles will not be available in Node editing mode.

Create Polygons

The Create Polygon tool  allows you to design Polygon shapes that will be filled with stitches. You can

create any polygon shape and complex shapes by combining many polygon shapes. To create a polygon you

have to select the Create Polygon tool from the Tools toolbar or by pressing the ‘Y’ shortcut key from the

keyboard and by click and dragging diagonally on the working space, draw the polygon shape you want. By

releasing the mouse click the shape will be placed on the position you have designed it. 

By holding the Ctrl key pressed while drawing a polygon, guidelines will appear on every 22.5 degrees of the

X and Y axes, with center the point you clicked and dragged to draw the Polygon. By click and dragging

diagonally you can draw a Polygon with equal dimensions to all its sides. Therefore depending on its sides

you can create a perfect hexagon a perfect pentagon and so forth. Also, by click and dragging with the mouse

based on the guidelines you can draw different variations of polygons. While drawing the object, it will snap

on the guidelines, allowing you to draw the shape along the guidelines. 
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Hold Ctrl key and guidelines will appear on every 22.5 degrees

By holding the Alt key pressed while drawing a polygon, vertical and horizontal guidelines will appear on X
and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. When you press the Alt key
the object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that
point you can draw the object to the position you want based on the ruler. The Alt key will work even if the
ruler is disabled.  

Hold Alt key - Horizontal and Vertical guidelines appear

By holding the Shift key pressed while drawing a Polygon the center of it will change and become the point

from where you started drawing the polygon. 

By holding both Ctrl and Shift key pressed while drawing a Polygon, the center of the shape will be the point

from where you started drawing the shape and the shape will be a perfect Polygon. This is helpful when you

know the center of the design and you want to add a polygon shape that will have as center a specific point. 

There are some more editing abilities that Polygon tool has and they are available in Node editing mode .

You can change a polygon shape you have created by selecting it and then selecting the Edit shape nodes

option  from the Tools toolbar, to change to node editing mode. On the outline of the selected polygon will

appear three handles, one positioned at the center of the design, one on the Vertical axis and one on the

top right corner of the object.
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Three handles of Polygon objects

By click and dragging the handle of the Vertical axis you can change the angle of the polygon by rotating it

clockwise or anti-clockwise. By dragging the handle to the right you can rotate the Polygon shape clockwise.

On the other hand by dragging the handle to the left you can rotate the shape anti-clockwise. If you hold the 

Shift key while dragging, the mouse will snap on every 22.5o degrees allowing you to make precise rotations.

 

  

CC Rotation         –        ACC Rotation         –  Shift 22.5o snap Rotation

By click and dragging the handle of the corner you can change the size of the polygon shape freely. If you

hold the Ctrl Key pressed during the resizing process the polygon will be resized proportionally and become

a perfect polygon. 

By changing the position of those two handles you can make precise changes on the size, shape of the

polygon and rotate it also.

By click and dragging the handle that is located at the middle of the design you can move the object to the

position you want. 

You can also define the number of sides and the starting angle of the Polygon from the Tool options toolbar.

If you select the polygon object in Node editing mode two options will appear on the Tool options toolbar

related with the Polygon object. Also, the same option will appear if you select the polygon object in Object

editing mode (when you make a rectangle\lasso selection) together with some other useful sizing and

positioning options. Those options are the Number of sides and the Start angle.

Tool options - Number of sides, Start angle

With the Number of side’s value you can set the number of sides you want the

selected polygon object to have. The default value of sides is 6; therefore when you insert a polygon shape on
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the working area, it always comes with 6 rays. The minimum value of Number of side’s option is 3, because

with less than 3 sides we cannot create a polygon object, and the maximum value is 16. You can change the

value of the filed by selecting the current value and typing a new one. Then press the Enter key from the

keyboard to confirm the new value. The change will be applied immediately on the shape. Also you can

increase or decrease the value by pressing the arrow buttons next to the field respectively.  

3 Sides    –        9 Sides            –           5 Sides         –         16 Sides

With the Start angle you can define the starting position of the angle that the Polygon

is making based on virtual X and Y axes. The value of the Start angle is in degrees; therefore, if the Start

angle value is 90 the starting position of the angle will be the top point of the polygon, which is also the initial

position of the handle (the same with 90o degrees on X and Y axes).  You can change the value of the filed by

selecting the current value and typing a new one. Then press the Enter key from the keyboard to confirm the

new value. The change will be applied immediately on the shape. Also you can increase or decrease the

value by pressing the arrow buttons next to the field respectively.  

Notice: If you have converted the polygon shape to curves by selecting the respective option of the right click

menu, the handles will not be available in Node editing mode.

Create Rectangles

The Create rectangle tool  allows you to draw rectangle shapes that will be filled with stitches. You can

create any rectangle shape but also squares and complex shapes by combining rectangle shapes. To create

an ellipse shape you have to select the Rectangle tool  from the Tools toolbar or by pressing the F6

shortcut key from the keyboard and by click and dragging diagonally on the working space, draw the

rectangle shape you want. By releasing the mouse click the shape will be placed on the position you have

designed it. 

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 degrees of the X

and Y axes, with center the point you click and dragged to draw the rectangle. By click and dragging

diagonally you can draw a Square. Also, by click and dragging with the mouse based on the guidelines you

can draw perfect parallelepiped shapes. While drawing the object, it will snap on the guidelines, allowing you

to draw the shape along the guidelines. 
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Hold Ctrl key and guidelines will appear on every 22.5 degrees

By holding the Alt key pressed while drawing a rectangle, vertical and horizontal guidelines will appear on X

and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. When you press the Alt key

the object automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that

point you can draw the object to the position you want based on the ruler. The Alt key will work even if the

ruler is disabled. 

Hold Alt key - Horizontal and Vertical guidelines appear

By holding the Shift key pressed you can draw a rectangle from its center outward while drawing a rectangle.

When you press the Shift key the center of the design changes and become the point from where you started

drawing the rectangle. 

By holding both Ctrl and Shift key pressed while drawing a rectangle, the center of the shape will be the point

from where you started drawing the shape and the shape will be a Square. This is helpful when you know the

center of the design and you want to add a Circle that will have as center specific point.

Node editing

There are some more editing abilities that rectangle tool has and they are available in Node editing mode

. You can round the corners of a rectangle or square you have created by selecting it and then selecting

the Edit shape nodes option  from the Tools toolbar, to change to node editing mode. On the top side of

the selected rectangle will appear three handles, one positioned on the left corner, one on the middle and one

on the Right corner. By click and dragging the handle of the left corner you can round the corners of the

rectangle. 
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Four handles of Rectangles

By click and dragging the handle of the left corner you can round the corners of the rectangle. The roundness

applies to all four corners of the rectangle. 

Drag left handle to add roundness

You can also define the roundness of the rectangle from the Tool options toolbar. If you select the

rectangle object in Node editing mode the Roundness options will appear on the

Tool options toolbar. Also, the same option will appear if you select the rectangle object in Object editing

mode (when you make a rectangle\lasso selection) together with some other useful sizing and positioning

options. By changing the roundness value you can increase the roundness of the rectangle’s corners. The 

Roundness is a percentage value that can take values from 0 to 100. The 0 value will have as result normal

corners and no roundness. The 100 value will have round corners to their full extend. Therefore, by giving a

specific value you can produce the result you want. Also you can increase or decrease the value by pressing

the arrow buttons next to the field respectively.  

By click and dragging the handle of the top right corner you can change the size of the Rectangle shape

freely or based on guidelines by using the Ctrl, Alt or Shift keys (Ctrl, Alt or Shift keys has the same

functionally that we described previously in this section). If you hold the Shift key pressed during the resizing

process the shape will be resized proportionally and become a square. 

By click and dragging the handle that is located at the middle of the design you can move the object to the

position you want. 

Notice: If you have converted the rectangle shape to curves by selecting the respective option of the right

click menu, the handles of the top left and right corner of the rectangle will not be available in Node editing

mode.  
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Designing tools’ options
Tool options pane, provides immediate access to the properties of every object. Using the available controls
we can customize the properties of every object. The pane is content sensitive; it shows the properties of the
selected object. The same usability exists also while designing. Select a design tool and before you start
designing, you can see a set of options appearing on tool options pane. These options can be customized
either before using the tool or afterwards. Not all design tools have customizable options. 

In case that the pane is not visible you can re-enable it by pressing Tool options option of menu View -

>Toolbars. Whenever you select an object or a tool that has options such as Text tool the Tools options

toolbar is updated to show the additional options that are available for the selected object or tool. There is a

basic set of options that appears for all objects. The standard options that will appear when you select an

object are:

v The X and Y position of the object in the design area based on the Ruler

v The dimensions of the selected object (Width and Height)

v The Horizontal - Vertical scale of the object 

v If Scaling operations will be proportional or not. 

v Duplicate object. 

v Mirror the object, based on the X or Y axis. 

v Rotate the object. 

v The thickness of the border. 

Tool Options pane

There are also some options that appear only for specific types of objects. If you create a free hand design or

insert a star shape for example, you will view some extra options appearing on the Tool options toolbar.

Each of these options contains numerical values that can be changed according to your needs. In this

section we will discuss the standard options that appear for all objects. The special options that each design

tool provides are analyzed separately in the section that describes any of the design tools.

Extra options for Star shape Extra options for freehand design

By changing the X and Y values you can reposition the object inside the design area. The X and Y axes are

based on the X and Y rulers that exists on the Left and Top sides of the design area. The position of the

selected object is calculated based on its center. Therefore any inserted value in the X and Y fields will define

the position you want the center of the object to be located in the design area. In order to change these

values, type the value you like in the respective fields and then press enter or click outside of the field. The
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change is automatically previewed in the design area. You can also use the arrows next to the fields to

change the values. 

By changing the Width and Height values you can change the dimensions of the selected object. The values

represent the exact dimensions of the object and not the approximate dimensions that you are viewing on the

selection rectangle whenever you select an object. To change the Width and Height values, you have to click

inside the relative field and then type the value you like. Press Enter from the keyboard or click outside the

field to confirm the value you have entered. Also you can increase or decrease the value by pressing the

arrow buttons next to the field. In case that the option proportional is checked and you select to scale one

dimension the program automatically adjusts the other dimension in order to keep the same analogy between

the horizontal and the vertical size.

The next 2 fields (Scale X-Y (%))provide the capability to scale the object by a providing a percentage of

scale according to the initial size. You can scale the object according to the X dimension or according to Y

dimension. In case that the option proportional is checked and you select to scale one dimension the

program automatically adjusts the other dimension in order to keep the same analogy between the horizontal

and the vertical size.

Duplicate object, press this button and an exact duplicate of the object will be created slightly moved from

the initial object. 

Mirror object, the next 2 buttons can be used to Mirror the original object based on the Horizontal or Vertical

axis. It is like flipping the object around a horizontal or vertical axis that is located on the horizontal or vertical

center of the object. 

Rotate object, using this filed you can set a number in degrees to rotate the selected object. Type a numeric

value or use the arrows next to the field to specify one, press enter or click out of the control. The object is

automatically rotated clockwise for the degrees that you have specified.

The last option you can adjust is the Outline thickness. By changing this value you can add an outline on

the selected object or change the width of an existing outline.  If the value of the Outline width field is 0 means

that the selected object does not have a border. By changing the value to any value greater than 0, an outline

will be added to the object with the specified width. You can change the value of the Outline thickness by

highlighting the current value and then typing the new one. The old value will disappear and the new one with

take its place once you press Enter key from the keyboard or click outside the field. The value change affects

the outline of the selected object. Also you can increase or decrease the value by pressing the arrow buttons

next to the field respectively.  If you want you can remove the border of the selected object by changing the

Outline thickness value to 0.

Array tool (Circular-Rectangular)

Using Array tool you can create Rectangular or Circular arrays. The array creates copies of one or
more objects and places them in a patterned way (Circular - Rectangular). Select one or more objects and
with array tool you can multiply them along the design area and create unique formations. 
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Starting from a simple shape  you can create a Rectangular or Circular arrays like these on
the following figures.

Rectangular array Circular array

Array tool can be used in combination to Cloned objects. While applying the array you have the ability to
mark the created copies of the original object as Clones. In this case if you reshape any of the copies, all
other clones will be affected as well. The arrays of the above figures have been reshaped, simply by
reshaping any of the copies and now the look like in the figure below. 

The shape of all clones has changed.

Using Array tool.

You can find both Rectangular and Circular array shortcut icons on Tools toolbar that is located on the left
side of the application window. 

The one that is visible on the toolbar can be used by a single click. In order to see both tools, click and hold
on the icon. Holding left key pressed, move your mouse over the one that you want to use. Once it is
highlighted, release the mouse and it is activated. The tool that has been selected is also the currently visible
on tools toolbar, in order to able to access it the next time by a single click. 
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Array icons aren't enabled when nothing is selected. You must first select one or more objects. After clicking
on any of the array icons a preview of how the array will look like will appear. Now you are in preview array
mode. You can customize the array and then apply it. 

In some cases while in preview array mode you can get carried away and think that you can use other tools
or change design mode. The array hasn’t been applied until you press Apply array button. Anyway if you by
mistake try to select any other design tool or change design mode before you have applied the array, a
warning about applying array will appear. At this point if you don’t want to apply the array yet, select No and
you are brought back to the state before the array. If you select Yes the array will be applied with its current
configuration.  

Apply array 

Using Array

At this point we will present the basic steps to apply an array. In the following sections you more detailed
information on how to customize an array before applied and how Array tool can be combined will Cloned
objects in order to change the pattern of any created array. 

1. Select one or more objects

2. Click on any of the array icons.

3. A virtual preview of how the array will be appears.

4. A floating window has appeared on top of the
design area. While using array tool this dialog is
always visible.

5. You can always alter the selection using "Select
another shape" button and then make a new
selection.

6. At this point you can customize the array (adjust
number of horizontal - vertical copies, distance
between them and rotate - mirror any of the
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copies.These customizations will be described in
detail in following sections.

7. Finally when you are satisfied by the appearance of
the array , press Apply rectangular array button in
order to apply the array.

8. The Array has been applied. 

Rectangular array
Rectangular array tool creates copies that are placed in a Rectangular way. The following example will
provide you the basic knowledge in order to use array tool. 

1. Select one or more objects.

2. Click on Rectangular array icon.

3. A virtual preview of how the
array will be will appear.
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Before we apply the array we can customize it in various ways.

First way: Using the options that appear on tool options toolbar as shown in the following figure.

Customize rectangular array

Number of Horizontal and Vertical Copies 
In these two fields you can specify the number of copies that you want to be created in the horizontal axis and
in the vertical axis. 

Horizontal and Vertical spacing 
In this field you can specify the distance between the horizontal and the vertical copies of the array that will be
created.

Clone objects
If this option is enabled, the copies of the original object will be clones. This means that we can reshape them
all together by simply reshaping one of them. This option can save us a lot of time and it is also a tool that
can produce unique embroidery designs. Any shape transformation you make, on any of the cloned copies, is
applied to all of them immediately. 

Take your time and adjust the properties of the created array. We can also adjust the properties of the array
using the various visual handles that appear when we are in preview array mode.
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Using  these control handles we can:

· Change the orientation of the copies.

· Adjust number of copies.

·  Mirror copies.

· Change the distance between copies. 

· Move the array.

· Rotate the array.

In the following sections we will present the usage of these control handles.

Basic customizations

Create a design to multiply and then press 
Rectangular array.

You are in preview array mode. The
selection has been multiplied, the array is
not applied, it is a just preview.

Select number of copies and Horizontal -
Vertical distance.
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The preview is automatically updated.

At this point we will present all the ways to customize the array using mouse and keyboard combinations.
When in preview array mode several control handles appear on top of the array. Some of them provide
different functionality than the others. For example, as you can see on the following figure you can use:

· Handle 1 in order to move the whole array to another position.

· Handle 2 All the handles that are no top of array items except the original can be used in order to change
the horizontal - vertical distance.

· Handle 3 to rotate the whole array. 

Besides these handles there are also some keyboard shortcut that we can use in order to perform array
customizing tasks. We can hold Shift key and any Control handle and the by dragging the mouse we can
manage number of Horizontal - Vertical lines. Some handles appear on top of any copy and you can use
them to rotate - mirror copies. These option will be described in the following section "Advanced
Customizations"

Move array

The first upper left copy is actually the initial object. The control handle that is on top of it can be used to
move the whole array to another place.  Only the part that is visible on the preview will remain after we apply
the operation. As you can see on the moved part the initial part that has no control on top of it is not part of the
array anymore.  
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Change horizontal and vertical distance

Move any of the control handles besides the top left one and you change the horizontal and vertical distance.
See figure below.

If you hold Ctrl key while changing horizontal and vertical distance, the horizontal and vertical distance is kept
the same. 

Rotate array

You can use this handle that is outside of the array grid in order to rotate the whole array. 
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Advanced Customizations

Change number of Horizontal and Vertical copies

You can easily change number of Horizontal and Vertical lines. Hold Shift key and then click and drag from
any control handle to any direction you like. Drag to the right and you can see columns added. Drag to the left
and they are removed. Drag to the bottom to add more lines and Diagonally to add Rows and Columns at the
same time.The distance between the copies remains the same. Take this in consideration while dragging;
you have to drag for a distance such as the distance between the copies, in order to create another row or
Column.  

Change the orientation of copies and create mirrored objects

 A very nice way to create unique patterns in your designs is by using different orientation or use mirrored

copies in arrays. If you place your mouse over any of the control handles these 2 handles appear .
These handles appear highlighted not only on the current clone but also on every 2 clones to any dimension
(Horizontal-Vertical).  It is like a 2x2 table pattern, the clone after the next of the clone horizontally and
vertically is affected. 

Rotate copies  
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The first handle is a rotate handle . Change the orientation of the clones with 90o degrees step. With a
simple left click you rotate the clone 90 degrees. Click once more to rotate again. 

Place your mouse over any of the
control handles. You can see all the
affected copies with a highlighted
handle over them. array

Click once on the rotate handle and the
copies are rotated 90 degrees.

Click once more and they are rotated again
90 degrees.

Mirror copies 

Next to the rotate handle there is a mirror handle , place your mouse over it. On this copy and on all other
affected copies the same handle appears highlighted. Click once to Mirror all these copies. 

Place the mouse over any of the control
handles, all affected copies are highlight too.

Left click once and all affected copies are
mirrored.

You can mirror any copy in any state. Rotate any copy and then apply mirror, now it is mirrored vertically. The
mirror is applied based on the horizontal center of the selected object.
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Place the mouse over any of the control
handles, all affected copies are highlight too.

Left click once and all affected copies are
mirrored.

Edit clones

Once we have applied an array and we have enabled Clone objects option the we can edit the pattern of the
array by reshaping any of the clones. In order to change the shape of all objects you have to follow the steps
bellow:

Select any of the cloned objects.

Click on Edit shape nodes mode on Tools
toolbar (F10 keyboard shortcut), to switch to
Edit Shape nodes mode 
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Reshape the object by click and dragging the
node segments to the direction you want. 

The reshaping has been automatically applied to

all clones.

There is also the functionality to select all clones and to detach one or more clones.  More information about
Cloned objects can be found in Add new objects as clones section.

Circular array
The Circular array tool, works in the same as the rectangular, creates copies of the initial design, but the
copies are placed on an arc-circle, instead of a rectangle. A virtual circle is created and the center of the
circle is automatically placed at the center of the circle. Later in this section we will present how to change
the virtual center and the size of the circle. 

Select one or more objects that you want
to multiply 

Press Circular array icon  
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A virtual preview of the array appears.

Customize the properties of the array.

Customize Circular array options

· Start-End angle

· The angle between the copies 

· The number of copies 

· Enable - Disable Clone objects.

· The rotation that the clones will be applied.

· Contour steps 

Customize circular array

· Select start/end angle 
With this option you can specify where the copies of the selected object(s) will be placed on the
arc/circle. It is like selecting a part or whole circle to be filled with copies of the initial object. When
setting Start-End angle the Step count option is also changing accordingly based on the size of the
arc. 

· Step angle 
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In this field you can specify the angle step (degrees) that each copy of the circular array will be placed
on. For example if you type 15o degrees, every copy of the circular array will be placed on the arc with
15o degrees between them, until the end of the specified "start/end angle". The Step angle that you will
specify affects also the number of object/design copies that will be added on the Circular array. The
Step angle and the Step count options are connected and the value specified in the first options affect
the value of the second and the opposite. The valid values of Step angle option is from 0o to 359o.

· Step count 
In this field you can specify the number of copies that you want to be placed in the circular array,
between the specified start-end angles. For example if you set Step count to 5 copies, it will place 5
copies of the selected object(s) on the specified start/end angle by adjusting the Step angle
accordingly. The step count that you specify affects also the angle step (degrees) that each copy of the
circular array will be placed on. The Step angle and the Step count options are connected and the
value specified in the first options affect the value of the second and the opposite. Also the value of Step
count from the size of "start/end angle" that you have specified.

· Clockwise 
With this checkbox you can specify if you want the circular array to be created clockwise or
anticlockwise. If the Clockwise option is checked, (this is the default option) then the objects/designs
will be placed on the circular array with clockwise order and the opposite if it is not. 

· Clone objects if possible

If this option is enabled, the copies of the original object will also be clones. This means that we can
reshape them all together by simply reshaping one of them. This option saves us a lot of time and it is
also a tool that can produce unique embroidery designs. Any shape transformation that you will make on
any of the cloned objects/designs will be applied to all of them immediately. 

· Contour steps

Contour lines are evenly spaced concentric lines on the outside border of an circular array. Using this
option we select the number of the added contour lines. This way we can repeat the circular array.
When contour steps are added an extra property appears 

Added one contour step Added one contour step and Equal pieces.
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Using Circular array

Create a design to multiply and then press Circular array icon to enter Preview array mode.

You are in preview array mode, your selection has been multiplied, the array hasn’t been applied yet it is a
just preview. Customize the dimensions and the distance for your array.

 

Change number of copies, in the same part of the circle we have now added 6 copies. When we change
number of copies the program automatically changes the step angle to so that the specified munber of
copies fits into the provides angle.

Change the End angle into 270 degrees. 
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Change the placement into clockwise. 

Add contour steps and then enable equal steps.
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Added 1 Contour step Added 1 Contour step with Equal steps 

Basic customizations

When we press Circular array  icon, we are in preview array mode. While in preview array mode all the
copies have various control handles on top of them. These control handles can be used to adjust the
properties of the array in the same way as we can edit them using tool options toolbar. They can also be
combined to mouse and keyboard in order to provide extra functionality.

In this section we will make a brief description of the way that these control handles are used and present
mouse and keyboard combinations.  All the operations that we will describe below can only be used before
we apply the array. The center of the array is by default on the center of the axis (0,0). 

When we are in Preview array mode a copy is placed on the Start angle and one on the End Angle. For
all the copies there are guidelines that connect them to the center of the array. The copy that is on the Start
angle has a green guideline and the one on the End angle has a red guideline. All copies between Start
and End angle have blue guideline.  
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Initial object - node

We can use the handle that is on top of the first node in order to change the position of the arc-circle that
the array is applied on and the distance from the center of the array. The rotation of the initial object is the
same; the only thing that changes is the placement of the arc. Move the control handle of the first node in
the direction that is shown by the arrow.

The arc that the array is applied on and the distance from the center have both changed. The item that has a
magenta outline is the initial object. It is not part of the array and when we apply the array it will be discarded. 
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If we Hold Ctrl key while moving the first node, the movement of the array snaps on every 15 degrees. Hold
Alt key and the movement snaps on the grid. If we hold Shift key, while moving the first node the arc
doesn’t change and only the distance from the rotation center. 

Change distance between copies (Angle)

In any movement of the first node the distance between the copies is left unchanged (Step angle).  In case
that we want to change the distance (Step angle) between objects we have to move any other node. If we
move any other node the distance between the copies will change and the end angle will change
accordingly, so that the same number of copies fits, with the new distance between the copies.  The arc
has changed so that the number of copies and the distance between them can fit on it. If we reduce the
distance the arc will shrink too. 

If we Hold Ctrl key while adjusting the distance between the copies, the distance snaps every 15 degrees.
This is very assisting in having more accurate angle changing. 

Change number of copies

In any of the above cases the number of copies doesn’t change only the angle between the copies. While
changing the angle there is an easy way to leave the angle the same and based on this angle to increase or
decrease the number of copies. Select any of the control handles, hold Shift key and move to the direction
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you like. Move your mouse circular and you we will see that copies are created on the circle towards the
direction you are moving. If you move backward copies are removed. The distance between them does not
change, it is the same as it was at the start of the operation.  In reality while holding Shift you define with
the mouse the arc that the array will be placed on. The start angle stays the same and moving your mouse
you define the end angle. You must take in consideration that you must move the mouse clockwise or not
according to what has already been selected for the array on tool options toolbar.

Move array center

The rotation center of the array is by default set to the center of the axis (0,0). According to our design we
may need to move the rotation center and its distance from our design in order to create the pattern we like
for the array. If we move the array center we can see that the whole array is moved to a new position
without changing the angle of arc or rotation of the items. When we press Apply array it will be placed in the
position that is defined by the preview. 

Initial array Moved array

If we move the center of the array Holding Shift, the position of the initial object and the size of the arc
remain the same, but the rotation of the copies and the placement of the arc, changes according to the new
center. While moving the rotation center we can also move it closer to the initial object. In order to move the
rotation center, we have to hold Shift key while moving the rotation center node.
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When we move the center of the array holding Shift, in reality we perform multiple tasks at once. We change
the distance form the center, the position of the arc and the rotation of the copies. 

Change the rotation 

The direction that the array is created is usually clockwise. You can reverse this direction easily by leaving
unchecked the Clockwise option on tool options toolbar. Another way to change the direction is by clicking
on the round arrow that appears when placing the mouse over the rotation center.  Click once and the
direction of the array becomes anti-clockwise.  Click once more and it is reversed once more.

 

Click on this small round arrow and the direction of the array is reversed.

Rotate - mirror copies

A very nice way to create unique patterns in your designs is by using different orientation or use mirrored
copies in arrays. If you place your mouse over any of the control handles these 2 handles appear . These
handles appear highlighted not only on the current clone but also on every 2 clones, It is like a x2 pattern, and
on every 2 clones the one is affected. 

Rotate copies  

The first handle is a rotate handle . Change the orientation of the clones with 90o degrees step. With a
simple left click you rotate the clone 90 degrees. Click once more to rotate again. 
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Place your mouse over any of the
control handles; you can see all the
affected copies with a highlighted
handle over them. 

Click once on the rotate handle and the
copies are rotated 90 degrees

Click again and they are rotated again
90 degrees

Mirror copies 

Next to the rotate handle there is a mirror handle , place your mouse over it. On this copy and on all other
affected copies the same handle appears highlighted. Click once to Mirror all these copies. 

Place the mouse over any of the control handles, all
the affected copies are highlighted too.

 Left click once and all affected copies have
been mirrored.

You can mirror any copy in any state. Rotate any copy and then apply mirror, now it is mirrored vertically. The
mirror is applied based on the horizontal center of the selected object.

These 2 copies have been rotated. The rotated version is mirrored

Edit Clones

Once we have applied an array and we have enabled Clone objects option the we can edit the pattern of the
array by reshaping any of the clones. In order to change the shape of all objects you have to follow the steps
bellow
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Select any of the cloned objects.

Click on Edit shape nodes mode on Tools
toolbar (F10 keyboard shortcut), to switch to
Edit Shape nodes mode 

Reshape the object by click and dragging the
node segments to the direction you want. 

The reshaping has been automatically applied to

all clones.

There is also the functionality to select all clones and to detach one or more clones.  More information about
Cloned objects can be found in Add new objects as clones section.

Autoborder
Auto border tool is a very useful tool for creating automatic borders. With this tool you can add a Running,
Satin serial, Paint ZigZag, Paint Line, Cut and Stencil  border to one or more objects in the design. The
respective Techniques should be enabled in order the options to appear. In order to use Auto border tool you
must first select one or more objects that you want to apply auto border. Then you can activate Auto border
function in 3 ways:

vPress on Auto border icon  that is located on tools toolbar.

vUse the Autoborder option of right click menu 

vUse Autoborder option of Tools menu. 

The following dialog box will appear.
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Auto border dialog

In Auto Border dialog box you can define the Type,  the Position and the number of repeats of the border.

· Type: In this choice set you can define the type of the Auto border. You can select between

Running, Satin serial, Paint ZigZag, Paint Line, Cut and Stencil types. The respective

Techniques should be enabled in order the options to appear. For Satin serial and Paint ZigZag you

can also adjust the width you want the border to have. 

· Position of border: In this choice you can set the position you want the border to be placed. You can

choose between To the inside and To the outside. Both options, if you do not enter a specific value

in the Distance field, will be placed in the same position.  The value that will be entered in the

Distance field is in millimeters, defines the distance between the default position of the border and the

new position, inside or outside the object, of the border.

· Number of repeats: in this field you can define a number of repetitions for the auto border. Any

distance that you define in distance field will be the distance between the repetition of the auto border.

· Remove holes:  This option is useful when you want to create an autoborder of many design

objects. 
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Remove holes disabled Remove holes enabled

If this option is disabled, the smaller objects of the selection, tend to create autoborder around them

and this autoborder is like a hole into the autoborder that is created around the whole selection.

Enable this option in case that you don't like to have holes and create only an autoborder around a

multiple object selection.  

Autoborder Example

Let's see an example we have created the
flower of the following figure. 
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We selected to create 3 satin serial border
repeats in distance 3mm.

See these 3 created satin bars, in a
distance from the initial flower. 

Any inserted autoborder or any repetition is a separate object and can be handled and edited as any object.
Edit it's shape, it's properties, transform and move in any way you like.
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Transformations

Chapter VIII

In this chapter we will analyze all the available transformation tools that can be used for editing the objects
of a design. You will learn how to reposition objects, how to reorder them and how to duplicate and delete
them. You will also learn how to change the shape of an  object. Additionally you will learn, object sizing,
skewing, rotating, mirroring and some special functions such as Trim, Intersection, Weld, Combine and
group that can be applied on multiple objects. Finally, we will analyze how to use the color manager and
adjust the colors of the objects. 

Positioning objects
There are various ways to position objects in Creative DRAWings. You can simply drag objects any position
you like, move them using the arrow keys of your keyboard or define their position by specifying their
horizontal and vertical position on the working area. Any of the positioning ways can help you work easier and
more precisely

Move an object(s)

You can move an object or a selection of objects using a left click and drag them in their new position.
Release the mouse click and the object(s) are placed in the specified position. Zoom into the object to make
even more precise movements of objects.

Hold the Ctrl key pressed while moving an object and guidelines will appear on every 22.5 degrees of the X
and Y axes. Move the object and it will snap on the guidelines, allowing you to make accurate movements
along the guidelines. 

Hold Ctrl key and guidelines will appear on every 22.5 degrees

The point that you clicked when started dragging is used as the center point of the appearing guidelines. In
case that you like to have guidelines according to the center of the object, you must first move the center
handle outside of the shape and then move the object from its center while having the Ctrl key pressed. 
Additionally you can hold the Alt key pressed while moving an object and vertical - horizontal guidelines will
appear on X and Y axes that will snap on the lineation of the Ruler. Grid option of View menu must be
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enabled. While moving the object it will snap on the guidelines, allowing you to make accurate movements
along the guidelines.  

Hold Alt key - Horizontal and Vertical guidelines appear

When you press the Alt key the object automatically moves/snaps on the closest vertical and horizontal
lineation of the ruler. From that point you can move the object to the position you want based on the ruler. The
Alt key will work even if the ruler is disabled and the Grid enabled.  

Move a shape while drawing it

You can also move a shape object while drawing it. This is an ability that you have when you are inserting any
of the readymade shapes (Ellipses or Rectangles) in the Create mode of Creative DRAWings. While
drawing a shape (after selecting the respective tool) by click and dragging you can change its position by
holding also the right click of the mouse pressed. The shape object will start moving, allowing you to
reposition it. If you release the right click without releasing the left click also, the shape will stop following the
movement of your mouse but continue changing the shape of the object you want to create. If you release
both mouse clicks, the object shape will be positioned on the working area by having the shape you gave to it.
This is very useful because you can reposition the shape you want and place it exactly where you want it
while designing, without having to do that afterwards. 

Move objects with arrow keys

The position of an object can be also changed by using the Arrow keys from the keyboard. Select one or
more objects and then click on the respective arrow key to move towards the direction that you want to move.
You can move the objects until you are satisfied with the position that objects have. Every time you click on
the arrow key, the object(s) moves 1mm to the direction of the arrow. If you hold the Ctrl key pressed and
then press the arrow key, the object(s) will move 5mm to the direction of the arrow. Finally, if you hold the 
Shift key pressed and the press the arrow key, the object(s) will move 0,10mm to the direction of the arrow.
By using the arrow keys and its combinations you can position the object(s) exactly in the place you want. 

You can change the movement step (distance) of the arrow keys from the Tools tab of  Options  dialog that
you will find under Tools menu. In the tools tab you will find the Selection movement step option, where
you can define the distance you want the selected object to move every time you press the arrow keys. The
value that you will enter will also change the movement of objects when you are holding the Ctrl key pressed.
The movement of objects when you hold the Ctrl key pressed will be multiplied with the value you have
defines in the Selection movement step. For example, if you have set the Selection movement step to be
3mm, the movement while holding the Ctrl key pressed will become 3mm multiplied with 5mm, which is the
default movement, equals 15mm movement.
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Move an object with X and Y coordinates

Another way to change the position of a shape, which is also the most accurate one, is to move an object

based on its X and Y coordinates. When you select an object its coordinates appear on the Tool options

toolbar. 

X & Y coordinates 

Tool options is a proprietary toolbar that holds the options of the selected object. In order to change the
position of the object you have to change its coordinates, X and Y and place new ones based on the ruler of
the working area. From the Ruler  you can find the exact portion you want the design to be placed and enter
the respective values. The ruler is defining virtual X and Y axes and that is why you can enter negative
numbers as values to X and Y fields. The specified coordinates define the position of the center of the object. 

Aligning, distributing and auto-sizing objects
Using align toolbar you can align-size-distribute objects precisely in any design. Align objects to each
other, and position them exactly where you want them to be. Distribute the objects automatically and make
their sides appear at equal intervals (vertically or horizontally). Finally size the objects automatically based on
the dimensions of a specific object. In case that the toolbar is not visible you can bring it up using the
respective option of View menu. 

Align bar

The alignment and the auto-sizing of objects is made based on the last selected object or on the
highlighted object (the highlighted object has magenta outline). If you make multiple selection of objects by
holding the Shift key pressed each time you add an object to your selection the last added object is the one
that the alignment will be based on. If you make a lasso or rectangle selection, the highlighted object, with
magenta outline, will be the one where the alignment will be based on. 

For example: If you have three objects like those in the figure below and you make a rectangle or lasso
selection, the one that will have magenta outline will be the object that the align bar tools will use to align/auto-
size the other two objects. As you can see from the figure below the Triangle is the highlighted object. The
highlighted object is automatically selected and there is no way to specify which one will be highlighted inside
a rectangle/lasso selection.  
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Rectangle / Lasso selection and the Highlighted object.

To specify the highlighted object you have to select the objects one by one while holding the Shift key
pressed. Each time you click on an object, it will be added to your selection. The last object that you will
select will be the object that the align bar tools will be based on. 

Therefore, in our example, if we want the highlighted object to be the rectangle, we have to select the
triangle first, hold the shift key down, then select the star object, keep the Shift key pressed and select
the rectangle object which will be the highlighted one. View the figures below.

  
Define the highlighted object by making a multiple selection 

Then you can apply any option from the Align bar based on the rectangle. 

· Aligning objects

· Auto-sizing objects

· Distributing objects

By aligning, distributing and auto-sizing objects you can create your designs even easier and quicker. 

Aligning objects

The first six buttons of the Align bar are the available aligning options of the software. By default the Align
options are disabled and they become available only if you select two or more objects. If you select only one
object the options will remain disabled. After selecting the objects you have to select the alignment option you
want to apply on them based on the highlighted object.

The Alignment options you have are the following:

o Align Left : To apply Align Left option at list two objects must be selected. After selecting the

objects you want to align click on the Align Left icon from the Align bar or by pressing the ‘L’ shortcut

key from the keyboard. The selected objects will be aligned left, based on the highlighted object.  
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Align left based on the Triangle

o Align Right : To apply Align Right option at list two objects must be selected. After selecting the

objects you want to align click on the Align Right icon from the Align bar or by pressing ‘R’ shortcut key

from the keyboard. The selected objects will be aligned Right, based on the highlighted object.

 

Align Right based on the Rectangle

o Align Centers Vertically : To apply Align Centers Vertically option at list two objects must be

selected. After selecting the objects you want to align click on the Align Center Vertically icon from the

Align bar or press the ‘C’ shortcut key from the keyboard. The centers of the selected objects will be

aligned vertically (on the vertical axis), based on their center of highlighted object.

  
Align Center Horizontally based on the House drawing

o Align Centers Horizontally : To apply Align Center Horizontally option at list two objects must be

selected. After selecting the objects you want to align click on the Align Center Horizontally icon from

the Align bar or press the ‘E’ shortcut key from the keyboard. The selected objects will be aligned

vertically, based on the center of highlighted object.
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Align Center Vertically based on the House drawing

o Align Top : To apply Align Top option at list two objects must be selected. After selecting the

objects you want to align click on the Align Top icon from the Align bar or press the ‘T’ shortcut key

from the keyboard. The selected objects will be aligned Top, based on the highlighted object.

Align Top based on the Star

o Align Bottom : To apply Align Bottom option at list two objects must be selected. After selecting the

objects you want to align click on the Align Bottom icon from the Align bar or press the ‘B’ shortcut key

from the keyboard. The selected objects will be aligned Bottom, based on the highlighted object.

Align Bottom based on the Triangle

Auto-sizing objects

On the align bar there are three available Auto-sizing tools. By default the Auto-sizing options are disabled
and they become available only if you select two or more objects. If you select only one object the options will
remain disabled. After selecting the objects you want to auto-size you have to select the sizing option you
want to apply on them based on the highlighted object.

o Make same width : To apply Make same width option at list two objects must be selected. This

option allows you to make the selected objects to have same width with the highlighted object that it is

also included in the selection. After selecting the objects you want to have the same width, click on the 

Make same width icon  from the Align bar or press the Shift + W shortcut keys from the

keyboard. The selected objects will be resized and have the same width with the highlighted object.
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Make same width based on the Circle

o Make same height : To apply Make same height option at list two objects must be selected. This
option allows you to make the selected objects to have same height with the highlighted object that it is
also included in the selection. After selecting the objects you want to have the same height, click on the 

Make same height icon  from the Align bar or press the Shift + H shortcut keys from the
keyboard. The selected objects will be resized and have the same height with the highlighted object.

 
Make same height based on the Circle

o Make same size : To apply Make same size option at list two objects must be selected. This

option allows you to make the selected objects to have same size with the highlighted object that it is

also included in the selection. After selecting the objects you want to have the same size/dimensions,

click on the Make same size icon  from the Align bar or the Shift + S shortcut keys from the

keyboard. The selected objects will be resized and have the same dimensions with the highlighted

object.

  
Make same height and width based on the Circle

Distributing objects

On the align bar there are two available Distributing tools. By default the Distributing options are disabled
and they become available only if you select three or more objects. If you select only one or two objects the
options will remain disabled. After selecting the objects you want to make their sides appear at equal intervals
vertically or horizontally, you have to select the distributing option you want to apply on them and it will be
applied immediately. While distributing objects the highlighted object it is ignored because it does not affect
the functionality of the options. The available distributing options are the following:

Equal horizontal spacing : When this option is applied on the selected objects, the horizontal distance

between objects becomes equal. Therefore this options places equal horizontal intervals between the
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selected objects. To apply this option, select the objects you want and then click on the Equal

horizontal spacing icon  from the standard toolbar or the Shift + C shortcut keys from the

keyboard. 

Equal horizontal spacing between objects

Equal Vertical spacing : When this option is applied on the selected objects, the vertical distance
between objects becomes equal. Therefore this options places equal vertical intervals between the
selected objects. To apply this option, select the objects you want and then click on the Equal vertical

spacing icon  from the standard toolbar or the Shift + E shortcut keys from the keyboard.

Equal Vertical spacing between objects

By aligning, distributing and auto-sizing objects you can create your designs even easier and quicker. 

Re-order objects

In the Create mode of Creative DRAWings you can change the order of objects. You can change their order
by bringing one to front and send another to back. The re-ordering you are making is for the vector design
mainly. The final embroidery sequence is only based on the design and it is not identical with the order that
the vector design was created.

There are four available reordering options which are To front one, To back one, To front of design, To
back of design. To apply any of the reordering options to the object(s) you have to select it and then right
click on it in order the popup menu to appear. From the right click menu expand the Order submenu and
select any of the four reordering options.

· To front one: With this option you can move the selected object forward one position. If the selected

object is positioned at the top of the design then the To front one option will not be available. Another

way to apply this option directly is by pressing Page-Up shortcut key (PgUp) together from the

keyboard.
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· To back one: With this option you can move the selected object behind one position. If the selected

option is the last object of the design, this option will not be available. Another way to apply this option

directly is by pressing Page-Down shortcut key (PgDn) together from the keyboard.

· To front of the design: With this option you can move the selected object(s) to be in front of all other

objects of the designs. Another way to apply this option directly is by pressing End shortcut key (End)

together from the keyboard.

· To back of the design: With this option you can move the selected object(s) to be behind of all other

objects of the designs. Another way to apply this option directly is by pressing Home shortcut key

(Home) together from the keyboard.

For example, in the figure below we have five circles; and the blue circle is at the lowest level, the red to the
next level, the green to the next level, the purple to the next level and the brown at the top level. In order to
change the order of the circles we have to select the blue one and from the right click menu select Order >
To front of the design option. . 

            
               Initial position    -    Blue “To front of the design”  -   Brown “To back of the design”

 

Green “To back one”   -   Red “To front one”

Immediately the circle at the lowest level goes to the highest level. We can do also the opposite by selecting
another circle (Brown object) and from the right click menu select Order > To back of the design option.

This option sends the circle to the lowest level of the design. If we want to change an object one level,
upwards or downwards we can do it by selecting the object (Green object) and again from the right click
menu select Order > To back one option.

The green circle will be re-ordered under the red circle that is one level down. We can do the opposite to the
red circle by bringing it one step forward. The red object will be positioned over the purple object and under
the blue object

When we finish reordering the design we can go to the stitch mode to see how the embroidery design will
look like or enable the Stitches option from the View menu inside the Create mode. The reordering tools can
help you create exactly the design you want to embroider. 
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Sequence manager
Sequence manager provides a graphical representation of the design's order and provides an easy way to
change it. Sequence manager is a transparent floating dialog that appears on top of the design area. All the
design items are represented as icons of the items to be embroidered. All these items have a number, in the
lower left corner, which reveals their position in the embroidery sequence. In any sequence icon there are
also 2 descriptive icons on the bottom right side of the icon that reveal the type of the fill or outline that is
used for any object. These 2 icons represent the type of fill or outline of the object. The left icon reveals the
type of the fill and the the right icon reveals the outline type. 

Auto-sequence option

Auto-sequence option is available only when the Embroidery Technique is enabled. When Auto-
sequence is enabled, objects of multiple stitch types are grouped into one sequence manager icon. In this
case the items that are included, are embroidery items that have various fill or outline types. This bulb icon  

 is used to reveal that in this sequence item multiple stitch items.

When Auto-sequence is disabled or when the Embroidery Technique is disabled you can see the icons
and the type of the objects that they represent in the following table. As we have already mentioned the left
icon represents the fill type and the right icon the outline type. 

Normal stitch objects(Running, Satin serial, Netfill)

Appliqué  objects

Imported artwork from stitch files

Imported Cross-stitch or Photo-stitch

none Fill or Outline 

Array fill or Outline

Crystal fill or Crystals on outline

Cut on outline

Paint fill or Outline

Stencil on Outline

As we can see in the following figure the first item  is at the bottom of sequence manager and the last is at
the top. 
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Auto-sequence is enabled Auto-sequence is disabled

Sequence manager floating dialog

At this point we must mention that a very special tool of Creative DRAWings, the Auto-sequence, affects the
way that the items of sequence manager are viewable. When Auto-sequence is enabled the program
automatically decides the sequence of all stitch objects, so you don’t have any control of the sequence of the
design items via sequence manager. The only items that are separated are the Appliqué  objects.

As you can see on the above figure when Auto-sequence is enabled, there are multiple items grouped into

one sequence icon and only the Applique object is separate. This bulb icon  reveals that Auto
sequence is enabled and multiple objects are grouped into one sequence icon. The program uses intelligent
mechanisms to automatically create the sequence of the stitch - crystal items and you don’t have any kind of
control of the order that they will be embroidered using sequence manager. When Auto-sequence is
enabled you can easily separate normal stitch - crystal objects - cut object -stencil object -paint - object from 
appliqué  objects and change the ordering between them. 

If you want to have full control of the ordering of all stitch objects you can disable Auto-sequence. This can

be easily done by pressing Auto-sequence icon  on Tools toolbar that is usually located on the left side
of the application window. Once Auto-sequence is disabled all design items become separate icons on
sequence manager. This can be clearly seen in the right part of the above figure. 

At the left part of the figure, when Auto-sequence is enabled, you can see that the first design item at the
bottom is an appliqué  object and then you can see all stitch objects. In the right part where Auto-sequence
is disabled every design item has a separate sequence item. By clicking and dragging any item you can
change its order. You have full control of the embroidery sequence and all the intelligent mechanisms have
been disabled. 

More information about the usage and customizations of the Auto-sequence is provided in chapter
Embroidery sequence. 

Sequence manager dialog

Sequence manager appears by default on the right area of the window on top of the design area. In case
that it is not visible or you have closed it by mistake you can always reactivate it by selecting the respective
option of View menu. If you place the mouse anywhere over the Sequence manager you can see an outline
appearing around it. Place your mouse over any item of the sequence and you can see it appearing like
highlighted and on top of the other items, revealing that it is currently selected. If you click on any item of the
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sequence manager it gets selected and you can see it inside the design area with a highlight rectangle
around it.

As we have already mentioned by click and drag you can move any sequence item up or down to change its
place in the embroidery sequence.

The sequence manager window appears floating over the design area. Although you can select where it will
be placed and you can easily customize its size.

You can also use this icon  or  to select a view mode for sequence manager. You can toggle between
two modes, one that shows the object with a best fit on the icon of sequence manager and one that show the
actual size of the object into the design.

Icons with actual size Icons in best viewable

You can easily group the design objects on sequence manager according to their color  (Fill and Outline). 
Use Group by color button   that is located on the tittle bar of sequence manager. Cut, Paint, Stencil
and Applique objects cannot be grouped. It is a toggle button; any click on the button switches Group by
color functionality from enabled state to disabled and vice versa. Using this option you can group multiple
objects, into one sequence manager icon, according to the used color (Fill and Outline). When enabled all
successive objects that use the same fill and outline color are grouped into one sequence manager icon.  

You must always have in mind that the Auto-sequence or  the Embroidery Technique must be disabled in
order to be able to see all design objects into separate icons  . In this case, (when Group by color option is
enabled) the sequence manager icons are reduced and you are able to locate any design item easier. In
advance, by clicking on any sequence manager icon that has multiple items grouped you can easily select all
of them with one click.

For Cut, Paint, Stencil and Applique objects, the order that will be set at the sequence manager will be the
same with the order that will appear, if you export the design to be cut(File > Export > To Crystals/Cutters). 
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Split by color enabled Split by color disabled

If you want to close the Sequence manager dialog you have to click on the close icon . In case that you
have closed sequence manager you can reactivate it using the respective option of view menu. You can also
minimize it by clicking on the hide icon . The minimize icon will make Sequence manager to disappear and
leave its title bar floating over the design area. You can maximize the dialog by clicking once more on the
show icon .

Minimize backdrop properties dialog

Place your mouse over the title bar of sequence manager and a move handle appears. Click and drag in
order to place Sequence manager wherever you like. 

Move sequence manager
1. Place the mouse over its title bar
2. A move handle appears
3. Click and drag to move the sequence wherever you
like.
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In case that not all sequence items can be seen with the
current size of the window, a horizontal scrollbar
appears. 
Use this scrollbar to see all sequence items.

In order to have larger sequence icons and have a better
view of sequence items you can resize vertically the
window
Place your mouse over any of the horizontal edges, a
resize handle appears. Click and drag towards any of the
provided directions, the window is enlarged and the size
of icons has changed accordingly.

In the same way you can change the height of the dialog.

You can also enlarge diagonally to both dimensions.
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The extra ability of this tool is that you can re-arrange the sewing order for the current design, and select one
or more objects in the design area. This way you can organize the sequence of embroidery production in the
way you prefer. 

We can also change the sequence of design items using Order options that appear on right click menu.
These ordering options will be described in a separate section. In order to simulate the embroidery sequence
you can use slow redraw tool.

Re-sequence items

Using sequence manager you are able to easily see and change the sequence of all the designs objects.
When Auto-sequence is enabled (Embroidery Technique is enabled) all design items are shown into
separate  sequence items and only embroidery items are organized as one. This way the normal stitch
objects are separated from the rest design objects and change the order between them easily in case that is
needed. As we can see on the following figure, all the embroidery parts are grouped into the first icon of
sequence manager and only the applique object has a separate icon.  

At this point we can only change the order between the applique/cut/stencil/paint/crystal object and all
embroidery objects. If we disable the Auto-sequence or disable the Embroidery Technique all the design
objects will be separated into sequence items. Now we must define the order of all objects in order to
embroider them any way we like. You can Click and Drag any sequence item and reorder all design objects.
Let’s see how easily we can change this sequence. 

The Red polygon is embroidered first and
it looks like it is below the other objects
that are embroidered later.



Creative DRAWings® 7.1 manual296

© 2017 DRAWstitch Ltd.

Place the mouse over the Red polygon
icon and click to select the icon. 

Click and Drag the icon on top of the 
Green polygon icon. 

The part of the  Red polygon that was
under the Green polygon is now on top.

 

In the same way we can move the Red
polygon icon on top of the Brown polygon
and now we can see the the Red polygon
is on top of all others.

We can select more than one sequence items, by holding Ctrl key and clicking on the items that we want to
select. This way we can change the order of more than one sequence items at once. 

Duplicating and deleting objects

In Creative DRAWings you can duplicate and delete objects with various ways. There are menu options to

do that, mouse combinations and keyboard shortcuts. We will learn all of them and you can use any that fits

most, your designing style. The only objects that you cannot apply the duplicate and delete options are stitch

objects. Also, duplicate and delete are available only inside Create mode and inside the stitch mode that is

combined with Create mode. 
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Cutting, copying and pasting

You can Cut or Copy an object or multiple objects to clipboard and paste them in the design area. The
objects can come from any bitmap or vector designing application. You can copy or cut an object from
another application and paste it in the Create mode of Creative DRAWings.  

You can Cut an object by selecting the respective option from the Edit or the right click menu and by
pressing Ctrl + X or Shift+Delete keys from the keyboard. The selected object will be placed to the
clipboard and will be removed from the working area. In order to make it appear again you have to paste it in
the location you want.

You can Copy and object or multiple objects by selecting the respective option from the Edit or the right
click menu and by pressing Ctrl + C or Ctrl+Insert keys from the keyboard. The selected object(s) will be
copied to the clipboard but will leave the object unchanged. The copied object can be used as many times as
we want by pasting it on the working area. 

You can Paste an object only when you have anything inside the clipboard. If the clipboard is empty, the
Pasting function is disabled. You can paste a design that it is on the clipboard by selecting the respective
option from the Edit or the right click menu or by pressing Ctrl + V or Shift+Insert keys from the keyboard.
The object(s) that were on Clipboard will appear on the working area without being removed from the
clipboard. The items on clipboard will stay there until something else is placed. Remember that only the last
item stored in the Clipboard will be pasted in the working area, all the previous will be lost.

Paste special

With the Paste special option that you can activate from Edit menu you can specify how you want to paste

items by selecting options in the Paste Special dialog box. The Paste Special dialog includes various

options that you can adjust before pasting the object on the design. 

Paste Special

v Source: The Source field displays the format, path, and name of the file from which you cut or copied

vector, bitmap or text artwork.

v Paste: The Paste option inserts or embeds the clipboard contents at the insertion point in the format you

select in the As box.

v Paste link: The Paste link option inserts the clipboard contents and creates a link to the source file for the

data. This is an advanced way of pasting objects inside Creative DRAWings it is available only when the 

clipboard contents come from an application that supports linking. Be sure to save the source file in the

source application before you link it to Creative DRAWings.
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v Display as icon: This option is available only if the contents of the clipboard support linking. The Display as

icon option displays the linked or embedded object as an icon inside the software. To open or edit the object

that was paste in the working area you have to double-click the icon.

v Result: In the Result area, you can view the effect of the selected options. Please read the description of

each option carefully, because it will help you decide which on you will use. 

Once you have decided the way you will paste the objects inside Creative DRAWings you click OK button to

complete the paste. 

Duplicating a design

There is also a way to create duplicates of selected objects without using the clipboard and the Copy, Paste

tools. In order to do that you have to select the object(s), click and drag it to the location you want to be

placed, right click once without releasing the left click to activate the Duplicate function and then release the

left click to insert the duplicated object. To understand that the duplicate function was activated you will see

the cursor changing to  icon. When the duplicate function is enabled you can disable it by right clicking

once more. The duplicate function is faster than Copy and Pasting and more precise because you duplicate

the design exactly in the position you want it with two mouse clicks.

Another easy way to duplicate the selected objects is by clicking on the Duplicate button  that
appears on the Tool options bar. By clicking the Duplicate button the selected objects are automatically
duplicated and are placed exactly over the source objects. When you duplicate objects they always appear
selected which allows you to move them easily to a different location by click and dragging with the mouse.
This is the easiest way to move duplicate design to a different location and separate them from the original
ones. If you want them to be exactly over the source objects, you can simply deselect them and they will
remain in place.

Delete objects

To delete any selected object(s) you can either press the Delete key form the keyboard, or select Delete
from the right click menu option. The selected objects will be removed from the design and can be recalled
only by selecting the Undo from the standard toolbar. 

Sizing and skewing objects
In Creative DRAWings you can size and skew the objects proportionally by preserving their aspect ratio or by
change their dimensions/shape in the way you want. You can change the size of the object by specifying the
dimensions of the object or by changing the object directly. These abilities are available only inside Create
mode and inside stitch mode. 

· Size objects

· Skewing objects

Size objects

When you select an object a selection rectangle appears around the shape. At the corners and at the

middles of each side there are transformation handles that allow you to change the size of the object. If you

position the mouse cursor exactly over the resize handles, the cursor will change to a two sided arrow that
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will show you the resizing directions. By click and dragging the transformation handles you can enlarge,

shrink or stretch the object to the directions that the arrows show. If you click and drag the corner handle you

can resize the object proportionally. On the status bar at the bottom of the screen you can view the

percentage of resizing that you are making. 

If you hold the Ctrl key pressed while sizing an object, the object will be sized proportionally and snap on

every 25%. While sizing the object you can view the proportional change of the dimensions on the Status bar

at the bottom of the application window. If you try to enlarge an object while holding the Ctrl key pressed, its

size will increase with 25% step (125%, 150%, 175% etc.). The same step appears when you shrink an

object. This ability allows you to make accurate changes on the shape and produce the result you prefer.

Also, if you drag a handle to the opposite direction, until you see the proportional change on the status bar

reaches the -100%, you will have produce the exact mirror of the object. 

  
Hold Ctrl key and proportionally resize with 25% step

If you hold the Shift key pressed, while resizing the object from any corner handle, you can Enlarge/Shrink

proportionally the design to all dimensions based on the initial center of the design.

Hold Shift key - Enlarge/Shrink proportionally the design

By holding both Ctrl and Shift keys pressed, while resizing the object from any corner handle, you can

Enlarge/Shrink proportionally the design to all dimensions based on the initial center of the design and keep

the original shape at the same time.

If you hold the Alt key pressed while sizing an object from the corner handles you will be able to resize the

object freely, without keeping any proportion of its initial shape. 
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Hold Alt key – resize the object freely

Therefore, by holding the Alt key pressed while resizing you can not only resize the object but reshape it

also. 

The handles at the middle of each side can be used to Stretch the design to the directions that the arrows

show. 

If you hold the Shift key pressed, while resizing the object from any corner handle, you can Stretch

proportionally the design to two dimensions based on the initial center of the design.

Hold Shift key - Enlarge/Shrink proportionally the design

Another way to resize an object is by specifying the exact dimensions you want to have on the Tool options

toolbar. When you select an object all related options appear on the Tool options toolbar. 

Width and Height of the shape 

There are listed also the Width and Height of the object which you can change by inserting new ones. Select

the values inside the field and then type the new value you want to have. Press enter to confirm the value or

click outside the field. The change you made it is applied immediately on the object. This is a useful way to

change the dimensions of an object or an entire design because you can do that precisely. 

The same sizing abilities apply to Cross-stitch objects. You can select any Cross-stitch object and re-size it

applying any method we described above. By changing the size of Cross-stitch objects you can increase or

decrease the number of crosses in the design. More crosses in the design increase the quality of the cross-

stitch embroidery result. 
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Skewing objects

At the middles of each side there are transformation handles that allow you to skew the objects. If you

position the mouse cursor near the handles, the cursor will change to a two sided half arrow that will show

you the skewing directions. By click and dragging the transformation handles you can skew the object to the

directions that the arrows show.

Skew horizontally and Vertically 

By default the center of the design is located at the center of the object and all skewing transformations are

made based on this. You can change the skewing center by click and dragging it to the position you want,

even outside of the design. By positioning the center of the design outside of it you can skew the design

based on the new center. 

Skew based on Skewing Center

If you hold the Shift key pressed, while skewing the object, the center of the design will change automatically

and will be positioned at the opposite side, based on which the skewing will be made.  

Hold Shift key - Skew based on the opposite side

Rotating and mirroring objects
Creative DRAWings allows you to rotate and mirror the designs you are creating easily. You can rotate and
mirror the design by click and dragging the rectangle selection handles to the position you want. 
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Rotating objects

When you select an object a selection rectangle appears around the shape. At the corners there are

transformation handles that allow you to rotate the object. If you position the mouse cursor the handles, the

cursor will change to a semi-circle arrow that will show you that you can rotate the design. By click and

dragging the transformation handle you rotate the design clockwise or anticlockwise. The rotation of the

design is made based on the center of the design. The rotation center of the design is by default at the center

of the design but you have the ability to change its position. Select the rotation center and move it to position

you want the rotation center to be. If you want you can move it outside of the design. Once you have moved

the rotation center you can rotate the design based on the new rotation center. 

   
Clockwise rotation   –  Anticlockwise Rotation with different rotation center

If you hold Ctrl key pressed while moving the rotation center, guidelines will appear on every 22.5 degrees of

the X and Y axes based on the position you have moved it from. While moving the rotation center it will snap

on the guidelines, allowing you to make accurate movements along the guidelines. The guidelines that appear

have as center the point you click and dragged to move the rotation center.  If you hold the Alt key pressed

while moving the rotation center, vertical and horizontal guidelines will appear on X and Y axes that will snap

on the lineation of the Ruler when the Grid is enabled. While moving the rotation center it will snap on the

guidelines, allowing you to make accurate movements along the guidelines. When you press the Alt key the

rotation center automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From

that point you can move the rotation center to the position you want based on the ruler. The Alt key will work

even if the ruler is disabled.   

If you hold the Shift key pressed, while rotating the object, the center of the design will change automatically

and will be positioned at the diagonally opposite rotation handle, based on which the rotation will be made. 

Hold Shift key - Rotation based on the opposite rotation handle
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If you hold the Ctrl key pressed, while rotating the object, guidelines will appear on every 22.5 degrees of the

X and Y axes based on the rotation center of the design. While Rotating the object, it will snap on the

guidelines, allowing you to make accurate rotations along the guidelines. If you have changed the rotation

center of the object the guidelines will start from the new position of the rotation center. 

Rotate objects precisely 

You can also rotate the objects you have created precisely by defining the exact rotation degrees on the Tool

options toolbar. To do that you have to select the object you want to rotate, change the rotation center by

dragging it to the position you prefer, type the exact degrees you want to rotate the design in the Rotate field

from Tool options toolbar and press Enter key from the keyboard to apply the rotation. The object will be

rotated the exact degrees you have defined. 

The Rotate option can take values from 0o to 360o if you want to rotate the design anti-clockwise and from -

0o to -360o if you want to rotate the design clockwise. Besides inserting the degrees 

Mirroring objects

Mirroring an object in Creative DRAWings is similar with resizing procedure. Select an object in order the

rectangle selection handles to appear at the corners and on each sides. If you position the mouse cursor

exactly over the resize handles, the cursor will change to a two sided arrow that will show you the resizing

directions. In order to mirror the design you have to drag the transformation handle all the way to the opposite

direction until the complete mirror of the design appear on the working area. According the mirroring you want

to do, you have to drag the respective handle that will give you the mirroring you want. You can mirror the

design Vertically, Horizontally and Diagonally. 

Horizontally, by dragging the handles of the vertical sides to the direction you want the mirror to be made. 

Mirror Horizontally

Vertically, by dragging the handles of the horizontal sides to the direction you want the mirror to be made..



Creative DRAWings® 7.1 manual304

© 2017 DRAWstitch Ltd.

Mirror Vertically

Diagonally, by dragging the corner handles the direction you want the diagonal mirror to be made.

Mirror Diagonally

If you want in place mirroring of the object you have to hold Shift key pressed during the mirroring process.

The object will mirror based on the center of the design and not on the opposite side/handle of the design.

Mirror while holding shift key pressed

To all above cases, if you want to make accurate mirroring you have to hold the Ctrl key from the keyboard

pressed during the mirroring process. By holding the Ctrl key pressed the mouse will snap on every 25% of

the mirroring movement allowing you to make an identical object mirror. Because you are dragging the

transformation handle to the opposite side of the object, the percentage movement starts from 100% (original

shape), decreases with 25% step until 0, and then increases with negative values until -100% which is the

perfect mirror of the object. The percentage changes are shown on the Status bar that is located at the

bottom of the application window and the negative numbers show that you are in the Mirroring process.   
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Also, you can make accurate mirroring by changing the Width and Height values from Tool options toolbar.

This can be done by inserting negative size values to the respective size fields.

 To mirror the shape you want based on the vertical axis you have to insert a minus in front of the current 

Width value and then press Enter key. The shape will be mirrored horizontally by keeping the same

dimensions. You can mirror the design horizontally to the preferred width by changing also (except the sign)

the width value.  

To mirror the shape you want based on the horizontal axis you have to insert a minus in front of the current 

Height value and then press Enter key. The shape will be mirrored vertically by keeping the same

dimensions. You can mirror the design vertically to the preferred height by changing also (except the sign) the

height value.  

To mirror the shape diagonally you have to insert negative values on both Width and Height values of Tools

options toolbar. The diagonal mirroring will be made in the position where the shape is located. 

Another way to mirror the selected design accurately is by clicking the Mirror X and Mirror Y buttons that you

will appear on Tool options toolbar.

To mirror the design vertically you have to select it and click on the Mirror X button. The design will flip and

you will view its vertical mirror.

To mirror the design horizontally you have to select it and click on the Mirror Y button. The design will flip and

you will view its horizontal mirror.

Use any of the above methods to mirror your designs and produce the result you
want.

Repeat transformation
In Creative DRAWings you have the ability to Repeat your last transformation by using the respective
option of the Right click menu. For example, if you have rotated an object you can repeat the last rotation as
many times you want by selecting the Repeat last transform option from the right click menu or by pressing
the Ctrl+R shortcut keys from the keyboard. The object will be rotated, by keeping the same rotation angle
with the last made rotation, as many times as you used the Repeat last action option. This ability is available
only inside Create mode of Creative DRAWings. 

If you want to repeat your last transformation you have to select the object you want the last transformation

you made to be applied. Then Right click on the object and select the Repeat last transform option from

the popup menu. The last transformation you made will be applied to the selected object as many times as

you used the Repeat last transform option. Every time you make a transformation it is automatically

becoming the last transformation and this one will be used when the Repeat last transform option will be

applied.

Clear transform
Clear transform option of object editor context menu provides the ability to Cancel all the transformations that
have been done to an object in object editing mode. This option of Object editing context menu appears when
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right clicking on any object that has been repositioned, resized, slanted, rotated or when any other
transformation has been applied to it while you are in Object editing mode. The reverted transformations can
be more than one. The object is reverted to its initial state and position that it was designed. When applying 
Clear transform you are prompted to select whether you like to keep the distorted shape or not. This way
you can make the present state of an object have no transformations. This is used when you like the current
state of an object and you want to be able to recover this state in case you apply any transformations. 

Grouping objects

Creative DRAWings includes grouping tools that are very useful in the designing face of the embroidery. By

grouping two or more objects the software treats them as a single unit. Any change you make on grouped

objects is automatically applied to members of the group. A group in reality is a way to make a multiple

selection of objects to be treated as one object. These options are available only inside Create mode of

Creative DRAWings. 

Group objects

In order to make a group you have to select the objects you want become one group by making a multiple

selection of objects and from the right click menu select Group option or press the Ctrl and G shortcut keys

(Ctrl+G) together from the keyboard. The selected objects will become one group and will be treated as one

object.

   

Two separate objects - Select both objects and group them - Grouped objects

Add object to a Group

If you want, you can add more objects to a group. In order to do that you have to select the object(s) and then

select the group of objects. From the right click menu select Group option and the object will be added to the
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group. If you want you can group multiple groups and make nested groups. To do that you have to select two

or more groups of objects and from right click menu select Group option once more. 

    

One group and one separate object – Add object to group - Grouped objects

Delete an object form a Group

To delete an object from a Group you have to ungroup it first, by selecting the respective option from the right

click menu, delete the object you want and then re-group the objects. This is the standard way you can delete

an object from a Group.

Edit an object form a Group

To edit an object from a Group you have to ungroup it first, by selecting the respective option from the right

click menu, edit the object you want and re-group the object. This is the standard way to edit an object form a

Group.

Ungroup objects

In order to Ungroup a group of objects or nested groups you have to select it and from the right click menu

select Ungroup option or press the Ctrl and U shortcut keys (Ctrl+U) together from the keyboard. The group

of objects will break and all objects will be handled as separate objects. The nested groups will be separated

to its sub-groups and will be handled as separate groups. You can continue ungrouping the sub-groups of the

nested groups until all groups become separate objects. 

    

Grouped objects       –       Ungroup objects             –         Ungrouped objects

Combining and breaking apart objects

Combining two of more objects has as a result a single object with common fill and outline attributes. You

can combine two or more objects and create one that will have common attribute. If you want to separate

combined objects to the objects that they consist of you can break them apart and edit them separately.

These options are available only inside Create mode of Creative DRAWings. 
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Combine overlapping objects – Combine objects that are not overlapping 

To combine two or more objects you have to select them, Right click menu and from right click menu select

Combine option or press the Ctrl and L shortcut keys (Ctrl+L) together from the keyboard. The two objects

will become one with common fill and outline attributes. If the objects are overlapping then the shape of the

object that is above will become a hole in the shape below. This is the way how the overlapped objects are

combined. This is very useful when you want to create holes inside an object. If the objects are not

overlapping then the objects will have the common attributes but the combine option will not affect the initial

shape of the combined objects. 

If you want to separate a combined object to its objects you have to select the object, right click on it, in order

the Right click menu to appear and from the right click menu select the Break apart option or press the Ctrl

and K shortcut keys (Ctrl+K) together from the keyboard. The objects will be separated to its initial objects

but will retain their common fill and outline attributes. If you have just combined the objects and you want

them back as they where you have to Undo your last action by selecting the respective option from the Edit

menu or by clicking on the Undo button from the standard toolbar. 

Combined objects that are not overlapping in embroidery are connected with a Jump-stitch between them.
Therefore whenever you see two objects that are far one from the other and they are connected with Jump-
stitch, this means that they are combined. 

Intersection and Weld
Creative DRAWings includes two more editing tools that allow you to create irregular shapes. These tools

are Intersection  and Weld . You can Intersect or Weld almost every object, including shape objects
and text objects. However you cannot intersect or Weld bitmap images that where imported as backdrops or
where filled with cross-stitch stitches. 

These options are available only inside Create mode of Creative DRAWings. 

You can Weld two or more overlapping objects by selecting them and then selecting the respective option

from the Edit menu or by clicking on the Weld   icon from standard toolbar. The objects will become one

with outline the perimeter of the objects that created the Weld shape. 
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Weld overlapping objects

If you made a multiple selection of objects by selecting one object first and then the second object by holding

the Shift key pressed, the new object will adopt the fill and outline properties of the last select object. 

If you made a multiple selection of objects by making a Rectangle or Lasso selection, the new object will

adopt the fill and outline properties of the object that is under the other objects in the order of objects.

You can Weld objects regardless if they are overlapping or not. If you try to Weld objects that do not overlap,

you will have as a result a combined object. The objects will act as one object with many sub objects with the

same attributes. In order to separate such Weld objects to its sub-objects you have to select the Break

apart option from the right click menu. 

If you want you can, preview the Welding result by selecting the objects you want to Weld and then

positioning the mouse over the Weld  icon. The software will preview how the objects will look like after

applying the Weld option on them. The red line that surrounds the two objects will be the outline of the object

after applying the Weld option. 

  
Weld Preview 

After previewing the Weld option you can decide easier if you will apply it or not.

You can Intersect overlapping objects by selecting them and then selecting the respective option from the

Edit menu or by clicking on the Intersection   icon from standard toolbar. Intersect option creates an
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object from the area where the objects overlap. The shape that will be created from the intersection depend

on the shapes of the objects you intersect. 

    
Intersect overlapping objects

If you made a multiple selection of objects by selecting one object first and then the second object by holding

the Shift key pressed, the new object that will be created from the intersection will adopt the fill and outline

properties of the last select object. 

If you made a multiple selection of objects by making a Rectangle or Lasso selection, the new object will

adopt the fill and outline properties of the object that is under the other objects in the order of objects.

If you want you can, preview the Intersection result by selecting the objects you want to Intersect and then

positioning the mouse over the Intersect  icon. The software will preview how the objects will look like

after applying the Intersect option on them. The red line that surrounds the object shows the object that will be

produced after applying the Intersect option. 

 
Intersect Preview

After previewing the Intersect option you can decide easier if you will apply it or not.

Both Weld and Intersect functions are helpful in the creation of irregular shapes that you can use to create

the vector design you want. 

Remove overlaps
The remove overlaps option is located on the Object properties toolbar and it appears when you select an
object filled with Satin, Step, Row fill, Netfill Satin Serial or Running stitches. 
It is used mainly for .draw file designs that have area fill and you have opened them inside Creative
DRAWings software. With Creative DRAWings software you can only create designs with outline stitches
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(Running, Satin Serial), but this functionality exits in case you open a design that have shape areas filled with
stitches.

This is an automatic filter which removes all overlaps between the objects of the vector designs. This filter
uses artificial Intelligence and it is applied only where necessary. The application of the filter results in the
reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping
status of each object. There are three possible options that you can apply on a specific object, Auto, Never
and Always. The Auto is the default option and the one that Creative DRAWings uses to create the best
possible results on the design. When the Never option is applied on an object, the specific object will never
trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will
be embroidered normally, placing all their stitches on the fabric. The opposite option is Always. When it is
applied to a specific object it trims all the objects that it overlaps. This means that all the parts of
objects/shapes that are under the selected object will not be embroidered. 

The advantage of this option is that it is applied automatically during the creation of the design without having

to apply it manually. It will automatically decide which objects will trim and which not based on embroidery

rules.

Trimming objects

With the Trim  function you can create wholes inside objects or reshape them by removing parts of their
shape. You can trim any object you want in a vector design but you cannot trim a bitmap image that it is
imported in the design. 

This option is available only inside Create mode of Creative DRAWings. 

You can apply the Trim function only to objects that overlap partially or entirely. First you have to decide

which object will be the one that will be trimmed (target object) and which object you will use to apply the

trimming (source object). Then you have to select the source object first and then the target object by holding

the Shift key pressed, to add it to your selection. From Edit menu or from the right click menu under

Shaping submenu, select the Trim option to apply it on the selected objects. You can also apply the Trim

option by pressing the  icon from standard toolbar. The trim will be applied on the target object and the

area that was covered from the source object will be removed from the target object. The trimmed object will

have a new shape but will retain its fill and outline attributes. If you make a rectangle selection the objects you

want to trim and then apply the Trim tool, the only shape that will be trimmed is the one at the bottom in the

overlapping order of the objects. You can make as many trims you want on overlapping objects to create the

vector design you want. 

  
Before trim      –      Apply trim tool on overlapping objects – Trimmed object
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If you try to Trim two objects that are not overlapping, nothing will happen. Trim option it only applies on

overlapping objects. If you want you can make a multiple trim of a target object with many source overlapping

objects. To do that you have to select the source objects first one by one by holding the Shift key pressed to

add them to your selection. The last object that you will add to your selection must be the target object that

will be trimmed. After applying the Trim option all the source objects will trim the target object. 

If you want you can, preview the Trimming result by selecting the objects you want to Trim and then

positioning the mouse over the Trim  icon. The software will preview how the trimmed object will look like

after applying the Trim option. The red line that surrounds the trimmed object shows the object that will be

produced after applying the Trim option. 

Trim Preview – Star trims Rectangle object

After previewing the Intersect option you can decide easier if you will apply it or not.

Trimming and Remove overlaps tools have similar functionality but not the same. Creative DRAWings with

the Remove overlaps mechanism, removes the unneeded parts of the design from the final embroidery

result but it is not removing the overlaps from the Vector artwork. Therefore, if you export the embroidery

design to Wings’ modular (select File>Export>To editor…) you will view that the overlapping areas are

removed automatically, but if you export the same design to SVG vector file (select File>Export>To SVG) you

will view that the overlapping areas are there as they were designed. On the other hand if you apply the 

Trimming function on the objects the embroidery result will be the same but the SVG vector artwork will

differ. If you open the SVG file you will view that the objects you trimmed are remain there trimmed and not as

they were before you apply the Trim tool. This is the main difference between Trimming and Remove

overlaps tools. Trim tool alters the vector shape but Remove overlaps tool does not. 

Note: If you apply Trim option on two objects, it is better to set the Remove overlap value of both objects to

Never  to ensure better embroidery results.

Convert outline to Object
To all fill objects (objects that are filled with Satin, Step, Row fill or Appliqué  stitch type) can be added an
outline easily by left clicking on the top left corner of the color you want the outline to have. The outline will
be added around the object filled with Satin serial or Running stitch type but it will not be a separate object.
Therefore you will not be able to reshape it separately. For this purpose the Convert outline to Object
exists. This option allows you to covert the outline/border that is attached on an object to a separate object
and handle it as a Fill or outline/pen object. If you convert the outline to a Fill object, you will be able to fill it
with Step, Satin, Row fill or Appliqué  stitch type that it is not possible to do it otherwise. Also, you will be able
to apply all kind of shape transformations on it. 
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If the outline thickness is smaller than 0.9mm and you apply the Convert outline to object option, the
outline will be converted to Running or Satin Serial object and not to a Fill object. Therefore whenever you
want to separate the outline from the object but keep the stitch type as Running or Satin Serial you have to
set the outline thickness lower that 0.9mm. 

This options is available only inside build in Designer of Creative DRAWings. If you are working with a

different designer, this ability will not be available to you.

  
Apply Convert outline to object option to star object

To apply Convert outline to object option you have to select an object that has an outline and from Edit

menu select the respective option. You can also apply the same option by pressing the Ctrl, Shift and Q

keys (Ctrl+Shift+Q) from the keyboard after selecting the object you want to apply it. The outline will be

separated from the fill object and can be handled as a different object.

(Freehand, Bezier or Outline tool) and do not add an outline to the Fill object. This is the only way to do
that. 

Undo
Using this option in the Edit menu, you can undo the very last action you took. You can also access the Undo

function from the Standard toolbar by clicking on the icon. If you click the arrow next to the Undo  icon,
Creative DRAWings displays a list of the most recent actions you can undo. Click the action you want to
undo, to take your design back to the state you want. When you undo an action, you also undo all actions
above it in the list. If you decide to cancel the undo you made, click on redo function. 

You can also change the undo level from Tools > Options in the General options tab.

Redo
Using this option from the Edit menu, you can cancel the latest undo that you have performed. You can also

access the Redo function from the Standard toolbar by clicking on the  icon. If you click the arrow next to

the Redo  icon, Creative DRAWings displays a list of the most recent actions you can redo. Click the
action you want to redo, to take your design to the state you want. When you redo an action, you also redo all
actions above it in the list.

Add new objects as clones
A very useful capability for making designs with repeated shapes is Add new objects as clones. You can
enable this option using Add new objects as clone’s option of Edit menu. When this option is enabled, any
created duplicate of an object is marked as a clone of the initial object. If you reshape any of the clones all
other clones are reshaped too. 
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You can create clones in various ways. The easiest way is by selecting one or more object and the press 

 button on Tools options pane. 

The other way is, while moving or transforming any object (resize, rotate, slant) you can right click and create
a duplicate of the original object. This object has been created, leaving the original object impact.

Let’s make a brief example of how it this function works. 

1. Create a new design by pressing new design   icon

2. Press create ellipse   tool 

3. Click and drag on the design area, to create an ellipse  

4. Now the newly created object is selected.

5. Enable Add new objects as clone’s option of Edit menu.

6. Move the rotation center simply by click and drag it, in order to rotate the object relative to another

point.

The rotation center is a small cross that is located at the center of the object.

7. Place your mouse over the upper right corner, a rotate handle will appear. 

Notice  the highlighted rectangle around the object. On the corners and on the middle of
the s ides there are some highlighted bullets that can be used to transform the object.

8. Click and drag to rotate the ellipse to the position you like, before you release the mouse Right

click in order to create a duplicate.  

9. Press Ctrl+R to repeat this transformation and create more clones 

10. Once you have created the clones you like you can now take advantage of the clone editing. 

11. You can now edit the shape of any clone (Node editing mode) and all other clones will be affected

as well. This way you can improve the pattern in an aspect that you didn’t imagine at first. 

This is a created ellipse. Once you have
created the ellipse make sure that Add new
objects as clones of layout menu is selected. 
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Use any of the transform handles that appear
while an object is selected to transform it and
by right clicking create a clone of the first
object. 

Create as many clones as you like by applying
Repeat last transform option from "Edit"
menu. 

In node editing mode, select any of the clones.
Reshape the object using Edit nodes mode,
any change you make is immediately applied to
all other clones

The flower like shape has changed
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We have changed with a couple of clicks all
these flower petals and created a different
version of the flower.

Once you have created cloned objects you can access some extra functionality that is located on the right
click menu, in order to better control these items. 

Select all clones 

You can select all clones by using Select all clones option of Clones submenu that appears when right
clicking on any of the clones. Now you move all of them or apply a change on all of them.

Detach from clones 

Another useful option is that you can select one or more of the clones and detach it from the other clones by
selecting Detach from clone’s option of Clones submenu that appears when right clicking on any of the
clones. The detached clone will no longer inherit the changes that are applied to any of the clones. It is a
normal object now. 

Available clone management options
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Color management

Chapter IX

In this section we will present how to work with colors for your projects. When creating a new design either
you are prompted to select a Thread/Brush palette (Color reduction wizard step) or you are working with
the default Thread/Brush palette that contains RGB colors. In any case you can select which

Thread/Brush palette to use using the Edit palette icon  on standard toolbar. When using Edit Palette
option you can selected a Thread/Brush palette to use, among the color palettes of the major
Thread/Brush manufacturers or use the default RGB (Red Green Blue) color palette. You can select the
Thread/Brush palette that actually use, to create the design you want based on the colors that actually exist.
If you have selected a Thread/Brush manufacturer palette then the colors of the palette will be available on
color palette. According to the Techniques you have enabled for a design you may have more than one color
palettes available on the Palette toolbar. All the Techniques, besides Paint technique, are using the same
palette as you can  see on the following figure.

If we have any technique enabled when Paint technique is enabled, then an extra Brush palette is added to
the palette toolbar in order to be able to add colors to your Paint objects as you can see on the following
figure.

At this point we will not analyze how to work with Paint colors since they are presented into a separate
section in the chapter about Paint. One thing to have in mind is that generally the Thread/Brush palettes
have a limited number of colors. When importing Vector graphics or Bitmap images that have too many
colors, the program can not automatically set identical color, from a Thread/Brush palette, as on the original
artwork. There is a mechanism that can make a color match and reduce the produced colors, use Edit

palette icon  to bring up color reduction dialog. For example we have imported a cmx design that
contains 6 colors, as you can see on the left area of the following figure, If we do not select any Thread
palette and leave the default RGB palette. In the right part we have selected  ACKERMANN ISAMET palette
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and as we can see the color reduction mechanism has matched the colors to the Threads of the selected 
palette.

RGB palette used, no color reduction Brush palette selected automatic color reduction

This is happening because there is no limitation to the colors that you can use on a vector artwork, but there
are limitations to the colors you can use on an embroidery design. The software has a limitation of 99 colors
on the embroidery designs. But considering the max needles that your embroidery machine can support you
have to make a choice about the final number of colors. You must always keep in mind this limitation
whenever you use stitch mode. If you have a design with 6 colors but in Edit palette you have defined 4 colors
(According to your embroidery machine  needle carriers). Then in stitch mode you will see you design
changing and using only the number of colors that are selected for embroidery. When this automatic
conversion takes place it does not change the color of the original artwork, the colors that you can see on the
design are the default RGB colors and not the automatically matched colors from Color reduction. In order to

preview the design with the palette matched colors you must switch Stitch mode   (Ctrl+2) where you
can see the final colors. To summarize, the colors of the final design can be adjusted using the Edit palette,

but you can only see final colors when switched in stitch  mode. You must always keep in mind this

limitation whenever you click on the stitch button and you see changes on the colors you have assigned
to the design. This is becoming clearly obvious when you are working with a specific manufacturer's thread
palette where all RGB colors are not available. The color match will not be identical and when you are in the
stitch tab you will see the design preview with slightly different colors but closer to the final results.

Thread palette



319Color management

© 2017 DRAWstitch Ltd.

Thread palette toolbar
The Thread/Brush palette toolbar is located at the bottom of the application window (Visible only in Draw
mode). Using the color icons you can choose colors (Fill or Outline) for any part of the design. In case that
the toolbar is not visible you can use the respective option of View menu - Toolbar section. The toolbar is
consisted of two parts, the available colors and the colors that are currently used.

Color palette

Available colors

The available colors are the colors of the color palette you have selected to use. The colors are located at
the top rectangle area of the Palette toolbar and by default the RGB palette is loaded. You can change the
default color palette and use a specific Thread/Brush color palette from the Edit palette dialog (we will
explain it thoroughly later in this chapter).

Available colors

Currently used colors

There is also the currently used colors area where all the currently used colors are listed. If the design has
five different colors they will be listed at the bottom of the palette toolbar. 

Currently Used Colors

As you can see any color icon is consisted of 2 triangles , one on the upper left part and one on the lower
right part. If you place the mouse on top of the upper left part of a color you can see a pen icon. This means
that the selected color will be used for the outline of the object. If you place the mouse over the lower right
part you will see a bucket icon revealing that the selected color will be used for the object fill. For any object
we select the colors (outline-fill) that are used for it are marked with icons in currently used colors. If you

select an object of the design the color that was used to be filled will be highlighted with a fill bucket  on
the currently used colors area. If the object has outline, also, the color of the outline will be highlighted with a

pen  icon. The used colors can be reused to new created objects by selecting the object on the working
area and then the color you want to be filed. 
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At the beginning of the currently used color palette there is a square , which is the empty/none color. If a

selected object does not have a Fill color, then the fill bucket will appear inside the None color  square.
If the selected object does not have an Outline color then the pen icon will appear inside the None color

 square. Also, if you do not want an object to have a Fill or an Outline color, you have to select the

object it and then click on both part of the none color square  to remove the colors from the object. 

The palette toolbar is movable and re-sizable. You can change its position by click and dragging the Title
bar to a new position. The toolbar will float on the working area and become re-sizable. You can change its
dimensions and position on the software. You can keep it as a floating toolbar or you can position it back to its
initial position by click and dragging it at the bottom of application window.

Setting colors
By default when creating an object, the default Fill - Outline color is applied on it. The software has a pre-
defined set of Fill - outline colors to be used by default. Later in this topic we will present how to set the colors
that you wish to have as defaults. When you select an object, on the design area, you can see the color that

was used for the specific object's fill to be highlighted with a Fill bucket  on the bottom right corner of the

color. In the same way If the object has an outline color, the outline color will be highlighted with a Pen 
icon on the top left corner. Any of the used colors can be reused for newly created objects easily by creating
the object and then selecting on a  the color from currently used colors.

In order to change the Fill color of an object you have to select it and  then click on the bottom right area of
the color you want from the color palette or from the used colors. You can also Right click on the color and
from the right click menu select the Set fill color option. The object will be filled with the selected color and
the color will be added in the used colors area (if it is not already there). In addition, the color you have

selected can be easily recognized from the Fill bucket  icon that will have on it when it will be added in
the used colors area.

Furthermore, in order to change the Outline color of an object, you must select the object, and then click on
the top left corner of the color you want from the color palette or from the used colors. You can also Right
click on the color and from the right click menu that will appear select Set pen color option. The color you
have selected will be added in the currently used colors area (if it is not already there) and it will have the Pen

  icon on the top left corner. The selected object is colored immediately with the Fill or Outline color that
we have clicked.

If you do not want an object to have Fill or Outline color you can click on the bottom right or on the top left

corner on the Empty/None color  box, that it is located in the currently used colors area, according to

whether you want to remove the Fill or Outline/Pen color. The Fill  or the Outline  color will be
immediately removed from the object allowing you to create the design you want.

Set default Fill or Outline colors 
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As we have already mentioned when creating an object a set of default Fill or Outline colors is automatically
applied on the created object. We can easily change the default set of Fill and Outline colors and decide
whether to make the new selection a program default or use only as default set for the specific design. 

When no object is selected if we click on lower right area of any color, then the Set default fill color dialog
will appear displaying the color you have selected. On this dialog you can select for which types of objects 
Graphic objects - Text objects the selected color will be used as default Fill color. Furthermore you can
select whether this fill color will be used only for the current design or for every design from now on. In case
that have a selection that you do not want to release but you want to set a default fill color, you must hold Ctrl
key on your keyboard and then click on the Fill color that you want to set. The same dialog will appear, your
selection will not be filled with the clicked color, it will be just set as default Fill color.

Set default Fill color dialog

In the same way we can change the Default Outline color. When no object is selected if we click on upper
left area of any color, then the Set default Pen color dialog will appear displaying the color you have
selected. On this dialog you can select for which types of objects Graphic objects - Text objects the
selected color will be used as default Pen color. Furthermore you can select whether this Pen color will be
used only for the current design or for every design from now on. In case that have a selection that you do
not want to release but you want to set a default Pen color, you must hold Ctrl key on your keyboard and
then click on the Pen color that you want to set. The same dialog will appear you can apply default Pen color
and your current select will not be changed.

Set default Outline color dialog

From the same dialog you can change the Width of the default outline/pen. Check the Set default color
width to checkbox and type the width you want in the respective field. The default outline will set to the new
value and will be applied to the current design or on every design according the changes you have made in
the Set default pen options dialog.
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In case that you want the created objects not to have have Fill or Outline color, by default, you can click on

the bottom right or on the top left corner on the Empty/None color  box, according to whether you want

not to have Fill  or the Outline  color.

Editing default color palette (RGB)
The default color palette of the application is the RGB (Red, Green, Blue). This color palette consists of 358
colors selected from all available colors as representatives. Since this palette has generic colors we can 
Add, Edit or Remove colors from this palette. Threads and Brushes palettes are using the same RGB
palette, so if we edit the Threads RGB palette then the color changes will also be applied on the Brushes /
Pen RGB palette. In order to Edit the RGB palette we must edit the Threads palette part. 

In order to edit the RGB palette  you must also have enabled the Embroidery technique.
When embroidery technique is enabled you can also see Threads palette as on the
following figure.

To Add a new color you have to Right click on the RGB color palette that is listed on the Thread palette
toolbar and select the respective option.

Right click menu

The Color dialog box will appear from where you can choose the color you want the new color to have. There
are various ways you can choose a color from the Color dialog. You can choose a color by clicking on the
respective one from the Basic colors list, or by clicking on the color rectangle where all possible colors are
listed, or you can type the exact code number of the color you want on the Red – Green – Blue / Hue – Sat –
Lum fields and produce the color you want.
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Color dialog

After choosing the color, you can set the name of the color in the Color name field or leave the suggested
name and click Ok button to confirm your selection. The color you have chosen will appear at the end of the
existing RGB color palette. The newly added color can be used normally. 

To Edit an existing or newly added color you have to right click on the color and select the Edit color option
from the right click menu. The Color dialog box will appear from where you can choose a different color or
name for the color that you are editing. There are various ways you can change the color from the Color
dialog. You can change the color by clicking on a different one from the Basic colors list, or by clicking on the
color rectangle where all possible colors are listed, or you can type the exact code number of the color you
want on the Red – Green – Blue / Hue – Sat – Lum fields and produce the color you want. If you want you can
edit also the Color name by typing a new one in the respective field. When you finish you can click the OK
button to confirm the changes or Cancel button if you want to discard the changes you made. The changes
you made will be applied on the selected color and it will be ready for use. 

To Delete an existing or newly created color you have to Right click on the color and select the respective
option from the right click menu. The color will be deleted immediately.

Important: Be careful when you use the Delete function because you cannot Undo the deletion of a
color.

If you want to Reset the RGB palette to its default status you have to right click on any color and select the 
Reset palette option. The color palette will return to its default status and all the changes you have made will
be lost.

Important: All the above options are available only for RGB color palette. 
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Selections by color
The palette toolbar includes the ability to select objects by color. This option is very useful when you want to
make a change to all objects that have the same color. You can select them and then make the change you
want. You can change colors or fill types to all objects or apply any other option you want. You can select
objects by Fill color, by Pen (outline) color or simply by color.

To select the objects by color you have to right click on the color you want from those that are listed on the
currently used area and from the right click menu select one of the three available selection options: Select
by Fill, Select by Pen and Select by color. 

· If you select Fill color option, all objects that have the fill color you right clicked on will be selected. 

· If you select Pen color option, all objects that have the Pen (outline) color you right clicked on will be
selected. 

· If you select Any color option all objects that have Fill or Pen (outline) color you right clicked on will be
selected. 

Any change you make on the selected objects, affects all objects.  

Select by color right click menu

Cross-stitch designs

The Thread palette toolbar does not have any use on Cross-stitch designs. The colors that are used to fill the
cross-stitch designs are listed on the Object properties toolbar. In order to make them appear you have to
change to stitch mode, select the cross-stitch and its options will appear on the object properties toolbar,
from where you can edit the colors of the design. More information on how to handle cross-stitch colors your
will find in the respective section of Embroidery transformations chapter.

After creating the design you want to embroider in the Create mode, you can click on the stitch mode and
view how the final embroidery will look like. To avoid the automatic reduction of colors you have to reduce
them yourself in the Create mode of Creative DRAWings. You have to count the currently used colors
from the Thread palette bar and reduce them, by re-assigning colors to objects, to the number of Thread
colors you want to use with a maximum of 20 colors. If the currently used colors are less than 20 then there
will be no change on the colors when you will click on the stitch mode.  

Edit Palette

Creative DRAWings includes various mechanisms that make conversion of artwork files (Bitmap, Vector
images, Embroidery files) a simple procedure. The only thing we must have in mind is that those artwork
files may have hundreds of colors, something that cannot be easily handled in Embroidery/Paint  designs
because there are limited Thread/Brush colors on the market, which means that not all RGB color
variations are available. This is the reason of existence for the Color reduction mechanism. The color
reduction dialog exist to help us select a Thread/Brush palette and reduce the production colors by
matching multiple colors to a representative color. Let's see how Color reduction works, while creating a
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new design, if you import any artwork file the Color reduction wizard step appears. In this dialog you can set
the number of the Thread/Brush colors that will be used for the design and how they are matched to the

colors of any manufacturer palettes. You can also use Color reduction at any time using Edit palette 
 option on standard toolbar (Ctrl+L keyboard shortcut) or using the respective option of Tools menu. In this
topic we will present the usage of color reduction with an example. We will import a vector design, once we
get to the color reduction step, by default the program has RGB Thread/Brush palette enabled. In the list you
can see the number of colors of the imported artwork and their area coverage percent.

Edit palette dialog

Select Palette

In the drop down menu the color palettes of the major Thread/Brush manufacturers are listed as well as the
default RGB (Red Green Blue) color palette. You can choose one of them to change your current palette.
Your changes are automatically previewed behind the dialog box for your convenience. For example, if you
choose Janome color palette all RGB colors will be assigned to their respective ones from the selected
palette. All the changes can be viewed in the color reduction area and visualized behind the dialog box.
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Palette drop down menu

It is  important to remember that if you use any other palette besides RGB palette the
actual colors of the palette which will be c loser to the final Embroidery or Paint result can
be viewed only in the Stitch mode.

To continue our example we will select Janome thread color palette for the imported vector design. As you
can see on the following figure all the colors of the design have been assigned to a thread color from Janome
palette. The colors were automatically reduced from 12 to 11, because the specific palette does not have a
close match for one of the colors, it matches to another color that has already been used, so both of the
colors are substituted by this one color.

Palette selection - Color assignment
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Reduce colors

Using Threads to use or Brushes to use track bar you can decide how many colors you want to be used
for the design. If you click and drag the track bar to the left side, you will reduce the number of colors in the
design. If you do the opposite you will increase them until the initial point. The changes are automatically
calculated and previewed in the color reduction area, where you can see multiple colors grouped and
substituted by one color.

Threads to use track bar

According to the enabled techniques your design may be converted into Embroidery,
Paint, Cut or Artwork design. When it is  converted into Embroidery you are selecting
Threads to use  and  when converted into Paint you are selecting Brushes to use . 

Track bar

1. Click to increase three scale units. 

2. Drag to move to the point you want. 

3. Click to decrease three scale units.

Also you can change the value of the track bar by pressing the Left & Right arrows of the
keyboard.

To continue our example we will use the track bar and we will reduce the colors from 11 to 8. Now as you
can see there 2 thread colors that are used to substitute 6 colrs of the artwork design. We can reduce the
number of colors to a number of colors that is easy to produce with our embroidery machine. 

Reduce number of colors
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Always have in mind that you can Undo any change you have made by c licking on the undo

 icon or c lick on the Redo icon to cancel the last Undo you have made.

Each color palette contains a number of Thread/Brush colors that the specific manufacturer produces. We
can view the available colors of the Palette by double click on any of the color squares in the Thread/Brush
list of the color reduction area, see the above figure. The Replace color dialog box window will appear where
all colors are listed. Using this dialog you can see all available colors and replace the clicked color with
another one that you want. As you can see on the following figure we have clicked on the 234 Coral color and
selected to replace with 225 Red.

Now all colors that were substituted by Coral color will be substituted with Red color. Finally we will mention
that if you close color reduction dialog and you see the improted artwork in the design area you will see the

design with original colors and only when you switch to Stitch mode  you will see the final matched
colors.

Import artwork design
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Color reduction area

The color reduction area includes functionality that can not seen on first look, so we will spend some time to
say some things about extra functionality.

Color reduction area

The color reduction area contains all the information about the colors of a design. You can see the colors of
the vector design, the Thread/Brush colors that are assigned to the artwork colors and the percentage of
area that any Thread/Brush color covers. It also shows any changes that are made in the Palette and in
Thread to use functions. In addition, you can make manual changes that will have an instant effect.

If your design has too many colors or you have used the Threads/Brushes to use function and reduced the
number of color in your design, the Design colors list in the color reduction area, will contain more than one
colors in each Thread/Brush. This means that colors that cover the smallest area on the design are
automatically put together with similar ones and replaced with the one that represents it from the 
Thread/Brush list.

You can also change the color position manually. Click and drag a colored square in the Design colors list,
from one thread to another, and view how the thread color changes. Using the same procedure you can drag
a color in the bottom of the color reduction area, where it says Drag here for new color, and add a new
thread with the dragged color.

When you finish setting the color groups you can change the thread color. Double click on a colored square
in the Thread/Brush list of the color reduction area. A dialog box window will appear where all thread
manufacturers’ colors are listed. 

There you can choose another color and click OK. The thread color in the area changes. If you want to
change back to the color you had before, you must double click on the color and, in the dialog box, Click on
the Nearest color button. Select it and click OK to confirm your change.



Creative DRAWings® 7.1 manual330

© 2017 DRAWstitch Ltd.

Change color dialog

If you have set a thread manufacturers’ color palette, in the dialog you will see the names/numbers of the
respective threads and you can choose exactly the thread you want. You can also navigate in the thread list
by typing the name/number of the thread. According with the typed letters/numbers, the respective thread will
be selected from the list. In addition, when you click on the list headers (Thread, Color, Used), the contents
of the list will be reordered according the type on the list. Therefore, if you click on the Color list header, the
colors will be listed according the color tone. 

Color palettes from thread manufacturers have a fixed number of thread colors. The only palette that has
infinite colors is the RGB palette. If you try to change any thread color in RGB palette, through the way we
explained previously, you will see that in the color palette there are only the thread colors are used in the
design. You can add more colors by clicking on the New color... button. Select the color you want to add by
using the available tools, type the Color Name in the respective field and click OK button to add it.
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Choose color

If for any reason you want to remove a color from the list you can click on the Remove color... button.
Confirmation will be requested from a pop-up dialog and the color will be removed from the list.

If you want to make any changes on a specific color you can click on the Edit color... button, make an
changes you want in the Color dialog and click OK to apply the changes.

The software by default finds and applies the closest color from the available ones. if for any reason you have
changed this color and you want to change it back to the nearest color possible you can click on the Nearest
color button. The Nearest color will be found immediately and applied on the dialog.

Any changes in the Edit palette dialog box are automatically previewed in the embroidery design area behind
the dialog box. In addition, every time you pass the mouse over a color in the dialog box, you can view in the
design area which parts of the design this color fills. Click OK to confirm your changes.

Finally, in the Edit palette dialog, you can Undo any change you have made by clicking on the undo  icon

or click on the Redo  icon to cancel the last Undo you have made.
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Node editor

Chapter X

In this chapter we will analyze all the node editing abilities that Create mode of Creative DRAWings has. You

will learn how to select, move, add, delete and split the nodes of a vector design. In addition, you will learn all

the terminology that will help you to understand node editing better and how to use the functions of the node

editor’s right click menu.

All the options that are described in this chapter are only available inside Create mode.

What is a node

There are two kinds of nodes. The Smooth nodes which are indicated with  icon and the Cusp nodes

which are shown with the  icon. During designing the nodes that you are adding can be Smooth nodes

or Cusp nodes according the tool you are using and the design you are creating. You can easily convert a

Smooth node, to a Cusp node by selecting the respective option from the right click menu in node editing

mode. Even if you did not create the design you wanted with your first try, you can adjust the shape you

created later by changing the position of the nodes and their segments. 

Node: The starting or connection point of a line or a curve segment. Any movement of a
node affects the shape of the line or the curve segment.

A node is the point indicated with the arrow in the
drawing at the left.
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A curve can be controlled by the control handles, which
are indicated with the arrows in the drawing at the left.

Segment: The line between two nodes is called a segment.

The nodes are connected between them with a line that is called segment. Moving an object’s segments lets
you make coarse adjustments to the object’s shape; while changing the position of its nodes lets you fine-
tune the shape of the object.

Cusp nodes

Cusp nodes are called these that are shown with this icon  or with this  icon  (when the node is
selected). Usually cusp nodes are added to the design automatically at the corners of the design or when the
curvature is changing. With cusp nodes you can change one segment of the node without affecting the other.
This is useful when you want to make precise adjustments on one part of the design without affecting
another.

Smooth nodes

Smooth nodes are those that are shown with the  icon or with the  icon (when the node  is
selected). Usually smooth nodes are added to the design automatically at the middle of a curve or on the
higher point of a curve. With smooth nodes you can adjust both segments of a node by moving the position of
the control handle and changing its length. Smooth nodes are preferred on designs that will be converted to
stitches. 

Curve objects

We can call a Curve object, any shape that we can draw inside Creative DRAWings. A curve object
consists of segments and nodes that construct the shape of the each object. Most shape objects that are
inserted (rectangles, ellipses etc.) together with the Text objects, are not curve object because they have
special abilities when you are edit them in Edit shape nodes mode. On the other hand freehand lines,
Bezier lines and outline lines are curve objects and their nodes/segments can be edited directly in Edit
shape nodes mode. 

To make an object a curve object you have to select it, right click on it and from the right click menu select
the Convert to curves option or press the Ctrl and Q shortcut keys (Ctrl+Q) together from the keyboard.
The object will be converted to a curve object that you can edit its nodes and segments in Edit shape nodes
mode. Every time you convert an object to curve you must know that you cannot convert it back to a standard
object. The only way to do that is to Undo your last actions, if you have converted it to curves recently. 
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Edit shape nodes

Every shape that you are creating is consisted of a number of nodes and segments/lines. You can edit the
nodes and the segments/lines to change the shape of the design you have created in node editing mode. The
nodes of the object will become visible only if it is a curve object. To change to node editing mode, first you

have to click on the Edit shape nodes icon  that you will find on the vertical toolbar (Tools toolbar) of
Create mode or pressing the F10 shortcut key from the keyboard, which will change the mode to node
editing. The outlines of the selected objects are highlighted and you can see all existing nodes. In node editing
mode you can change the shape of the selected object by using the mouse and by using the available
options of right click menu. 

Select Node(s)

If you want to select a node, click on the node and it will become bigger and change color indicating that it is
selected. In order to select more than one node, click and drag the mouse on the screen forming a rectangle.
All the nodes contained within this rectangle will be selected. 

By holding the Ctrl key down while you selecting nodes you can reverse the current status of the nodes. If
they were selected they will become deselected and the opposite. The same functionality applies either on
separate node selections or on rectangle selections.  

By holding the Shift key down you can add more nodes on the current selection or make a new multiple
selection. You can either add nodes to the current selection by clicking on the nodes you want to add or by
making rectangle selections. 

If you have selected more than one node you can move or delete them but you cannot change the tangents
that are controlling them. To edit the tangents of the nodes you have to select a single node and adjust its
tangents.  

In addition, you can use the Select All or Select polyline options of the right click menu that we will describe
later on.

Move node(s)

To move specific nodes of the design you have to select them first by using any of the available methods
(Rectangle selection or single click selection). Then you have to click on any node that is included in the
selection and drag the mouse to the point you want. The nodes will be moved to position you want them to
be. If you want to move a single node you have to click and drag it to its new position with your mouse.

Move multi nodes

By moving the selected nodes all the segments that are attached to them are also changing.  
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If you hold the Ctrl key pressed while moving a node, guidelines will appear on every 22.5 degrees of the X
and Y axes. While moving the node it will snap on the guidelines, allowing you to make accurate movements
along the guidelines. The guidelines that appear have as center the initial position of the node. 

If you hold the Alt key pressed while moving a node, vertical and horizontal guidelines will appear on X and Y
axes that will snap on the lineation of the Ruler when the Grid is enabled. While moving the node it will snap
on the guidelines, allowing you to make accurate movements along the guidelines. When you press the Alt
key the node automatically moves/snaps on the closest vertical and horizontal lineation of the ruler. From that
point you can move the node to the position you want based on the ruler. The Alt key will work even if the
ruler is disabled.  

Using control handles of a node

If you want to change a curve you can move, insert or delete one or more nodes. You can also edit a curve
using the control handles of a node. The control handles of a node appear whenever you select a node. You
can change the position of the control handle by click and dragging the control point (the arrow at the end of
the control handle) to the position you want. The curve from the side of the control handle you are moving will
change accordingly. By changing the direction and the length of the control handle, you can make precise
coarse adjustments on the curve. For example:

Normal Curve

By changing the length of the control handle.

By changing the direction of the control handle.
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Also the control handles of a curve can be changed by clicking on this curve and drag it on another point, as
you can see in the following draw.

The arrow shows the movement of the temporary node.
The blue line shows the curve prior to the movement and
the green line indicates its shape after the changes.

Add a node

While shaping objects in node editing mode you will need to insert an additional node inside a curve that will
help you re-shape it easier. To insert a new node, right click on the point where you wish to insert it. The right
click menu will appear with all the available option. If this is not the exact point that you wanted to insert it, you
can click on another point of the curve. By selecting the Add node option from the right click menu a new
node will be inserted in the position you wanted. Another way to add a node is by double clicking on the
position you want the node to be added or position the mouse over the point you want the node to be added
and press the Num + button form the keyboard to insert it. The new inserted node can be edited as any
existing node. The new node that is inserted is always a smooth node. If you want to insert a cusp node you
have to insert a Smooth node first and by right clicking on the node select the Cusp node option.

You can also add automatically a node between two nodes by selecting the node and pressing the Num +
key from the keyboard. A node will be added at the middle of the curve segment before the selected node. 

 

Num + adds a node at the middle of previous segment

You can also add automatic nodes to more than one selected nodes. To do that you have to select the nodes
that are after the segment you want the automatic node to be added and press the Num+ key from the
keyboard. To all curve segments before the selected nodes, automatic nodes will be added.  

Delete a node

If you don't need a node you can delete it. First select the node(s) that you want to delete and then click the 
Delete key on your keyboard. You can also right click on the node you want to remove and select the Delete
node option from the right click menu.

Note: If you delete one or more nodes of a curve, the shape of the object it might change. 

To line

If you have a curve and you want two nodes to be connected with a straight line, you can use the option To
line from the right click menu. First you have to select the node, from which the line will start. Right click on
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the node and from the popup menu select the To line option. You can apply also the same option to more
than one selected nodes. 

 
Apply To line option 

This option changes the type of the selected node(s) and the next node(s) to cusp nodes. 

You can also apply the To line option directly on the curve you want to convert. Right click on the curve you
want and from the right click menu select the To line option. The curve will be automatically converted to a
straight line. 

To curve

The To curve option is the opposite of the To line option. Therefore if the shape has two or more nodes
connected with straight lines and you want to convert them to curve lines you have to use the To curve
option from the right click menu. There are two ways to apply the To curve option. The first is to select the
node that is before the line you want to convert to curve, right click on it and from the right click menu select
the To curve option. The line next to the node will become a curve allowing you to change its shape. You can
apply also the To curve option to multiple nodes, by following the same steps. 

The second way that you can apply the To curve option on a line is by right clicking directly on the line and
from the right click menu that will appear select the respective option. The line will become a curve and
allowing you to re-shape it.  

If you have applied the To curve option to multiple cusp nodes , the will automatically converted to

smooth nodes . 

Select all and Select Polyline

With the Select all option you can select all nodes of an object and with the Select Polyline option you can
select all nodes of a specific curve (or line or closed shape) of a complex object (combined objects). 
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Nodes of Shape           Select all nodes       Select polyline 

If you want to use Select all nodes of the object, first you have to select the object, change to Edit shape
nodes mode from the Tools toolbar and select a node of a curve by clicking on it. Right click on the selected
node and from the node editing menu select the Select all option. This option selects all nodes of the current
object. You can use the same option through the Edit menu. 

On the other hand, if you want to select all nodes of a single curve (or line or closed shape) that it is part of a
complex object (combined objects) you have to select a node of the curve and then from the right click menu
select the Select Polyline option. All nodes of the specific curve (or line or closed shape) with selected
nodes will then be selected.

Close outline

With this option you can connect two nodes with a line or by making them one node. You can close an outline
that belongs to the same curve object such as line art designs or shapes with open outlines. 

In order to close an open outline or make a line art design a closed shape you have to select the ending node
of the object and right click on it. From the right click menu select the Close outline option and Creative
DRAWings will connect the selected node with the starting node of the object with a line and make it closed
shape. Then the object can be handled as a closed shape.

Another way to create a closed shape is to select the ending/starting node of an open shape or line art design
and move it towards to the starting/ending node. When the ending node will reach the starting node they will
be automatically connected and make the object a closed shape. 

Join nodes

If you want to connect the nodes of two different curves and make them a single curve you have to follow a
different procedure. 

Note: These nodes should be the first or the last node of each curve, but not necessarily the same type of
node (curve or curve break). These nodes should be near each other and the two curves should be in
the same section.
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Join nodes Select ending nodes and apply Join nodes  Nodes are joined 

Click on the rectangle selection tool from the Tools toolbar in order to change to Object editing mode and
then select the two curves you want to connect. Right click on the selected curve objects and from the right
click menu select Combine option. The two curves will become one object with two sub sections (the two
curves). Click on the Edit shape nodes to change to Node editing mode. Select the ending nodes of the two
curves and right click on them. From the right click menu select the Join nodes option. The two nodes and
curves will become one. The two objects will become one but not a close object. In order to make it a closed
object you can try any of the two methods we described in the Close outline section above. 

Split outline

With this option of right click menu you can split the selected node or the current curve in two sections. If this
function is applied on a closed shape it will become an open shape without fill color. If this function is applied
on an open shape like a line art object it will be split in two line art objects. 

    

Split outline       Select node and apply split outline       Nodes are split 

In order to split a node, you have to right click on the selected node and click on Split outline option. The
selected node will become two nodes that belong to the same object but in two different sections, if the object
was a closed shape, or in two open objects if the shape was a line art object.

In case that you have applied the Split outline option on a segment of a shape, the shape will be split and
two separate nodes will be added. The split nodes that will be created can be joined again by moving the one
node over the other. The two nodes will be automatically become one. For the same purpose you can also
select both nodes and then from right click menu select Join nodes.

Stencil bridge

There is a special chapter that shows how the Stencil mechanism works, in this article we will present how
to easily change normal closed shapes into stencil designs in just a few clicks. 

This is the initial artwork (left part) and in the right part of the figure you can see the same object with stencil 

 type applied. As you can see the object has not changed since it is a closed shape. 
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In order to convert it into stencil outline, we must create stencil bridges. Start node editing mode and right
click at any point you like and from appearing menu use Stencil bridge option.

A special split is made to the outline of the object, in the same way we can easily create as many stencil
bridges as we like. 
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Auto remove overlaps

Auto remove overlap checkbox

The Auto remove overlap option appear on the Tools options toolbar inside Edit shape nodes mode,
from where you can activate it. This option allows you to convert crossing curves inside an object (object that
looks like the 8 shape) to separate ones that can be handled as subsections of the same object. 

  

Before removing overlaps After removing overlaps Break apart the object 

These objects can be created by editing the nodes of a shape in Edit shape nodes mode , and then
automatically remove overlaps by simply checking the Auto remove overlap checkbox. Once you check the
Auto remove overlap button it remains checked. Therefore if you want to continue editing nodes without
applying the option you have to uncheck the checkbox by clicking on it. 

Transform in Node editor (Multiple node selection)_2
A very powerfull capability of Creative DRAWings is that we can transform multiple nodes selection. This can
help us in many cases when editing shape nodes. Let's se how this works.

Once you have selected a number of nodes you can see a highlight rectangle appearing around the
selection to indicate the selected section. This highlight rectangle is like a holder for a number of control
handles. The bullets that exist on the sides and corners of the rectangle are transform handles. When
placing the mouse over any of the transform handles it gets highlighted and shows a cursor that reveals the
functionality of the control.  By using these control handles you can freely transform the selected section(s) of
the object. Using the available transform capabilities you can Move, Rotate, Scale and Slant a selection of
nodes. 

· Move selection

· Rotate selection
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· Scale selection

· Slant selection

Move selection

By pointing your mouse over any of the selected nodes or over the lines of the highlight rectangle you can see

a move cursor like the one in the figure below. Click and drag to move the selection anywhere you wish. 

Place the mouse over the selection of nodes, until
you see the cursor turning into a four arrow
cross. 

Click and Drag to any direction that you want to
move the selection of nodes. 

The nodes affect the size and shape of the object.
The movement of the selection of nodes has
changed the shape and size of the object.
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Rotate selection
As described before when placing the mouse over any of the corners of the selection highlight rectangle you

can see a rotation handle. Click and drag in order to rotate the selected section. You can rotate to any direction

you like. The section is rotated based on the rotation center which is the cross that is usually located into the

center of the highlight rectangle. You can move the rotation center in order to make any rotation you like. You

can also rotate the section based on the opposite diagonally corner by holding "Shift" key. 

Place the mouse over any corner of the
selection rectangle until the cursor
changes into this rotate symbol.

Click ad Drag to rotate the selection

The rotated selection of nodes applies
this shape change.
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Resize selection

While placing your mouse over any corner of the highlight rectangle you see the available control handles.
There are 2 available controls handles, resize and rotate. When your mouse is over the corner towards the
inside of the highlight rectangle the resize handle appears and when placing your mouse a little to the outside
of the rectangle, the rotate handle appears.

On the sides there is a resize handle on top of the control handle and a slant handle if you move a little to the
outside. 

At this point we will present how to use the resize handles.

Place the mouse over any of the highlighted control
handles that are on the corners and on the middle
of sides until you see a 2-side arrow. 

 

Click and drag towards any direction that the arrow
shows in order to resize the node selection in any
way you like.

 

If you hold "Shift" key pressed while resizing the section, it is resized on both sides based on the horizontal
center of the section.   

If you hold "Ctrl" key pressed while resizing, the section is resized on a 25% basis.  This way the selected
section gets resized on a step of 25% of the starting size. You can see the percentage you have used while
you are in the process by checking out the status bar. 
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Slant selection

Another useful transformation handle is the Slant handle. 

Place the mouse over any handle that there is on the
middle of the sides and a little to the outside until you
see a slant handle.

Click and drag to the directions that are shown by half
arrows at the edges of the handle in order to apply a
slant transformation.

The slant operation is based on the rotation center.

  As you know you can move the rotation center in order to create any shape you like. You can also hold
"Shift" key pressed while applying Slant transformation and then the transformation will be applied based on
control handle of the opposite side.
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Working with text

Chapter XI

In this section we will analyze all the Text art abilities that the software has. Inside Creative DRAWings you
can add text in different languages and convert them to stitches. Creative DRAWings supports most existing
languages and allows you to create Text Art designs easily. All the fonts that are installed in windows are
available and can be used inside Creative DRAWings. You can even copy and paste Text from any text editor
inside Creative DRAWings and convert it to stitches.

Whenever you create Text art designs, the software will fill the text with the default fill type
and the default outline/pen type, based on the active Techniques. 

To add text

To insert text in the working area you have to select the Text tool  from the Tools toolbar or by pressing

the F8 shortcut key from the keyboard and then click on the position you want the text to be placed on the

working area. The Text cursor will appear waiting from you to type the text you want to convert to stitches.

While the Text cursor is active you can even paste any text that it is copied on the clipboard. To paste the text

you have to select the Paste option from Edit menu or by selecting the respective option from the right click

menu. The pasted text will be inserted allowing you to edit it further. The small dash on the Test cursor

shows the horizontal axis where the text will be placed and the direction of the text. 

Inserted text 

If you are writing from left to right the dash will be at the right side of the Text cursor. On the other hand if you

are writing from Right to Left the Text cursor will be at the left side. While Text cursor is still active you can

delete or type more text to the same Text object and make paragraphs by pressing Enter key from keyboard.

To confirm the inserted text you have to select the Selection tool from the Tools toolbar or any other tool. 

If you have the 3D preview of stitches enabled you will view the Text filled with stitches, otherwise you will

view the vector artwork of the Text design. 
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Selecting Text
Add Text tool, works like an ordinary text editor, you can type text or edit the inserted text. The selection
options while working with text, are similar with those of an ordinary text editor. In order to edit a text object,

select the object and the start text tool (  or F8), it will become editable allowing you to edit the text. You can
easily select the text to be edited using the mouse, using the arrow keys or by using the Ctrl + Home and
Ctrl + End keys from the keyboard.

Click and drag to select any part of the text. Click on the position from where you want the selection to start
and then select the characters by click and dragging with the mouse until the character you want. Then you
can type a different text that will replace the specific selected characters.

To select the text by using the arrow keys, click on the position you want the selection to start, hold Shift key
pressed and start pressing the arrow key that shows the direction where the characters you want to select
are located. Keep pressing the arrow key until all the characters you want are selected. By holding both Shift
and Ctrl keys from the keyboard pressed, you can select the text word by word. Each time that you will press
the arrow key, a word will be selected instead of a character. Then you can type a different text that will
replace the specific selected characters.

To select the text by using the Ctrl + Home and Ctrl + End keys from the keyboard you have to click on the
position you want the selection to start and by holding the Shift key pressed, press the Ctrl + Home or Ctrl +
End Key from the keyboard according the direction you want to make a selection. If you want to select the
characters to the right, you have to press the Ctrl + End key from the keyboard. All characters between the
cursor and the end of the line will be selected. If you want to select the characters to the left you have to
press the Ctrl + Home key from the keyboard. All the characters between the cursor and the beginning of the
text will be selected. Then you can type a different text that will replace the specific selected characters.

The selected text can be also copied, cut and deleted by selecting the respective options from the right click
menu. 

Right click menu options 

Change Font and Size
We can start Text tool in order to add text or edit existing text. In both cases while Text tool is active you
can see on Tool options pane various options of the text. We can edit these options before adding the text
and they are applied to the inserted text or alter them on an existing text object. You can change the Font
name and the Font size, you can also make the text Bold or Italic. Finally you can enable/disable Smart
text and edit text abbreviations.

Tool options – Font size, Font name, Bold, Italic 
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To change the Font name you have to click on the drop down menu on Tool options and select the Font
you want. The Font will change on the text allowing you to visualize how the embroidery will look like with a
different font. 

To change the Font size you have to select the value of the Font size field and type a new one. To confirm
the change you have to press the Enter key from the keyboard. The size of the selected Text will change on
the working area. 

You have also the option to make the inserted text Bold or Italic (or Bold and Italic) by checking respective
checkbox of Tools options toolbar. Any change it is directly applied on the inserted Text. Checking Smart
text to enable - disable the usage of abbreviations for inserted text. Finally press Abbreviations button in
order to add-edit-remove items on the abbreviations set.

Text abbreviations
We call an Abbreviation any combination of letters – characters that can be used in order to represent a
special character which we can’t easily add using the keyboard. The software includes a list with commonly
used abbreviations that can be easily added to our text designs.

In order to see the list of the available abbreviations we must first activate text tool by using this icon   or
by pressing F8 keyboard shortcut. When text tool is activated various options appear in tools toolbar that
can be used to customize the inserted text. 

Text tool options

We can Press  button in order to bring up the abbreviations editor.

In this dialog we can see the list of available abbreviations. 

We can also manage abbreviations 

1. Create new 

2. Edit existing
3. Delete 

4. Reset all modifications 

The usage of these options will be described in a separate
section.

Using Abbreviations

When typing text we can use any of the available character combinations in order to add various special
characters. For example if we type “1/2” it will be automatically converted into the “½”, as there is an
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abbreviation for that special type. 

In the same way we can use any of the available abbreviations. The program automatically recognizes the
pressed keys and replaces the inserted text with the interconnected abbreviation.

In order to use that feature and have abbreviations automatically applied on inserted text
make sure that Smart Text option is enabled. In case that we want to write normally
without applying abbreviations we must disable smart text option.

Abbreviation Disabled Abbreviations Enabled

Creating - Editing Abbreviations

Creating abbreviations

There are special characters that we may like ti use in our
designs. 

Use new option to create your own abbreviations.

For example 

Press new button of Abbreviations editor dialog. 

On the lower part of the dialog this part will appear 

Define the text that will be replaced and then the symbol
that will be added.
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Press OK to apply the new abbreviation.

In our case when we type “e=” then it will be replaced by
the Euro “€” sign. 

Edit abbreviation

Select any of the available abbreviations
Use Edit button

On the lower part of  the dialog this part will appear. 
We can change thereplace text or the special
character. 

Delete abbreviation

Select any of the available abbreviations.
Press delete to remove it

A confirmation message will appear.
Confirm the deletion and it has been removed. 

Reset abbreviations
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Use Reset button to alter all abbreviations to the default
set and remove all custom abbreviations. 

Edit Text shape
In Edit shape nodes mode (F10) you can edit the shape of the text objects. You have the ability to change
the position of each Text character and create complex text artwork. Select the text object and activate Edit
shape nodes mode. In this mode you can see a handle sign on the bottom part of each character. Click and
drag to move any letter into a new position. Move any character to any position you like and create a text art
design. 

Move any of the letters.

Just like that you can reposition the characters easily
and create text art designs.

You can change the position of each character as long as it still a text object. In case that a text object is 
Converted into curves then the text options are removed and you can only handle it as any other curve
object. Another way to separate the characters and deal with them as separate objects is by converting the 
text object into curves and then break the object apart into curves. Select a text object, right click and
from the appearing menu select Convert to curves option. Then right click once more on the object and
form the appearing menu, select the Break apart option. The text object now is split to its characters and
can be handled as any curve object. 

Text on path

With the text tool you can also add text on a path that you have created. The text that will be added on the

path will follow its curvature and create a text art design. To add a text on path, first, you have to create the
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path you want the text to be placed on by using any of the drawing tools such as freehand or outline tools.

Then you have to insert the Text that you want to be placed on the path on the working area by using the Text

tool from the Tools toolbar. Make the needed adjustments on the text object by changing the Font size and

type from the tool options bar to make it proper for placing it on the path you have created. Also, you can

adjust the curvature of the path you have created in Node editing mode by clicking on the Edit shape nodes

 from the Tools toolbar. Adjustments on both Text and curve objects can be made, also, after placing the

Text on path. 

Before applying the text on a path you have to make sure that the text is a text object and it is not converted to

curves. Otherwise the Apply path option will not be available. 

  

Apply path procedure

To place the text on the path you have to select them both by making multi selection, right click on them and

from the right click menu select the Apply path option. The Text object will be placed on the path and follow its

curvature. The two objects will become one but they can be edited separately. This means that you can edit

the Text and the curve object as you did before applying the Apply path option. 

Edit text on a path

To edit the text that is on the path you have to select the Text on path object and select the Text tool from

Tools toolbar that will make the Text editable. You can change the type, the size, the style (bold or italic) and

add or delete text to the existing text object from the tool options bar. The additional option you have on Text

on path objects is that you can change the Text placement, the Text alignment, the Offset and the

Direction of the text on the path. 

Text placement: You can change the text placement by selecting any of the four prefix text positions from
the Text placement drop down menu of the tool options toolbar. The four options define the position that the
path (curve) will have on the Text on path object and are the following:

Text Placement
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v Baseline (Default): The Baseline option is the default option and positions the text on the curve having

characters such as small ‘g’ to expand under the curve. 

Baseline

v Bottom: The Bottom option positions the text over the curve completely. The curve (path) will be

position at the bottom of the text. The characters such as small ‘g’ will be positioned over the curve

completely. 

Bottom

v Ascent: The Ascent option positions the text exactly under the curve, having the capital letter or

characters such as ‘h’, touching the curve from below. The curve line is positioned over exactly over the

text.

Ascent

v Top: The Top option positions the text under the curve by keeping a small distance from the curve.  

Top

Text alignment: You can change the Text alignment by selecting any of the three prefix text positions from
the Text alignment drop down menu of the tool options toolbar. The three options define the alignment of the
Text on a path or a shape object and are the following:

v Left: The Left option is the default option and sets the Text on path to start from the Left side of the path.
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Left Alignment

v Right: The Right option sets the Text on path to start from the Right side of the path.

Right Alignment

v Center: The Center option centers the Text on the path.

Center Alignment

Offset: The Offset numerical field specifies the distance of the Text from its current position. The default
offset value is zero and you can change it by either typing a new value in the field, and then press enter key
from the keyboard to apply it, or use the arrow buttons next to the field to increase or decrease the current
value. The Offset value can take positive or negative values and move the Text on the path accordingly. 

Reverse Direction: When you place Text on a path or on a shape the text takes the direction of the path. If
the path was drawn from left to right, then the Text will be also placed from left to right and over the path. On
the other hand if the path was drawn from right to left then the Text will be also placed from right to left but will
be positioned below the path. 

 

Path right to left  -  Path left to right

When the path or the shape was designed from right to left and the text you have placed on appears in the
opposite way from what you expected, you can simply check the Reverse direction checkbox and the text
will appear in the way you wanted to be. 

You can also edit the curve that the text was placed one. To edit the curve (path) you have to select the Edit
shape nodes option from the tools tab and edit its nodes. Any change you are making on the curve (path),
affects also the way the Text is placed on the curve. 
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Remove text from path

If you have Text placed on a path you can easily remove it by right clicking on it and selecting the Clear path
option from the right click menu that will appear. The Text will be removed from the path (curve object) and
will lose its curvature. The Text object will keep its attributes (Font type, size, style etc.) and it will position on
a virtual straight line which is the default position of every text you are inserting on the working area. 

The curve (path) object where the Text was placed on will remain as it was before applying the text on path
option. 

Monograming
As we have already described we can create a monogram design using the new design wizard. We can also
create a monogram design manually from scratch. 

1. Click on Monogram icon   that is located on Tool toolbar. 

2. On tool options toolbar we can see monogram customization options.

3. The cursor turns into add shape  icon 

4. Click and Drag to define the size of the Monogram. While dragging you can see a preview of the created
monogram. 
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5. Right click to apply the monogram.

6. After the monogram is applied, when we select the monogram object, the monogram customization
options are enabled on tools options and we can edit the created monogram. We can change all the
properties of created monogram (Font, Text and Monogram template).

7. At this point you can use the Insert Clipart library option is order to add a Frame to your monogram. 
There is also a more automated way to create a monogram. Many users may find it more useful to follow
the wizard steps to create a monogram and then copy the created design into an existing design. 

More information about can be located in New monogram section. We will now present available ways to edit
a monogram despite the way it has been created. 

Edit Caption

As we already mention in previous section we can edit an applied monogram at any time. First of all we can
simply change Characters, Font and-or Monogram template using tool options toolbar. 
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Starting from the monogram of the previous
section we can change any of the parameters
and the monogram is automatically aupdated.

We can change the used Font.

We can change the used Characters.

Finally we can change the monogram
template. This final monogram is a completely
new monogram. 

In following section we will demonstrate how to Edit the template of the monogram using node editor.
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Edit monogram template

The program comes we a set of monogram templates and we can select any of them using artwork source
wizard - new monogram or using tool options toolbar. All the monogram templates are consisted of 2 or 3
rectangular areas that the letters are added into them. The monogram mechanism makes the best fit of any
added character into any of the rectangular areas. Any of the templates has some 1,2,3 numbers on top of its
icon. The number on top of any rectangular area is the number of the used character. For example in
Template 11, the third character will be placed in the rectangular area of the center. From the characters 
"Qog" when applying the "Template 11" we have the "Qgo" monogram of the following figure. 

At this point we must mention that we have the ability to edit freely the inserted monogram containers inside
the Node editor and transform their shape. In the following example we will edit a created monogram using
Node editor mode. 

Select any applied monogram.

Edit shape nodes.
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As we can see any of the monogram characters is
surrounded by a rectangle that implements some
handles on the corners.  

Using node editing options we can completely
change the shape, the position, the orientation of
this area. 

When editing the area around of any letter the
program tries to automatically best fit the letter into
the new area. 

We will provide some examples of how we can edit the holding area of any letter. But as you are getting more
familiar to node editing functionalities you will find out that are various other ways to manipulate the node of an
object.

Edit curve - Move node(s)

In any of these cases the area that the character is placed changes and the letter is transformed in order to fit
the new area.

Place the mouse over any curve and by click
and drag we can change the curve. 

The shape of the Character area changes and
the characters shape changes in order to fit the
new area.
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In the same way we can move any corner
node to change the shape of the area. 

In the following example we will move more than one nodes in order to reshape a monogram template.

Initially applied monogram

Select the 2 nodes on the left side of
the left letter. 
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Move the selection up in order to
create a curvature to the letter

We will move the same nodes on the
right letter in order to create the
same curvature on the right side of
the monogram.

Just like that in a few clicks, we have
transformed the monogram template
and created a much different version
of the monogram.

Transform monogram area

Move - transform the whole character area.

We want to select all the nodes of the 2 "o" letters and move the letter in order to create overlapping of the
letters.

Right click on any node and from appearing menu use "Select polyline" option.
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Click and Drag to move the selection and release on top of lower part of the "B" letter.

We will do the same for the "o" letter that is on the right side of the monogram.

At this point we must mention that you can use Transform options of Node editor menu in order to Move,
Rotate, Scale and Slant a selection of nodes. 

Move selection 
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Rotate selection 

Scale selection 

Slant selection 

Overlapping areas

As we have already described if we use Node editing mode to transform - move monogram characters then
we may create monogram with overlapping letters. At this point we must mention that we have the ability to 
specify which section of a character will be under or above when two or more are overlapping. 
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In cases like that there are overlapping areas there is a mechanism to help us change the overlapping order. 

Place the mouse pointer over any overlapping area.
The area is highlighted.

Left Click on the highlighted area.

The overlapping order has changed. The part that was
on top is now underneath.

In the same way we can change the overlapping order for the bottom part of the letter.
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Initial overlapping order Modified overlapping order

Insert symbol
Furthermore from adding text you can also insert symbols. Insert symbol option, takes advantage of the
symbols that accompany any font that is installed into your computer. Each font type includes its own list of
symbols that are based on the artwork of Font. You can easily insert a symbol by activating the Insert
symbol option from Tools menu or by pressing Ctrl + F11 shortcut keys. The Insert symbol dialog will
appear where all symbols of a specific font will be listed. You can navigate yourself between the symbols by
scrolling with the scroll bar at the right side of the dialog. Once you have found the symbol you want to use
you have to select it and click the Insert button. 

Insert symbol dialog

By clicking the Insert button the cursor changes to cross, allowing you to insert the selected symbol on the

working area and the Insert symbol dialog disappears making more working space visible. 
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Horizontal placement with 5,33 mm width – Placed on an angle with 5,33 width 

To insert the selected symbol on the working area you have to click and drag with the mouse specifying the

width of the symbol and the angle you want to have from the horizontal axis. After releasing the mouse click

the symbol appears on the working area with the default fill and outline colors and the Insert symbol dialog

turned back on. You can insert as many symbols you want by following the same steps.

While dragging with the mouse useful information appear next to the cursor such as the Width and Angle. If

you hold the Ctrl key pressed while dragging, the cursor will snap on every 22.5o degrees allowing you to

insert the symbol on a specific angle. 

You can also change the symbols list you are viewing by changing the Font type. On top of Select Symbol

dialog you can view the current font that you are using. You can change the font by clicking on the current font

and from the list that will appear select a different one. The symbols will change accordingly allowing you to

insert new symbols on the working area. 

If you want to close the Insert symbol dialog you have to click on the close icon . You can also minimize it

by clicking on the hide icon . The minimize icon will make Backdrop properties to disappear and leave the

title bar to float on the working area. 

Minimize backdrop properties dialog

You can maximize the dialog by clicking once more on the show  icon.
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Clipart Library

Chapter XII

The software includes a very useful tool that allows you to insert existing or create your own clip-art designs
that you can reuse easily.

Whenever you inset a c lip-art the software will fill it with the default fill type and the default
outline/pen type, based on the active Techniques. 

In this section we will discuss the following: 

v Insert item from library

v Filter visible clipart items

v Change view

v Clipart names and Tags

v Adding items to clipart library 

Insert item from library

1. From Tools menu use Clipart Library item
and Insert sub item.

2. You can also use Ctrl+I keyboard shortcut in
order to open Object clipart dialog.

3. The object clipart dialog will appear.
4. We can select any of the available clipart to

add in the design area.
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5. Simply Click to select any item and by
pressing Insert we can add it on the design
area.

6. We can also right click on any item and use
Insert option. 

7. The cursor turns into a Cross waiting to
specify the position. 

8. lick and drag to add a reference line. 

9. The item is sized according to the size of the
arrow.

10.Release the mouse and the clipart is
automatically added.

We can also use a left click to place the clipart item into its original
dimensions.

Filter visible clipart items

We can easily filter visible items in order to see

more relevant icons according to what we are

looking for. 

We can also search for any clipart by searching by

name. In the lower part of the clipart library dialog

there are 2 type texts areas.

Search by name
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Type in Name text entry area to search for a clipart by name. While typing the list is automatically updated to show the
item that its name is a closest match to the text that has been types.

Filter visible items

There 3 ways to apply filters

1. Type any term, in Tags text area. 

2. Use the plus sign to pick any term from the drop
down menu. 

3. Right click on any item and from Tags submenu
select any of the available filter terms. 

Remove applied filters

1. Delete the text that from the text area.
2. Right click on any item and from tags menu item use

clear option.
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Change view

We can easily change from detail view into icon

view.

1. Right click on any item 
2. From appearing menu select View icons

Now we can see only the icon of any clipart item,
not its dimension or the currently used tags.
In the same way we can change into detail view. 

Clipart names and Tags

1. Right click on any item 

2. Use rename option to change the name of the

clip. 

3. Edit the name and press Enter key to apply
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1. In the same way as above we can also change the

available tags of any clip. 

2. Use a comma, to add more than one tags.

Adding items to clipart library
The power of the clipart library is that we can always create our own clipart items. Add items that you

like in library and you can have a powerful set of objects for reuse in any design.

There are 2 ways to add a design part into the library. 

Method 1:

1. Select any object
2. Start Insert clipart dialog 
3. From right click menu select Add

object option.
4. The selected object is added into the

clipart library. 

Method 2:

1. Select one or more objects
2. Use Create clipart option of Tools

menu. 
3. The cursor turns into a cross 

4. Click and drag to specify a reference
line.

5. Type a name and the clipart item has
been added.
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It is a very good practice too add names relative to the item and tags in order to reuse the item easy at
any time.
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Array

Chapter XIII

The Array is a new fill type that uses a base object or a clipart item to create an area fill or an outline fill
using the base object. When applying  Array fill, a pattern grid is created and copies of the base object are
placed on the grid in a patterned way. 

Whenever you apply Array fill the software will fill the shape used with the default fill type
and the default outline/pen type, based on the active Techniques. 

You can use any shape for creating an array fill/outline, such us embroidery, cut, stencil, crystals and paint
objects.

For example the shape on the left part of the following figure is used as a base object. Using the base object
we have applied Array on the fill area of the circle (middle part of the figure), and array on the outline of the
same circle (Right part of the figure).

Using Array (Fill or Outline) you can create amazing effects. In the following sections we will present how to
apply Fill or Outline array, the customizations that can be applied and the various tools that the Array can be
combined to.

Base object Array on object fill Array on object outline

Array on Object Fill
In this section we will demonstrate how to apply Array on an object's fill. In order to apply the array fill you
must first select one or more objects to be used as fill object. You can use as fill object any part of your
design or any item from the Clipart library. There are 2 methods to apply the array fill, In the following
example we will present in detail the available methods. 
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Object with applique fill Array fill with a design object

Method 1. Use any item from clipart library 

Select any object that you to apply Array fill on.

Press Array  icon.

The Clipart dialog appears to select any clipart item  to
be used in order to fill the area of the objects with copies
of the clipart. 
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Select a Clipart item and insert it like adding a clipart.

By releasing the mouse the selected clipart item will
be applied as array. It is not added on the design area
only in the selected object’s fill, in a patterned way.

We can always select the object with the array fill and by pressing again Array icon , the Clipart
library dialog will appear again to select another clipart item. The second method to apply the Array fill is
described below. In this method we are not using a Clipart item as fill object, but we are using a part of the
design.

Method 2. Use a part of the design as fill item.
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Select an object to be filled.

Use Ctrl key in order to add one or more objects  to the
selection. This object will be used as fill object.

The base object must be smaller than the object to be filled.

Press Array  icon or right click on the selection and
from appearing menu use Create Fill from Shapes option of
Array submenu.
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The larger object is automatically filled with the smaller
object placed in a patterned way.

When an Array fill is applied we can replace the fill object at any time in various ways. 

1. Press Array icon to use a clipart item

2. Select a design object together with the already filled object and click on array icon to change the existing
fill and use the newly selected fill object.

Any of the above ways to replace can be also performed by using a right click on the filled object and then
using Create fill from shapes option.

There are various options that you can adjust in order  to customize the way that the array is applied and edit
the applied array. These options will be presented in the following section.

Edit Array fill

When you have applied an Array fill, you can see that the Array object has various parameters that you can
adjust. There are some parameters that are common for all Array objects and  the others vary according to
the selected fill pattern. You can edit the fill pattern in 2 ways. First by using the parameters of each pattern
provides or by the pattern handles of Node editor. 

The available fill patterns are  5 as shown in the following figure. The usage and the ways to edit the fill
patterns will be described int o the following section.
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In this section we will present the common parameters of the array objects (Offset, Item rotation, Trim
Shapes and Separate to objects). 

Offset 

The Offset parameter specifies the distance between the outline and the cut edge of the repeated object. 

Item rotation

This parameter rotates the base object. Specify the rotation of the object in degrees and all the copies of the
array are rotated like if the initial object was rotated in these degrees.

Item rotation 0 Item rotation 45

Trim Shapes 

With trim shapes parameter you can specify whether the repeated objects will be cut according to the
outline of the object in which they are repeated or if the software will nevertheless repeat the objects on the
edge.

With trim shapes Without trim shapes

Separate to objects

By using the Separate to Objects button you can convert the repeats of the array into individual objects.
This means that you are able to delete, move or manually add/copy objects. This option is mainly used to
avoid overlaps and to refine certain designs.
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More information about the available parameters of Array fill can be located in
Embroidery Transformations chapter in the respective section of Fill properties.

Array - Fill patterns

The Fill pattern is the most important parameter of the Array fill. When applying Array fill we must first
select one of the available fill pattern and then customize the pattern using: 

The available parameters of each fill pattern. 

The pattern handles that appear when using Node editor.

All the options that are used in order to customize the fill
pattern of the array can also be adjusted visually using the
available pattern handles of Node editor.

The available pattern handles and their usage also vary according to the Fill pattern. The following example
will provide information on how we can access these pattern handle but their usage will be presented into
following section separately according to the selected fill pattern. 

Select the object with the array fill.

Start Node editing mode by pressing on Node
editor icon.
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On the center of the object the pattern handles
appear. 

Using the pattern handles of the above figure we can change various parameters that vary according to the
fill pattern. 

· Rectangle

· Circular

· Contour

· Single Line

· Shape Fit

· Line Fit

For normal objects when entering Node editing mode you can edit their outline. When using Node editing
mode for object with applied Array fill only some pattern editing handles are available. We can also edit the
outline of these objects but this process will be described later into a separate section.

Rectangle

When applying Array using Rectangle fill, a rectangular grid is created and copies of the fill object are
placed on the grid. You can edit the look of the array in 2 ways. First by using the object properties to control
the Horizontal - Vertical distance and Start - Slant angle. 

· Horizontal Spacing 

· Vertical Spacing 

· Start angle 

· Slant angle

You can also edit the look of the array using the controls that appear on node editing mode. As you can see
on the following figure a corner pattern handle appears in node editing mode. 
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There are three control points:

· Using control handle 1 you can adjust both Vertical distance and Slant angle.

· Using control handle 2 you can change the center of the array. This is the the first object of the array the
whole rectangular grid is based on this object. All the other objects will be placed based on the position of
the first, following the parameters of the array fill type.

· Using control handle 3 you can adjust the Horizontal distance and the start angle.

The distance between control points 2 and 3 specifies the Spacing parameter.

The angle of 2-3 line, specifies the Starting angle.

The distance between control points 1 and 2 specifies the Vertical Spacing parameter.

The angle of 1-2 line, specifies the Slant angle.

Horizontal Spacing

This numeric value defines the horizontal distance between the copies of the same horizontal line. You can
type any numeric value in millimeters and press Enter to apply. You can also adjust the spacing between
horizontal copies, in node editing mode, using the control handle that is indicated on the following figure.
Click and drag to change the length of the line that ends on the handle, the horizontal distance changes
according to the movement of the control handle. At this point we must mention that you can hold Ctrl key so
that the movement will snap on the horizontal axis.

Horizontal Spacing 0 Horizontal Spacing 1,5

The part of the line that this handle is placed on is also the Start angle that the rectangular grid is based on.
If the Start Angle is 90 degrees as on the figure below then it looks like we are editing the vertical distance,
but the direction of the object has also changed.
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Vertical Spacing

This numeric value defines the vertical distance between the lines. This part of pattern handle is placed on
top of the slant angle. You can enlarge this handle to increase the vertical distance. 

Vertical distance 0 Vertical distance 2mm

Start angle

This numeric value defines the degrees that the pattern fill will start from. You can also move the node as
indicated in the following figures in order to change the start angle. In reality the placement pattern changes
angle at once. The pattern handle is moving as is. The angle between the lines of the handle remains the
same when editing the handle that adjusts the start angle. 

Move this node to change the start angle The start angle has changed and the whole place of the pattern.

Slant angle
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The slant angle defines the pattern placement. This numeric value defines the degrees of the pattern handle
corner. As we can see on the following figure Slant angle is 90 degrees. 

You edit the numeric value on Object properties toolbar but we can also move this node as shown on the
following figure in order to change the Slant angle.

The slant angle has changed and you can see that the fill pattern is a lot different. All other option remain
unchanged, that's why we have this overlapping. You must now change Horizontal - Vertical distance in order
to improve array appearence.

Finally we must mention that we can move the center of Array fill (Control point 1) in order to change how
copies the copies are placed. By default the center of the array  is placed on the center of the object. As we
can see the center of the first copy starts from the center but all the copies on the bottom- top of are not
whole. We don't like the placement of the copies at the edges of the object as we can see the left part of the
figure. Move the center of the array as indicated in the right part of the figure below and see how all copies fit
inside the shape. 
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Circular

When applying Array using Circular fill, a Circular grid is created and copies of the fill object are placed on
the circle. Detailed information about all the properties of Array fill can be located in the respective section of
Embroidery transformations chapter.  At this point we will only present the properties that affect the array
fill pattern.

· Horizontal Spacing 

· Start angle 

· Steps

Horizontal Spacing

When applying Array fill using Circular appliance option, the program creates copies of a base object and
places the copies on a Circular grid. The circular grid has inner circles. Using this option you can define the
distance between the circles. In reality the Spacing parameter specifies the distance between the rectangles
which include any of the copies. 
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In node editing mode a pattern handle appears. Using the nodes of this pattern handle we can adjust
Horizontal spacing.

Click and Drag to move this node, in the direction that is shown by the arrow in order to to increase the
Horizontal spacing or to the opposite direction in order to decrease the Horizontal Spacing. While Dragging
you can see the handles enlarging, release the mouse to apply the operation.

  

Start angle
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In circular placement there is always a line that the copies are placed on a straight line and the rest of the
copies follow the placement of this start angle line. The whole pattern changes to follow the start angle, the
copies of each circle are placed according to the start angle line.

Steps

The Steps parameter, defines the increase Step of added copies on inner circles of Circular placement,
starting from the center of the Array. First a copy is added to the center of the circle. Then in first circle the
number of copies is the number that is defined by Steps property, in our case we have 8 copies. The next
circle increases the number of included copies by the Step number, so the second circle has 16 copies. The
third circle will have 24 copy objects etc. The object of the same circle are distributed evenly.

When editing Circular array fill using node editor there are three control points:

vControl point 1 specifies the position of the first object that will be
repeated. All the other objects will be placed based on the first one,
following the parameters of the Circular array. We can move this
control point and change the center of the circle. 

vThe distance between control points 1 and 2 specifies the Spacing
parameter. In reality the numeric value defines the distance between
the rectangles that include any of the copies and not the length from
node1 to node2.

vUsing the Control node 2 you can specify the Start angle.

vUsing the control node 3, you can adjust number of Steps property. 

As we have mentioned before we can move control point 1 (The center of the circle)  in order to create
design like the above. Starting from the design on the left with the standard circular pattern we can easily
change into the design on the right with the moidfied centerof the circle.
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Contour

Contour array has the following parameters:

H. Spacing

The Horizontal spacing parameter specifies the distance between the rectangles that include each
repeated object of the same contour. The Spacing in this case may not be precise, since the objects of the
same contour should be distributed evenly.
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V. Spacing

The Vertical spacing parameter specifies the distance between the rectangles that include each repeated
object, of different (adjacent) contours. The Spacing in this case may not be precise, since the contours
should be placed in a way that does not leave big gaps in the middle of the object.

Follow angle

With the Follow angle parameter you can specify if the repeated object will be rotated, to follow the direction
of the outline or if it will keep the angle of the original object.

With “Follow angle” Without “Follow angle” 

Node editing of Contour array

When selecting an object which is filled with Contour array and clicking on the Node Editor icon, you can
edit the control points of the objects placement. There are three control points
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vControl point 1 specifies the offset of the parameter, where the first
contour will be placed.

vThe distance between control points 1 and 2 specifies the Spacing
parameter.

vThe distance between control points 1 and 3 specifies the Vertical
Spacing parameter.

You cannot change the angle of 1-2 and 1-3 lines since there is no
meaning in changing the starting or slant angle in contour fill type.

If you wish to edit the outlines of the object you have to enable the
parameter “Edit outline” from the “Tool options” toolbar

Single Line

Single line array has only the following parameter:

Spacing

The Spacing parameter specifies the distance between the rectangles that include each repeated object. The
Spacing in this case may not be precise, since the array of the same letter should be evenly distributed. 
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Shape Fit

Shape fit array has the following parameters:

H. Spacing

The H. Spacing parameter specifies the distance between the rectangles that include each repeated object.
The Spacing in this case may not be precise, since the objects of the same letter should be evenly
distributed.

V. Spacing

The Spacing parameter specifies the distance between the rectangles which can include each repeated
object.

Start angle

The Starting angle parameter specifies the angle of the horizontal lines of repeated objects, which will fill the
area you specified. When the starting angle is set to 0 degrees, the lines will be horizontal.
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Node editing of Shape fit array

When editing an object which is filled with Shape fit array in Node editing mode, you can edit the control
points of the array placement.

There are three control points:

Control point 1 specifies the Vertical position of the first object
of the array. All the other objects will be placed based on the
first one following the parameters of the array fill type.

The distance between control points 1 and 2 specifies the
Spacing parameter.

• The angle of 1-2 line, specifies the Starting angle.

• The distance between control points 1 and 3 specifies the
Vertical Spacing parameter.

The angle of 1-3 line cannot be changed since it has no
meaning for the Shape fit array.

If you wish to edit the outlines of the object, you need to enable
the parameter “Edit outline” from the “Tool options” toolbar.

Line Fit

Line fit array has the following parameter:

H. Spacing
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The Spacing parameter specifies the distance
between the rectangles that include each repeated
object.

The Spacing in this case may not be precise, since
the copies of the same letter should be evenly
distributed. 

Line fit fill array does not have control points in node editor.

Edit outline

One very powerful feature of Creative DRAWings is that can edit the shape of any created object at any
time using Node editor. For the objects that have Array Fill applied by default we can't edit their outline. As
we have already mentioned when using Node editing mode for these object we can edit the fill pattern using
the pattern handles. 

Pattern Handles Array Fill 

In case that we want to edit the shape-outline of the object when using node editor as for any normal object
we must enable Edit outline option of Tools options toolbar. 

Edit the outline of object's with Array fill.

After enabling Edit outline option we can Edit the outline of the object as any normal other object.
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Edit outline enabled Move any node The shape of the object has changed

More information about Editing Nodes is provided into a separate chapter.

Array on Object Outline
Array can can also be used for object's outline. We can select an object to be added on the outline of any
object. When this option is applied the selected design part or Clipart item is added on the outline of the
selected object. For example in the following figure you can see the initial Satin serial object on the left part,
and on the right part the initial object after  we have applied Array outline using this small leaf.

Satin Serial outline Array outline with this leaf

In this section we will demonstrate how to apply Array on the outline of any object. In order to apply the array,
you must first select one or more objects to be used as copy object. You can use as copy object, any part of
your design or any item from the Clipart library. There are 2 methods to apply the array fill, In the following
example we will present in detail the available methods. 

Method 1. Use any item from clipart library 
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Select any object that you to apply Array on.

Press Array  icon.

The Clipart dialog appears to select any clipart item  to
be placed on the outline of the selected object.

Select a Clipart item and insert it like adding a clipart.
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By releasing the mouse the selected clipart item will
be applied as array. It is not added on the design area
only in the selected object’s outline.

We can always select the object with the array outline and by pressing again Array icon , the Clipart
library dialog will appear again to select another clipart item. The second method to apply the Array on outline
is described below. In this method we are not using a Clipart item as fill object, but we are using a part of the
design.

Method 2. Use a part of the design as outline item.

Select an object.

Use Ctrl key in order to add one or more objects  to the selection.
This object will be used as copy object.

The copy object must be smaller than the object that the array will
be applied.

Press Array  icon or right click on the selection and from
appearing menu use Create Outline from Shapes option of Array
submenu.
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The outline of the larger object is automatically filled with the
smaller object.

When an outline Array  is applied we can replace the copy object at any time in various ways. 

1. Press Array icon to use a clipart item

2. Select a design object together with the already filled object and click on array icon to change the existing
outline and use the newly selected object. You can also right click on the filled object and then use 
Create outline from shapes option.

The available options that you can adjust in order to customize the way that the array is applied are described
into the following section. Outlines array does not have control points in node editor. We can only edit the 
outline (shape) of the object but this procedure will be described into a separate section.

Outline array options

Offset

The offset parameter specifies the distance between the outline and the center of the repeated object. The
offset parameter can also accept negative values from -15 to + 15 mm.

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -15mm and highest value 15mm. Also, you can increase or
decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
outline to have from its initial position. The default offset value is zero and can be changed only from you. Any
changes you are making on the offset value it is previewed on the design.
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No offset 4mm offset

Item rotation

This parameter rotates the base object. Specify the rotation of the object in degrees and all the copies of the
array are rotated like if the initial object was rotated in these degrees.

Item rotation 0 Item rotation 45

Spacing 

The Spacing parameter specifies the distance between the rectangles which can include each repeated
object. The Spacing in this case may not be precise, since the copies letter should be evenly distributed and
the software also places repeated objects on sharp corners (1-135 degrees). Using this option you can
define the distance between the copies of the array. The distance is defined in Millimeters.  In the numeric
field you can type the distance in "mm". You can also adjust Spacing by clicking the arrows next to the value

or by clicking on the value and rotating the mouse wheel  if there is one. Changes are instantly previewed
on the design area and can be set by clicking outside the density field.
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No spacing 2mm Spacing 

Array and Cloned objects
When using tools, like Array fill, that create repetitive patterns it is very useful to change any part of the
pattern and improve - change the whole pattern. Using the control handles of the array we can change the
placement of the array copies but using Array together with Cloned objects can help us create amazing
patterns.

We will provide 2 simple examples on how this toll combination works.

· Array on Object fill

· Array on Object Outline

Edit Clones (Fill)

One of the powerful combinations of Array fill is that it can be used together with Cloned objects in order to
create amazing repetitive fill or Outline patterns. In this section we will provide a simple example on how
combine these tools. 

This is the initial object that we will use to fill a
rectangular area. 

Make sure that Add new objects as clones
option of Edit menu is enabled.

Apply Array fill on this rectangular area. 

For the purpose of this example we are using 
Rectangle fill, the procedure is the same in any
fill pattern.



399Array

© 2017 DRAWstitch Ltd.

Using Node editor, edit the shape of the initial
object.

Any shape change on the initial object is
automatically applied on the array fill.

Using select polyline option you can rotate the
whole object and change the pattern completely.

Make as many transformations you like in order
to create any fill pattern you like.

Edit clones (Outline)

As we presented in previous section using Add new objects as clones option together with Array fill we
can create amazing fill effects - patterns. In the same way we can use Cloned object for Outline array. 

Starting with this shape like triangle we will place it on the outline of the circle.See how the shape
has been applied.
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We will move this upper node of the triangle in order to change the shape. The shape outline
array object is updated at once.

Using select polyline option we will rotate the whole object 180 degrees. The placement patter
changes completely. 

Finally, using Select polyline once more will rotate the object again in order to create the
outlinje pattern of the figure below. 
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You can see how easily we have started from this initial applied array and with a few clicks we have created a
whole new outline pattern.

Nested array
In this section we will present a way to use Circular array tool together with Array on objects fill and
Cloned objects. The combination of these 3 tools can be used in order to create amazing fill patterns.  In the
same way we can use Rectangular or Circular array with Array on Fill or on Outline and Clone objects in
any combination between them. Any combination of them can be used in order to create different types of
patterns. 

Starting from this simple shape.

Use Circular array tool and customize the array in any way
you like.

Before applying the array make sure that Clone objects
option is enabled. 
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Using Circular array tool we have created this set of objects.

We will now use the created set of objects in order  to fill an
area using Array on Object fill.

Each of the produced objects is handled separately. We can
group them in order to be able to work with them easier.

We will use this circular set of objects, in order to create a fill
on the rectangular object.

Select both objects and Click on Array icon of Fill tab of
object properties toolbar.

The rectangular area is filled with the initial set of objects in a
patterned way. In our case we have used rectangular fill
pattern.

Use Node editor to edit the shape of any of the copies.
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The shape of all the objects has changed to reflect the shape
change. 

Just like that you can see that the pattern has changed
completely.

Change the pattern fill From Rectangle to Circular.

Change the shape a little more and the pattern has completely
changed.
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Crystals - Creating designs with Crystals

Chapter XIV

Creative DRAWings gives you the ability to add crystals/rhinestones/strass in your designs and make them
look beautiful. It includes various methods to add crystals in the designs. You can add them crystal by crystal,
fill shapes with crystals, create line art designs with crystals and fill outline shapes with crystals. Each
method gives you a lot options that can help produce the result you want. 

In order to be able to use the Embroidery tools of the software you will have to enable the 

Crystals Technique  from the Techniques  option. 

Design with crystals

The various methods that you can use to create crystal design will be analysed in this section.

The material you need in order to produce cutting templates are: 

· Template material

· Backing board for a firm surface to mount the template 

· A Brush to position the rhinestones

· Transfer tape to move the crystals/Rhinestones to your project

· and of course Rhinestones

Insert Crystal shapes

With the Insert crystal shapes  designing tool you can insert crystals anywhere in the design by simply
selecting the tool and and left clicking once in the position you want each crystal to be added. If you want to
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end the insertion of crystals you have to right click once or to select a different tool from the Tools toolbar
like the Rectangle selection tool.

When you select the Insert crystal shapes designing tool, relevant options appear on the Tools options
toolbar. These options allow you to select the Palette of the crystals you want to add crystals from, specify
the Color/Shape you want to use and the Size of the crystal you want to add.

crystal options

Make the adjustment you want on the Tool options toolbar and you can start inserting single crystals on the
design by simply clicking on the position you want to add them. You can change the Palette, the
Color/Shape and the Size after the crystal insertion from the Object Properties toolbar. Select the crystal
you want and you will be able change its properties from the Object Properties toolbar. Also, you can make
multiple selection of crystals and make changes to all of them at the same time. 

Create a design with crystals

1. Select the Insert crystal shapes  designing tool
from Tools toolbar.

2. From the Tool options toolbar select the Palette
you want to use from the respective drop down
menu.

select palette 

3. Then from the Color/Shape drop down menu
select the crystal/rhinestone you want to use by
clicking on its name. 

Select crystal Color/Shape
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4. From the third drop down menu you can select the 
Size of the crystal you want to add. 

crystal size

The actual size of the crystals varies between the
rhinestone manufacturers and this is the reason
why there are two values with the same crystal
size. You have to select the correct size based on
the dimensions of the crystals you have purchased.
Each crystal manufacturer states the actual crystal
size on the packaging. the following table will help
you select the correct size for the crystals you have
purchased. 

Crystal size table

5. Now you can start inserting crystals in the design by
simply left clicking on the position you want to be
added. 

6. With some clicks you can create easily a design
like this one.

design with single crystals

Crystal Fill
Creative DRAWings gives you the ability to fill objects with crystals with a single click. You can load existing
designs or create your own and produce the results you want.
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The Crystal fill is a new fill type. When it is applied, the object is filled with Crystals, in a patterned way. For
example, the circle of the following figure, in the beginning, it is filled with step. Then by using Crystal fill it is
filled with Crystals in a patterned way (Rectangular). 

Applique fill Crystal fill

When applying Crystal fill there are various options that you can adjust in order to customize the way that
the Crystals will be applied. 

Create a design with Crystal fill

1. Select the Create ellipse  tool and draw an ellipse
by clicking and dragging on the working area.

Create ellipse
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2. Select the Create outline shape  tool and draw a
curve line to make it look as a string attached on a
balloon. 

balloon string

3. Select the ellipse and click on Crystal fill icon
from Object properties toolbar.

Balloon Crystal fill

4. Select the entire design by using the rectangle selection
tool, and from the right click menu select Copy option.

Right click and select Copy 

5.Then right click once more and from the pop up menu
select Paste option.

Right click and select Paste 

6. The design will be pasted exactly over the original one.
While it is selected click and drug it in a new position. 
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7.The pasted designs are always coming grouped. Right
click on the pasted design and select Ungroup option. 

Right click and select Ungroup 

8. Select the ellipse with the crystals and select Palace
green opal crystal from the Color/Shape list.

Change Color/shape of crystals

9. You can repeat steps 4-8 as many times you want and
produce great balloon design with crystals for your kid. 

Beautiful balloon design

10. Optionally you can resize the balloon design and have it
various sizes.

Create a design with crystals

Every crystal fill object that you are creating can be adjusted with the options that appear in the Object
properties toolbar. You can change the fill pattern, the spacing between the crystals, the crystal size, the
crystal color/shape and other options that will be explained through examples in this section. 

We will analyze the available options through the creation process of a design with crystals. We will use a
symbol and transform it to a beautiful design. 

1. From Tools menu select Insert symbol option.

2. From the Font list select Webdings and then design with the bouquet of flowers.
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Insert symbol dialog

3. Insert the bouquet of flowers in the working area by selecting Insert and then click and dragging to specify
the designs size.

bouquet symbol design

4. Remove the outline from the design by setting the pen color to empty  and from the right click menu
select Break apart option.

Break apart the design

5. Select the entire design and click on the Crystal fill  icon from the Object properties toolbar or
from the right click menu expand Array option and then select Create crystal fill.
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Break apart the design

6. The design will be filled with crystals automatically. with a first look the result is not attractive but Creative
DRAWings gives you all the needed to make it so. 

bouquet filled with crystals

7. First we will change the Color/Shape of the crystals that are placed on the flowers. Select a bud by
holding the Shift key pressed and clicking first on the bottom object and then on the top object. 

select bud

8. From the Object properties toolbar select the Palette of crystals you are using. Currently there are three
palettes available. The Default Palette, the Swarovski Round and the Preciosa VIVA12. 

select palette

Each crystals' creator palette contains only the crystals that are included in the specific collection. After
selecting, for example Swarovski Round palette the crystals that includes appear on the Color/Shape
list from where you can select any crystal by simply clicking on it. 
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Color/Shape

If you do not have any of the available palettes your only alternative is to use the Default palette. The
Default palette contains only one crystal. You can use this crystal to fill all your crystal designs and
change its color by simply changing the color of the shape where crystal was placed. Therefore with only
one crystal you can apply any color you like by changing the color of the shape. 

In our example with will select the Swarovski Round palette and apply the Topaz crystal on the selected
bud. 

apply Topaz color/shape

9. We will do the same for the rest buds by assigning different Crystal Colors/Shapes.

change colors/shapes to crystals

10. The next thing we have to do to improve our design is to adjust the Fill pattern of each shape in the
design. This is important because not all Fill patterns fit on all shapes. Therefore based on the shape and
the look we want to give to our design, we set a different fill pattern. By default the fill pattern to all shapes
is set to Shape fit. To change that you have to select the object you want and from the Fill pattern drop
down menu select a different one.
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Single line Fill pattern Circular Fill pattern Contour Fill pattern

line fit Fill pattern Shape fit Fill pattern Rectangle Fill pattern

Each Crystal Fill pattern has different parameters that you can adjust to produce the results you want. We
explain each Crystal Fill pattern and its options later in this chapter. In this example we will set all buds to
Contour Fill pattern and the rest objects to Single line Fill pattern.

Contour & Single line fill pattern

11.If you want you can edit each Fill pattern by adjusting the vertical (V.Spacing) or horizontal (H.Spacing)
spacing of crystals, the Start angle and the Slant angle (Rectangle fill pattern), the expansion Steps
(Circular fill pattern) and add offset to increase or decrease the distance of crystals from the shape's
outline.

12.One final adjustment that we will do to our design is to change the Size of crystals. Select the three stem
objects and set the crystal size to SS20 from the respective option of the Object properties toolbar.
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Change crystal size

The sizes list varies based on the crystal Palette you have selected. The sizes that are available on the
list are those that the specific palette supports. Only the Default palette contains all crystal sizes. 

13. The design is ready. Within some simple steps we managed to create a beautiful design that can be
created from everyone easily. 

14. The only thing that remains is to export the design to the cutting machine and start creating the holes
where the crystals will be placed on. 

Edit Crystal fill object's outline

One very powerful feature of Creative DRAWings is that can edit the shape of any created object at any
time using Node editor. For the objects that have Crystal Fill applied by default we can't edit their outline.
Only single line and Line fit Fill patterns retain the ability to edit the outline directly. As we have already

mentioned when using Node editing  mode for these object we can edit the fill pattern using the pattern
handles. 

Pattern Handles Crystals shape fit

In case that we want to edit the shape-outline of the crystal object when using node editor as for any normal
object we must enable Edit outline option of Tools options toolbar. 
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Edit the outline of object's with Array fill.

After enabling Edit outline option we can Edit the outline of the object as any other object.

Edit outline enabled Move outline The shape of the object has changed

More information about Editing Nodes is provided into a separate chapter.

Overlapping Crystals

This option is very useful when you are creating designs with crystals. You can enable this option from View
menu by selecting Overlapping crystals. By enabling this view all crystals that overlapping will be marked
with an 'X' in order to be easily recognizable.

If the overlapping between the crystals is limited on the outline of the crystals the 'X' will be yellow. 

Crystals outline overlapping

If the overlapping between the crystals is on the actual crystals the 'X' will be red. 

Actual crystals overlapping

Every time you finish a design with crystals it is a good practice to enable the Overlapping crystals option in
order to check if there is any overlapping in your crystals that you have not noticed and needs to be fixed.
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Notice: It is  advisable not to leave the Overlapping Crystals always on because it might
slow down your PC. 

Crystal fill - Common parameters

There are Crystal fill parameters in the Object properties toolbar which are common for all types of fill
areas. Those are:

· Palette

· Size

· Color / Shape

· Offset

· Item rotation

· Separate to Crystals

Palette

From the Object properties toolbar select the Palette of crystals you are using. Currently there are three
palettes available. The Default Palette, the Swarovski Round the Preciosa VIVA12, the Swarovski Drop,
the Swarovski Square and the Swarovski Triangle . 

select palette

Each crystals' creator palette contains only the crystals that are included in the specific collection. After
selecting, for example Swarovski Round palette the crystals that includes appear on the Color/Shape list
from where you can select any crystal by simply clicking on it. 

Color/Shape

If you do not have any of the available palettes your only alternative is to use the Default palette. The
Default palette contains only one crystal. You can use this crystal to fill all your crystal designs and change
its color by simply changing the color of the shape where the crystal was placed. Therefore with only one
crystal you can apply any color you like by changing the color of the shape. 
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Color-Shape

The available crystal colors/shapes depend on the Palette you have selected. Currently there are two
palettes available with rounded crystals Swarovki and Preciosa.

Color/shape Swarovski Color/shape Preciosa

The Swarovski palette has 85 crystals and the Preciosa 59. You can apply any one of them by simply
selecting it. Also the Color / Shape list has special selection abilities that you can view in the Make
Selections chapter.

There are three more Swarovski palettes with different shapes: Triangle, Square and Drop. You can select
any of them and use them in your designs. 

Different crystal shapes

If you do not have any of the available palettes your only alternative is to use the Default palette. You can
use this crystal to fill all your crystal designs and change its color by simply changing the color of the shape
where crystal was placed. Therefore with only one crystal you can apply any color you like by changing the
color of the shape. 
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Size

The available crystal sizes depends on the palette you have selected.  For example: 

Swarovski has 15 different sizes

Preciosa has 4 different sizes

Default Palette 33 different sizes

The Swarovski Round palette has 15 different crystal sizes, the Preciosa has 4 and the Default palette
includes all possible sizes that can be cut from the cutting machines, 33 sizes. The Size selection table
includes different values in order to be easier from the user to select the one that corresponds to the
crystal/rhinestone he wants to use. 

· SS: SS stands for Stone Size. This name is used for flat back and larger pointed back stones

· PP: PP stands for Pearl Plate. This name is used for stones and it comes from pearl sizing techniques.
The size approximation is 1/2 PP = SS

· mm: This value shows the approximate size range of the crystals in millimeters. 

· inch: This value shows the exact size of the crystals in inches. 

Usually the crystal packages mention the actual size of each crystal. The size is very important for the
software because all the crystal hole sizes are calculated based on this value. If for example you select a
larger size from the actual size of the crystal you want to use, the holes will be larger and the pattern after
placing the crystals might not be correct. If you do the opposite the crystals will not fit in the holes you have
cut. 

The default crystal size of the software is SS10 or PP21- PP22.



419Crystals - Creating designs with Crystals

© 2017 DRAWstitch Ltd.

Offset

The offset parameter specifies the minimum distance between the outline and the center of the Crystal. 

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -15mm and highest value 15mm. Also, you can increase or
decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
outline to have from its initial position. The default offset value is zero and can be changed only from you. Any
changes you are making on the offset value it is previewed on the design.

Offset distance

The offset distance value starts from the outline until the center of the crystal. Therefore, every time you want
to set offset you have to keep in mind the way the software calculates it. 

Item rotation

With the Item rotation you have the ability to rotate the crystals you have inserted in the shape. 

Item rotation

You can increase or decrease the Item rotation value by clicking on the arrows next to the value or by
clicking on the value and rotating the mouse wheel. The value that you are inserting defines the exact rotation
angle you want the crystals to have from their initial position. The default Item rotation value is zero and can
be changed only from you. Any changes you are making on the Item rotation value it is previewed on the
design. The crystal rotation is always counter-clockwise. 
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0 degrees                                                                      25 degrees                                                                   90 degrees

A proper combination of Item rotation option with Circular or Contour Fill patterns can produce beautiful
crystal designs.

Separate to crystals

By using the Separate to Crystals button you can convert the selected object into individual Crystals. That
means that you are able to delete, move or manually add Crystals.

This option is mainly used to avoid overlaps and to refine certain designs.

Also, is very useful when you want to create a shape filled with crystals and then assign different crystal 
Color/Shape to parts of the design. 

Separate to crystals

Keep in mind though that you cannot group the separated crystals back to an crystal fill object. Therefore
keep the Separate to crystals option as your last choice or keep a duplicate object of the one that you will
Separate to crystals in order to be able to go back and edit it again

Crystal Fill patterns

In this section we will analyze the rest options that are available for editing Crystal fill objects separated by
their Fill pattern. Each Fill pattern has some unique options that affect differently the pattern where they
belong. We will analyze them separately in order to be clear how they work and what you can create by
editing them. The Fill patterns that we will analyze are the following:
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· Rectangle

· Circular

· Contour

· Single line

· Shape fit

· Line fit

Rectangle

The Rectangle fill pattern has the following extra parameters:

1. H. Spacing 

2. V. Spacing

3. Start angle

4. Slant angle

H. Spacing

The H.Spacing (Horizontal Spacing) parameter specifies the distance between the outlines of the crystals.
For this calculation the “Crystals cut offset” (blue circle around the crystals) is not taken under consideration .

Horizontal Spacing

The default value of the H.Spacing is 0.8mm and is calculated by adding the Crystal cut offset (0.4mm)
together with the Crystal minimum hole spacing (0.4mm). These values can be adjusted from Tools
>Optimizer options... dialog.

V. Spacing

The V.Spacing (Vertical Spacing) parameter specifies the vertical distance between the outlines of the
crystals. For this calculation the “Crystals cut offset” (white circle around the crystals) is not taken under
consideration.
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Horizontal Spacing

The default value of the V.Spacing is 0.8mm and is calculated by adding the Crystal cut offset (0.4mm)
together with the Crystal minimum hole spacing (0.4mm). These values can be adjusted from Tools
>Optimizer options... dialog.

Start angle

The Starting angle parameter specifies the angle of the horizontal lines of crystals which will fill the object you
created. When the starting angle is set to 0 degrees, the lines will be horizontal. By changing the angle you
will get different results on the Rectangle fill pattern. Each shape might need different Start angle in order the
pattern to fit in the design. Therefore it is good practice to change values until you find the one that is
appropriate with the design. 

For better result also you will have to adjust the H.Spacing and V.Spacing values. By adjusting the spacing
between the crystals you will be able to apply the pattern you want.

Start Angle 0o Start Angle 45o Start Angle 135o

The Start angle parameter it is also specified in the design with the horizontal green handle. This handle can

be edited while you are in Edit shape nodes  mode and the Edit outline  option is
unchecked from the Tools options bar. 

This parameter is especially useful when you want to force pattern to start from a specific angle that fit better
on a specific shape. 
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Slant angle

The Slant angle parameter specifies the way in which the crystals will be repeated vertically. When the Slant
angle is set to 90o degrees the crystals will be placed vertically in lines. The range of values that this
parameter can take varies from 10o degrees up to 170o degrees. By changing the Slant angle you can create
different patterns that will fill better in the design you are creating. 

For better result also you will have to adjust the H.Spacing and V.Spacing values. By adjusting the spacing
between the crystals you will be able to apply the pattern you want.

Start Angle 90o Start Angle 115o Start Angle 60o

The Slant angle parameter it is also specified in the design with the vertical green handle. This handle can

be edited while you are in Edit shape nodes  mode and the Edit outline  option is
unchecked from the Tools options bar. 

Node editing of Rectangle fill area with Crystals

When selecting an object which is filled in with Rectangle Fill pattern and clicking on Edit shape nodes 
icon , you can edit the control handles of the crystal placement. If you cannot see the control handles as they

appear in the images below you will have to uncheck the Edit outline   option from the Tools
options bar. Then you will see a 90o green corner  at the middle of the design.

There are three control points:
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Control handles

1. Control point 1 specifies the position of the first crystal in the design. All the other crystals will be placed
based on the first one, following the parameters of the Crystal fill type that where specified on the
Object properties toolbar. You can click and drag the starting point of the design and change the
way that crystals are positioned in shape. Also, you can select the control point and use the arrow keys
to move it for more precise adjustments. By holding the Ctrl key pressed and using the arrow key the
movement step is larger for quicker movements. 

Starting Point Start Point at bottom left corner

The way that the crystals are positioned inside the shape will change immediately 

2. The distance between control points 1 and 2 specifies the H.Spacing parameter. This means that by
dragging the control point 2 you can change the horizontal spacing (H.Spacing) of the crystals.  
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Adjust H.Spacing Drag distance H.Spacing Increased

Important: The distance between control points 1 and 2 is not the actual value that you see
on the H.Spacing parameter but the handle that is defined from these two points can
change this parameter by dragging the control point 2.

3. The angle of 1-2 line, specifies the Starting angle.
By rotating the control point 2 clockwise or counter clockwise you can change the Starting angle of the
crystal fill.

Rotate control point 2 Hold Ctrl to snap on every 22.5o Rotated 45o degrees

If you hold the Ctrl key pressed the handle will snap on every 22.5o degrees. Also, if you hold the Alt key
pressed the handle will snap on the grid points.

4. The distance between control points 1 and 3 specifies the Vertical Spacing parameter.
This means that by dragging the control point 3 you can change the horizontal spacing (V.Spacing) of
the crystals.
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Adjust V.Spacing Drag distance V.Spacing Increased

Important: The distance between control points 1 and 3 is not the actual value that you see
on the V.Spacing parameter but the handle that is defined from these two points can
change this parameter by dragging the control point 3.

5. The angle of 1-3 line, specifies the Slant angle.
This means that by dragging the control point 3, you can change the fill pattern of the crystal fill by
changing the way crystals are applied line by line.

Starting Point Start Point at bottom left corner

If you hold the Ctrl key pressed the handle will snap on every 22.5o degrees. Also, if you hold the Alt key
pressed the handle will snap on the grid points.

6. If you wish to edit the outlines of the object, you have to enable the parameter Edit outline from the
Tool options toolbar.

Circular

Circular pattern fill it is very useful especially for rounded shapes or shapes that are curvy. With the special
parameters that includes you can create unique and complex crystal patterns. 

Circular way of filling areas with Crystals has the following parameters:

· Spacing

· Start angle
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· Steps

H.Spacing 

The Spacing parameter specifies the distance between the outlines of the crystals placed on different circles.
The distance between the crystals of the same circle are specified from the Step parameter. For this
calculation the Crystals cut offset (white circle around the crystals) is not taken under consideration.

Spacing 0,8mm Spacing 1.5mm

The default value of the Spacing is 0.8mm and is calculated by adding the Crystal cut offset (0.4mm)
together with the Crystal minimum hole spacing (0.4mm). These values can be adjusted from Tools
>Optimizer options... dialog.

Start angle
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The Start angle parameter specifies the angle of the horizontal lines of crystals which will fill the object you
created. When the starting angle is set to 0 degrees, the lines will be horizontal. The Start angle also is
defined from the horizontal green handle of the Circular Fill pattern.

0o degrees angle 30o degrees angle

This parameter is especially useful when you want to force pattern to start from a specific angle that fit better
on a specific shape. For example if you want to add a circular fill pattern inside a rhombus and you want the
center of the circular pattern to start from the bottom corner and the start angle to be parallel with the side of
the rhombus you have to use this parameter. The Start angle must be set equal with the angle that the
rhombus shape side has. 

Start Angle 0o Start Angle 60o

Steps

The Steps parameter specifies the number of crystals which will be added in any circle pattern starting from
the center of the object to the outside. 
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In the center of the object the software will put one crystal. Then, if for example the Steps value is set to 6, it
will make the first circle with 6 crystals, the second with 12 crystals, the third with 18 crystals etc. The
crystals that belong to the same circle pattern will be distributed evenly. 

Steps set to 6 Steps set to 4 Steps set to 3

By trying various Steps values you will see that the pattern changes accordingly. 

Node editing of Circular fill area with Crystals

When selecting an object which is filled in with Circular Fill pattern and clicking on Edit shape nodes 
icon , you can edit the control handles of the crystal placement. If you cannot see the control handles as they

appear in the images below you will have to uncheck the Edit outline   option from the Tools
options bar. Then you will see a 90o green corner  at the middle of the design.

There are three control points:

Control handles

1. Control point 1 specifies the position of the first crystal. All the other crystals will be placed based on
the first one, following the parameters of the Crystal fill type. All the other crystals will be placed based
on the first one, following the parameters of the Crystal fill type that where specified on the Object
properties toolbar. You can click and drag the starting point of the design and change the way that
crystals are positioned in shape. Also, you can select the control point and use the arrow keys to move
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it for more precise adjustments. By holding the Ctrl key pressed and using the arrow key the
movement step is larger for quicker movements. 

Starting Point Start Point at the bottom out of the shape

2. The distance between control points 1 and 2 specifies the Spacing parameter.This means that by
dragging the control point 2 you can change the horizontal spacing (H.Spacing) of the crystals.  

Adjust H.Spacing Drag distance H.Spacing Increased

3. The angle of 1-2 line, specifies the Starting angle. By rotating the control point 2 clockwise or counter
clockwise you can change the Starting angle of the crystal fill.
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Rotate control point 2 Hold Ctrl to snap on every 22.5o Rotated 45o degrees

If you hold the Ctrl key pressed the handle will snap on every 22.5o degrees. Also, if you hold the Alt key
pressed the handle will snap on the grid points.

4. The angle of 1-3 line, specifies the Steps parameter. By dragging the 3 control point you can change
the circular fill pattern steps. 

from 6 Steps change to 3 steps 3 steps 

5. If you wish to edit the outlines of the object, you need to enable the parameter Edit outline from the
Tool options toolbar.

Contour

Contour fill pattern is a very useful crystal fill pattern which can give an echoing effect to the designs. It can fill
complex designs easily and produce unique results. 

Contour way of filling areas with Crystals has the following parameters:

· H.Spacing

· V. Spacing

Contour Crystal fill

H. Spacing 
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The H.Spacing parameter specifies the distance between the outlines of the crystals which are on the same
contour. The H.Spacing in this case may not be precise, since the crystals of the same contour should be
distributed evenly. Therefore whenever you set a H.Spacing value for the contour fill pattern you must always
keep in mind the fluctuation of the distance between the crystals.

horizontal Spacing 1.1 mm Horizontal Spacing 2mm

horizontal spacing

V. Spacing 

The Vertical Spacing parameter specifies the distance between the outlines of the crystals which are on
different but adjacent contours. The spacing in this case may not be precise, since the contours should be
placed in a way that does not leave big gaps in the middle of the object.

Vertical Spacing 1.5mm Vertical Spacing 3mm

When the contour Fill pattern is selected the V.Spacing option could not be accurate because the software
in order to produce the contour fit result needs to average the distances between the crystals. Therefore
sometimes the V.Spacing option you have defined might not be exactly the same on the actual design.

Node editing of Circular fill area with Crystals
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When selecting an object which is filled with Contour fill type of crystals and clicking on the Edit Shape

nodes icon , you can edit the control points of the crystal placement. There are three control points:

Control handles

1. Control point 1 specifies the offset of the parameter, where the first contour will be placed.

2. The distance between control points 1 and 2 specifies the H.Spacing parameter. This means that by
dragging the control point 2 you can change the horizontal spacing (H.Spacing) of the crystals.  

Adjust H.Spacing Drag distance H.Spacing Increased

Important: The distance between control points 1 and 2 is not the actual value that you see
on the H.Spacing parameter but the handle that is defined from these two points can
change this parameter by dragging the control point 2.

3. The distance between control points 1 and 3 specifies the Vertical Spacing (V.Spacing) parameter.
This means that by dragging the control point 3 you can change the horizontal spacing (V.Spacing) of
the crystals.
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Adjust H.Spacing Drag distance H.Spacing Increased

Important: The distance between control points 1 and 3 is not the actual value that you see
on the V.Spacing parameter but the handle that is defined from these two points can
change this parameter by dragging the control point 3.

4. You cannot rotate 1-2 and 1-3 handles since there is no meaning in changing the starting or slant angle
in contour fill type. Therefore the only changes that you can make to the handles are only on their axis.
The only limit you have is that you cannot shrink the handles and make the crystals to overlap. 

5. If you wish to edit the outlines of the object you have to enable the parameter Edit outline from the
Tool options toolbar.

Single Line

Single line fill pattern is filling areas with Crystals in a continuous line order and it has the following parameter:

· H. Spacing

It is very useful for filling text art designs which otherwise is very difficult to match their shapes. 

  

Single line Crystal fill

H. Spacing

The H.Spacing (Horizontal Spacing) parameter specifies the distance between the outlines of the crystals.
The H. Spacing in this case may not be precise, since the crystals inside the shape should be distributed
evenly. Therefore whenever you set a H.Spacing value for the Single line fill pattern you must always keep in
mind the fluctuation of the distance between the crystals.
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Horizontal Spacing

Shape fit

Shape fit is the default way if filling crystal fill designs because it fits better to the most designs that you will try
to fill with crystals. Its major advantage is that adjusts the way that the crystals will be placed by not keeping
the distance between objects standard and by following better the shape's flow. 

Shape fit way of filling areas with Crystals has the following parameters:

· H.Spacing

· V. Spacing

· Start angle

Shape fit fill type

H. Spacing 

The H.Spacing parameter specifies the distance between crystals. The H.Spacing in this case may not be
precise, since the crystals may not be distributed evenly. Therefore whenever you set a H.Spacing value for
the Shape fill pattern you must always keep in mind the fluctuation of the distance between the crystals.
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horizontal Spacing 0.8 mm Horizontal Spacing 2mm

horizontal spacing

V. Spacing 

The Vertical Spacing parameter specifies the distance between the outlines of the crystals which are on
different but adjacent contours. The spacing in this case may not be precise, since the contours should be
placed in a way that does not leave big gaps in the middle of the object.

Vertical Spacing 1.5mm Vertical Spacing 3mm

When the contour Fill pattern is selected the V.Spacing option could not be accurate because the software
in order to produce the contour fit result needs to average the distances between the crystals. Therefore
sometimes the V.Spacing option you have defined might not be exactly the same on the actual design.

Start angle

The Starting angle parameter specifies the angle of the horizontal lines of crystals which will fill the object you
created. When the starting angle is set to 0 degrees, the lines will be horizontal. By changing the angle you
will get different results on the Shape fit fill pattern. Each shape might need different Start angle in order the
pattern to fit in the design. Therefore it is good practice to change values until you find the one that is
appropriate with the design. 
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For better result also you will have to adjust the H.Spacing and V.Spacing values. By adjusting the spacing
between the crystals you will be able to apply the pattern you want.

Start Angle 0o Start Angle 45o Start Angle 135o

The Start angle parameter it is also specified in the design with the horizontal green handle. This handle can

be edited while you are in Edit shape nodes  mode and the Edit outline  option is
unchecked from the Tools options bar. 

This parameter is especially useful when you want to force pattern to start from a specific angle that fit better
on a specific shape. 

Node editing of Shape fit fill area with Crystals

When selecting an object which is filled in with Shape fit Fill pattern and clicking on Edit shape nodes 
icon , you can edit the control handles of the crystal placement. If you cannot see the control handles as they

appear in the images below you will have to uncheck the Edit outline   option from the Tools
options bar. Then you will see a 90o green corner  at the middle of the design.

There are three control points:

Control handles

1. Control point 1 specifies the position of the first crystal in the design. All the other crystals will be placed
based on the first one, following the parameters of the Crystal fill type that where specified on the
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Object properties toolbar. You can click and drag the starting point of the design and change the
way that crystals are positioned in shape. Also, you can select the control point and use the arrow keys
to move it for more precise adjustments. By holding the Ctrl key pressed and using the arrow key the
movement step is larger for quicker movements. 

Starting Point Start Point at bottom left corner

The way that the crystals are positioned inside the shape will change immediately 

2. The distance between control points 1 and 2 specifies the H.Spacing parameter. This means that by
dragging the control point 2 you can change the horizontal spacing (H.Spacing) of the crystals.  

Adjust H.Spacing Drag distance H.Spacing Increased

Important: The distance between control points 1 and 2 is not the actual value that you see
on the H.Spacing parameter but the handle that is defined from these two points can
change this parameter by dragging the control point 2.

3. The angle of 1-2 line, specifies the Starting angle.
By rotating the control point 2 clockwise or counter clockwise you can change the Starting angle of the
crystal fill.
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Rotate control point 2 Hold Ctrl to snap on every 22.5o Rotated 45o degrees

If you hold the Ctrl key pressed the handle will snap on every 22.5o degrees. Also, if you hold the Alt key
pressed the handle will snap on the grid points.

4. The distance between control points 1 and 3 specifies the Vertical Spacing parameter.
This means that by dragging the control point 3 you can change the horizontal spacing (V.Spacing) of
the crystals.

Adjust V.Spacing Drag distance V.Spacing Increased

Important: The distance between control points 1 and 3 is not the actual value that you see
on the V.Spacing parameter but the handle that is defined from these two points can
change this parameter by dragging the control point 3.

5. If you wish to edit the outlines of the object, you have to enable the parameter Edit outline from the
Tool options toolbar.

Line fit

Line fit fill pattern is filling areas with Crystals in a continuous line order and where is needed it adds more
lines. This fill pattern it has the following parameter:

· H. Spacing

It is very useful for filling text art designs which otherwise is very difficult to match their shapes. Line fit pattern
will add single line crystals in narrow areas and will double/triple the lines in wider areas. With this procedure
will match better the text art design or any other design that has narrow and wide areas. 
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Single line Crystal fill

H. Spacing

The H.Spacing (Horizontal Spacing) parameter specifies the distance between the outlines of the crystals.
The H. Spacing in this case may not be precise, since the crystals inside the shape should be distributed
evenly. Therefore whenever you set a H.Spacing value for the Single line fill pattern you must always keep in
mind the fluctuation of the distance between the crystals.

Horizontal Spacing

Edit Crystal fill outline

Outlines with Crystals has the following parameters:

· Offset

· Spacing
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Crystal fill outline

Outlines for crystals does not have control points in node editor.

Offset

The Offset parameter specifies the distance between the outline and the center of the Crystal. The Offset
parameter can also accept negative values from -15 to + 15 mm. This is a very useful parameter when you
want to move the crystals placed on the outlines away from the design and the opposite. Usually when you
apply crystals on the outline, they are placed along the outline which makes them overlap with the fill area of
the shape. This is the reason why the offset value is there, to allow you make changes on the outline easily. 

Crystal fill offset 0mm Crystal fill offset 2.0mm Crystal fill offset -2.0mm

Spacing

The Spacing parameter specifies the distance between the outlines of the crystals. For this calculation the 
Crystals cut offset (green circle around the crystals) is not taken under consideration . The Spacing in this
case may not be precise, since the crystals of the same outline should be distributed evenly and the software
also adds crystals on sharp corners. This is a very import options because it allows you to create perfect
crystal holes on the material you want and avoid crystals' overlapping. 
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Horizontal Spacing

Crystal outline/pen Fill
The Crystal outline is a new outline type. When it is applied, the object's outline is filled with Crystals. For
example, the circle of the following figure, in the beginning, it is filled with step. Then by using Crystal fill it is
filled with Crystals in a patterned way. 

Satin serial stitch fill Crystals outline fill

When applying Crystal outline there are a few options that you can adjust in order to customize the way that
the Crystals will be applied. 

Separate to Crystals

Use this option to separate the Crystals into individual Crystal objects. The separated crystals can not be
rejoined into one object with the same properties. Each Crystal will be converted into a separate object. The
only way to reverse this operation is by using Undo option.

Offset

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -15mm and highest value 15mm. Also, you can increase or
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decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
outline to have from its initial position. The default offset value is zero and can be changed only from you. Any
changes you are making on the offset value it is previewed on the design.

Item rotation

With the Item rotation you have the ability to rotate the crystals you have inserted in the shape. 

Item rotation

Crystal rotation 0 Crystal rotation 45

You can increase or decrease the Item rotation value by clicking on the arrows next to the value or by
clicking on the value and rotating the mouse wheel. The value that you are inserting defines the exact rotation
angle you want the crystals to have from their initial position. The default Item rotation value is zero and can
be changed only from you. Any changes you are making on the Item rotation value it is previewed on the
design. The crystal rotation is always counter-clockwise. 

Spacing 

Using this option you can define the distance between the Crystals. The distance is defined in Millimeters.  In
the numeric field you can type the distance in "mm". You can also adjust Spacing by clicking the arrows next

to the value or by clicking on the value and rotating the mouse wheel  if there is one. Changes are instantly
previewed on the design area and can be set by clicking outside the density field.

Palette

Using this option we can select one of the available Crystal palettes.
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Size 

Select the Size of the used Crystal. In this table you can find useful information about the Codes (SS, PO)
that may be used to label the various Crystals and the actual size of the Crystals in Millimeters and in Inches.
The visible Sizes vary according to the selected palette.

Color /Shape

Click to select one of the available Crystals. The visible Crystal icons vary according to the selected palette. 
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Cut - Creating designs with Cuts

Chapter XV

Creative DRAWings implements Cut capability in a way that cutting was made simple. In the following topis
we will present how Cutting works with Creative DRAWings. Connect to your Digital cutter and your
possibilities are endless. You can easily connect to a variety of Digital Cutters (Artistic Edge, Zing, Silhouette
Cameo-Portrait-SD, eCraft, Foison, eClips USB 2, Redsail and GCC Jaguar) or export to an file format that
your cutter supports (*.HPGL,*.SVG,*.DXF,*.Brother FCM file).You have the ability to create shapes, motifs
and designs in the software and cut it out of virtually any material. You can cut fabric for applique, templates
for crystal designs, vinyl to adhere to shirts, glassware, walls or mirrors, magnets for your car or fridge, paper
for any scrap-booking or paper-crafting projects. Be prepared to find yourself experimenting with new
techniques, materials and designs in no time! In the following topis we will present some samples of how to
create Cut designs. 

All the functionality that is  described into the following topics (Cut chapter) is  enabled only
if you have enabled Cut Technique technique for the created/edited design.

Generally we can easily change any design part into a Cut line by apply Cut Outline type. 

 

Create your first Cut design
This is a step-by-step tutorial to guide you in importing an artwork file and convert automatically into Cut lines.

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.

2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.
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Starting dialog

3. Select the Create new option and click Next> button to proceed.

4. In the appearing dialog you must select which Techniques you want to be enabled for the created
design. For the purposes of this sample we will enable only Cut technique. Then click on Next
button to proceed.

Select Techniques

5. The Artwork source dialog will appear.

6. Select the From artwork file option and click on the Browse button , to import the design you
want to convert to Cut. Since we have enabled only Cut technique all the parts of the design will be
converted into Cut lines. 

Artwork source 

7. The Open dialog box will appear to locate the design that you want to embroider.
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Open design dialog

8. On My documents folder there is an Embroidery designs folder. 

9. Inside Embroidery designs folder you will find another folder called Creative DRAWings samples.

10. For the purposes of this example we will select one of the files that are located Cutting samples
folder.

11. Select any sample, in our example we will use the cloud_thunder.svg file.

12. Left click to select any sample, take a look on the preview to confirm that it is as you like and then
click the Open button to confirm the selection.

13. The Artwork source dialog will appear once more with the design you selected under From file
field.
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Artwork source 

14. You can also select the cutting mat to preview the design on.

15. Click Finish to end the process and convert the imported design to Cut lines.

16. The design will appear in the working area previewed on a matte surface.

The imported artwork converted into cut lines

17. There are many changes that you can do on the artwork or create new parts, but we will not present
them now in this Quick Start topic. We will only present the procedure of producing this Cut design
with a digital cutter.

At this point we must mention that any design part - artwork can be converted into a cut

line s imply by selecting the desired part and click on the Cut outline type . You can

use the design tools to add new parts on this design and by selecting cut outline type 
you can easily changes created parts into Cut lines

18. Let's suppose that we are done with the design and we are ready to Cut the parts using our digital
cutter.

19. From File menu, Export sub-menu activate Export to Cutters option.
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20. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

21. The Export to Cutter dialog will appear, using this dialog you can Cut any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog. 

Before proceeding you must have loaded the cutting mat with the cutting material into
the Cutter. 

22. First select the design parts that you want to cut from the Templates area.

23. Then you should select an origin. This is the point that you want the cutter to begin from. 

24. If you have never used this material on your Cutter you should first perform a Test cut to verify that
the material is Cut properly with the current settings. Using the arrow buttons move the Blade to a
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position that will not be used for the actual Cut and press Test button. The cutter will perform a test
Cut of the material, peel the cut part in order to verify if it was correctly Cut. if it was not adequate
adjust the cutter options until you are satisfied by the result.

25. Now you must position the Blade for the actual Cutting of the material. In our case we must move
the Blade close to the edge of the upper left part of the material according to the origin we have
selected. Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the
position of the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

26. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

27. Finally press Cut in order to start the actual cutting process. 

28. After the cutting process remove the cutting mat with the material and peel the cut Cloud and
Thunder parts. That's all for now if you have followed the guide you should now have on hands the
Cut thunder and the Cloud parts.

Import from scanner and Cut

Many times you find a design in a magazine or a flyer which you would like to embroider but don’t realize how
easy it is to acquire the image. If your computer has a scanner installed, you can scan and import almost any
design you want to embroider.
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Important: The image you import must be suitable for Cut according to the material you

wish to Cut. Real time images are too complex to use them for Cutting. 

Follow these steps to scan an image and automatically convert into a design with Cut lines.

1. Start Creative DRAWings by double clicking on the shortcut icon  that is located on your
Desktop.

2. Creative DRAWings will open and the New Design start-up wizard will appear.

Starti-up wizard

3. Select the Create new option and click Next> button.

4. In the following step you must select which Techniques you want to be enabled for the created design.
For the purposes of this sample we will enable only Cut technique. Then click on Next button to
proceed.
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Select Techniques

5. The Artwork source dialog will appear. In this guide we present how to acquire an image from
scanner so you must select the Get image from scanner option and click Next to proceed.

Artwork source  dialog - 2nd page 

6. The Image Scan dialog appears. 
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Image scan dialog

7. The Image Scan dialog helps you scan the image you want to import it into Creative DRAWings. If
your scanner is correctly installed, all you have to do is press the Preview button. 

8. The design will be scanned and the image will appear in Preview. You can specify the exact image to
want to embroider in Preview by drawing a rectangle with your cursor. Only the area inside the
rectangle will be embroidered. 

9. If the design in the Preview is what you want to embroider, press the Scan button to continue.

10. Then you will be asked to save the design on your hard disk, using the Save As dialog.
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Save as dialog

11. Browse to select a location for the scanned image. Select Documents icon from the left side and then
double click on the Embroidery designs folder.

12. In the File name field type a name for your image. Select Save button to save the scanned image. The
scanned image is saved as bitmap image (like photo) with .jpg file extension.  

13. The Artwork Image dialog will appear offering various conversion options.

Artwork image dialog

14. In our example we will select the Trace option and press the Next> button.

Trace (Convert to outlines): This option will guide you to convert the Bitmap (picture)
image that you are importing to a Vector (c lipart) based image which will be automatically
converted into Cut lines. Tracing a Bitmap image is not an easy procedure; therefore you
must be careful with the images which you are tracing. They must be clear and ones that
can be actually used.

15. The Trace Image dialog will appear with the scanned image imported. In the Preview on the right you
can see what the traced result of the Bitmap (picture) image will look like. The Vector (clipart) design
from tracing the scanned image is the same image you see in the Preview of the Trace Image dialog.
What you see is what you get.
· You can also adjust the traced result by changing the available options which are listed at the left

side of the dialog. 
· You can change the size of the Trace result by adjusting the Scale image option.

· You can set how exact the traced image will be to the scanned image by adjusting the Accuracy
value.
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· You can select the number of colors for your traced image by adjusting the Color limit value.

· And you can remove the background color that the scanned Bitmap images usually have by using
the Use background option.

Any changes you make to these options are automatically adjusted by Creative DRAWings and shown
in Preview.

Trace image dialog

16. The Color reduction dialog will appear where you can select a Thread palette to use. 
17. Click on the arrow of the Palette drop-down menu and the available thread manufacturers will appear.
18. Select the brand-name thread you want by choosing it from the list. For example, select Mettler

Seralon.
19. The colors of the design you are importing will automatically be assigned to the closest thread color of

the Mettler Seralon in the Thread palette. 

 
Color reduction dialog

20. In the same dialog you can see that your design has 4 different colors. The number of colors can be
reduced now by sliding the Threads to Use arrow to the left, or later inside the software. The
reduction of colors sometimes is not noticeable, but will reduce sew-out time. Experiment with the 
Threads to use slider. 

21. Click Finish to end the process and imported the converted artwork into the design area. 
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22. The scanned image will appear in the design area. Since we only have Cut technique enabled it has
been converted into Cut lines.

The scanned design in the design area.

23. In order to be able to see the result clearly we will hide the automatically added backdrop. From menu 
View, sub-menu Backdrop, enable Hide option. You can also use Alt+1 keyboard combination in
order to hide the backdrop.

Hide backdrop

24. Now as you can see  on the following figure the scanned image has been converted into Cut outlines.
At this point we must mention that there may be various unneeded parts that you may need to delete
from the design. We have already removed them as you can see in the figure.



457Cut - Creating designs with Cuts

© 2017 DRAWstitch Ltd.

The imported design

25. There are many changes that you can do on the artwork or create new parts, but we will not present
them now in this Quick Start topic. We will only present the procedure of producing this Cut design
with a digital cutter.

At this point we must mention that any design part - artwork can be converted into a cut

line s imply by selecting the desired part and click on the Cut outline type . You can

use the design tools to add new parts on this design and by selecting cut outline type 
you can easily changes created parts into Cut lines

26. Let's suppose that we are done with the design and we are ready to Cut the parts using our digital
cutter.

27. From File menu, Export sub-menu activate Export to Cutters option.

28. From the appearing dialog we must select one of the Cutters to connect or a File format if we want to
export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.
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Select a Cutter or Export to a file

29. The Export to Cutter dialog will appear, using this dialog you can Cut any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be able
to directly communicate with the Cutter through this dialog. 

Before proceeding you must have loaded the cutting mat with the cutting material into
the Cutter. 

30. First select the design parts that you want to cut from the Templates area.

31. Then you should select an origin. This is the point that you want the cutter to begin from. 

32. If you have never used this material on your Cutter you should first perform a Test cut to verify that the
material is Cut properly with the current settings. Using the arrow buttons move the Blade to a position
that will not be used for the actual Cut and press Test button. The cutter will perform a test Cut of the
material, peel the cut part in order to verify if it was correctly Cut. if it was not adequate adjust the
cutter options until you are satisfied by the result.

33. Now you must position the Blade for the actual Cutting of the material. In our case we must move the
Blade close to the edge of the upper left part of the material according to the origin we have selected.
Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the position of
the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

34. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

35. Finally press Cut in order to start the actual cutting process. 
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36. After the cutting process remove the cutting mat with the material and peel the letters. That's all for
now if you have followed the guide you should now have on hands the letters of the scanned image.

Import from camera and Cut

Another way to acquire an image from a magazine or a flyer or from a drawing you have created on a page is
by using any camera that is attached on your pc. If your computer has a camera installed (most modern
laptops have a camera already installed), you can capture a snapshot image and import almost any design.
At this point we are demonstrating the usage of Cut technique so please make sure that the artwork that you
wish to import is suitable for Cutting.If we have only Cut technique enabled the imported artwork will be
converted into Cut lines, so a very complex design with lines passing on top of others and a material that is
not stable on the cutting mat may fail to produce. If you wish to import a complex design and Cut only parts of
it you must edit the imported artwork and select which parts to be Cut.

Important: The image which you desire to import must be suitable for Cut according to
the material you wish to Cut. Real time images are too complex to use them for Cutting.

Follow these steps to convert a Bitmap (picture) images to an embroidery design with your camera:

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop. 

2. Creative DRAWings will open and the starting dialog named New Design will appear.
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Starting dialog

3. Select the Create new option and click Next> button to proceeed.

4. In the following step you must select which Techniques you want to be enabled for the created
design. For the purposes of this sample we will enable only Cut technique. Then click on Next
button to proceed.

Select Techniques

5. The Artwork source dialog will appear. In this guide we present how to acquire an image from
camera so you must select the Get image from camera option and click Next to proceed.
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Artwork source dialog

6. The camera Preview dialog appears. 

Image scan dialog

7. The camera Preview dialog helps you capture the image you want to import into Creative
DRAWings. If your camera is correctly installed, all you have to do is press the Capture button and
take a snapshot of the design you want.

8. The design will be captured and the image will appear in Preview area. You can specify the exact
image to want to embroider (crop image) in Preview by drawing a rectangle with your cursor. Only
the area inside the rectangle will be embroidered. We will leave it as it is.
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Image scan dialog

9. If you are not satisfied with the image you captured you can click on the Capture new button and
take a new snapshot.

10. If the design in the Preview is what you want to convert to Cut, press the Save button to continue. 

11. Then you will be asked to save the design on your hard disk. The Save As dialog will appear.

12. Select Documents icon from the left side and then double click on the Embroidery designs folder.

13. In the File name field type a name for your image.

14. Select Save button to save the scanned image. The captured image is saved as bitmap image (like
photo) with .jpg file extension. 

Save as dialog

15. The Artwork Image dialog will appear offering various conversion options.



463Cut - Creating designs with Cuts

© 2017 DRAWstitch Ltd.

Artwork image dialog

16. In our example we will select the Trace option and press the Next> button.

Trace (Convert to outlines): This option will guide you to convert the Bitmap (picture)
image that you are importing to a Vector (c lipart) based image which will be automatically
converted into Cut lines. Tracing a Bitmap image is not an easy procedure; therefore you
must be careful with the images which you are tracing. They must be clear and ones that
can be actually used.

17. The Trace Image dialog will appear with the captured image imported. In the Preview on the right
you can see what the traced result of the Bitmap (picture) image will look like. The Vector (clipart)
design from tracing the scanned image is the same image you see in the Preview of the Trace
Image dialog. What you see is what you get.

18. The conditions of lighting are very important when importing from camera. In order to improve the
result we have adjusted some options of the Trace dialog. 

19. We have changed the Accuracy value by setting to 1.

20. We have set the Color limit to 6.

21. And we have removed the Gray background by enabling Use background and selecting the
background color. 

Any changes you make to these options are automatically adjusted by Creative DRAWings and shown
in Preview.
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Trace image dialog

22. Click on Trace to proceed.

 
Color reduction dialog

23. Click Finish to end the process and convert the imported design into Cut lines. 

24. The camera capture will appear in the design area. Since we only have Cut technique enabled it
has been converted into Cut lines.
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The traced image filled with stitches

25. In order to be able to see the result clearly we will hide the automatically added backdrop. From
menu View, sub-menu Backdrop, enable Hide option. You can also use Alt+1 keyboard
combination in order to hide the backdrop.

Hide backdrop

26. Now as you can see  on the following figure the scanned image has been converted into Cut
outlines. 

27. At this point we must mention that there may be various unneeded parts that you may need to delete
from the design. We have already removed them as you can see in the figure below.
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The imported design

28. There are many changes that you can do on the artwork or create new parts, but we will not present
them now in this Quick Start topic. We will only present the procedure of producing this Cut design
with a digital cutter.

At this point we must mention that any design part - artwork can be converted into a cut

line s imply by selecting the desired part and click on the Cut outline type . You can

use the design tools to add new parts on this design and by selecting cut outline type 
you can easily changes created parts into Cut lines

29. Let's suppose that we are done with the design and we are ready to Cut the parts using our digital
cutter.

30. From File menu, Export sub-menu activate Export to Cutters option.
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31. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

32. The Export to Cutter dialog will appear, using this dialog you can Cut any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog.

33. Before proceeding you must have loaded the cutting mat with the cutting material into the Cutter. 

34. First select the design parts that you want to cut from the Templates area.

35. Then you should select an origin. This is the point that you want the cutter to begin from. 

36. If you have never used this material on your Cutter you should first perform a Test cut to verify that
the material is Cut properly with the current settings. Using the arrow buttons move the Blade to a
position that will not be used for the actual Cut and press Test button. The cutter will perform a test
Cut of the material, peel the cut part in order to verify if it was correctly Cut. if it was not adequate
adjust the cutter options until you are satisfied by the result.

37. Now you must position the Blade for the actual Cutting of the material. In our case we must move
the Blade close to the edge of the upper left part of the material according to the origin we have
selected. Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the
position of the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

38. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

39. Finally press Cut in order to start the actual cutting process.



Creative DRAWings® 7.1 manual468

© 2017 DRAWstitch Ltd.

40. After the cutting process remove the cutting mat with the material and peel the letters. That's all for
now if you have followed the guide you should now have on hands the letters of the scanned image.

Create a Cut design from stratch
In the previous Quick start topics we have described the various ways to import artwork and automatically
convert into a design with Cut objects. Now we will create a design from scratch, without using any artwork
source and using the available design tools and we will design some objects and make them Cut objects.

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.

2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.

Starting dialog

3. Select the Create new option and click Next> button
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4. In the following step you must select which Techniques you want to be enabled for the created
design. For the purposes of this sample we will enable only Cut technique. Then click on Next
button to proceed.

Select Techniques

5. The Artwork source dialog will appear. In this guide we will create a design from scratch so we
must select New Graphic option and click Finish to proceed.

Artwork source  dialog - 2nd page .

6. The workspace will appear, with a grid that looks like a cutting mat but without any design in it.
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Empty workspace

7. We will create a logo like design with a Text object and a Symbol, and then cut the letters and the
symbol into a material with different color. From the Tools toolbar that is located at the left side of

the working space, and holds all the designing tools select the text tool . 

8. First of all you should notice that using Tools options toolbar you can adjust the options of the
added text. 

Adjust Text options

9. Now click on the position that you like to place the text. The text cursor will appear waiting for you to

type the text. We will type Water and the we will left click the Rectangle selection  to finalize the
entered text and release the text tool.

Entered text
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10. In order to be able to separate text object i will select a light Fill color and a darker outline color as
you can see in the following figure.

11. Now we will use Insert symbol of Tools menu option in order to add a drop shape. Activate Insert
symbol option, on the appearing 3D dialog, select Wingdings font, select the drop icon as on the
following figure and press Insert button.

 
Insert symbol

12. The insert symbol dialog closes and the cursor turns into a cross waiting for you to specify the
position of the symbol. Click and drag to define position and size of the the symbol.

Insert symbol
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13. We will select a light blue color for the fill of the symbol and a darker blue for the outline of the
symbol. 

14. Since we have only Cut technique enabled any object we design is automatically set to have a Cut

 outline type. So we do not need to do anything, the created objects are already Cut 
objects. Select both the Text object and the Symbol and check the outline properties. As you can
see on the following figure there are also some options about the Cutter we will present them later in
detail.

15. Let's suppose that we are done with the design and we are ready to Cut the parts using our digital
cutter. We want to Cut the characters on a Red color material and the symbol on a Blue color
material. So we need a Red adhesive material sized Width 6.5 and Height 2,5 according to the size
of the Text part to be placed on the cutting mat and Blue one according to the size of the drop
symbol.
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16. From File menu, Export sub-menu activate Export to Cutters option.

17. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed
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Select a Cutter or Export to a file

18. The Export to Cutter dialog will appear, using this dialog you can Cut any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog.

Before proceeding you must have loaded the cutting mat with the cutting materials into the
Cutter. 

19. First we will select the Text part to be cut from the Templates area and set the starting point o the
upper left corner. This is the point that you want the cutter to begin from. 
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20. If you have never used this material on your Cutter you should first perform a Test cut to verify that
the material is Cut properly with the current settings. Using the arrow buttons move the Blade to a
position that will not be used for the actual Cut and press Test button. The cutter will perform a test
Cut of the material, peel the cut part in order to verify if it was correctly Cut. if it was not adequate
adjust the cutter options until you are satisfied by the result.

21. Now you must position the Blade for the actual Cutting of the material. In our case we must move
the Blade close to the edge of the upper left part of the material according to the origin we have
selected. Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the
position of the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

22. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

23. Finally press Cut in order to start the actual cutting process..
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24. After the cutting process of the text part is complete you must Cut the symbol part. Select the
symbol template, set the same starting point and move the Blade to the upper left corner of the blue
material on the cutting mat using the arrows. Press Cut to proceed cutting the Symbol part. If you
have followed all the steps correctly then at this point you must be peeling out the part to use them
for your projects.

Cut properties

As we have already mentioned we can easily create any design and by applying the Cut  outline type we

can Cut the design using our digital cutter. Cut  outline type is applied only on objects that have outline,
otherwise it is not available. If we import a vector design, with only Cut Technique enabled then the vector
design is automatically converted into Cut lines. In any other case the imported - created artwork will have
another type of outline. We can apply Cut on any object simply by selecting the object and then select the

Cut  option from the Outline tab .

Cut properties

The options that can be adjusted, in order to produce the Cut you want, are cutting offset and various cutting
options. 

Offset

Using offset option for cut  outlines  you can specify the distance, inner or outer, you want the Cut to be
moved. For example: if you set the Cutting offset value to 3mm the Cut will move its outline by 3mm to all
directions outside its starting position. On the other hand if you set the value to -3mm the Cut will move its
outline by 3mm to all direction inside its starting position. In the Offset numeric field you can enter the value
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of offset you want (Cut offset), with lowest value of -15mm and highest value 15mm. Also, you can increase
or decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
Cutting to have from the initial artwork position. If the value is negative an inner offset will occur and the
opposite, if it is positive. The default offset value is zero and can be changed only from you. Any changes you
are making on the offset value they are automatically previewed on the design

Cutter presets

All the Cut objects are produced by placing a Blade to your digital cutter and then exporting the design to the
cutter. The following cutter options  (Cutter pressure, Speed, Passes, Blade color and Depth) should be
adjusted correctly in order to produce any design using your digital cutter. The following cutter options must
be adjusted either for each object, here in object properties, or at the Export to Cutter dialog. In order to
assist you in selecting the proper settings according to the material and the type of the operation we have
prepared various operation presets. Click on the Cutter presets button and from the drop down menu,
select any of the available presets for your Cutter and the material that you are going to use. This preset
selection affects only the selected objects

Artistic Edge - Vinyl preset

For example, if you are going to cut a design onto Vinyl using Artistic Edge cutter you must select the
appropriate preset. If we select Edge - Vinyl preset then all the cutter options we be set as on the above
figure.
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Cutter speed

With this value, you can specify the speed that the machine will cut the design. This value varies from cutting
machine to cutting machine and some machines does not allow you to change this value at all through our
software. You can make adjustments though, through the machine's panel. Feel free to change the Speed
setting based on the speed you want the design to be cut. 

The Cutter speed field can take values from 0 up to 100. 

Cutter pressure 

With this value, if it is enabled, you can specify the force that the machine will add on the blade in order to cut
the design or to the Pen/brush in order to draw the design. This value varies from cutting machine to cutting
machine and some machines does not allow you to change this value at all through our software. You can
make adjustments though through the machine's panel.

Feel free to change the Cutter Pressure setting based on the depth you want the material to be cut or paint.
The value of Cutter Pressure varies from cutting material to cutting material. Thicker material need more
pressure and thinner less.

The Cutter pressure field can take values from 0 up to 100. 

Passes

You can specify the number of Passes you want the design to be made with. It actually defines how many

times each shape will be made by the machine. 

Blade depth

With this option you can set the Blade depth of the cutter blade. This value varies from cutting machine to
cutting machine and it depends on the blade selection (some digital cutter have more than one blades) . This
option is some kind of informational because you may need to adjust the blade depth manually by hand when
placing the blade to the digital cutter. The value of Blade depth varies from cutting material to cutting
material. Thicker material need more depth and thinner less.

The Blade depth field can take values from 1 up to 12. 

Blade color

This drop down menu lists the Blade color that you have to use in order to cut the specific material. This is
applicable on specific machines that include various blades, with different colors. Usually each color is for
cutting different  material. Check the cutters manual for more information about which blade is from which
material. 

For example, for Artistic Edge cutter the Blades are for the following use:
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· Blue Cap Blades is for cutting thicker materials

· Red Cap Blades is for cutting thin materials

· Yellow Cap Blades is for cutting fabrics

Select the Blade color that you will use for the currently selected object and during the Cutting process the
Software will notify you that you will have to use the respective Blade color in order to cut the shape. 

Print & Cut
Let's make a brief presentation on how Print & Cut functionality works. As we have already mentioned Print
& Cut functionality works is 2 ways according to the used cutter. For Zing and Foison Koala that have a
laser pointer we must point (on the printed paper) with the laser pointer these special marks during the
procedure so that the print and the cut are properly aligned. For Silhouette CAMEO that has a special
optical recognition mechanism we must place the printed paper to the cutter and the Cutter will recognize the
special marks using optical recognition. For the following example we have used Zing cutter that uses a laser
pointer. We will start from the design of the following figure.

From File menu, expand option Export and from appearing menu use To Cutters option. 
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From the appearing dialog we must select one of the Cutters to connect or a File format if we want to
export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge cutter, click
on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

The Export to Cutter dialog will appear, using this dialog you can Cut any design part with your cutter. If the
Digital Cutter is properly connected and powered ON, then at this point you should be able to directly
communicate with the Cutter through this dialog. For the purposes of this demonstration we will present 
Print & Cut functionality.

A wizard will start to guide us through the procedure. First you must press print to send the design to your
printer. 
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Adjust printing options and press OK to send to your printer.

At this point we must mention that you can remove the cutting line from the print  in order to have only the
artwork and not the cut line.
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Now you must place the printed paper onto the cutting mat and place the mat to the Cutter. The printed paper
appears on the following figure. Now by pressing next on the Print & Cut wizard we are prompted to move
the laser pointer to the 3 points that are pointed by the red ellipses. 

Press Next to define the first one, move the laser pointer using the arrow keys to the center of the cross of
each point. 
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Move the laser pointer using the arrow keys on your keyboard
to move the pointer at the center of axis of the first point

Move to the center of the first point using the arrow keys and
press Next.

Move the pointer to the center of the second point using the
arrow keys and press Next.

Move to the center of the third point using the arrow keys and
press Cut to start the actual cutting process.

At the end you can remove extra paper and you have the outline of your design cut.
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Stencil - Creating stencil designs

Chapter XVI

In this section we will describe the ability of the software to create Stencil designs. Stencil produces an image
or pattern by coloring a surface over an intermediate object with designed gaps in it, which create the pattern
or image by only allowing the color to reach some parts of the surface. There are stencil designs that have
large cut areas that need to be bridged before cutting them, otherwise the pattern/shape will not be applied
correctly. To do that, you have to add a bridge in the outline of the design and increase the support of the
material. 
There are many parameters in the software that can help you adjust the stencil design and produce the result
you want.

In order to be able to use the Embroidery tools of the software you will have to enable the

Stencil Technique from the Techniques  option. 

Stencil how it works
Creative DRAWings includes a special Pen/Outline type that can convert any open shape to stencil shape.

To apply it on an open shape you have to select it and then click on the Stencil  icon at the object
properties toolbar. The open shape will become stencil shape without altering the artwork. A curve outline will
be drawn around it to specify the area that will be cut.

Open shape Stencil tool applied The outline is there but hidden

If you try to apply stencil on a closed shape you will see no difference. To create a stencil based on a closed
shape you will have to make it an open shape first and then  apply the stencil tool. To make it open shape you

will have to click on the Edit shape nodes option, right click on the outline of the closed shape(at the
location where the stencil bridge will be added) and select Stencil bridge option. The closed shape will
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become open and the stencil outline will be applied. If you want you can continue adding more stencil bridges,
in order to make your stencil more stable. 

For example if you have a stencil shape circle, you cannot have only one stencil Bridge. You have to add
more than one bridges in order to make the stencil design more stable. 

Only one stencil Bridge Many stencil Bridges

It is important to know that if the closed shape you want to apply stencil bridge is any of the build in shapes 

, you will have to convert it to curves first by selecting the respective

option from the right click menu, while you are in the Rectangle/Lasso selection  mode. Otherwise you
will not be able to apply the Stencil bridge option.

Create your first stencil design
This is a step-by-step tutorial to guide you in importing an artwork file and convert automatically into Stencil
lines.

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.

2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.

Starting dialog

3. Select the Create new option and click Next> button to proceed.
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4. In the appearing dialog you must select which Techniques you want to be enabled for the created
design. For the purposes of this sample we will enable only Stencil technique. Then click on Next
button to proceed.

Select Techniques

5. The Artwork source dialog will appear.

6. Select the New graphic option, select the Cutting mat that you will use from the drop down menu
and click Finish. 

New graphic - Select Cutting mat
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7. The dialog will finish and the working area will apear empty, showing only the cutting mat that you
you have selected to use. If the cutting mat is not visible, from View menu select Cutting mat  and it
will become visible.

New empty design with cutting mat

8. From Tools menu select Insert Symbol option.

Tools - Insert Symbol
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9. Select the Windings font from the font list and select the symbol shown below.Click Insert to insert
it on the cutting mat.

Select the Symbol you want

10. Click and drag on the cutting mat to draw the symbol on the cutting mat. Release the mouse to
insert it. 
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Insert Symbol on the working area

11. The symbol will inserted without fill type (Artwork fill) and with Stencil  outline/pen type.

Stencil outline/pen type

12. Set fill color to none  by clicking on the none fill  icon.
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Set fill type to none 

13. The design is a closed shape and the Stencil cutting area is not visible. To convert it to a proper
stencil design you have to convert it to an open shape by adding stencil bridges. To do that you have

to click on the edit shape nodes  from the options toolbar.

Edit Shape nodes of the symbol 

14. To add stencil bridges you have to right click on the location where the bridges will be added and
select the respective option from the pop-up menu.
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Add stencil bridge on the symbol 

15. Continue adding Stencil bridges in generally close distances to make the stencil more stable. 
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Add more stencil bridges on the symbol 

16. The outline of the symbol is correctly converted to stencil and can be send to the cutter. If you want
also convert the inner part of the symbol to stencil you can add stencil bridges to this object tool 

Add stencil bridges at the shape inside 

17. The stencil design is ready and you can send it to your cutter. 

18. From File menu, Export sub-menu activate Export to Cutters option.



Creative DRAWings® 7.1 manual494

© 2017 DRAWstitch Ltd.

File > Export > To Cutters

19. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

20. The Export to Cutter dialog will appear, using this dialog you can cut the Stencil design with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog. 
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Ready to send the design to the cutter

Before proceeding you must have loaded the Cutting mat with the cutting material into
the Cutter. 

21. First select the design parts that you want to cut from the Templates area.

22. Then you should select an origin. This is the point that you want the cutter to begin from. 

23. If you have never used this material on your Cutter you should first perform a Test cut to verify that
the material is cut properly with the current settings. Using the arrow buttons move the Blade to a
position that will not be used for the actual Cut and press Test button. 

24. The Test Cut dialog will appear listing all the cutter settings that you can adjust. Make the
adjustments you prefer or select any cutter preset from the available ones. Click Test to cut the
test design, which will be made based on the specific settings. Peel the cut part in order to verify if it
was correctly Cut. If you are satisfied with the specific settings you can click Apply. The settings will
be updated on the Object properties toolbar.
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send the design to the cutter

25. Now you must position the Blade for the actual Cutting of the material. In our case we must move
the Blade close to the edge of the upper left part of the material according to the origin we have
selected. Use the arrow buttons to move the Blade to a desired position. If you need to fine tune the
position of the Blade you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

26. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

27. Finally press Cut in order to start the actual cutting process. 
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Export to Cutter

28. After the cutting process remove the Cutting mat with the material and peel the cut shapes to
produce the final stencil design. That's all for now if you have followed the guide you should now
have your first stencil design created.

Stencil parameters
To every stencil design you are creating you have the ability to make adjustments on the stencil width and to
the cutter parameters that will affect the way the stencil will be cut. Therefore it is important to make the
correct adjustments, to ensure the best results. All adjustment can be made on the Object properties
toolbar Outline/Pen tab, where the stencil's parameters will appear after selecting the object. The
parameters that you can adjust are the following:



Creative DRAWings® 7.1 manual498

© 2017 DRAWstitch Ltd.

Stencil Parameters

All options except the Width option are referring to the cutter and the way that it will cut the stencil. Some
machines does not allow you to change some or any of these values through our software. You can make
adjustments though, through the machine's panel. 

These options will be available always at Object properties toolbar because no cutter is selected. If you
want to see which options the cutter allows you to adjust,  

1. you can go to File > Export > Cutters... and from the wizard dialog that will appear select the cutter
you have connected on the PC.

2. Click Connect and from the next dialog select Test. 

Test Cut dialog

3. A dialog will appear that will show you only the options that you can adjust at the connected cutter. 

4. You can adjust the settings and even test them on the cutter. 
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5. If you are satisfied with the setting you have selected you can click Apply apply them to the object(the
object properties toolbar will be updated automatically).

Cutter presets

The Cutter presets button allows you to select cutter settings presets, based on the material that you will
cut and the blade that you will use, and apply them on the currently selected object. By clicking on the Cutter
presets button a pop up list will appear with the available cutter presets. The cutter presets are listed with the
following information Name, Material, Blade color and Blade depth. 

· Name: Lists the Cutter's name that the the template is made for

· Material: Lists the Material that you can cut by using the preset. Those are referring to Rhinestones,
are mainly for Vinyl material.

· Blade color: Lists the Blade color that you have to use in order to cut the specific material. This is
applicable on specific machines that include various blades. Usually each color is for cutting different
 material. Check the cutters manual for more information about which blade is from which material.

· Blade depth: Lists the Blade depth that you have to set on the cutters blade. Usually the Blade depth
is set manually. Therefore you have to check the Cutter's manual and find how to change the Blade
depth.  

Cutter Presets

To apply the preset you want you can simply click on it. The settings of Object properties toolbar will be
adjusted accordingly. 

Width



Creative DRAWings® 7.1 manual500

© 2017 DRAWstitch Ltd.

With the width property you can change the stencil width. The default value is 1.6mm and the one that most
of the times you will use in your designs. The minimum value is 0.5mm and the maximum 3.0mm.

1.6 stencil width 2.1 stencil width

The higher the width value the smaller the stencil bridge gap. If you set the width to 3.0mm, bridge would be
tiny. If you want to keep this stencil width but you want to increase the bridge width you will have to edit the
shape's outline and manually increase the bridge width.

Cutter Speed

With this value, you can specify the speed that the machine will cut the design. This value varies from cutting
machine to cutting machine and some machines does not allow you to change this value at all through our
software. You can make adjustments though, through the machine's panel. Fill free to change the Speed
setting based on the speed you want the design to be cut. 

The Cutter speed field can take values from 0 up to 100. 

Cutter Pressure

With this value, if it is enabled, you can specify the force that the machine will add on the blade in order to cut
the design or to the Pen/brush in order to draw the design. This value varies from cutting machine to cutting
machine and some machines does not allow you to change this value at all through our software. You can
make adjustments though through the machine's panel.

Fill free to change the Cutter Pressure setting based on the depth you want the material to be cut or paint.
The value of Cutter Pressure varies from cutting material to cutting material. Thicker material need more
pressure and thinner less.

The Cutter pressure field can take values from 0 up to 100. 

Cutter Passes
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You can specify the number of Passes you want the design to be made with. It actually defines how many

times each shape will be made by the machine. 

Blade depth

With this option you can set the Blade depth of the cutter blade. This value varies from cutting machine to
cutting machine and some machines does not allow you to change this value at all through our software. You
can make adjustments though on the actual machine. 

Fill free to change the Blade depth setting based on the depth you want the material to be cut. This value is
there only for your information, to remind you that for this object you have to change the Blade depth on the
machine. The value of Blade depth varies from cutting material to cutting material. Thicker material need
more depth and thinner less.

Blade color

This drop down menu lists the Blade color that you have to use in order to cut the specific material. This is
applicable on specific machines that include various blades, with different colors. Usually each color is for
cutting different  material. Check the cutters manual for more information about which blade is from which
material. 

For example, for Artistic Edge cutter the Blades are for the following use:

· Blue Cap Blades is for cutting thicker materials

· Red Cap Blades is for cutting thin materials

· Yellow Cap Blades is for cutting fabrics

Select the Blade color that you will use for the currently selected object and during the Cutting process the
Software will notify you that you will have to use the respective Blade color in order to cut the shape. 
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Paint - Painting designs

Chapter XVII

Creative DRAWings gives you the ability to create Paint designs by mounting a Pen/Brush to your Digital
cutter. It is a totally new way to create Paint designs on garments or any other material. There are various
Paint fill types and various Paint outline types. Each design will be applied on the material by drawing the
paint pattern you have created using the software. The Digital cutter moves back and forth with the 
Pen\Brush attached on it and draws the design you have created, object by object, following a similar
sequence of action that you usually follow when you Cut a design. Although this time instead of Blades you
are changing Pen\Brush colors.

Paint design

All options that are lis ted in the following topics will be available to you only if you have the
Paint technique activated when you create a design or if you enable Paint technique using

the Select techniques  option.

Create your first Paint design
This is a step-by-step tutorial to guide you in creating your first Paint design.

1. Start Creative DRAWings by double clicking on shortcut icon  that you will find on your
Desktop.
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2. The application will load and the startup wizard will prompt you to create a new design or load an
existing.

Starting dialog

3. Select the Create new option and click Next> button to proceed.

4. In the next step you must select which Techniques you want to be enabled for the created design.
For the purposes of this sample we will enable only Paint technique. Then click on Next button to
proceed.
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Select Techniques

5. The Fabric dialog will appear, using this dialog you must select a fabric type and a color that is as
close as possible to the one you are going to produce the design on. Expand any of the fabric
categories, by clicking on the + icon next to it, to select a fabric and-or a color for the fabric. After
selecting the Fabric, choose the color from the list at the middle of the dialog. The Fabric selection
is not just an issue of previewing the design on the fabric. The software automatically adjusts,
according to the selected fabric, various embroidery parameters. Embroidery quality depends on
some of these parameters. The software suggests the appropriate backing materials for every
fabric, in the printout of each design. In case that you don’t want to preview the design on any fabric
you can select the none option that exists in any of the fabric categories. In this case only the color
that is select in fabric dialog will appear in the background of the created design. More information
about Fabric selection is provided into a separate topic. After selecting a Fabric and a color for the
fabric click on Next to proceed.
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·
Select fabric dialog

6. The Artwork source dialog will appear.

7. Select the From artwork file option and Click on the browse button  at the right to select a
design.

Starting dialog - 2nd page 

8. The Open dialog box will appear from where you can browse to find any bitmap or Vector image to
be used as artwork for the new design.
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Open design dialog

9. Click on My documents folder at left side of the dialog.

10. Then find and double click on the Embroidery designs folder 

11.  Inside Embroidery designs folder you will find another folder called Creative DRAWings
samples. Double click on it.

12. Inside the samples folder you will find ready-made Vector (clipart) designs that you can import and
convert to a Paint design. Select any of them, in our example we will use the ASC-00340.cmx file.
Select it and click the Open button. 

13. The Artwork source dialog will appear once more with the design you selected under From file
field. Click on Next to proceed.

14. The Color reduction (number of Brushes) dialog will appear where you can select the Brushes
palette. Since only the Paint technique is enabled, the software will convert the imported design
using paint types and paint colors.
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Color reduction dialog

15. Click on the arrow under the Brushes Palette and the drop-down menu will show the available
ones.

16. Select the brand-name brush palette you want to use by clicking on the list. For example, select the 
MARABU TEXTIL PAINTER brush palette.

17. The colors of the design you are importing will automatically be assigned to the closest brush color
of the MARABU TEXTIL PAINTER palette. 

18. In the Color reduction dialog you can see that the design has 6 different colors but the design is
automatically reduced to 4 colors since the palette has only 4 brushes.

19. You can reduce the number of colors in the design by moving the arrow to the left.  Click Finish to
end the process and convert the imported design to a Paint design.

20. The design will appear in the working area filled with the available Paint types. You can have a better
preview of the paint effect by activating Realistic paint 

The imported design converted to Paint Realistic paint view

21. Select any of the design parts and see on Object properties, Paint fill or outline types have been
automatically applied. Every time you select a Paint object its properties appear on the Object
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properties Toolbar. You can select multiple object by holding the Shift key pressed and clicking on
the objects you want to add it to the selection.

22. For example select the heart, as you can see Paint fill is the automatically select Paint type. You
can easily change the fill type by clicking on any other fill type for example Row-fill.

23. We can  use all editing tools and perform various transformation on the artwork. At this point we will
only mention something about object properties. There are various properties for any of the paint
types. For example for the Paint Row fill of the previous figure we can adjust the Density and or use
Short/long movements.

Initial object Disable short/long Increased density

24.  At this point we should mention about Cutter settings, let's suppose that we own Artistic Edge
digital cutter and our design has only paint objects. We will select all objects and from Cutter
presets we will select the preset Edge - Paint. The selected set of cutting options (Cutter speed,
pressure, passes) will be applied to all selected objects. This cutter settings are suitable for Paint
objects.

Paint preset - Cutter settings 

25. Let's suppose that we are done with the design and we are ready to Paint the parts using our Digital
cutter (the cutter must support placing of a Brush instead of the Blade).
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You should always save the design to .draw file format, in order to have it for later
reference.

26. From File menu, Export sub-menu activate Export to Cutters option.

27. From the appearing dialog we must select one of the Cutters to connect or a File format if we want
to export to a file and import to our cutter in a manual way. In our sample we will use Artistic Edge
cutter, click on the Artistic Edge Cutter icon and then click on Connect to proceed.

Select a Cutter or Export to a file

28. The Export to Cutter dialog will appear, using this dialog you can DRAW any design part with your
cutter. If the Digital Cutter is properly connected and powered ON, then at this point you should be
able to directly communicate with the Cutter through this dialog. At this point that we must mention
that on the preview you can see the actual colors of the Brush palette that you have selected for the
design. Some colors have been substituted by their closest one from the Brush palette. For
example the Pink  color was substituted by this number 029 color called Flesh Color.
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Before proceeding you must have loaded the cutting mat with the material to Draw into
the Cutter. 

29. We will now proceed and Draw the design parts onto any paper like material or onto a Fabric.
Select all items from the Templates area.

30. Then you should select an origin. This is the point that you want the cutter to begin Drawing from. 

31. If you have never used this material or the Pen on your Cutter you should first perform a Test to
verify that the Pen/Brush Draws as you wish on the current material. More information about Test
functionality setting is provided into separate topic.

32. Place the respective Pen on the pen holder and now you must position the head of Cutter with the
first Pen / Brush at the position on top of the area the you want to Draw. More specifically we need
to place the head close to the edge of the upper left part of the material according to the origin we
have selected. Use the arrow buttons to move the Head to a desired position. If you need to fine tune
the position of the Head you can use Ctrl , Shift keys on your keyboard to adjust the step of the
movement.

§ Hold Shift key  in order to make the movement small.

§ Hold Ctrl key  in order to have a large movement step.

§ Use Ctrl and Shift keys together (  + ) to make a very small movement step.

33. You can Trace the area that the design will need to make sure that it fits into the material you have
placed.

34. Finally press Draw in order to start the actual cutting process. When the part of the first Pen is
complete the Cutter will stop and you will be prompted to place the next Pen/Brush onto the pen
holder.
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Color management

In this section we will present how to work with colors for your Paint projects. In the following topics we
assume that you have only Paint technique enabled in order to present how to handle Pen\Brush colors for
your designs. When creating a new design either you are prompted to select a Brush palette (Color
reduction wizard step) or you are working with the default Brush palette that contains RGB colors. In any

case you can select which Brush palette to use using the Edit palette icon  on standard toolbar. In the
Edit Palette drop down menu are listed the color palettes of the major brush manufacturers as well as the
default RGB (Red Green Blue) color palette. You can select the brush palette you are using (the
manufacturer of the brushs you are using), to create the design you want based on the colors that actually
exist. Select a brush palette and click Ok button to apply changes. The colors of the selected palette will now
appear on the brush palette toolbar allowing you to use them to fill with color the objects you have designed or
you will design. By following this procedure you can be sure that the color you used on the design actually
exist and can be found in the market. 

 

Palette drop down menu

On the lower part of the application window you can see the Palette toolbar. On the top area of the toolbar
you can see the available colors and on the bottom area you can see the already used colors for the design.
The available colors may differ according to the Brush palette you have selected. For example on the
following figure the available colors are from the Marabu Textil Painter palette.

Color palette

Generally the Brush/Pen palettes have a limited number of colors. When importing Vector graphics or
Bitmap images that have too many colors, the program can not automatically set identical color, from a
Brush palette, as on the original artwork. There is a mechanism that can make a color match and reduce the

produced colors, use Edit palette icon  to bring up color reduction dialog. For example we have
imported a cmx design that contains 6 colors, as you can see on the left area of the following figure if i do not
select any Brush palette and leave the default RGB palette. In the right part we have selected  Marabu Textil
Painter palette  and as we see can the color reduction mechanism has matched the colors to the Brushes
of the selected Brush palette. 
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RGB palette used, no color reduction Brush palette selected automatic color reduction

One this we must say is that in any case when the design appears in design area (DRAW mode) the colors
that you can see on the design are the default RGB colors and not the automatically matched colors from
Color reduction. In order to preview the design with the palette matched colors you must switch Stitch mode

  (Ctrl+2) when you cna see the final colors. To summarize, the colors of the final design can be adjusted

using the Edit palette, but you can only see final colors when switched in stitch  mode. Double click on
any of the matched colors and from appearing dialog select any of the available Brush palette colors. You will
see the color applied on the design in the design area. This is happening because there is no limitation to the
colors that you can use on a vector artwork, but there are limitations to the colors (brushes) you can use on
an Paint design. The software has a limitation of 99 colors on the brushes designs. You must always keep in

mind this limitation whenever you click on the stitch button and you see changes on the colors you have
assigned to the design. This is becoming clearly obvious when you are working with a specific
manufacturer's thread palette where all RGB colors are not available. The color match will not be identical
and when you are in the stitch tab you will see the design preview with slightly different colors but closer to
the final results.

Brush palette toolbar

The Brush/Pen palette toolbar is located at the bottom of the application window (Visible only in Draw
mode). Using the color icons you can choose colors (Fill or Outline) for any part of the design. In case that
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the toolbar is not visible you can use the respective option of View menu - Toolbar section. The toolbar is
consisted of two parts, the available colors and the colors that are currently used.

Color palette

Available colors

The available colors are the colors of the color palette you have selected to use. The colors are located at
the top rectangle area of the Palette toolbar and by default the RGB palette is loaded. You can change the
default color palette and use a specific Brush color palette from the Edit palette dialog (we will explain it
thoroughly later in this chapter). 

Available colors

Currently used colors

There is also the currently used colors area where all the currently used colors are listed. If the design has
five different colors they will be listed at the bottom of the palette toolbar. 

Currently Used Colors

As you can see any color icon is consisted of 2 triangles , one on the upper left part and one on the lower
right part. If you place the mouse on top of the upper left part of a color you can see a pen icon. This means
that the selected color will be used for the outline of the object. If you place the mouse over the lower right
part you will see a bucket icon revealing that the selected color will be used for the object fill. For any object
we select the colors (outline-fill) that are used for it are marked with icons in currently used colors are, in
order to be able to see clearly the colors that are used for the object. If you select an object of the design the

color that was used to be filled will be highlighted with a fill bucket  on the currently used colors area. If

the object has outline, also, the color of the outline will be highlighted with a pen  icon. The used colors
can be reused to new created objects by selecting the object on the working area and then the color you want
to be filed. 

At the beginning of the currently used color palette there is a square , which is the empty/none color. If a

selected object does not have a Fill color, then the fill bucket will appear inside the None color  square.
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If the selected object does not have an Outline color then the pen icon will appear inside the None color

 square. Also, if you do not want an object to have a Fill or an Outline color, you have to select the

object it and then click on both part of the none color square  to remove the colors from the object. 

The Brush palette toolbar is movable and re-sizable. You can change its position by click and dragging the
Title bar to a new position. The toolbar will float on the working area and become re-sizable. You can change
its dimensions and position on the software. You can keep it as a floating toolbar or you can position it back to
its initial position by click and dragging it at the bottom of application window.

Setting colors

By default when creating an object, the default Fill - Outline color is applied on it. The software has a pre-
defined set of Fill - outline colors to be used by default. Later in this topic we will present how to set the colors
that you wish to have as defaults. When you select an object, on the design area, you can see the color that

was used for the specific object's fill to be highlighted with a Fill bucket  on the bottom right corner of the

color. In the same way If the object has an outline color, the outline color will be highlighted with a Pen 
icon on the top left corner. Any of the used colors can be reused for newly created objects easily by creating
the object and then selecting on a  the color from currently used colors.

In order to change the Fill color of an object you have to select it and  then click on the bottom right area of
the color you want from the color palette or from the used colors. You can also Right click on the color and
from the right click menu select the Set fill color option. The object will be filled with the selected color and
the color will be added in the used colors area (if it is not already there). In addition, the color you have

selected can be easily recognized from the Fill bucket  icon that will have on it when it will be added in
the used colors area.

Furthermore, in order to change the Outline color of an object, you must select the object, and then click on
the top left corner of the color you want from the color palette or from the used colors. You can also Right
click on the color and from the right click menu that will appear select Set pen color option. The color you
have selected will be added in the currently used colors area (if it is not already there) and it will have the Pen

  icon on the top left corner. The selected object is colored immediately with the Fill or Outline color that
we have clicked.

If you do not want an object to have Fill or Outline color you can click on the bottom right or on the top left

corner on the Empty/None color  box, that it is located in the currently used colors area, according to

whether you want to remove the Fill or Outline/Pen color. The Fill  or the Outline  color will be
immediately removed from the object allowing you to create the design you want.

Set default Fill or Outline colors 

As we have already mentioned when creating an object a set of default Fill or Outline colors is automatically
applied on the created object. We can easily change the default set of Fill and Outline colors and decide
whether to make the new selection a program default or use only as default set for the specific design. 

When no object is selected if we click on lower right area of any color, then the Set default fill color dialog
will appear displaying the color you have selected. On this dialog you can select for which types of objects 
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Graphic objects - Text objects the selected color will be used as default Fill color. Furthermore you can
select whether this fill color will be used only for the current design or for every design from now on. In case
that have a selection that you do not want to release but you want to set a default fill color, you must hold Ctrl
key on your keyboard and then click on the Fill color that you want to set. The same dialog will appear, your
selection will not be filled with the clicked color, it will be just set as default Fill color.

Set default Fill color dialog

In the same way we can change the Default Outline color. When no object is selected if we click on upper
left area of any color, then the Set default Pen color dialog will appear displaying the color you have
selected. On this dialog you can select for which types of objects Graphic objects - Text objects the
selected color will be used as default Pen color. Furthermore you can select whether this Pen color will be
used only for the current design or for every design from now on. In case that have a selection that you do
not want to release but you want to set a default Pen color, you must hold Ctrl key on your keyboard and
then click on the Pen color that you want to set. The same dialog will appear you can apply default Pen color
and your current select will not be changed.

Set default Outline color dialog

From the same dialog you can change the Width of the default outline/pen. Check the Set default color
width to checkbox and type the width you want in the respective field. The default outline will set to the new
value and will be applied to the current design or on every design according the changes you have made in
the Set default pen options dialog.

In case that you want the created objects not to have have Fill or Outline color, by default, you can click on

the bottom right or on the top left corner on the Empty/None color  box, according to whether you want

not to have Fill  or the Outline  color.



Creative DRAWings® 7.1 manual516

© 2017 DRAWstitch Ltd.

Editing default color palette (RGB)

The default color palette of the application is the RGB (Red, Green, Blue). This color palette consists of 358
colors selected from all available colors as representatives. Since this palette has generic colors we can 
Add, Edit or Remove colors from this palette. Threads and Brushes palettes are using the same RGB
palette, so if we edit the Threads RGB palette then the color changes will also be applied on the Brushes /
Pen RGB palette. In order to Edit the RGB palette we must edit the Threads palette part. 

In order to edit the RGB palette  you must also have enabled the Embroidery technique.
When embroidery technique is enabled you can also see Threads palette as on the
following figure.

To Add a new color you have to Right click on the RGB color palette that is listed on the Thread palette
toolbar and select the respective option.

Right click menu

The Color dialog box will appear from where you can choose the color you want the new color to have. There
are various ways you can choose a color from the Color dialog. You can choose a color by clicking on the
respective one from the Basic colors list, or by clicking on the color rectangle where all possible colors are
listed, or you can type the exact code number of the color you want on the Red – Green – Blue / Hue – Sat –
Lum fields and produce the color you want.
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Color dialog

After choosing the color, you can set the name of the color in the Color name field or leave the suggested
name and click Ok button to confirm your selection. The color you have chosen will appear at the end of the
existing RGB color palette. The newly added color can be used normally. 

To Edit an existing or newly added color you have to right click on the color and select the Edit color option
from the right click menu. The Color dialog box will appear from where you can choose a different color or
name for the color that you are editing. There are various ways you can change the color from the Color
dialog. You can change the color by clicking on a different one from the Basic colors list, or by clicking on the
color rectangle where all possible colors are listed, or you can type the exact code number of the color you
want on the Red – Green – Blue / Hue – Sat – Lum fields and produce the color you want. If you want you can
edit also the Color name by typing a new one in the respective field. When you finish you can click the OK
button to confirm the changes or Cancel button if you want to discard the changes you made. The changes
you made will be applied on the selected color and it will be ready for use. 

To Delete an existing or newly created color you have to Right click on the color and select the respective
option from the right click menu. The color will be deleted immediately.

Important: Be careful when you use the Delete function because you cannot Undo the deletion of a
color.

If you want to Reset the RGB palette to its default status you have to right click on any color and select the 
Reset palette option. The color palette will return to its default status and all the changes you have made will
be lost.

Important: All the above options are available only for RGB color palette. 

Selections by color

Brush palette toolbar includes the ability to select objects by color. This option is very useful when you want
to make a change to all objects that have the same color. You can select them and then make the change
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you want. You can change colors or fill types to all objects or apply any other option you want. You can select
objects by Fill color, by Pen (outline) color or simply by color.

To select the objects by color you have to right click on the color you want from those that are listed on the
currently used area and from the right click menu select one of the three available selection options: Select
by Fill, Select by Pen and Select by color. 

· If you select Fill color option, all objects that have the fill color you right clicked on will be selected. 

· If you select Pen color option, all objects that have the Pen (outline) color you right clicked on will be
selected. 

· If you select Any color option all objects that have Fill or Pen (outline) color you right clicked on will be
selected. 

Any change you make on the selected objects, affects all objects.  

Select by color right click menu

Change brush width

The actual brushes have various widths. Therefore in order the software to be more accurate, in the Brush
palette you have the ability to define the width of the specific brush color you will use.

Right click menu

To do that you have to right click on any of the currently used colors and from the right click menu select the
Change brush width option. The change width dialog will appear where you can set the width of the actual
brush that you will use.

Change width dialog

In the Change color's width dialog type the brush width you like or use the up and down arrows to increase
of decrease the current width. After making the appropriate changes click OK button to confirm the change or
Cancel to exit. If you hover over the color you right clicked on you will see that in a pop-up info box shows you
the color width of the specific color.
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color width

If you want to use the same color but this time to set a different color width, you have to assign the same
color on the object by clicking on it on the Available colors and then right click on it (on the currently used
area) to change width.  

same colors with different widths

Please remember that the brush manufacturer's palettes have a fixed brush width and if you try to change
their width then the color will change to a custom RGB color. The brush colors from the manufacturer's
palettes must be used as is. 

Paint transformations
The Object properties bar holds all the available object types, there are various Embroidery, Crystal and
Paint types. For the purposes of this chapter we will only present the properties of the available Paint types.

The object types are separated into types that are used to fill an area ( Fill tab ) and types that are placed

on the objects Outline ( Outline tab ). If the property bar is not visible you can open it from the View menu
or with the shortcut key Alt + Enter. Using the provided options you can change the Fill or Outline type of
any design part just by clicking on the desired type.

Paint technique must be enabled for the current design in order to view the available
Paint types.

 

Click on each tab, on the above image, to view their options.

The Paint fill types that are added in Paint technique are ZigZag, Fill, Row-Fill and Paint net fill and the
Paint outline types are   ZigZag and Line. Using the available Paint types you can chose the method that
will paint your objects. Each one of them uses a different method to paint a shape which allows you to give an
embroidery feel to the paint designs you are creating.

·
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Paint Fill

When Paint technique has been enabled, in the fill tab there are extra paint fill types, their icons have a brush
to reveal that they are paint types. The available fill types are not visible until you select an object from a
design or the whole design. When a vector design is imported and we have only Paint technique enabled, the
design  is filled with paint types automatically. You can apply any paint fill on the design manually by selecting

the object and then clicking on the respective Fill you want(Fill , ZigZag , Row-fill  or Paint

Netfill ). By default the Fill is set to Fill(paint Fill ).

Fill stitch type options

For designs that have only outlines or they are line art designs, the Fill option is not available. According to
the enabled techniques, in the fill tab there may be various stitch type fills (Embroidery technique) which are
explained in the Embroidery transformations chapter and Crystal Fill (Crystals technique) that is described
into a separate chapter. All the Paint fill types may have some properties that are specific for each of them
but mainly they have some common properties that will be described later in this topic in section Common
Paint fill properties (Density, Cutter settings and Remove overlaps).

ZigZag fill: 

This paint type is a special fill type that brush-lines are connecting two points from one side of the object to
the other. These points are formed like closely arranged zigzag  lines along the shape of the object. The
direction of the object defines the angle of the stitches. We can easily set the angle of Zigzag using the

Directions tool  on standard toolbar. Generally small and oblong objects will be filled with ZigZag Paint
type automatically. The ZigZag Fill includes some more options that allow us to customize the way that it will
be applied (Density) and the way that it will be produced (Cutter presets, Cutter speed, Cutter pressure and
passes). All these properties are common for all paint fill types and we will present them all together in
section Common properties.

Vector object Zig-Zag Fill Paint type
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Fill: 

This paint type is a series of brush-lines commonly used to fill large areas. You can create various fill
patterns by altering the angle and the density of the brush-lines. Most of the times the large objects are filled
with Fill paint type. This is the default Paint fill for every object that will be filled with a Brush color.

Vector object Fill Paint type

 The Fill Paint includes some more options that allow us to customize the way that it will be applied on the
selected object. These options are the following:

Row-Fill:

this paint type is a fill type similar to Fill paint type. It is longitudinal brush lines from one side to the other that
are vertical to the defined direction that it is automatically defined from the software. Row-fill is commonly
used to fountain like shapes. Row-fill type can be laid down at any angle and with varying densities. There is
also an extra option, Use short/long, which allows you to fill the object with fill like stitches that will adjust the
density based on the shape where they are placed in.

Vector object Row-fill Paint type
Row-fill Paint type

with short-long

Use short/Long:  

This parameter has to do with the brush-lines that will pass from the thick or narrow parts of the created
piping. If you want to keep the same density in all parts of the Row-fill you should enable this parameter.
With this way there will be less brush-lines passing from the narrow parts of the Row-fill and more brush-
lines from the thick parts.

If this parameter is disabled, the same number of brush-lines will pass from all the parts of Row-fill.
Therefore in some narrow areas of the shape, there may be too many brush-lines passing and the quality
of the result may not be the expected one. On the other hand if this parameter is enabled, the Row-fill
paint type will try to fill the shape with the best possible way by avoiding to paint areas that have been
already covered with color by using short/long brush movements
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Paint Net fill: 

this type is a special paint type that adds two scan lines that are crossing with parallel equidistant paint lines.
These two scan lines are forming a Net of paint lines. Using the available properties you can adjust the size
of the cells the angle of the Net and finally add offset to the Net fill.

Vector object Net Fill paint type

When Paint Net fill is applied it sets the fill type to be Net Fill. The Paint Net fill type is a special fill type
that adds two scan lines that are crossing with parallel equidistant running paint lines. These two scan lines
are forming a Net of Paint lines.

The Net Fill includes some more options that allow us to customize the way that will be applied on the
selected object. These options are the following:

Cell s ize: 

Using this option you can specify the size of each square of the Net. For example by setting the Cell size
to be 2.0 mm all squares of the net will have 2.0 mm side size. The maximum value that the Cell size
can have is 9.9mm and the minimum is 0.5mm. To change the value of the Cell size option you have to
either click on the up and down arrows next to the field to increase or decrease its value or type the exact
value you want and then press the Enter key from the keyboard. Another way to increase or decrease the
value is by clicking inside the Cell size field and use the mouse wheel to change its value. The changes
that you will make will be immediately applied on the design. By changing this value you can create a net
with large squares or small squares according your preferences.

Offset: 

Using this option you can specify the distance, inner or outer, you want the Net fill to be moved. For
example: if you set the Offset value to 3mm the Net fill will increase its size by 3mm to all directions
outside its original outline. On the other hand if you set the value to -3mm the Net fill will decrease its size
by 3mm to all direction inside its original outline. 

The maximum value that the Offset can have is 9.0mm and the minimum is -9.0mm. To change the
Offset value you have to either click on the up and down arrows next to the field to increase or decrease
its value or type the exact value you want and then press the Enter key from the keyboard. Another way
to increase or decrease the value is by clicking inside the Offset field and use the mouse wheel to change
its value. The changes that you will make will be immediately applied on the design.
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Angle:

With this option you can change the Angle that the Net fill will be applied. For example: When the angle is
set to 0o degrees the Net fill will be aligned on the X and Y axes creating right angles. If you change the
Angle value to 30o degrees the Net fill will be rotated 30o degrees anticlockwise and change completely
its direction. 

The Angle values that you can set are between 0o and 360o degrees. To change the Angle value you
have to either click on the up and down arrows next to the field to increase or decrease its value or type
the exact value you want and then press the Enter key from the keyboard. Another way to increase or
decrease the value is by clicking inside the Angle field and use the mouse wheel to change its value. The
changes that you will make will be immediately applied on the design. 

By changing the Angle of the Net fill you can orientate it based on the shape that it is applied on. This
ability allows you to produce better and more beautiful embroidery results.

There are also two more options that are very useful in customizing the way that the design will be
produced. Those are the Remove overlaps option and the Sequence option. 

Common fill properties

Density:  

You can activate the Density option by checking the check-box next to it. In the numeric field, you can
specify the density of the brush-lines that you are adding. You can also adjust density by clicking the

arrows next to the value or by clicking on the value and rotating the mouse wheel  if there is one.
Changes are instantly previewed on the design area and can be set by clicking outside the density field.
The default Density is 1.20mm that ensures a good area coverage. 

Zigzag 

If you increase the density over 5mm then the ZigZag paint fill will change to single lines that will not be
connected with a diagonal line. This means that if two successive lines go further away than 2.5mm width
the ZigZag will switch to single lines.

 Zigzag Density 3.00mm Zigzag Density 5.00mm

Fill
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If you increase the density over 5mm then the Fill paint will change to single lines that will not be
connected with each other. This means that if two successive lines go further away than 2.5mm width
the Fill paint type will switch to single lines.

Density 3.00mm Density 5.00mm

Row fill

If you increase the density over 5mm then the Row-Fill paint fill will change to single lines that will not be
connected with each other. This means that if two successive lines go further away than 2.5mm width
the Row-Fill will switch to single lines.

Density 3.00mm                                                                     Density 6.00mm

Cutter presets

All the paint objects are produced by placing a Brush/Pen to your digital cutter and then exporting the
design to the cutter. When exporting Paint designs, the cutter must be instructed to use lower speed and
less pressure in order to achieve best results. These are some settings that you must adjust either for
each object, here in object properties, using the following properties (Cutter pressure, Speed, Passes)
or at the Export to Cutter dialog. In order to assist you in selecting the proper settings according to the
material and the type of the operation we have prepared various operation presets. Click on the Cutter
presets button and from the drop down menu, select any of the available presets for your Cutter and the
material that you are going to use. This preset selection affects only the selected objects. For example
for painting tasks for users that own Artistic Edge cutter  you can select the preset Edge , Paint. After
selecting the preset you will see the values of the following properties change (Cutter pressure, Speed,
Passes). 

Cutter speed

With this value, you can specify the speed that the digital cutter will produce the design. This value takes

values from 0 - 100, 100 is the max speed that each digital cutter can support. Some digital cutters may
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not allow you to adjust this value at all through our software, you can make adjustments though through

the machine's panel. So the selection of speed though this property may not be applied during production.

Cutter pressure 

With this value, you can specify the pressure (force) that the digital cutter will use on its head. In our
case, we will use a Brush/Pen to our digital cutter in order to paint a design the pressure must be less
than when we actually use a Blade. This value takes values from 0 - 100, 100 is the max pressure that
each digital cutter can support. Some digital cutters may not allow you to adjust this value at all through
our software, you can make adjustments though through the machine's panel. So the value that you have
selected may be ignored. The value of Pressure varies from material to material, thicker material need
more pressure and thinner less.

Passes

You can specify the number of Passes you want the design to be made with. It actually defines how

many times each shape will be made by the machine. 

Remove overlaps: 

This is an automatic filter which removes all overlaps between the objects of the vector designs. This
filter uses artificial Intelligence and it is applied only where necessary. The application of the filter results
in the reduction of brush's paint that will be placed on the fabric or any other material used. It is also
possible to manually alter the overlapping status of each object. There are three possible options that you
can apply on a specific object, Auto, Never and Always. The Auto is the default option that is used to
create the best possible results on the design. When the Never option is applied on an object, the
specific object will never trim the objects that overlap. This means that all the objects/shapes that are
under the selected objects will be painted normally, coloring the fabric with the color the specific object
had. The opposite option is Always. When it is applied to a specific object trims all the objects that it
overlaps. This means that all the parts of objects/shapes that are under the selected object will not be
painted with color. 

The software uses this tool to color your design more efficiently and effectively. But in order for this
function to work well, avoid applying trim tool when in DRAW mode. Trim tool must always be used with
care or after the setting Remove overlaps option to Never.  

Paint Outline

When Paint technique has been enabled, in the Outline/Pen tab there are extra outline types, their icons
have a brush to reveal that they are paint types. Using the extra Outline/Pen types we can create line-art
objects with paint. The available outline types are not visible until you select an object from a design or the
whole design. When a line-art vector design is imported and we have only Paint technique enabled, the
program automatically puts paint pen fill on it automatically. You can apply any paint outline on the design

manually by selecting the object and then clicking on the respective Brush/Pen outline you want (Line ,
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ZigZag ). By default the outline is set to Line( Line ). For designs that do not have border the
Outline option is not available.  Every time you select one,it is applied immediately to your design.

Click on each stitch type icon, on the above image, to view how they applied.

For designs that have only outlines or they are line art designs, the Fill option is not available. According to
the enabled techniques, in the Outline/Penl tab there may be various stitch types (Embroidery technique)
which are explained in the Embroidery transformations chapter , Crystals type (Crystals technique), Cut
objects (Cut technique) and Stencil objects (Stencil technique) that are described into separate chapters. All
the Paint outline types may have some properties that are specific for each of them but mainly they have
some common properties that will be described later in this topic in section Common Paint outline
properties (Offset, Cutter settings and Remove overlaps).

Paint Line

this Paint type consists of a single brush-line between two points. It is used mainly for outlining, fine detail and
complete designs or for creating redwork line art designs. The program automatically puts Line pen on line
art designs and thin object outlines. For all Paint line objects there are some properties to adjust, Offset and
various Cutting options, all these options are described later in this chapter in  

 Vector object Line Pen Paint type

ZigZag Pen:

This Paint type is applied on thick outline objects by forming closely placed zigzag brush-lines along it. It is
generally used to fill borders and line art designs. Generally all the thick line art designs and object outlines
will be filled with ZigZag Pen Paint type. On this Paint type you can adjust the density and produce the design
you want to paint with the brush.
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Vector object Zig-Zag Pen Paint type

Density: 

You can activate the Density option by checking the checkbox next to it. In the numeric field, you can
specify the density of the ZigZag outline brush-lines that you are adding. You can also adjust density by

clicking the arrows next to the value or by clicking on the value and rotating the mouse wheel  if there
is one. Changes are instantly previewed on the design area and can be set by clicking outside the density
field. The default Density is 1.20mm that ensures a good area coverage. If you increase the density over
4mm then the ZigZag paint fill will change to single lines that will not be connected with a diagonal line.
This means that if two successive lines go further away than 2.5mm width the ZigZag will switch to single
lines.

Density 3.00mm                                Density 5.00mm

Common Paint outline properties 

Offset:

You can activate the Offset option by checking the check-box next to it. In the numeric field you can enter
the value of offset you want, with lowest value of -15mm and highest value 15mm. Also, you can increase
or decrease the offset value by clicking on the arrows next to the value or by clicking on the value and
rotating the mouse wheel, if there is one. The value that you are inserting defines the exact distance you
want the running outline to have from its initial position. If the value is negative, running object will make an
inner offset and the opposite, if it is positive. The default offset value is zero and can be changed only
from you. Any changes you are making on the offset value they are automatically previewed on the
design.
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Paint line offset Paint Zigzag offset

Cutter presets

All the paint objects are produced by placing a Brush/Pen to your digital cutter and then exporting the
design to the cutter. When exporting Paint designs, the cutter must be instructed to use lower speed and
less pressure in order to achieve best results. These are some settings that you must adjust either for
each object, here in object properties, using the following properties (Cutter pressure, Speed, Passes)
or at the Export to Cutter dialog. In order to assist you in selecting the proper settings according to the
material and the type of the operation we have prepared various operation presets. Click on the Cutter
presets button and from the drop down menu, select any of the available presets for your Cutter and the
material that you are going to use. This preset selection affects only the selected objects. For example
for painting tasks for users that own Artistic Edge cutter  you can select the preset Edge , Paint. After
selecting the preset you will see the values of the following properties change (Cutter pressure, Speed,
Passes). 

Cutter speed

With this value, you can specify the speed that the digital cutter will produce the design. This value takes

values from 0 - 100, 100 is the max speed that each digital cutter can support. Some digital cutters may

not allow you to adjust this value at all through our software, you can make adjustments though through

the machine's panel. So the selection of speed though this property may not be applied during production.

Cutter pressure 

With this value, you can specify the pressure (force) that the digital cutter will use on its head. In our
case, we will use a Brush/Pen to our digital cutter in order to paint a design the pressure must be less
than when we actually use a Blade. This value takes values from 0 - 100, 100 is the max pressure that
each digital cutter can support. Some digital cutters may not allow you to adjust this value at all through
our software, you can make adjustments though through the machine's panel. So the value that you have
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selected may be ignored. The value of Pressure varies from material to material, thicker material need
more pressure and thinner less.

Passes

You can specify the number of Passes you want the design to be made with. It actually defines how

many times each shape will be made by the machine. 

Remove overlaps: 

This is an automatic filter which removes all overlaps between the objects of the vector designs. This
filter uses artificial Intelligence and it is applied only where necessary. The application of the filter results
in the reduction of brush's paint that will be placed on the fabric or any other material used. It is also
possible to manually alter the overlapping status of each object. There are three possible options that you
can apply on a specific object, Auto, Never and Always. The Auto is the default option and the one that
Creative DRAWings uses to create the best possible results on the design. When the Never option is
applied on an object, the specific object will never trim the objects that overlap. This means that all the
objects/shapes that are under the selected objects will be painted normally, coloring the fabric with the
color the specific object had. The opposite option is Always. When it is applied to a specific object trims
all the objects that it overlaps. This means that all the parts of objects/shapes that are under the selected
object will not be painted with color. 

The software uses this tool to color your design more efficiently and effectively. But in order for this
function to work well, avoid applying trim  when in DRAW mode. Trim tool must always be used with care
or after the setting Remove overlaps option to Never.  

Directions and Divides

For the objects that have a paint fill there are 2 extra tools available in the Tools toolbar. Available only for

Paint, Embroidery technique. These are Divide  and Directions  tools. 

Divide 

Using Divide tool , it is possible to divide ZigZag and Row-fill paint fill objects and manage the way in
which the paint lines are split into sub sections. The objects are not increased but split to internal branches.
This tool gives you the flexibility to customize the way ZigZag and Row-fill objects are painted on the fabric

simulating even better the "embroidery look" style. In order to add a Divide line, click on   icon or press
the Shift + D shortcut keys from the keyboard. Then click on the object you wish to divide (in order to select
it). Click and drag from one side of the object to the other in order to specify the divide line. If you want to
delete the divide line you have created, just click on the ‘X’ icon in the middle of the line. You can change any
existing divide line by clicking and dragging the points of the line. The Divide lines have green color in order
to distinguish them from the directions lines which are red. It is very useful also when you want to create
designs with Text. You can divide sections of the the characters and define exactly the way you want to be
painted. 
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Before divide Apply divide tool    After divide tool

      

Directions 

Using Directions tool , it is possible to change the direction of all paint fill objects except paint net fill. In

order to add a direction first you have to click on  icon or press the ‘D’ shortcut key form the keyboard.
Then click on the object, which direction you wish to change (in order to select it). Click and drag in order to
specify the direction of the paint fill lines. To delete the direction you have created, just click on the ‘X’ icon at
the middle of the direction. You can change any existing direction by clicking and dragging the points of the
direction. 

Step Directions Satin Directions

By changing Directions in a design you can adjust the way the paint lines will be applied on the fabric and be
able to produce different results. In ZigZag and Row fill objects you can have more than one paint directions
allowing you have fluctuations in the way the paint lines will be applied. On the other hand in paint Fill objects
you can have only one Direction of paint lines. With the combination of Divide and Directions tools you can
create unique designs that can have many sub-objects as brunches and specific direction of paint lines for
each sub-object. 



531Paint - Painting designs

© 2017 DRAWstitch Ltd.

Realistic Paint
You can enable or disable Realistic Paint option from the View menu. By enabling the Realistic paint option
the software will try to create a more realistic preview of the Paint design you have created. The brush-lines
will become transparent to a level that their overlapping areas will make the color appear darker. This will give
you a more accurate preview of the final result. On the other hand if you disable the Realistic Paint option
you will get a solid color coverage which is also the default way the objects are filled with brush-lines. This is
a very useful option that allows you to have a better preview of the final Paint result.

Realistic Paint Disabled Realistic Paint Enabled

Open as Photopaint
When creating a new design and you have only Paint technique enabled you can convert any Bitmap image
directly into a Photo-Paint design, Let's see how it works.

1. From the start-up wizard select the Create new option and click Next> button to proceed..

Starting dialog

2. Select which Techniques you want to be enabled for the created design. For the purposes of this
sample we will enable only Paint technique. Then click on Next button to proceed.
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Select Techniques

3. The Fabric dialog will appear. Expand the Embroidery normal category from the list at the left by
clicking on the + icon next to it.

4. Select the Fabric similar with the one you will actually use for your Paint project. For example, select
Cotton fabric. 

5. After selecting the Fabric, choose the color from the list at the middle of the dialog.

6. Click Next> button to continue.
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Select Fabric

7. The Artwork source dialog will appear. Select the From artwork file option and Click on the

browse button  at the right to select a design. Se 

Starting dialog - 2nd page 

8. The Open dialog box will appear from where you can browse to find any bitmap or Vector image to
be used as artwork for the new design.

9. In order to open as Photo-paint we must select any Bitmap image (.jpg *.png *.bmp *.gif etc) using
the open dialog. 
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Open design dialog

10. The artwork source dialog will appear once more with the selected Bitmap in the path .Click on next
to proceed to the Artwork image step. Select option Open as Photo-paint / Photo-stitch  and click on
next to proceed. 

 

11. The Color reduction (number of Brushes) dialog will appear where you can select the Brushes
palette. Since only the Paint technique is enabled, the software will convert the imported design
using paint types and paint colors.
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Color reduction dialog

Just like that you can convert the bitmap image to a perfect Photo paint design. The conversion is made
automatically, the Photo-paint will appear in the design area where you can make the adjustments. Photo-
paint is another alternative you have when it comes to filling bitmap images with paint.  It consists of 4 paint
layers that have different colors. Each brush color layer is one of the CMYK(Cyan, Magenta, Yellow and
Black) color model. First the Magenta color is painted, then the Cyan color, the Yellow color follows and finally
comes the Black color. These colors cannot be changed and you must use them exactly as they are
produced, if you want to produce accurate Photo-paint results. Generally you cannot edit the actual bitmap
image but you can re-size and change the position of the Photo-paint design. If you want to edit the actual
bitmap image you have to use a Bitmap editing software and then import the edited bitmap back to Creative
DRAWings to view the results. By editing the bitmap you can increase the quality of the painted result.

 

Photo to Photo-paint

You can increase the painted result of the Photo-paint design by adjusting the image contrast. By increasing
the contrast of the image you will get thicker zigzag bars in the darker areas of the photos and add detail to
the final colored design. Also, some adjustments to the image size might needed to get more detail to your
photo-paint. To increase the size of the bitmap inside Creative DRAWings you have to select the Photo-paint
design, and then re-size it by click and dragging the corner handles of the bitmap or the handles at the
middles of each side. The bitmap will be re-sized and the Photo-paint will be recalculated. By increasing the
size of the bitmap you automatically increase the area that will be covered from the satin bars that will lead to
detail increase. 
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The photo-paint object gives you the ability to adjust the satin bars’ Width and the Density of each satin bar
for more accurate results. With the Width value you can set the distance that two satin bars will have
between them and with the Density value you can set the density that each satin bar will have when it
passes over dark areas. By adjusting those two values you can get more detailed photo-paint results. 

Also, you have the ability to create Monochrome Photo-paint by checking the respective option from the
Object properties toolbar. The Photo-paint will become monochrome created from only one color (black or
any other you have selected from the brushes color palette) . This is a great effect that can give an artistic
feeling to your photo-paint.  

Monochrome Photo-paint

Important: Creative DRAWings can import only Bitmap images that have been created
with RGB (Red, Green, and Blue) colors. Any Bitmap that was created with CMYK (Cyan,
Magenta, Yellow, and Black) will not convert properly.

Convert outline to Object
Any created object may have have outline or not. In case that an object does not have any outline we can
easily add outline color simply by left clicking on the top left corner of the color you want the outline to have.
In case that you click on a Thread color, running outline of that color will be automatically added. In the same
way if you click on a Brush color, Paint line outline will be automatically added with the selected color. 

The added outline  is  not a separate object it belongs to the selected fill object. 

if we want to reshape the outline then the fill will be reshaped as well because it is an object. Convert
outline to Object exists in order to covert the outline/border that is attached on an object to a separate
object and handle it as a Fill or outline/pen object. 

If you convert the outline to a Fill object, you will be able to fill it with Appliqué  stitch type that it is not possible
to do it otherwise. Also, you will be able to apply all kind of shape transformations on it.

If the outline thickness is smaller than 0.9mm and you apply the Convert outline to object option, the
outline will be converted to Running object and not to a Fill object.

If the outline thickness is greater than 0.9mm and you apply the Convert outline to object option, the outline
will be converted to Paint ZigZag object (Fill object).
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Apply Convert outline to object option to star object

To apply Convert outline to object option you have to select an object that has an outline and from Edit

menu select the respective option. You can also apply the same option by pressing the Ctrl, Shift and Q

keys (Ctrl+Shift+Q) from the keyboard after selecting the object you want to apply it. The outline will be

separated from the fill object and can be handled as a different object.
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Embroidery - Creating embroidery designs

Chapter XVIII

In this chapter we will describe all the stitch transformations that the software can perform. You will learn
about Object Properties toolbar functionality, how you can adjust Design properties, how to change Fabric
and how to add Divides and Directions. 

In order to be able to use the Embroidery tools of the software you will have to enable the 

Embroidery Technique  from the Techniques  option. 

At the object properties toolbar all the stitch types that can be applied in the embroidery design will  be added.
Stitch types like Satin, Step, Row fill, Appliqué , Photo stitch, Running and Satin Serial are available for
creating unique embroidery designs. Furthermore there are two fill types Array and Crystal fill that can be
used for any object. Also, includes all the advanced stitch parameters that you can adjust according the
needs of the embroidery design. 

In addition, you can select the fabric and its color that you want to embroider your design on, from a large
variety of fabrics and colors. This gives you a better visualization of how your embroidered design will look on
your garment.  

Finally, you can adjust the properties of your design by making optimization changes and adding useful
comments.

Stitch types - Embroidery types
The software includes several stitch types some and Various Special Embroidery types. In the following
table we can see them listed. 

Stitch types Embroidery type Special types
· Satin

· Step

· Row fill

· Running

· Satin Serial

· Photo-stitch, 

· Cross-stitch

· Netfil

· Appliqué

· Array fill

Stitch types

Satin, Step and Row fill stitch types are used from the software to fill vector shapes with stitches. Running
and Satin serial stitch types are used to fill vector outlines and line art designs.
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Embroidery types 

Cross-stitch and Photo-stitch are used mainly to fill bitmap images. Appliqué  and Net fill embroidery
types are special types of embroidery that are used from the software to fill vector shapes with Appliqué  and
create Nets with stitches. 

Special types

Array is a special type that is used in order to fill vector shapes or vector outlines using Clipart item or other
design items creating repetitive patterns. 

The same stitch types are used with the same or different names from the embroiderers around the world.
To understand to which stitch types we refer with the names Satin, Step etc. we will analyze them for you. 

Satin stitch type

When the Satin stitch type is applied on any object, stitches are connecting two points from one side of the
object to the other. These points are formed like closely arranged zigzag stitches along the shape of the
object. Satin stitch type can be laid down at any angle and with varying stitch lengths. In Creative DRAWings
small and oblong objects will be filled with Satin stitches. 

Vector object   Satin fill

Running stitch type

Running stitch type consists of one stitch between two points. It is used mainly for outlining, fine detail and
complete designs. Also known as a walk stitch. In Creative DRAWings all line art designs and thin object
outlines will be filled with Running stitches.

Thin outline object    Running fill

Satin Serial stitch type

Satin serial stitch type is applied on thick outline objects by forming closely placed zigzag stitches along it. It
is generally used to fill borders and line art designs. In Creative DRAWings all thick line art designs and object
outline will be filled with Satin Serial stitch type.  



Creative DRAWings® 7.1 manual540

© 2017 DRAWstitch Ltd.

  Thick outline object  Satin serial fill

Step stitch type

Step stitch type (or Fill stitch type or Tatami stitch type) is a series of Running stitches commonly used to fill
large areas. Different fill patterns can be created by altering the angle, length and repeat sequence of the
stitches. In Creative DRAWings the large objects in the vector design most of the times are filled with step
stitches.  

Vector object   Step fill

Row fill stitch type

Row fill stitch type is a fill stitch similar with step stitch type. It is longitudinal stitches from one side to the
other that are vertical to the defined direction that it is automatically defined from the software. Row fill stitch it
is commonly used to fountain like shapes. In Creative DRAWings you have to select it in order to apply it on
the shape you want. 

Vector object   Row fill

Appliqué  

Appliqué  is an embroidery type that allows you to create Appliqué  on fabric easily. It is a fill embroidery type
therefore you have to draw a shape similar with the appliqué  fabric you want to apply on the garment and fill it
with a color. Then you can apply the appliqué  embroidery type that will apply the needed sequence of actions
in order the design to be embroidered properly. Appliqué  embroidery type is a complex type that includes
“Running stitches before” to mark the appliqué  position, “Running stitches after” to hold the appliqué  in place
and the E-stitches or Zig-Zag to decorate and hold the appliqué .
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Vector object  Appliqué  embroidery type

Cross-stitch embroidery type:

Each cross-stitch stitch consists of two running stitches that are crossed in between creating an ‘X’. Cross-
stitches of different colors are shaping the image by creating a grid. In Creative DRAWings every imported
bitmap image can be filled with the Cross-stitch embroidery effect look. 

         

Bitmap image   Cross-stitch fill

Photo-stitch embroidery type

Photo-stitch is an embroidery type that automatically recognizes the graduation of colors of any backdrop
image and sets fill stitches on it. The fill stitches are satin bars that cover the backdrop image area.
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Actual Photo   Filled with Photo stitch

Net fill embroidery type

The Net fill embroidery type is a special fill type that adds two scan lines that are crossing with parallel
equidistant running stitches. These two scan lines are forming a Net that can be used to create Laces and fill
areas. It is a very useful embroidery type.

  

Vector object                             Net Fill embroidery type

Array (Fill or Outline)

Array is a special type that we can used for both Fill areas and objects outlines. As we have mentioned
Array fill uses a base object in order to fill an area with the base object copied and placed in patterned way.
In the same way we can apply Array on an objects outline. 
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Array on outline Array fill 

Fabric selection

Fabric selection is not just an issue of previewing the design on the fabric. The software automatically
adjusts, according to the selected fabric, various embroidery parameters. Embroidery quality depends on
some of these parameters. Import quality factor is also how the fabric is stabilized in the frame of the
embroider machine. The software suggests the appropriate backing materials for every fabric, in the printout
of each design. In case that you don’t want to preview the design on any fabric you can select the none
option that exists in any of the fabric categories. In this case only the color that is select in fabric dialog will
appear in the background of the created design. 

The fabrics in Creative DRAWings are categorized in groups of embroidery types with different preset
parameters:

· Embroidery smooth, starting with Density 55 for normal thread No 40,  with lighter underlay

· Embroidery normal, starting with Density 40 for normal thread No 40

· Embroidery normal light, starting with Density 40 for normal thread No 40, with lighter underlay

· Embroidery light, starting with Density 55 for thick thread No 30. 

· Embroidery Ultra light, starting with Density 85 for thick thread such as wool 

· Embroidery Heavy, starting with Density 35 for thin thread such as metallic. 

All the designs can be previewed on different fabrics. There are various colors and types of fabrics. When
you decide to save your design, in order to embroider it on a garment, you must be sure that the fabric you
have chosen in Creative DRAWings is the same with the one that will be embroidered. Otherwise the results
may not be the expected. There are 50 fabric types in any color spread to different categories, from which
you can select the appropriate one. 
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·
Select fabric dialog

This option can be accessed from menu Tools > Select fabric, from the shortcut key Ctrl+F or from the

standard toolbar by clicking the select fabric  icon. Select fabric option prompts you to a dialog box
window where you can choose the fabric type and color by clicking on them. Your selection is automatically
previewed in the dialog box and behind it for your convenience. The fabrics are under the six categories that
are available In order to view it, click on the + button at the left side of each category to be expanded.

The six fabric categories that are available are Embroidery smooth, Embroidery Ultra Light, Embroidery
Light, Embroidery Normal Light, Embroidery Normal and Embroidery Heavy. 

· Embroidery smooth: In this category you can choose between any of the fabrics that are listed. The

embroidery that will be placed on these fabrics will be light and smooth. That is why the embroidery

on the 3D preview will appear with low density. All the fabrics have specific internal embroidering

parameters that needed for high quality embroidering. The embroidering parameters are adjusted to

each fabric in order the embroidery that will be placed on to have smooth feel and keep the fabric

soft. 

· Embroidery Ultra Light: In this category you can choose between “Bridal Tulle”, “Waffle knit”, “Wool”

and “Standard Ultra Light”. The embroidery that will be placed on these fabrics will be Ultra light. That

is why the embroidery on the 3D preview will appear with low density. The first three fabrics have

specific internal embroidering parameters that needed for high quality embroidering. The “Standard

Ultra Light” fabric is not a specific fabric but can be used as an alternative for embroidering Ultra light

on any fabric you want. The embroidery results of the “Standard Ultra light” settings will depend on the

fabric. 
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· Embroidery Light: In this category you can choose a fabric between “Lycra lame”, “Sweat shirt knit”,

“T-shirt knit2”, “Vinyl2”, “Wool Crepe” and “Standard Light”. The embroidery that will be placed on

these fabrics will be Light. That is why the embroidery on the 3D preview will appear with low density.

Each of these fabrics has specific settings in order to produce the best possible results if you

embroider the design on the respective fabric. Be sure you have chosen the correct fabric from the

fabric list. If you want to embroider a design with light settings in a fabric that is not included in the list,

choose the “Standard Light” fabric that contains those settings. The embroidery results depend on the

fabric that is used. 

· Embroidery Normal Light: In this category you can choose a fabric between “Crepe Polyester”,

“Denim1”, “Light weight bridal satin”, “Linen1”, “Panne velvet”, “Rayon”, “Rayon Sand washed”,

“Sweater knit”, “T-shirt knit1”, “Towling”, “Vinyl1” and “Standard Normal Light”. The embroidery that will

be placed on these fabrics will be Normal with a tension to Light. That is why the embroidery on the

3D preview will appear with normal density. Each of these fabrics has specific settings in order to

produce the best possible results if you embroider the design on the respective fabric. Be sure you

have chosen the correct fabric from the fabric list. If you want to embroider a design with Normal

Light settings in a fabric that is not included in the list, choose the “Standard Normal Light” fabric that

contains those settings. The embroidery result depend on the fabric that is used.

· Embroidery Normal: In this category you can choose a fabric between “Berber fleece”, “Chiffon

scarf”, “Cordoury”, “Cotton”, “Craft Fleece”, “Denim2”, “Denim3”, “Faille1”, “Flannel”, “Fleece”, “Heavy

weight Bridal satin”, “Knit flannel1”, “knit flannel2”, “Linen3”, “MicroFiber”, “Nylon flag”, “Quilted cotton”,

“T-shirt knit3” and “Standard Normal”. The embroidery that will be placed on these fabrics will be 

Normal. That is why the embroidery on the 3D preview will appear with normal density. Each of these

fabrics has specific settings in order to produce the best possible results, if you embroider the design

on the respective fabric. Be sure you have chosen the correct fabric from the fabric list. If you want to

embroider a design with Normal settings in a fabric that is not included in the list, choose the

“Standard Normal” fabric that contains those settings. The embroidery result depends on the fabric

that is used.

· Embroidery Heavy: In this category you can choose a fabric between “Burlap”, “Chenille”, “Cross-

stitch cloth”, “Faille2”, “Fake fur”, “Linen2”, “Lycra bathing suit”, “Lycra workout clothes” and “Standard

heavy”. The embroidery that will be placed on these fabrics will be Heavy. That is why the embroidery

on the 3D preview will appear with high density. Each of these fabrics has specific settings in order to

produce the best possible results, if you embroider the design on the respective fabric. Be sure that

you have chosen the correct fabric from the fabric list. If you want to embroider a design with Heavy

settings in a fabric that is not included in the list, choose the “Standard Heavy” fabric that contains

those settings but the embroidery result depend on the fabric that is used.

You can change the color of the fabric by clicking on one from the list or by double clicking on a color from
the list and select one from the color table. By clicking the OK button the selected color will replace the one
that you double clicked on and will be previewed on the working area. If you want, you can continue changing
colors until you find the one that will matches the fabric color you want to embroider your design on.
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Object Properties
Object properties tool pane contains every embroidery design function of the program. It has two tabs Fill

 and Outline . If Object properties is not visible you can open it from the View menu or with the
shortcut key Alt + Enter. You can view the Object properties tool pane both in Create or Stitch modes. With
the options that are included you can change the stitch type of the design easily by just clicking on it.

Click on each tab, on the above image, to view their options.

Fill Properties

This tab contains every function that can be applied to the Fill of a design. The functions are not visible until
you select an object from a design or the whole design. When a vector design is embroidered for the first
time, Creative DRAWings automatically puts fill stitches on it. That is why the Auto checkbox, at the top of the
fill tab, is checked. When a change in the fill tab is made, the Auto becomes unchecked. You can check it
again and restore the automatic created design from Creative DRAWings. This is very useful when you have
made many changes to a design and you want to cancel all the changes you made by using the tool of
Object properties toolbar and start again from the beginning.

For designs that have only outlines or they are line art designs, the Fill option is not available. In the fill tab
there are eight stitch type fills: Artwork, Satin, Step, Row fill, Appliqué , Cross-stitch, Netfil and  Photo-stitch. 

Stitch types
In the fill tab there are seven embroidery fill types: None, Satin, Step, Row fill, Appliqué , Net fill and Array.
When importing Bitmap files you can also find Cross-Photo stitch embroidery types.

  

Click on each stitch type icon, on the above image, to view how they applied.

Artwork

When this option is applied, sets the fill area to be artwork (vector design). All the fill stitches are removed
from the design. Whenever you don’t want to embroider a specific fill area you can set its’ fill to Artwork and
have the stitches instantly removed.
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Satin

This option, when applied, sets the fill area to be Satin. All the fill stitches will change to Satin, which is
automatically calculated and produced in the program. You can change the feel of Satin by changing its Style
and Pattern. There are many different styles and patterns that you can apply on any stitch design. Also, you
have the ability to change Underlay, stitch Density and Compensation.

Styles

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative DRAWings
is a way of movement from one point to another, which normally can be done by one stitch. Some styles
when applied may not look good on the design. This happens because styles cannot fit correctly in all
possible shapes.

Satin Styles

Select the style you prefer by clicking on it and viewing it in your design. The none selection will restore the
default satin type. Your selections are instantly displayed in the design area letting you experiment with your
design. There are 325 styles that you can use to produce unique designs. The styles that are in film icon (for

example: ) are a series of different styles in one. 

Patterns

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, created
from stitches. You can make combinations between Styles and Patterns and produce your own designs.
Some combinations when applied may not look good on the design. This happens because combinations do
not always produce correct stitch results. 

Satin Patterns
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Select the pattern you prefer by clicking on it and viewing it in your design. The none selection will restore the
default satin type. Your selections are instantly displayed in the design area letting you experiment with your
design. There are 262 different patterns to apply to your design. If you want to view only the pattern you have
selected and not a combination of styles, you must be sure that styles option is set to none. Otherwise you
will view a pattern with a style in it. 

There are also two more options that are very useful in customizing the way that the software will be
embroidered. Those are the Remove overlaps option and the Sequence option. 

Remove overlaps: 

This is an automatic filter which removes all overlaps between the objects of the vector designs. This filter
uses artificial Intelligence and it is applied only where necessary. The application of the filter results in the
reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping
status of each object. There are three possible options that you can apply on a specific object, Auto, Never
and Always. The Auto is the default option and the one that Creative DRAWings uses to create the best
possible results on the design. When the Never option is applied on an object, the specific object will never
trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will
be embroidered normally, placing all their stitches on the fabric. The opposite option is Always. When it is
applied to a specific object it trims all the objects that it overlaps. This means that all the parts of
objects/shapes that are under the selected object will not be embroidered. 

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But in order for
this function to work well, avoid applying trim tool in the Create mode of Creative DRAWings. You must
always use it with care or after the setting Remove overlaps option to Never.  

Sequence: 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of the design
can be set to be embroidered at the start or at the end of the embroidering process. This gives you the ability
to embroider the designs in the order you prefer. More specifically, the Sequence drop down menu has three
options Auto, To start and To end. The Auto is the default option and the one that Creative DRAWings uses
to create the best possible embroidering sequence results. In order to change the embroidering sequence
manually, use the other two options. The To start option sets the selected object to be embroidered first.
This means that if it was to be embroidered fifth in the embroidering sequence, now will be embroidered first
in the row. Exactly the opposite for the To end option. When this is applied on an object of the embroidery
design, it will be immediately become the last object that will be embroidered. By using the To start and To
end options, you can change the embroidering sequence and embroider the design you have created the
way you prefer. This tool is really useful for embroidering hats and on delicate fabrics that need special care
regarding the placement of objects on the fabric.
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If you have set more than one object to be embroidered To start and more than one To end, Creative
DRAWings will decide automatically which one of those will be the first and which one will be last to be
embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered To start and 5 other
To end, DRAWings will embroider those set To start first, deciding automatically their embroidering
sequence, then those (10) set To auto and finally those set To end, deciding automatically the order of the
last 5.

Also, there are three more options that can help you adjust the embroidery parameters of the design. As we
have already mentioned in the Select fabric section previously in this chapter, each fabric has different
presets that affect the way the embroidery design will be placed on it and some of them are visible at the
bottom of the Object properties toolbar. For Satin stitch type they are Underlay, Density and
Compensation. These options can help you make useful adjustments on the design and produce the
embroidery results you prefer. 

Underlay: 

You can activate the underlay option by checking the checkbox next to it. Click on the Underlay you want,
and your change will be calculated and stored in the saved design. If you don’t select an underlay manually,
Creative DRAWings will automatically select the appropriate one for you. The underlay stitches are placed on
the fabric in order to create the base for the cover stitches that will follow. The Underlay is important for the
quality of the embroidery designs.

For Satin stitch type, the following underlay patterns are available:

Tacking – If tacking is selected, there will be no underlay and the software will
make running stitches in order to go from one position to another and cover the
area with cover stitches.

Single - If single is selected, Creative DRAWings will make a single line with
running stitches near the middle of the shape of the object and then cover this with
cover stitches.

Double - If double is selected, Creative DRAWings will make running stitches
following the shape of the object and position Double underlay near the edge of the
outline.

ZigZag - If zigzag is selected, Creative DRAWings will create a sophisticated
ZigZag pattern which automatically changes directions (according to the direction of
the cover stitches) and then fill the shape with cover stitches.

Cross - If cross is selected, Creative DRAWings will create a thicker sophisticated
ZigZag pattern which automatically changes directions (according to the direction of
the cover stitches) and then fill the shape with cover stitches.
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ZigZag+ - Is a combination of Zig-Zag and Double underlay.

Cross+ - Is a combination of Cross and Double underlay

Netting - If netting is selected, Creative DRAWings will cover the area of the object
with a thicker sophisticated ZigZag pattern, which automatically changes directions
(according to the direction of the cover stitches) two times and then fills the shape
with cover stitches. 

Netting+ - Is a combination of Netting and Double underlay.

Double ZigZag - If Double Zig-Zag is selected a Zig-Zag underlay is applied in both
directions.

Double ZigZag+ -  Is a combination of Double Zig-Zag and Double underlay.

Density:  

You can activate the Density option by checking the checkbox next to it. In the numeric field, you can specify
the density of the satin stitches that you are adding. You can also adjust density by clicking the arrows next to

the value or by clicking on the value and rotating the mouse wheel  if there is one. Changes are instantly
previewed on the design area and can be set by clicking outside the density field.

Compensation: 

You can activate the Compensation option by checking the checkbox next to it. In the numeric field you can
enter the value of compensation you want with lower boundery-0,3mm and upper bounder 2.0mm. Also you
can adjust density by clicking the arrows next to the value or by clicking on the value and rotating the mouse
wheel if there is one. 

The entered value changes the width of satin stitch that will be embroidered. The default compensation value
depends on the fabric you are using. If you change fabric the compensation will adjust automatically.
Changes are instantly previewed on the design area and can be set by clicking outside the density field. 

Step

This option, when applied, sets the fill area to be Step. All the fill stitches change to Step, which is
automatically calculated. The Step type that was placed is the default. You can change Steps by changing its
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Style and Pattern. There are many different styles and patterns that you can apply on any stitch design. Also,
you have the ability to change Underlay, stitch Density, Length and Compensation.

Styles

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative DRAWings
is a way of movement from one point to another, which normally can be done in one stitch. Some styles,
when applied, may not look good in the design. This happens because some stitch styles do not fit correctly
in all shapes.

Step Styles

Select the style you prefer by clicking on it and view it in your design. If do not want any select none. The
None selection will restore the default step type. Your selections are instantly displayed in the design area
letting you experiment with your embroidery design. There are 325 styles that you can use to produce unique

designs. The styles that are in film icon (for example: ) are a serial of different styles in one. 

Patterns

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes created
from stitches. You can make combinations between Styles and Patterns and produce your own designs.
Some combinations when applied may not look right in the design. This happens because combinations do
not always produce correct stitch results. 

Step Patterns

Select the pattern you prefer by clicking on it and view it in your design. In step type you can’t have none as a
selection pattern. Step is based on patterns, which means that even if you don’t select a pattern, Creative
DRAWings will set the default for you. Your selections are instantly displayed in the design area letting you
experiment with your embroidery design. There are 262 different patterns to apply in your design. If you want



Creative DRAWings® 7.1 manual552

© 2017 DRAWstitch Ltd.

to view only the pattern you have selected and not a combination of styles, you must be sure that the Style
option is set to none. Otherwise you will view a pattern with a style in it. 

There are also two more options that are very useful in customizing the way that the software will be
embroidered. Those are the Remove overlaps option and the Sequence option. 

Remove overlaps: 

This is an automatic filter which removes all overlaps between the objects of the vector designs. This filter
uses Artificial Intelligence and it is applied only where necessary. The application of the filter results in the
reduction of stitches that will be placed on the fabric. It is, also, possible to manually alter the overlapping
status of each object. There are three possible options that you can apply on a specific object, Auto, Never
and Always. The Auto is the default option and the one that Creative DRAWings uses to create the best
possible results on the design. When the Never option is applied on an object, the specific object will never
trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will
be embroidered normally, placing all their stitches on the fabric. The opposite option is Always, when it is
applied on a specific object, it trims all the objects that overlaps. This means that all the parts of
objects/shapes that are under the selected object will not be embroidered. 

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But in order for
this function to work well, avoid applying trim tool in the Create part of Creative DRAWings. You must always
use it with care or after the setting Remove overlaps option to Never.  

Sequence: 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of the design
can be set to be embroidered at the start or at the end of the embroidering process. This gives you the ability
to embroider the designs in the order you prefer. The Sequence drop down menu has three options Auto,
To start and To end. Auto is the default option and the one that Creative DRAWings uses to create the best
possible embroidering sequence results. In order to change the embroidering sequence manually you have to
use the other two options. The To start option sets the selected object to be embroidered first.  This means
that if it was to be embroidered fifth in the embroidering sequence, now will be embroidered first. Exactly the
opposite for the To end option. Therefore, when it is applied on an object of the embroidery design, this will
be immediately become the last object that will be embroidered. By using the To start and To end options,
you can change the embroidering sequence and embroider the design you have created in the way you
prefer. This tool is really useful for embroidering hats, or on delicate fabrics that need special care regarding
the way that the objects will be placed on the fabric.

If you have set more than one object to be embroidered To start and more than one To end, Creative
DRAWings will decide automatically which one from those that are set To start will be the first to be
embroidered and which one from those set To back will be the last to be embroidered. 
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For example, if you have a design with 20 objects and you have set 5 to be embroidered To start and 5 other
To end, Creative DRAWings will embroider those that are set To start first, deciding automatically their
embroidering sequence, then those (10) that remained set To auto and finally those that set To end,
deciding automatically the order of those last 5.

Also, there are four more options that can help you select the correct fabric for your embroidery design. As
we have already mentioned in the Select fabric section previously in this chapter, each fabric has different
presets that affect the way the embroidery design will be placed on it. These presets are visible at the bottom
of the Object properties toolbar, and for Step stitch type they are Underlay, Density, Length and
Compensation. The values that are shown, are there, only for your information and to help you decide the
fabric you will use. Below we will describe what each option shows. 

Underlay: 

You can activate the underlay option by checking the checkbox next to it. Click on the Underlay you want,
and your change will be calculated and stored in the saved design. If you don’t select an underlay manually,
Creative DRAWings will automatically select the appropriate one for you. Underlay is important for quality
embroidery designs.

For Step stitch type, the following underlay patterns are available: 

Tacking – If tacking is selected, there will be no underlay and the software will make
running stitches in order to go from one position to another and cover the area with
cover stitches.

Edging -  If edging is selected, Creative DRAWings will make running stitches following
the shape of the object and position Edging underlay near the edge of the outline.

Packing - If packing is selected, Creative DRAWings will cover the area of the object
with vertical running stitches (according to the direction of cover stitches) as the icon
shows.

Netting - If netting is selected, Creative DRAWings will cover the area of the object with
running stitches at 45o and -45o (according to the direction of the cover stitches) and
then fill the shape with cover stitches.

Packing + - Is a combination of Packing and Edging underlay.

Netting + - Is a combination of Netting and Edging underlay

Density:
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You can activate the Density option by checking the checkbox next to it. In the numeric field you can specify
the distance between the stitches of step lines. The number of this field shows the distance between one line
of stitches and the line after its next. Also you can adjust density by clicking the arrows next to the value or by

clicking on the value and rotating the mouse wheel  if there is one. Changes are instantly previewed on the
design area and can be set by clicking outside of the density field.

Length: 

You can activate the Length option by checking the checkbox next to it. In the numeric field you can specify
the length of each stitch in the step.

Compensation: 

You can activate the Compensation option by checking the checkbox next to it. The Compensation
changes the width of the step object that will be embroidered to avoid shrinking. The compensation
parameter has to do with the tendency of a punching object to shrink in itself in the stitching direction. This
means that sometimes you have to adjust your stitch design from its original position. In the numeric field you
can enter the value of compensation you want with lower bounder -0,3mm and upper bounder 2.0mm. Also,
you can adjust density by clicking the arrows next to the value or by clicking on the value and rotating the
mouse wheel if there is one.

The entered value changes the movement of stitches, to cover its shrink in. The default compensation value
depends on the fabric you are using. If you change fabric the compensation will adjust automatically. The
compensation becomes visible only if you export the design by using the To editor option from the File >
Export submenu.

Row fill

This option, when applied, sets the fill area to be Row fill. All the fill stitches are changed to Row fill, which is
automatically calculated and produced from the program. The Row fill type that was placed is the default. You
can change Row fill's feel by changing its Style and Pattern. There are many different styles and patterns
that you can apply on any stitch design. Also, you have the ability to change the stitch Density and Length.

Styles

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative DRAWings
is a way of movement from one point to another, which normally can be done by one stitch. Some styles
when applied may not look good on the design. This happens because stitch styles cannot fit correctly in all
possible shapes.
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Row fill Styles

Select the style you prefer by clicking on it and view it on your design. If do not want any select none. The
None selection will restore the default Row fill type. Your selections are instantly displayed in the design area
letting you experiment with your embroidery design. There are 325 styles that you can use to produce unique

designs. The styles that are in film icon (for example: ) are a serial of different styles in one. 

Patterns

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, created
from stitches. You can make combinations between Styles and Patterns and produce your own designs.
Some combinations when applied may not look good on the design. This happens because combinations do
not always produce correct stitch results. 

Row fill Patterns

Select the pattern you prefer by clicking on it and viewing it on your design. In Row fill type, like step, you can’t
have none selected. Step is based on patterns, which means that even if you don’t select a pattern, Creative
DRAWings will set the default for you. Your selections are instantly displayed in the design area letting you
experiment with your embroidery design. There are 262 different patterns to apply in your design. If you want
to view only the pattern you have selected and not a combination with styles, you must be sure that styles
option is set to none. Otherwise you will view a pattern with a style in it. 

There are also two more options that are very useful in customizing the way that the software will be
embroidered. Those are the Remove overlaps option and the Sequence option. 

Remove overlaps: 
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This is an automatic filter which removes all overlaps between the objects of the vector designs. This filter
uses Artificial Intelligence and it is applied only where necessary. The application of the filter results in the
reduction of stitches that will be placed on the fabric. It is, also, possible to manually alter the overlapping
status of each object. There are three possible options that you can apply on a specific object, Auto, Never
and Always. The Auto is the default option and the one that Creative DRAWings uses to create the best
possible results on the design. When the Never option is applied on an object, the specific object will never
trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will
be embroidered normally, placing all their stitches on the fabric. The opposite option is Always, which when
applied on a specific object, trims all the objects that overlaps. This means that all the parts of
objects/shapes that are under the selected object will not be embroidered. 

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But in order for
this function to work well, avoid applying trim tool in the Create part of Creative DRAWings. You must always
use it with care or after the setting Remove overlaps option to Never.  

Sequence

With this tool it is possible to change the embroidering sequence of the design. Specific objects of the design
can be set to be embroidered at the start or at the end of the embroidering process. This gives you the ability
to embroider the designs in the order you prefer. More specifically the Sequence drop down menu has three
options Auto, To start and To end. The Auto is the default option and the one that Creative DRAWings uses
to create the best possible embroidering sequence results. In order to change the embroidering sequence
manually you have to use the other two options. The To start option set the selected object to be
embroidered first.  This means that if it was to be embroidered fifth in the embroidering sequence, now will be
embroidered first in the row. Exactly the opposite for the To end option. Therefore when it is applied to an
object of the embroidery design, this will immediately become the last object that will be embroidered. By
using the To start and To end options you can change the embroidering sequence and embroider the
design you have created in the way you prefer. This tool is really useful for embroidering hats or on delicate
fabrics that need special care regarding the way that the objects will be placed on the fabric.

If you have set more than one object to be embroidered To start and more than one To end, Creative
DRAWings will decide automatically which one of those that are set To start will be the first to be
embroidered and which one from those set To back will be the last to be embroidered. 

For example, if you have a design with 20 objects and you have set 5 to be embroidered To start and 5 other
To end, Creative DRAWings will embroider those that set To start first, deciding their embroidering
sequence automatically, then those (10) that remained set To auto and finally those that set To end,
deciding automatically the order of those last 5.

Also, there are two more options that can help you adjust the embroidery parameters of the design. As we
have already mentioned in the Select fabric section previously in this chapter, each fabric has different
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presets that affect the way the embroidery design will be placed on it and some of them are visible at the
bottom of the Object properties toolbar, and for Row fill stitch type they are Density and Length. These
options can help you make useful adjustments on the design and produce the embroidery results you prefer.

Density: 

You can activate the Density option by checking the checkbox next to it. In the numeric field you can specify
the distance between the stitches of Row fill lines. The number of this field shows the distance between one
line of stitches and the line after its next. Also you can adjust density by clicking the arrows next to the value

or by clicking on the value and rotating the mouse wheel if there is one. Changes are instantly previewed
on the design area and can be set by clicking outside the density field.

Length:  

You can activate the Length option by checking the checkbox next to it. In the numeric field you can specify
the length of every stitch in Row fill.

Applique

When setting the Applique fill type, the fill area of the object will be covered with a fabric. The fabric will be
previewed with the selected fill color. The border will stay as it was surrounding the appliqué  area. If the

design does not have a border, the program will sew around the appliqué  an E-stitch ( ) in order to hold
the appliqué  on the fabric. If the object that you applied appliqué  on it has a border, you can set a running
style or satin serial stitches that will hold the appliqué  on the fabric. 

New zig-zag styles are added in the running stitch type that can be used for holding single
or double laser cut appliqué . 

For example:

Consider that we have an ellipse (like on the left  part of the figure below). As we can see, it has a Red fill
color and a Blue outline. If we set the fill type to be applique then the ellipse will look like in the middle part of
the figure (Applique with running outline). if we remove the outline color then the program will automatically
add E-stitch outline as shown in the right part of the figure. 

Initial object with Artwork fill Added applique fill Applique fill with e-stitch
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In order to actually produce designs with applique, there is a standard procedure that must be followed. This
production procedure needs interaction from the user during the embroidery process. In order to understand
the production procedure, we will analyze how an embroidery machine will react when instructed to
embroider an appliqué  object. 

When it is the time to produce the applique object: 

1. A running line will be added to reveal the position that the applique must be placed. 

2. A jump stitch will be made and the machine will stop in order to manually place the applique fabric. 

3. Then running stitches will be added to create the shape of the applique.

4. Another  jump stitch will be made and the machine will stop (again) in order to cut the applique according
to the shape.

5. Finally the border of the appliqué  will be added (E-stitch, Satin serial or Running) as it was selected. 

Then the machine will continue embroidering the rest objects. 

Using to editor option of File -> Export submenu you can also view/simulate the way that the design will be
embroidered. Wings’ modular will open with the design imported. In Wings’ modular you can see the exact
embroidery sequence and simulate the way the design will be embroidered in the embroidery machine.

Offset:

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -8mm and highest value 8mm. Also you can increase or
decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
appliqué  holding stitches outline to have from its initial position. If the value is negative, the holding stitches
will make an inner offset and the opposite, if it is positive. The default offset value is zero and can be changed
only from you. Any changes you are making on the offset value it is previewed on the design.

In addition, if the appliqué  shape has no pen/outline (Running or Satin Serial), the offset will move the holding
stitches (E-stitch or Zig-Zag) according the value set. The offset will be calculated together with the Position,
if any was set for Zig-Zag stitches. On the other hand, if the appliqué  shape has a border (Running or Satin
Serial), use the respective Offset field of Running or Satin serial border (Pen) tab option for the cover
stitches and use the appliqué  offset to control the offset of the placement/tack-down running stitches.

Fabric Trim: 

You can activate the Fabric Trim option by checking the checkbox next to it. In the drop down menu there are

three options: After embroidery, During embroidery and Pre-cut. In order to understand what exactly each

option does, we will analyze how an embroidery machine will react on each one.

If After embroidery is selected, the following steps will be performed: First will make the shape of the

appliqué  with Running showing the area where the Appliqué  must be placed. After that a jump stitch on top
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will be made and the machine will stop in order for the appliqué  to be placed on the fabric. Then the software

will make the border of the appliqué  ((“Default fixing”: E-stitch, Zig Zag) or Satin Serial, running) as it was

selected. Finally you will have to take the embroidery out of the machine and cut the appliqué  accordingly.

If During embroidery is selected, the software will perform the following steps: 

First it will make the shape of the appliqué  with running showing the area where the Appliqué  must be placed.

After that a jump stitch on top will be made and the machine will stop in order the appliqué  to be placed on the

fabric. Then the software starts to sew a running stitch creating the shape of the appliqué . A jump stitch on

top will be made and the machine will stop (again) in order to cut the appliqué  according to the shape. At the

end it will make the border of the appliqué  ((“Default fixing”: E-stitch, Zig Zag) as it was selected.

Finally, if Pre-cut is selected, the software will perform the following steps:

First it will make the shape of the appliqué  with Running showing the area where the Appliqué  must be

placed. After that a jump stitch on top will be made and the machine will stop in order for the appliqué  to be

placed on the fabric. Since the appliqué  has been cut on the shape of the object, the software will start to sew

the border of the appliqué .

Notice: Do not use simple running stitch type as border because the appliqué  will not be sewed correctly with

the fabric. 

Default fixing: 

This field has two options:

E-stitch: By choosing this option the appliqué  will be sewed on the fabric with stitches that will have the same

color as the fill area and they will look like the on the following figure.. 



Creative DRAWings® 7.1 manual560

© 2017 DRAWstitch Ltd.

E-stitch stitches E-stitch zoom Zig Zag stitches

Zig Zag: In this case Zig Zag stitch type will sew the appliqué  on the fabric. This Zig Zag stitch type is the

default (Position: Center) type, aligned to center of the border. If you want to change the Position of Zig Zag

you have to activate the Position option, which appear when Zig Zag is selected

This option aligns Zig Zag on the border. You can choose between five alignment ways that exist in the drop

down menu. Those are: Outside, Outside with Overlap, Center, inside with overlap and Inside. Select

the one that you prefer and view it on your design.

In addition, if the appliqué  shape has not got a border (Running or Satin Serial), the offset will move the

holding stitches (E-stitch or Zig-Zag) according the value set. The offset will be calculated together with the 

Position, if any was set for Zig-Zag stitches. On the other hand, if the appliqué  shape has a border (Running

or Satin Serial), use the respective Offset field of Running or Satin serial border (Pen) tab option for the

cover stitches and use the appliqué  offset to control the offset of the placement/tack-down running stitches.

Cutter parameters

All options below are referring to the cutter and the way that it will cut the Applique. 

Therefore the Cut Technique  or any other cutter relative technique should be enabled in
order to be vis ible.

Some machines does not allow you to change some or any of these values through our software. You can
make adjustments though, through the machine's panel. The parameters that you can adjust are the
following:
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· Cutter presets

· Cutter Speed

· Cutter Pressure

· Cutter Passes

· Blade depth

· Blade color

Applique Parameters

These options will be available always at Object properties toolbar because no cutter is selected. If you
want to see which options the cutter allows you to adjust,  

1. you can go to File > Export > Cutters... and from the wizard dialog that will appear select the cutter
you have connected on the PC.

2. Click Connect and from the next dialog select Test. 

Test Cut dialog

3. A dialog will appear that will show you only the options that you can adjust at the connected cutter. 

4. You can adjust the settings and even test them on the cutter. 

5. If you are satisfied with the setting you have selected you can click Apply apply them to the object(the
object properties toolbar will be updated automatically).
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Cutter presets

The Cutter presets button allows you to select cutter settings presets, based on the material that you will
cut and the blade that you will use, and apply them on the currently selected object. By clicking on the Cutter
presets button a pop up list will appear with the available cutter presets. The cutter presets are listed with the
following information Name, Material, Blade color and Blade depth. 

· Name: Lists the Cutter's name that the the template is made for

· Material: Lists the Material that you can cut by using the preset. Those are referring to Rhinestones,
are mainly for Vinyl material.

· Blade color: Lists the Blade color that you have to use in order to cut the specific material. This is
applicable on specific machines that include various blades. Usually each color is for cutting different
 material. Check the cutters manual for more information about which blade is from which material.

· Blade depth: Lists the Blade depth that you have to set on the cutters blade. Usually the Blade depth
is set manually. Therefore you have to check the Cutter's manual and find how to change the Blade
depth.  

Cutter Presets

To apply the preset you want you can simply click on it. The settings of Object properties toolbar will be
adjusted accordingly. 

Cutter Speed

With this value, you can specify the speed that the machine will cut the design. This value varies from cutting
machine to cutting machine and some machines does not allow you to change this value at all through our
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software. You can make adjustments though, through the machine's panel. Feel free to change the Speed
setting based on the speed you want the design to be cut. 

The Cutter speed field can take values from 0 up to 100. 

Cutter Pressure

With this value, if it is enabled, you can specify the force that the machine will add on the blade in order to cut
the design or to the Pen/brush in order to draw the design. This value varies from cutting machine to cutting
machine and some machines does not allow you to change this value at all through our software. You can
make adjustments though through the machine's panel.

Feel free to change the Cutter Pressure setting based on the depth you want the material to be cut or paint.
The value of Cutter Pressure varies from cutting material to cutting material. Thicker material need more
pressure and thinner less.

The Cutter pressure field can take values from 0 up to 100. 

Cutter Passes

You can specify the number of Passes you want the design to be made with. It actually defines how many

times each shape will be made by the machine. 

Blade depth

With this option you can set the Blade depth of the cutter blade. This value varies from cutting machine to
cutting machine and some machines does not allow you to change this value at all through our software. You
can make adjustments though on the actual machine. 

Feel free to change the Blade depth setting based on the depth you want the material to be cut. This value is
there only for your information, to remind you that for this object you have to change the Blade depth on the
machine. The value of Blade depth varies from cutting material to cutting material. Thicker material need
more depth and thinner less.

Blade color

This drop down menu lists the Blade color that you have to use in order to cut the specific material. This is
applicable on specific machines that include various blades, with different colors. Usually each color is for
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cutting different  material. Check the cutters manual for more information about which blade is from which
material. 

For example, for Artistic Edge cutter the Blades are for the following use:

· Blue Cap Blades is for cutting thicker materials

· Red Cap Blades is for cutting thin materials

· Yellow Cap Blades is for cutting fabrics

Select the Blade color that you will use for the currently selected object and during the Cutting process the
Software will notify you that you will have to use the respective Blade color in order to cut the shape. 

Sequence

Applique type does not have any customizable options, the only available option is sequence option. Using
sequence option we can customize the way that the design will be embroidered. Specific objects of the
design can be set to be embroidered at the start or at the end of the embroidery process. This gives you the
ability to embroider a design in the order you prefer. More specifically, the Sequence drop down menu has
three options Auto, To start and To end. 

The program by default uses Auto option and the sequence is automatically generated by the intelligent
mechanisms of the software. In order to change the embroidery sequence manually, use the other two
options. Use To start option to set the selected object to be embroidered first.  This means that if it was to be
embroidered fifth, now will be embroidered first in the row. The To end option is the exact opposite, when it is
applied on an object, this will immediately become the last object to be embroidered. This tool is really useful
for producing hats, or on delicate fabrics that need special care regarding the way that the objects will be
placed on the fabric.

If you have set more than one object to be embroidered To start and more than one To end, the software
will decide automatically, which one from those set To start will be the first to be embroidered and which one
from those that you have set To back will be the last to be embroidered. 

For example, if you have a design with 20 objects and you have set 5 to be embroidered To start and 5 other
To end, the software will embroider those that are set To start first, deciding automatically their
embroidering sequence, then those (10) that remained set To auto and finally those that are set To end,
deciding automatically the order of those last 5.

This is very useful because you can specify when the appliqué  objects will be inserted on the fabric.
Therefore you do not have to wait over the embroidery machine until it reaches the point where the appliqué
has to be placed. You can order it to be embroidered at the start or at the end of the embroidering process.
This will save you time and effort.

Cross-stitch

Cross-stitch fill option appears in Object properties pane only if we have imported and converted into Cross-
stitch design any (RGB) bitmap. It is the easiest and quickest way to make cross-stitch embroidery designs.
It is also possible to make combinations between normal embroidery (step, satin, Row fill and appliqué ) and
cross-stitches. By combining stitch-types you can end up with unique designs that you could never make
before. Creative DRAWings automatically reduces the number of colors that the bitmap has. Therefore, in
the stitch mode the maximum number of colors that the converted bitmap will have is 20. 
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In the created cross-stitch design it is possible to change the number of cross-stitch Repeats, the Cell size
of the cross and the Background color.

Repeats: 

By changing the value of this cross-stitch option you can change the number of times that each cross-stitch
will be embroidered. The bigger the number, the thicker the cross-stitch. The default value is 3 and it is the
most suitable in most of the cases. There is an upper limit of 10 and a lower limit of 1. Therefore, the number
of repeats must between those two limits.

Cell size: 

By changing this value you can change the size of the cross container. The value represents the side size of
the cross container square. Each point represents one 10th of mm, therefore, if you insert the value 20 in the
field, this will mean that the side of the cross square will be 0,20cm or 0,082’’. The default value of Cell size
is 20. 

Next to the Cell size field there is some information about the cross-stitch grid that is useful for those that
work with this kind of measurement. The Grid is: value shows the number of crosses per inch (ct).
Therefore you can calculate easily the number of crosses in your design.   

Background: 

The Background list of colors contains all the colors that the bitmap has. Each time you pass the mouse

cursor over a color, in the preview area you can view which part of the design will be filled with which color.

This is really helpful when you do not want a color to be embroidered. This color might be an extensive

background color of the bitmap or a thread color that is the same with the fabric that you will embroider on

your cross-stitch design. 
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Cross-stitch background

For example, if you have a bitmap that has a white background and you want to embroider it on a white t-
shirt, it would be better to check the white color’s checkbox from the object properties toolbar and remove it
completely. 

There is a possibility, while you are over a color from the list, for it to appear inside an object that is filled with
totally different color. This is happening because the bitmap images contain many colors and in order for
Creative DRAWings to reduce the number of colors, it groups them and assigns one that is similar to the
group. Therefore, many colors might be represented with one color on the design. You can edit the group
colors from the Edit palette option from the Tools menu. 

Photo-stitch

Any bitmap image that is imported in Creative DRAWings can be converted into Photostitch design. In
Photostitch embroidery type Creative DRAWings automatically recognizes the graduation of colors of any
backdrop image and sets fill stitches on it. The fill stitches are satin bars that cover the backdrop image area.
The parameters that you can adjust are: 

Monochrome 

Using Monochrome option we can either create CMYK (Cyan,

Magenta, Yellow, Black) photo-stitch designs or Monochrome in

any color you prefer. 

Check the box and the photostitch design changes into

monochrome photostitch. 

The design in based on the graduation of the colors of the selected

image. At any point by unchecking this option we can change back

to CMYK photostitch.
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Monochrome Photostitch CMYK Photostitch

Width

With this parameter you can adjust the width of satin bars that photo-stitch consists of. 

Starting density

Adjust the density of the satin bars that cover the backdrop image. 

Net Fill

When this option is applied it sets the fill area to Net Fill. The Net fill embroidery type is a special fill type that
adds two scan lines that are crossing with parallel equidistant running stitches. These two scan lines are
forming a Net that can be used to create Laces. It is a very useful embroidery type that can produce great
embroidery results. The Net Fill includes some more options that allow us to customize the way that will be
applied on the selected object. These options are the following:

Cell size: 

With this option you can specify the size of each square side that the Net fill consists of. For example by
setting the Cell size to be 2.0 mm all squares of the net will have 2.0 mm side size. The maximum value that
the Cell size can have is 9.9mm and the minimum is 0.5mm. To change the value of the Cell size option you
have to either click on the up and down arrows next to the field to increase or decrease its value or type the
exact value you want and then press the Enter key from the keyboard. Another way to increase or decrease
the value is by clicking inside the Cell size field and then by using the mouse wheel to change its value. The
changes that you will make will be immediately applied on the design. By changing this value you can create
a net with large squares or small squares according your preferences. 

Offset: 

With this option you can specify the distance, inner or outer, you want the Net fill to be moved. For example: if
you set the Offset value to 3mm the Net fill will increase its size by 3mm to all directions outside its original
outline. On the other hand if you set the value to -3mm the Net fill will decrease its size by 3mm to all
direction inside its original outline. 

The maximum value that the Offset can have is 15.0mm and the minimum is -15.0mm. To change the
Offset value you have to either click on the up and down arrows next to the field to increase or decrease its
value or type the exact value you want and then press the Enter key from the keyboard. Another way to
increase or decrease the value is by clicking inside the Offset field and use the mouse wheel to change its
value. The changes that you will make will be immediately applied on the design. By changing this value you
can make adjustments on the Net fill size, which is really useful when you want to cover a hole and making
sure that the net will be embroidered on the fabric and not inside the hole. This option is very important for
creating proper Net fills.
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Angle:

With this option you can change the Angle that the Net fill will be applied. For example: When the angle is set
to 0o degrees the Net fill will be aligned on the X and Y axes creating right angles. If you change the Angle
value to 30o degrees the Net fill will be rotated 30o degrees anticlockwise and change completely its
direction. 

The Angle values that you can set are between 0o and 360o degrees. To change the Angle value you have
to either click on the up and down arrows next to the field to increase or decrease its value or type the exact
value you want and then press the Enter key from the keyboard. Another way to increase or decrease the
value is by clicking inside the Angle field and use the mouse wheel to change its value. The changes that you
will make will be immediately applied on the design. 

By changing the Angle of the Net fill you can orientate it based on the shape that it is applied on. This ability
allows you to produce better and more beautiful embroidery results.

There are also two more options that are very useful in customizing the way that the design will be
embroidered. Those are the Remove overlaps option and the Sequence option. 

Remove overlaps: 

This is an automatic filter which removes all overlaps between the objects of the vector designs. This filter
uses artificial Intelligence and it is applied only where necessary. The application of the filter results in the
reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping
status of each object. There are three possible options that you can apply on a specific object, Auto, Never
and Always. The Auto is the default option and the one that Creative DRAWings uses to create the best
possible results on the design. When the Never option is applied on an object, the specific object will never
trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will
be embroidered normally, placing all their stitches on the fabric. The opposite option is Always. When it is
applied to a specific object it trims all the objects that it overlaps. This means that all the parts of
objects/shapes that are under the selected object will not be embroidered. 

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But in order for
this function to work well, avoid applying trim tool in the Create mode of Creative DRAWings. You must
always use it with care or after the setting Remove overlaps option to Never.  

Sequence: 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of the design
can be set to be embroidered at the start or at the end of the embroidering process. This gives you the ability
to embroider the designs in the order you prefer. More specifically, the Sequence drop down menu has three
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options Auto, To start and To end. The Auto is the default option and the one that Creative DRAWings uses
to create the best possible embroidering sequence results. In order to change the embroidering sequence
manually, use the other two options. The To start option sets the selected object to be embroidered first.
This means that if it was to be embroidered fifth in the embroidering sequence, now will be embroidered first
in the row. Exactly the opposite for the To end option. When this is applied on an object of the embroidery
design, it will be immediately become the last object that will be embroidered. By using the To start and To
end options, you can change the embroidering sequence and embroider the design you have created the
way you prefer. This tool is really useful for embroidering hats and on delicate fabrics that need special care
regarding the placement of objects on the fabric.

If you have set more than one object to be embroidered To start and more than one To end, Creative
DRAWings will decide automatically which one of those will be the first and which one will be last to be
embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered To start and 5 other
To end, Creative DRAWings will embroider those set To start first, deciding automatically their
embroidering sequence, then those (10) set To auto and finally those set To end, deciding automatically the
order of the last 5.

Array fill

The Array is a new fill type. When it is applied for an object, the object is filled with a design part  or with a 
Clipart item, in a patterned way. For example, the circle of the following figure, in the beginning, it is filled with
applique. Then by using array fill it is filled with a design part in a patterned way (Rectangular). 

Object with applique fill Array fill with a design object

When applying array fill there are various options that you can adjust in order to customize the way that the
array is applied. There are some parameters that are common for all Array objects and  the others vary
according to the selected fill pattern. More information about using Array can be located into a separate
chapter. 

Fill

The available fill patterns are  5 as shown in the following figure. The usage and the ways to edit the fill
patterns will be described int o the following section.
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· Rectangle

· Circular

· Contour

· Single Line

· Shape Fit

· Line Fit

In this section we will present the common parameters of the array objects (Offset, Trim Shapes and
Separate to objects). 

Offset 

The Offset parameter specifies the distance between the outline and the cut edge of the repeated object. 

Item rotation

This parameter rotates the base object. Specify the rotation of the object in degrees and all the copies of the
array are rotated like if the initial object was rotated in these degrees.

Item rotation 0 Item rotation 45

Trim Shapes 

With trim shapes parameter you can specify whether the repeated objects will be cut according to the
outline of the object in which they are repeated or if the software will nevertheless repeat the objects on the
edge.
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With trim shapes Without trim shapes

Separate to objects

By using the Separate to Objects button you can convert the repeats of the array into individual objects.
This means that you are able to delete, move or manually add/copy objects. This option is mainly used to
avoid overlaps and to refine certain designs.

When applying Array fill in Rectangular way the software creates copies of a base object and places them
in Rectangular way. A copy of the base object is placed on the center of the object. A line of copies is created
on the Start angle according to the Horizontal spacing and then other line are placed in order to fill the object
according to the Vertical spacing. Finaly the copies are placed vertically according to the slant angle.

The properties of the Array fill when selecting Rectangle fill appliance are: 

H. Spacing 

When applying Array fill using Rectangle appliance option, the program creates copies of a base object and
places the copies on a rectangular grid. Using this option you can define the distance between the copies of
the baseline. The distance is defined in Millimeters.  In the numeric field you can type the distance in "mm".
You can also adjust Spacing by clicking the arrows next to the value or by clicking on the value and rotating
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the mouse wheel  if there is one. Changes are instantly previewed on the design area and can be set by
clicking outside the density field.

V. Spacing 

When applying Array fill using Rectangle fill appliance option, the program creates copies of a base object
and places the copies on a rectangular grid. Using this option you can define the distance between the lines
of the rectangle grid. The distance is defined in Millimeters.  In the numeric field you can type the distance in
"mm". You can also adjust Spacing by clicking the arrows next to the value or by clicking on the value and

rotating the mouse wheel  if there is one. Changes are instantly previewed on the design area and can be
set by clicking outside the density field.

Start angle

With this option you can change the Start Angle that Array fill will be applied. 



573Embroidery - Creating embroidery designs

© 2017 DRAWstitch Ltd.

Start Angle 0 degrees Start Angle 15 degrees

The Start Angle values that you can set are between 0o and 360o degrees. To change the Start Angle
value you have to either click on the up and down arrows next to the field to increase or decrease its value or
type the exact value you want and then press the Enter key from the keyboard. Another way to increase or
decrease the value is by clicking inside the Angle field and use the mouse wheel to change its value. The
changes that you will make will be immediately applied on the design. 

By changing the Angle of the Array fill you can orientate it in any way you like. This ability allows you to
produce better and more beautiful embroidery results.

Slant angle

Using Slant angle option you can adjust the placement pattern. The angle that you define measures the angle
from the Start angle. 

Slant Angle 90 degrees Slant Angle 45 degrees
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The following options appear when applying Array fill in Circular way.

H. Spacing 

When applying Array fill using Circular appliance option, the program creates copies of a base object and
places the copies on a Circular grid. Using this option you can define the distance between the circles. The
distance is defined in Millimeters.  In the numeric field you can type the distance in "mm". You can also adjust
H.Spacing by clicking the arrows next to the value or by clicking on the value and rotating the mouse wheel

 if there is one. Changes are instantly previewed on the design area and can be set by clicking outside the
density field.

Start angle

The Starting angle parameter specifies the angle of the horizontal lines of repeated objects, which will fill the
area you specified. When the starting angle is set to 0 degrees, the lines will be horizontal.
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Start angle 0 degrees The start angle has changed and the whole place of the pattern.

Steps

The Steps parameter, defines the increase Step of added copies on inner circles of Circular placement,
starting from the center of the Array. First a copy is added to the center of the circle. Then in first circle the
number of copies is the number that is defined by Steps property, in our case we have 8 copies. The next
circle increases the number of included copies by the Step number, so the second circle has 16 copies. The
third circle will have 24 copy objects etc. The object of the same circle are distributed evenly.
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The following options appear when applying Array fill using Contour pattern.

H. Spacing

The Horizontal spacing parameter specifies the distance between the rectangles that include each
repeated object of the same contour. The Spacing in this case may not be precise, since the objects of the
same contour should be distributed evenly.

V. Spacing

The Vertical spacing parameter specifies the distance between the rectangles that include each repeated
object, of different (adjacent) contours. The Spacing in this case may not be precise, since the contours
should be placed in a way that does not leave big gaps in the middle of the object.
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Follow angle

With the Follow angle parameter you can specify if the repeated object will be rotated, to follow the direction
of the outline or if it will keep the angle of the original object.

With “Follow angle” Without “Follow angle” 

Single line apply pattern is used for designs that we have a small area to fill. Like the letter on the
following figure. When using Rectangle fill we can see that in most of the areas in reality one copy of
the object fits in. When using Single line fill then only a copy is added into middle part of the outline of
the object to be filled.
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Single line

H. Spacing 

Using this option you can define the distance between the copies. The distance is defined in Millimeters.  In
the numeric field you can type the distance in "mm". You can also adjust Spacing by clicking the arrows next

to the value or by clicking on the value and rotating the mouse wheel  if there is one. Changes are instantly
previewed on the design area and can be set by clicking outside the density field.

When you are using Shape fit fill pattern the software tries to make the best fit according to the shape of the
filled object. 
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Shape fit 

H. Spacing

The Spacing parameter specifies the distance between the rectangles that include each repeated object.
The Spacing in this case may not be precise, since the objects of the same letter should be evenly
distributed.

 

V. Spacing

The Spacing parameter specifies the distance between the rectangles which can include each repeated
object.

Start angle

The Starting angle parameter specifies the angle of the horizontal lines of repeated objects, which will fill the
area you specified. When the starting angle is set to 0 degrees, the lines will be horizontal.
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By changing the Angle of the Shape fit  you can orientate it based on the shape that it is applied on. This
ability allows you to produce better and more beautiful embroidery results.

Line fit works like Single line fill but there is a major difference. When there are points in the shape that
more than one copies may fit then the program adds them. Single line creates a line in the middle of the
outline and fill with the array design. Line fit tries to fit as much copies as possible inside the outline of the
object.

Line Fit

H. Spacing 

When applying Array fill using Rectangle appliance option, the program creates copies of a base object and
places the copies on a rectangular grid. Using this option you can define the distance between the copies of
the baseline. The distance is defined in millimeters.  In the numeric field you can type the distance in "mm".
You can also adjust Spacing by clicking the arrows next to the value or by clicking on the value and rotating

the mouse wheel  if there is one. Changes are instantly previewed on the design area and can be set by
clicking outside the density field.

Outline properties

This tab contains every function that can be applied to the outline of a design and in every line design. The
functions are not visible until you select an object from a design. When a vector design is embroidered for the
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first time, DRAWings automatically puts outline stitches on it. That is why the Auto checkbox, at the top of
the outline tab, is checked. When a change in the outline tab is made, Auto becomes unchecked. You can
check it again and restore programs initial outline design. 

Click on each stitch type icon, on the above image, to view how they applied.

For designs that do not have a border the Outline option is not available. 

Stitch types

In the outline tab there are four embroidery type fills: Artwork, Running ,Satin Serial  and Array. Every time
you select one,it is applied immediately to your stitch design.

Artwork

This option, when applied, sets the fill area to be empty. All the fill stitches are removed from the design and
only the border remains, if one exists. Whenever you don’t need to embroider a specific fill area you can set
its fill to Artwork and have the stitches instantly removed.

Running

This option, when applied, sets the border outline of a design or a line design to Running. All the border and
line stitches are changed to Running, which is automatically calculated and produced from the program. The
Running type that was placed is the default. You can change Running’s feel by changing its Thickness and
Style. There are different thicknesses and Styles that you can apply on any stitch design. Also, you have the
ability to change the stitch Offset and Length.

Mirror style 

Using this option we can mirror any applied style. 

Offset:

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -15mm and highest value 15mm. Also, you can increase or
decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
running outline to have from its initial position. If the value is negative, running object will make an inner offset
and the opposite, if it is positive. The default offset value is zero and can be changed only from you. Any
changes you are making on the offset value it is previewed on the design.
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Passes

Define the number of passes that running will make to create a line or border design. This way we can create
thickness in running stitch. The minimum value is 1 (Single pass) and the maximum is 9 (9 passes). Any
change in running thickness is not viewable in the 3D preview area but it is stored when the design is saved.
When the design is embroidered, the option you have selected will be applied. You can also see the multiple
passes using slow redraw. 

Styles

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative DRAWings
is a way of movement from one point to another, which normally can be done by one stitch. Styles, when
applied, are placed on the border one after another. Appling different styles you can create unique embroidery
designs. 

Running styles

Select the style you prefer by clicking on it and viewing it on your design. Your selections are instantly
displayed in the design area letting you experiment with your embroidery design.

The first three styles are automatically selected from the program and you cannot make any
changes between them. Their selection depends on the border width and the only way to change them is by
changing the border width of the vector design. All the other styles can be selected by clicking on them. 

There are 325 styles that you can use to produce unique designs. The styles that are in film icon (for

example: ) are a serial of different styles in one.

You can also stretch the styles applied on running stitches by adjusting the length (from Object properties
toolbar) and the Outline width (from Tool options toolbar). The moment you set a length manually, you start
stretching the styles on the running border. If you want proportional scale, you can leave the length at auto
(leave Length value unchecked) and adjust the Outline width, or set both of them to the same number.
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Length: 6.0mm - Outline:2.0mm Length: 2.5mm - Outline:0,4mm Length: 1.0mm - Outline: 5.0mm

The length value has by default a suggested value that is based on the selected style. You can increase or
decrease the length value according your preferences and you will view the change applied immediately on
the running object.

By increasing the Outline value  and decreasing the Length value you can make the style thinner. By doing
the opposite, decrease the Outline and increase the Length you can make the style wider. 

Keep in mind thought that the styles have an internal minimum length that you cannot lower further. Every
Length decrease below the minimum value will not affect the style size that you can check by either exporting
the file to the Editor (File > Export > to Editor) or by using the Slow redraw tool.

Length: 

You can activate the Length option by checking the checkbox next to it. In the numeric field you can specify
the length of stitches for the punching object that you are adding. Also you can adjust length by clicking the

arrows next to the value or by clicking on the value and rotating the mouse wheel  if there is one. Changes
are instantly previewed on the design area and can be set by clicking outside of the length field.

Satin Serial

This option, when applied, sets the border outline of a design or a line design to be Satin serial. All the border
and line stitches are changing to Satin serial, which is automatically calculated and produced from the
program. The Satin serial type that was placed was selected from the program and is the default. You can
change Satin Serial’s feel by changing its Pattern. As you can see in the figure below, there are different
Patterns that you can apply on any stitch design. Also, you have the ability to change Underlay, offset, stitch
Density and Compensation.

Offset

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -8mm and highest value 8mm. Also you can increase or
decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
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satin serial outline to have from its initial position. If the value is negative, satin serial object will make an inner
offset and the opposite, if it is positive. The default offset value is zero and can be changed only from you.
Any changes you are making on the offset value it is previewed on the design. 

The measurement system of Creative DRAWings in all Object properties parameters can only be metric.

Patterns

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, created
from stitches. You can apply patterns only in wide lines or border outlines. If you have a thin border, any
change in patterns will not take effect. 

Satin serial patterns

Select the pattern you prefer by clicking on it and viewing it in your design. If you do not want any select none.
None will restore the default satin serial type. Your selections are instantly displayed in the design area letting
you experiment with your embroidery design. There are 262 different patterns to apply in your design. 

Also, there are four more options that can help you adjust the embroidery parameters of the design. All four of
them are located at the bottom of the Object properties toolbar,. and for Satin serial stitch type they are
Underlay, Density, Offset and Compensation. Below we will describe how its option affects the
embroidery design. 

Also, there are four more options that can help you select the correct fabric for your embroidery design. As
we have already mentioned in the select fabric section previously in this chapter, each fabric has different
presets that affect the way the embroidery design will be placed on it. These presets are visible at the bottom
of the Object properties toolbar, and for Satin serial stitch type they are Underlay, Density, Offset and
Compensation. The values that are shown, are there, only for your information and to help you decide the
fabric you will use. Below we will describe what each option shows.

Density: 

You can activate the Density option by checking the checkbox next to it. In the numeric field you can specify
the density of the satin serial stitches that you are adding. Also, you can adjust density by clicking the arrows
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next to the value or by clicking on the value and rotating the mouse wheel if there is one. Changes are
instantly previewed on the design area and can be set by clicking outside the density field.

Compensation: 

You can activate the Compensation option by checking the checkbox next to it. In the numeric field you can
enter the value of compensation you want with lower bounder -0,3mm and upper bounder 2.0mm. Also you
can adjust Compensation by clicking the arrows next to the value or by clicking on the value and rotating the
mouse wheel if there is one. The entered value changes the width of satin serial stitch that will be
embroidered. The default compensation value depends on the fabric you are using. If you change fabric the
compensation will adjust automatically. Changes are instantly previewed on the design area and can be set
by clicking outside the density field.

Underlay: 

You can activate the underlay option by checking the checkbox next to it. Click on the Underlay you want,
and your change will be calculated and stored in the saved design. If you don’t select an underlay manually,
Creative DRAWings will automatically select the appropriate one for you. Underlay is important for quality
embroidery designs.

For Satin serial stitch type, the following underlay patterns are available:

Tracking  – If tacking is selected, there will be no underlay and the software will
make running stitches in order to go from one position to another and cover the area
with cover stitches.

Single - If single is selected, Creative DRAWings will make a single line with running
stitches near the middle of the shape of the object and then cover this with cover
stitches.

Double  - If double is selected, Creative DRAWings will make running stitches
following the shape of the object and position Double underlay near the edge of the
outline.

ZigZag - If zigzag is selected, Creative DRAWings will create a sophisticated ZigZag
pattern which automatically changes directions (according to the direction of the
cover stitches) and then fill the shape with cover stitches.

Cross - If cross is selected, Creative DRAWings will create a thicker sophisticated
ZigZag pattern which automatically changes directions (according to the direction of
the cover stitches) and then fill the shape with cover stitches.

ZigZag+  - Is a combination of Zig-Zag and Double underlay.
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Cross+  - Is a combination of Cross and Double underlay

Netting - If netting is selected, Creative DRAWings will cover the area of the object
with a thicker sophisticated ZigZag pattern, which automatically changes directions
(according to the direction of the cover stitches) two times and then fills the shape
with cover stitches. 

Netting+ - Is a combination of Netting and Double underlay.

Double ZigZag - If Double Zig-Zag is selected a Zig-Zag underlay is applied in both
directions.

Double ZigZag+ - Is a combination of Double Zig-Zag and Double underlay.

Array

When this option is applied for an object's outline, a design part or a Clipart item is added on the outline of
the selected object. For example in the following figure you can see the initial Satin serial object on the left
part, and on the right part the initial object after we have applied Array outline using this small leaf.

Satin Serial outline Array outline with this leaf

Offset

You can activate the Offset option by checking the checkbox next to it. In the numeric field you can enter the
value of offset you want, with lowest value of -15mm and highest value 15mm. Also, you can increase or
decrease the offset value by clicking on the arrows next to the value or by clicking on the value and rotating
the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the
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outline to have from its initial position. The default offset value is zero and can be changed only from you. Any
changes you are making on the offset value it is previewed on the design.

No offset 4mm offset

Item rotation

This parameter rotates the base object. Specify the rotation of the object in degrees and all the copies of the
array are rotated like if the initial object was rotated in these degrees.

Item rotation 0 Item rotation 45

Spacing 

Using this option you can define the distance between the copies of the array. The distance is defined in
Millimeters.  In the numeric field you can type the distance in "mm". You can also adjust Spacing by clicking

the arrows next to the value or by clicking on the value and rotating the mouse wheel  if there is one.
Changes are instantly previewed on the design area and can be set by clicking outside the density field.



Creative DRAWings® 7.1 manual588

© 2017 DRAWstitch Ltd.

No spacing 2mm Spacing 

Divide and Directions tools

In the Tools toolbar of Creative DRAWings when create, stitch mode is enabled, two more tools exist to

help improve embroidery quality. These are Divide  and Directions  tools. 

Divide

With this tool is possible to Divide Satin objects and manage the way in which the outlines are split into satin
bars. The objects are not increased but split to internal branches. This tool gives you the flexibility to
customize the way Satin objects will be embroidered and create exactly the design you wants. In order to add

a Divide line, click on   icon or press the Shift + D shortcut keys from the keyboard. Then click on the
object you wish to divide (in order to select it). Click and drag from one side of the object to the other in order
to specify the divide line. In order to delete the divide line you have created, just click on the ‘X’ icon in the
middle of the line. You can change any existing divide line by clicking and dragging the points of the line. The
Divide line has green color in order to distinguish them from the directions lines that are red.

The Divide tool can be applied with the same procedure and on objects filled with Row fill stitch type. Row fill
is a special stitch type that when you apply the Divide tool you must be careful and keep in mind its
distinctiveness to avoid having strange embroidering results. 

It is very useful also when you want to create Text art designs and embroider the design with a specific way.
You can divide the satin characters and define exactly the way you want to be embroidered. 

       

Before divide      –       Apply divide tool     –      After divide tool

You can activate the divide tool by clicking on the  icon of the Tools toolbar or by pressing the Shift + D
shortcut keys. 

Directions
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With this tool it is possible to change the direction of Step, Satin and Row fill stitches until you are satisfied

with the embroidery results. In order to add a direction first you have to click on  icon or press the ‘D’
shortcut key form the keyboard. Then click on the object, which direction you wish to change (in order to
select it). Click and drag in order to specify the direction of the stitches. To delete the direction you have
created, just click on the ‘X’ icon at the middle of the direction. You can change any existing direction by
clicking and dragging the points of the direction. 

Step Directions       Satin Directions

By changing Directions in a design you can organize also the embroidery tensions in a way that one object
will negate the tensions of the other object and produce a perfect result. 

In Satin and Row fill objects you can have more than one stitch directions that can help you produce the
embroidery result you prefer. On the other hand in Step objects you can have only one Direction of stitches.

You can activate the directions tool by clicking on the  icon of the Tools toolbar or by pressing the ‘D’
shortcut key. 

With the combination of Divide and Directions tools you can create unique designs that can have many
sub-objects as brunches and specific direction of stitches for each sub-object. 

Design Properties
Apart from the stitch changes that you can make in your embroidery designs, you can also adjust the
properties of its design. You can add general information about the design and optimize the way it will be
embroidered. You can access Design properties from menu File > Design properties. In the dialog box
that will appear, you can adjust the properties in the General and Optimizer tab.

Click on each tab, on the above image, to view their properties.
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Design properties

General

In the general tab you can add information about the Designer’s name, design Keywords, and any Remarks
about the design.

· Designer
In the Designer text field you can add information about the designer (Name, company, etc.). These

fields are useful for record keeping. 

Designer text field 

· Keywords
In the Keywords field you can add words that describe the current design. The keywords can be

used only if you save your design in “.NGS” or “.DRAW” format. 

Keywords text field

The “NGS” file format can be opened from WINGS SYSTEMS Ltd digitizing programs, eXPerience®
and Wings’ modular®. These include a browser where keywords can be used as a filter in search
option. If you are dealing with hundreds of designs it can be a vital function for quickly searching your
database. Many people find it easier to write down a fixed list of options or keywords to allow multiple
users to enter data in the same style into a common design database. 

· Remarks
In this text area you can add any remarks for your design. Any information about stitch type, color

palette, fabric type and number of threads that was used in the design creation are useful for quick
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reference for anyone that might use it. Also you can add instructions relating to embroidery

production. 

Remarks text area

Any changes in the General tab can be saved as default, by clicking on the Save as default button 

, which means that every time you create a new design the already saved settings will be
displayed. 

Optimizer

In this tab you can adjust Appliqué  frame out distance, Trimming distance between objects, Trimming
distance in Cross-stitch and Minimizing color changes. Also, can select Optimization strategy, and set the
options End points at closest connection even on trims, keep sequence of overlapped objects even if
trimmed, No thread trims inside combined objects. You have also the ability to disable some optimization
automations of the software that have to do with the embroidery sequence and re-sequence the embroidery
design manually.

All options that you will find inside the Optimizer, refer to embroidery production process and are important for
quality stitch output. The optimizer tab can be accessed, also, from Optimizer options of Tools menu or by
pressing Ctrl+Shift+J shortcut keys (Ctrl+Shift+J) together from the keyboard. 
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Design Properties - Optimizer

The Optimizer options that you can adjust are listed below:

Appliqué  frame out distance 

Appliqué  frame out distance

This setting is important for designs that include appliqué . In production of embroidery designs with appliqué ,
there is a phase where the machine will stop, bring the frame out and ask you to add the appliqué  in the
predefined area. In that phase the frame movement the embroidery machine makes is defined as Appliqué
frame out distance. By changing the value of this field, you are setting the frame out movement from its
current position. 

Trimming distance between objects
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Trimming distance between objects

This tool is applied only to embroidery objects (the Embroidery Technique should be active). 
With thread trims between the objects of the embroidery design you get high quality of embroidery in longer
time because every time the machine cuts a thread, it takes some time to start embroidering again.

On the other hand, without trims between the objects, you get high quality of embroidery in less production
time. The jump-stitches are there to connect the object without cutting the thread. You can either cut the
jump-stitches manually afterwards or keep them on the design. In cases where the objects are too close,
jump-stitches are not a problem for most embroiderers but it is the best way of embroidering. It is also matter
of embroidering style.

This setting is important for thread trimming in the embroidery production process. Setting the Trimming
distance between objects you are setting the distance where the machine will make a thread trim. More

specifically, if the objects are combined in Create mode , Creative DRAWings, in the stitch button, will
connect those objects with a jump-stitch that will be visible on the 3D preview area. This jump-stitch will
become a thread trim when the design is saved in an embroidery machine format and the thread trim
distance is shorter than the jump-stitch distance. If the objects are break apart and the distance between the
objects/shapes are longer than the value that you have set in Trimming distance between objects field,
then there will be thread trims between the objects. 

If the distance is shorter from the Trimming distance between objects and the objects are not combined
there will be no thread trims in between. 

Trimming distance in Cross-stitch

Trimming distance in Cross-stitch

This tool is applied only to embroidery objects (the Embroidery Technique should be active).

This option handles the trimming distance between cross-stitch objects. In Creative DRAWings the cross-
stitch designs are treated as one object. In the cross-stitch designs we can treat the thread colors that are
filling the design as objects. Cross-stitch designs in most of cases have scattered crosses with the same
color that makes the trimming calculations difficult. The Trimming distance in Cross-Stitch option gives
you the ability to define the distance that you want a thread trim to occur between the color objects of the
design. The trimming needs are different in different designs therefore you must be careful with the inserted
value in this option. 

Crystal cut offset

Crystal cut offset

This option handles the crystal cut offset. The crystal cut offset is the distance between the crystal and the
cutting edge of the circle that the cutting knife creates. This gap between the two gives us enough place to
position our crystals in the holes easily. 
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Crystal cut offset  0.4mm - 0.8mm

Therefore you can change the crystal cut offset based on the size of the crystal that you are using and your
actual preference. The default value is 0.6 mm which is considered enough for the standard sized crystals. 

The Crystal cut offset value is automatically added in the Spacing and V.spacing values that are shown in
the Object properties bar, whenever you create a Crystal fill object.

Crystal minimum hole spacing

Crystals minimum hole spacing

This option handles the crystal minimum hole spacing. The crystal minimum hole spacing is the default
distance between two crystal after the crystal cut offset inside a Crystal fill/outline fill object. The crystal
cut offset is the distance between the crystal and the cutting edge of the circle that the cutting knife creates,
and it is not measured in the crystal minimum hole spacing. 

  

Crystal cut offset  0.8mm - 1.2 mm

Therefore you can change the  crystal minimum hole spacing based on the crystal pattern you want to
create and your actual preference. The default value is 0.4 mm which is considered adequate for most
crystal cutting material.  

The crystal minimum hole spacing value is automatically added in the Spacing and V.spacing values that
are shown in the Object properties bar, whenever you create a Crystal fill object. 
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Important: Some Crystal fill patterns might not keep this distance constant in order to
produce the pattern. For example: Shape fit pattern fill 

End points at closest connection, even on trims

Closest point checkbox

This option is important for the way that the design will be embroidered. When the checkbox is checked, 
Creative DRAWings filters the entire design and finds the closest connection points between the objects,
even if a trim is made. This option gives better rooting between objects and better flow of the embroidery. In
addition, it gives fewer thread trims because the objects of the same color are connected from their closest
point.  

Start/Return to center of frame

Start/Return to center of frame

This option is important for the way that the design will be embroidered. When the checkbox is checked, 
Creative DRAWings will force the embroidery machine to return to the center of frame after the end of the
embroidering process. Also will force the machine to start from the center of frame. 

Auto-sequence

 

Enable auto-sequence checkbox

With this option (it is applied only to embroidery objects) you can enable or disable the Auto-sequence that is
responsible for producing automatically the embroidery sequence of the design that you are creating. It is an
intelligent system that takes under consideration many parameters, and tries to produce the best possible
embroidery results. It makes everything easier by saving you time and effort. 

This Auto-sequence option is enabled by default (checked). If you want to enable or disable the Auto-
sequence the Optimizer options dialog you have to do it outside the Optimizer options dialog.

On the Tools toolbar that is located in the left side of the software you will find a button with a lamp  on it
(the Embroidery Technique should be active). When this button is pressed, the Auto-sequence is enabled
and the opposite when it is not. Therefore if you want to enable or disable the Auto-sequence you can do it
directly from this button. The same option can be also, found under Tools menu.

Whenever you disable the auto-sequence by clicking on the lamp  icon, the Run optimizer once
dialog appears, that allows you to run the sequence optimizer only once or if you want not to run it at all and
then give you the ability to re-sequence the embroidery design freely through the Sequence manager.
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Inside the Run optimizer once dialog you have three options:

· Nothing (Leave design as is)

By selecting this option and clicking OK button, the Optimizer will not be applied at all and the objects

will appear on the Sequence manager exactly with the order that they have been designed. The

Optimization strategy will not be applied and all the re-sequencing must be made from you though

the Sequence manager.

· Simple (Just re-arrange objects)

By selecting this option and clicking OK button, the Optimizer will be applied once on the design, by

making the appropriate changes and then all objects will appear on the Sequence manger. The

produced embroidery sequence on the Sequence manager will depend on the settings you have

selected inside the Tools>Optimizer options dialog. 

· Advanced (Re-arrange and modify objects if needed)

By selecting this option and clicking OK button, the Optimizer will be applied once on the design but it

will modify the objects if needed. This means that the Fills and Outlines will be separated and re-

sequenced as different objects based on the selections of the Optimizer. More objects will appear on

the Sequence manager that you will be able to re-sequence freely. 

The four options that are becoming available inside the Optimizer dialog after enabling the option are the
Optimization strategy, the Keep sequence of overlapped objects even if trimmed, the No thread
trims inside combined objects and the Minimize color changes. All of them affect the way that the
embroidery design will be embroidered. For more information on how each option affects the embroidery
sequence of the design, read below.

Beside these options the Auto-sequence option affects also the way that the Sequence manager and the
Sequence option are working. The Sequence option that is located at the bottom of Object Properties
toolbar is disable automatically after disabling the Auto-sequence option and you cannot use it any more.

Similarly if you disable the Auto-sequence option the Sequence manager changes completely and
removes all the automatic optimizations of the software. The Sequence manager changes to manual mode
and all re-sequencing must be made from you manually. More information on how the Sequence manager
works in different modes, refer to the respective section of chapter 7. 

Optimization strategy
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Optimization Strategy

This tool is available only if the Auto-sequence option is enabled (the Embroidery Technique should be
active). 

With this tool you can define the way that the objects of the embroidery design will be embroidered. It is like
an automatic embroidering sequence creator. With this tool you can define the way/sequence in which the
objects of the embroidery designs will be placed on the fabric. This tool is really important for embroidering
hats which need to be embroidered from the center to right and left. Also, it is useful for delicate fabrics that
need special care regarding the way that the objects will be placed on them. The embroidering options for
defining the sequence of the objects are the following:

· Top to bottom: When this option is applied the objects of the design will be embroidered from top to

bottom. This means that Creative DRAWings will change the embroidering sequence and will begin

embroidering the objects/shapes that are at the upper most position in the design and will continue

with direction to those that are at the lower position in the design.

· Bottom to top: This is the opposite of Top to bottom option. Therefore when it is applied on an

embroidery design Creative DRAWings will change the embroidering sequence and will begin

embroidering the objects/shapes from those that are located at the bottom until it reaches the top

objects.

· Left to right: When this option is applied the objects of the design will be embroidered from left to

right. This means that Creative DRAWings will change the embroidering sequence and will begin

embroidering the objects/shapes that are at the left most position in the design and will continue with

direction to those that are at the right most position in the design.

· Right to Left: This is the opposite of the Left to right option. Therefore when it is applied on an

embroidery design Creative DRAWings will change the embroidering sequence and will begin

embroidering the object/shapes from those that are located at the right most position in the design

until it reaches the left objects.

· Small to large: When this option is applied Creative DRAWings orders the embroidering sequence

from the smaller object of the design to the largest ones.

· Large to small: This is the opposite option of the Small to large option. Therefore when it is applied

on a design the objects/shapes of the design will be embroidered from the larger ones to the smaller

ones.

· Inside to outside: When this option is applied the objects of the design will be embroidered from

inside to outside. This means that Creative DRAWings will change the embroidering sequence and

will begin embroidering the objects/shapes that are at the middle of the design and continue with

those that are at the outer positions of the design. This option is often used when embroidering

designs on hats. 

· Outside to inside: This is the opposite option of the Inside to Outside option. Therefore, when it is

applied on a design the objects/shapes will be embroidered from the outer to the inner ones. Creative
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DRAWings will check the current sequence of the design and will make recalculation in order to

create one you have selected.

Important:  Any changes on the Optimizer options dialog, affects, also, the Optimization strategy option.
Therefore, always keep in mind that a combination of Optimizer’s options will be applied on the embroidery
design and not only the selected Optimization strategy. With proper combination of options you can get the
appropriate embroidery results. 

Keep sequence of overlapped objects, even if trimmed

Keep sequence of overlapped objects checkbox

This option is available only if the Auto-sequence option is enabled  (the Embroidery Technique should be
active).

This option is important for the embroidering sequence of the design. When this option is checked, all shapes
of the vector design will be embroidered by keeping their overlapping order. This means that the order of the
embroidery will follow the overlapping order of the vector design. By applying this option it will be possible to
manage better the way that the design will be embroidered. 

Important: Changes that you make on the overlapping order of the Vector design are calculated accordingly
by the software. The overlapping order will not be followed as it is because more filters are applied on the
design, which affect the embroidering sequence. 

No thread trims inside combined objects

No thread trims inside combined objects checkbox

This option is available only if the Auto-sequence option is enabled  (the Embroidery Technique should be
active).

This option, when it is checked, does not allow any thread trimming between combined objects. This option

applies only to objects that are combined (not grouped) in the Create  mode  of Creative DRAWings. 

In order to use this option properly you have to go to Draw mode  of Creative DRAWings, select the
objects you want to combine and apply the Combine option from the right click menu. The objects will
become combined and react as one object, inheriting all the attributes of the last selected object. If you try to

embroider the design in the stitch button , you will view the combined objects (like text art objects) to be
connected with a jump-stitch between them. With the No thread trims inside combined objects option
checked, all combined objects will be embroidered with jump-stitches between them, even if you have set 
Trimming distance between objects option to shortest distance. 

If you leave the value of No thread trims inside combined objects unchecked, all thread trims will be
calculated normally.

Note: Combined object: An object created by combining two or more objects and converting them into a
single curve object. A combined object takes on the fill and outline attributes of the last selected object. 

Minimize color changes
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Minimizing color changes

This option is available only if the Auto-sequence option is enabled  (the Embroidery Technique should be
active).

This option is important for limiting color changes in the embroidery production process. Color changes have
to do with thread changes that the embroidery machine makes in order to embroider each stitch design
object. With more color changes the embroidery design sequence is followed more accurately but the
production process is longer. On the other hand with fewer color changes, the embroidery design sequence
changes to fit the Minimizing color change settings but gives shorter production process. The alteration in the
embroidery design sequence might produce inaccurate embroidery results, or might not. This depends on
the embroidery design, embroidery machine and the fabric. You can adjust color changes through the use of
the track bar. 

Track bar

1. Click to increase three scale units. 
2. Drag to move to the point you want. 
3. Click to decrease three scale units.

Also, you can change the value of the track bar by pressing the Left & Right arrows of the keyboard. 

Any adjustments you are making are for your current design. If you want your adjustments to be stored as

default, click on the Save as default button  in the Optimizer tab. 

In case you have changed the default Creative DRAWings settings with your own and you want to restore

them, you can click on the Restore factory defaults button 

In case you have changed the settings of Optimizer and you want to return to your previous Saved as

defaults settings, you have to press the  button. This function will restore the last saved setting
that you saved by clicking on the Save as defaults button.

Change hoop
The hoop you have selected from the starting dialog can be easily changed from the Change hoop option.
You can select a different one from the existing hoops or create a new one with custom dimension that will fit
your needs. It is important to select the correct hoop in order to make sure that your design fits in your actual
hoop that you will use to embroider it. If you select a larger hoop from the one that you will use your needle
carrier might hit the hoop you are using with a minimum result a broken needle. Therefore you must always
select the correct hoop and double check if the design fits in the hoop by using the Printout of the design. 
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If the hoop you have selected is not visible on the working area you have to enable it by selecting the Hoop
option from the View menu. If the Hoop option is checked and the hoop is not visible, try to Zoom out with
any of the available zoom tools or by using the mouse wheel. 

To change the current hoop you have to select the Change hoop option from Tools menu or press the Ctrl
and H shortcut keys (Ctrl+H) together from the keyboard. The Change hoop dialog will appear from where
you can select to use a predefined hoop or a custom hoop that you will define. 

Change hoop dialog

Select hoop

From the Select hoop drop-down menu you can select any of the predefined hoops that the software
includes or any of the custom hoops you have created and added to the software. To select the hoop you
want to use you have to expand the drop down menu and select the hoop you want. You can select either
predefined or custom hoops from the list. The selected hoop will be previewed on the Preview area of the
dialog and will become the current hoop. To apply the hoop on the working area you have to press the OK
button to confirm your selection and close the dialog. If you do not want to insert Hoop in the working area,
you have to select the None option from the drop down menu. With the None option selected no hoop will be
added and any existing one will be removed from the working area. 

  

Generic Round hoop - Generic Oval hoop

Also you can Rotate the hoop you are using by 90o degrees by checking the respective option from the
dialog. The hoop will be rotated and appear on the working area after pressing OK button. The way that you
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will create the design inside the hoop will be the same with the way that will be saved on the embroidery file
and embroidered. 

  

Rotated hoop – How it will be saved and embroidered

For example, if you rotate an oblong hoop in order the design to fit inside it, the final saved file will have the
design rotated instead, in order to fit in the hoop.

If you want you can also remove custom hoops you have created from the Select hoop drop down menu by
selecting it and clicking the Remove button. The hoop will be removed and it will no longer be available for
use. The Predefined hoops cannot be removed. To add more customs hoops you have to click on the Add
new button in the same dialog. 

After selecting the hoop that you will use you have the option to centralize the design inside the hoop by
checking the Center design to hoop checkbox. If you do not check this option, the hoop will be placed at the
middle of the working area and the design you have created will remain at the position you have placed it
before changing the hoop.

Add New Hoop

By clicking on the Add New button the Add new dialog will appear where you have the ability to define a new
custom hoop with the dimensions you prefer. The hoop that you will create will be saved in the Select hoop
drop down menu, allowing you to reuse it as many times as you want. The dimensions that you will enter
must be the dimensions that the manufacturer of the hoop gives for the specific hoop.  
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Add hoop dialog

To create a custom hoop you have to set the dimensions you want to have, the type of the hoop, the hoop
bracing arms, the curvature of the hoop and then add it to the hoop list by pressing the Add button. 

o Hoop Name – Description

The first option you have is to type the Hoop Name – Description in the respective field. The name-
description that you will type in this field will be the name that you will view in the Select Hoop drop down
menu. If you forget to fill this field, you will be asked from the software to do so. It is good practice also to
add always a description of the hoop (Oval, Rounded rectangle etc.) and the dimensions of it in the Hoop
Name – Description field, in order to be easier for you to decide which one you have to use. 

o Type 

From the Type drop down menu you can select the shape of the hoop you want to add. The options that
you have are Rectangle and Oval. The selected shape is previewed in the Preview area allowing you to
visualize how the hoop will look like. If you select the Rectangle option, the Corner curviness option will
become editable allowing you to round the corners of the Rectangle hoop shape. 

o Corner curviness

The Corner curviness becomes editable only if you have selected the Rectangle option from the Type
drop down menu. Many hoops have the shape of a rectangle with rounded corners and for this reason
the Corner curviness option exists. The Corner curviness consists of a track-bar and a value field. By
dragging the track-bar to the right, the corners of the rectangle that it is previewed in the Preview area
start to become rounded and their roundness increases as long as you continue. The value field shows
the percentage of roundness. The 0 value means that the rectangle has normal corners and not rounded
and the 90 value means that it has rounded corners to their full extend. By moving the track-bar you can
create the rounded hoop you want. 

o Width

In the Width value field you can insert the width of the hoop you want to use. The default value is 100
mm or the respective value in inches. You can change the value of the Width field by deleting the current
value and inserting a new one. Any width value change is automatically previewed in the Preview area.
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Check the manufacturer’s dimensions, to be sure that you are entering the correct ones. The Width
value sets the width of the sewing area that it is shown with a dashed line inside the hoop.

o Height

In the Height value field you can insert the height of the hoop you want to use. The default value is 100
mm or the respective value in inches. You can change the value of the Height field by deleting the
current value and inserting a new one. Any Height value change is automatically previewed in the 
Preview area. Check the manufacturer’s dimensions, to be sure that you are entering the correct ones.
The Height value sets the height of the sewing area that it is shown with a dashed line inside the hoop.

o Unit

From the Unit drop down menu you can select the measure unit you want to use. The options that you
have are millimeters (mm) and inches (inch). The selected Unit is automatically applied on the Width and
Height values. 

o Hoop Bracing arms

At the Hoop bracing arms area you can set where the bracing arms are located on the hoop you are
adding. To do that you have to check the checkboxes (Left, Right, Up, Down), where the bracing arms
are located. For example, if the Hoop has one bracing arm at the Right and one at the Left, the Right and
Left checkboxes must be checked. The preview of selected bracing arms is shown on the Preview area
helping you to decide the correct ones. 

After adjusting the options you can save the hoop by pressing the Add button that will add the hoop to the
Select hoop drop down menu. After pressing the Add button a confirmations dialog will appear that will
inform you that your hoop was saved successfully. Click OK to continue. To use the hoop you have
created you have to expand the Select hoop drop down menu and press the OK button to apply it. The
hoop you have created will become visible on the working area exactly as you designed it. The next time
that your will open the Change hoop dialog you will find the hoop you have created selected in the 
dropdown menu with the name you gave to it. Also, it will become accessible from the hoop selection
drop down menu of the starting dialog. 

Edit hoop

With the Edit button you can edit the custom hoops that you are inserting. The Edit hoop button is by default
disabled and becomes enabled only if you select a custom hoop that you have added on the Select hoop
drop down menu. If the hoop you want to edit is currently used you will not be able to edit it. You have to
select a different hoop, apply it on the working area by clicking OK button on the Change hoop dialog and
then open once more the Change hoop dialog to Edit the hoop you wanted. 
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Edit hoop dialog

To edit a custom hoop you have to select it on the Select hoop drop down menu and then click the Edit
button. The Edit hoop dialog will appear with the attributes of your hoop listed. You can edit the options of the
hoop and save it by pressing the Apply button. A dialog will appear that confirms the changes you made and
then you return back to Edit hoop dialog. You can continue editing the custom hoop or press the close dialog
to end editing process. 

The options you can change in the Edit hoop dialog are the following:

o Hoop Name – Description

The first option you can edit the Hoop Name – Description option. You can change the name-
description that the hoop will have by editing the respective field. The edited name will be added in the
Select Hoop drop down menu. Do not forget to add a description of the hoop (Oval, Rounded
rectangle etc.) and the dimensions of it in the Hoop Name – Description field, in order to be easier
for you to decide which one you have to use. 

o Type 

From the Type drop down menu you can change the shape of the hoop you have added. The options
that you have are Rectangle and Oval. The selected shape is previewed in the Preview area
allowing you to visualize how the hoop will look like. If you select the Rectangle option, the Corner
curviness option will become editable allowing you to round the corners of the Rectangle hoop
shape. 

o Corner curviness

The Corner curviness becomes editable only if you have selected the Rectangle option from the
Type drop down menu. Many hoops have the shape of a rectangle with rounded corners and for this
reason the Corner curviness option exists. The Corner curviness consists of a track-bar and a
value field. By dragging the track-bar to the right, the corners of the rectangle that it is previewed in
the Preview area start to become rounded and their roundness increases as long as you continue.
The value field shows the percentage of roundness. The 0 value means that the rectangle has normal
corners and not rounded and the 90 value means that it has rounded corners to their full extend. By
moving the track-bar you can change the roundness of the hoop. 
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o Width

In the Width value field you can change the width of the hoop. You can change the value of the Width
field by deleting the current value and inserting a new one. Any width value change is automatically
previewed in the Preview area. Check the manufacturer’s dimensions, to be sure that you are
entering the correct ones. The Width value sets the width of the sewing area that it is shown with a
dashed line inside the hoop. 

o Height

In the Height value field you can change the height of the hoop you want to use. You can change the
value of the Height field by deleting the current value and inserting a new one. Any Height value
change is automatically previewed in the Preview area. Check the manufacturer’s dimensions, to be
sure that you are entering the correct ones. The Height value sets the height of the sewing area that
it is shown with a dashed line inside the hoop.

o Unit

From the Unit drop down menu you can change the measure unit you want to use. The options that
you have are millimeters (mm) and inches (inch). The selected Unit is automatically applied on the 
Width and Height values. 

Preview

In the Preview area you can view the hoop you have selected from the Exiting hoops and the custom hoops
you are creating. The preview helps you visualize the available hoop and decide which one you want to use.

Embroidery sequence
In this chapter we will analyze the tools that the software includes to adjust the embroidery sequence of the
designs you are creating. Creative DRAWings software includes automatic and manual tools for producing
the embroidery sequence. You can combine the different available tools and produce the embroidery results
you prefer. 

Automatic Embroidery sequence

Creative DRAWings embroidery software includes an automatic sequencing mechanism that produces great
results based on the sequencing options that you have set. There are three tools that are responsible for
adjusting the automatic embroidery sequence. These tools are the Auto-sequence tool, the Sequence tool
(Embroidery Technique must be active) and the Sequence manager. With these tools you can adjust the
automatic embroidery sequence that is produced from the software. 

Enable Auto-sequence

The Auto sequence tool  is located at the bottom of the Tools toolbar and by default is enabled. This
means that any design that you are converting or creating from scratch will have its embroidery sequence
automatically produced according your preferences. The Auto sequence tool has some options that you can
adjust through Optimizer options dialog that you will find under Tools menu. 
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The Auto-sequence option is checked and all its options can be set to different values. The options that you
can adjust are the Optimization strategy, the Keep sequence of overlapped objects, even if trimmed,
the No thread trims inside combined objects and the Minimizing color changes. 

· Optimization strategy: With this option you can define the way that the objects will be embroidered.

It is an automatic embroidering sequence creator. With this tool you can define how the objects of the

embroidery designs will be placed on the fabric. The embroidering options for defining the sequence

of the objects are the following: Large to small, Small to large, Left to right, Right to left, Top to

bottom, Bottom to top, Inside to outside, Outside to inside. All these options do exactly what

their names specify on the objects of the embroidery design. Therefore based on how you want your

embroidery design to be embroidered you have to select the respective Optimization Strategy. 

· Keep sequence of overlapped objects even if trimmed: This option is important for the

embroidery sequence of the design. When this option is checked, all shapes of the vector design will

be embroidered by keeping their overlapping order. This means that the order of the embroidery will

follow the overlapping order of the vector design. This filter has effect, even if you have tiny areas

overlapping between objects and even if the software decides to add thread trims between them. If

this option is unchecked the software will rearrange the objects to match better the optimization

strategy and the other optimization options you have selected.  

· No thread trims inside combined objects: This option, when it is checked, does not allow any

thread trimming between combined objects. This option applies only to objects that are combined

(not grouped) in the Designer mode  of Creative DRAWings. 

With the No thread trims inside combined objects option checked, all combined objects will be

embroidered with jump-stitches between them, even if you have set Trimming distance between

objects option to shortest distance. 

If you leave the value of No thread trims inside combined objects unchecked, all thread trims will

be calculated normally and will re-sequence the objects based on the selected Optimization

strategy and the other optimization option you have selected(like the Trimming distance between

objects).

· Minimize color changes: This option is important for limiting color changes in the embroidery

production process. Color changes have to do with thread color changes that the embroidery

machine makes in order to embroider each embroidery object. With more color changes the
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embroidery design sequence is followed more accurately but the production process is longer. On the

other hand with fewer color changes, the embroidery design sequence changes to fit the Minimizing

color change settings but gives shorter production process. This option will do its best to minimize the

color changes but it cannot alter the overlapping order of the objects in order to make one color

change for each color used. Also, the decisions that this option makes are related with the other

optimizing tools such as the Optimization strategy option, trimming distance between objects

option, the Keep sequence of overlapped objects even if trimmed option and the Sequence

option from Object properties toolbar. 

It is important to keep in mind that all optimizing options are related and the embroidery sequence is
calculated based on all optimizing options and not only to a specific one. Whenever you set the optimization
settings you have to consider how the change you are making will affect the embroidery sequence by keeping
in mind all the other optimizer settings. You can view the results of the changes that you are making through
the slow redraw functionality (you will find in the Tool toolbar) which is simulating the embroidering process
of the design that you are creating.

Sequence tool

The Sequence tool has the functionality to order specific objects or set of objects to be embroidered at the
beginning or at the end of the embroidering process. The Sequence tool appears at the bottom of object
properties toolbar whenever you select an object or a set of objects. 

The Sequence option gives you three possible abilities: To start, To end and Auto. By default the Auto
option is selected that lets the software decide the embroidering sequence of the design. If you want an
object to change order and be embroidered first or last in the embroidering sequence you have to use,
respectively, To start or To end option. In case you have selected multiple objects and set them To start or
To end a different procedure will take place. Creative DRAWings will manipulate the objects that, for
example, are set To start, move them to the beginning of the embroidering sequence and decide
automatically the order of those To start objects. Therefore, the objects you have set to be embroidered To
start will be embroidered first but with the order that Creative DRAWings will decide based on the other
settings that you have set on the Optimizer options dialog. The same will happen if you set multiple objects
to be embroidered To end. The software will manipulate those objects and move them at the end of the
embroidering sequence but the order will be automatically decided. The objects that remained with the default
Auto sequence option will be embroidered after the To start objects and before the To end objects with order
automatically decided by the software. Therefore, you can re-sequence the objects of the design by creating
three groups: Those that will be embroidered first (To start), those in the middle (Auto) and those that will be
embroidered at the end of the object. If you do not make any change on the sequence option, Creative
DRAWings will automatically create the best possible embroidery sequence for you based on the other
settings that you have set on the Optimizer options dialog.

Every time you want you can simulate the embroidery sequence of the design through Slow redraw tool and
decide if you need to make more changes on the embroidery sequence. The Sequence manager bar

cannot help you with the embroidery sequence when the Auto sequence  is enabled. 

Sequence manager - Auto

The Auto-sequence, affects the way that the items of sequence manger will be viewed. When Auto-
sequence is enabled the program automatically decides the sequence of all stitch objects, so you don’t have
any control of the sequence of the design items via sequence manager in this case. All normal stitch  
objects will be shown as one object on the Sequence manager and there will be no separation between its
sub-objects. All the other objects will be shown separately. These objects can be re-sequenced normally by
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click and dragging them to a new position on the sequence manager. This is allowed because these kind of
objects are totally different from normal stitch objects and they need special care when they are
embroidered. 

The program is using intelligent mechanisms that automatically decide the sequence of the stitch objects and
it does not give you any kind of control in the order that they will be embroidered through the Sequence
manager. 

Manual Embroidery sequence

Creative DRAWings embroidery software includes a manual sequencing mechanism that gives you the
ability to re-sequence the design freely based on your preferences. The software by default uses the
automatic sequencing option that is very useful for inexperienced users and for those who are not familiar

with embroidery sequencing. To switch to manual mode you have to turn off the Auto-sequence  tool from
Tools toolbar and the available options will appear.

Disable Auto-sequence

If you want to disable Auto-sequence and use the manual way of setting the embroidery sequence of the

design you are creating you have to click on the lamp  icon or uncheck the Auto-sequence option from
the Tools>Optimizer options dialog. 

Whenever you disable the auto-sequence by clicking on the lamp  icon, the Run optimizer once
dialog appears, that allows you to run the sequence optimizer only once or if you want not to run it at all and
then give you the ability to re-sequence the embroidery design freely through the Sequence manager. Any
choice from this dialog affects only the Embroidery objects and not the objects that have other fills or outlines
(cut, stencil, paint etc.). 

Inside the Run optimizer once dialog you have three options:

· Nothing (Leave design as is)

By selecting this option and clicking OK button, the Optimizer will not be applied at all and the objects

will appear on the Sequence manager exactly with the order that they have been designed. The

Optimization strategy will not be applied and all the re-sequencing must be made from you though

the Sequence manager manually. Experienced users will find this very helpful and they will be able

to do whatever they like without any automation. Although it is important to know that if you trace a
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bitmap image with many different colors you might end up dealing with thousands of objects that are

very difficult to manage. 

· Simple (Just re-arrange objects)

By selecting this option and clicking OK button, the Optimizer will be applied once on the design, by

making the appropriate changes and then all objects will appear on the Sequence manger. The

produced embroidery sequence on the Sequence manager will depend on the settings you have set

in the Auto-sequence sub-section that you will find inside the Tools>Optimizer options dialog. This

is very useful because the software will do the hard work for you by applying the Optimization

strategy you prefer and leave you only minor sequence changes to make on the final embroidery

result.

· Advanced (Re-arrange and modify objects if needed)

By selecting this option and clicking OK button, the Optimizer will be applied once on the design but it

will modify the objects if needed. This means that the Fills and Outlines will be separated and re-

sequenced separately based on the selections of the Optimizer. More objects will appear on the

Sequence manager that you will be able to re-sequence freely. The produced embroidery sequence

on the Sequence manager will depend on the settings you have set in the Auto-sequence sub-

section that you will find inside the Tools>Optimizer options dialog. The only difference with the

Simple sequence option that is described above is that the fill and the outline objects are

manipulated and rearranged separately for ultimate sequencing results. The only thing that you must

keep in mind is that more objects will be produce that will make re-sequencing more difficult,

especially on traced bitmap objects.

Important: Despite switching the embroidery sequence to manual, all options inside Optimizer options
dialog which are not listed under the Auto-sequence option, will not be calculated from any of the above
manual sequencing options, until you save the design to stitch file(.dst,.pes, etc.) or export the design to
Wings’ modular or use the slow redraw functionality to simulate the final embroidery result. This means that 
Appliqué  frame-out distance, the Trimming distance between objects, the Trimming distance in
Cross-stitch and the End points at closest connection, even on trims options will not be calculated while
enabling or disabling Auto-sequence functionality. 

Sequence manager - Manual

To have full control of the ordering of all stitch objects you can disable Auto-sequence. This can be easily

done by pressing Auto-sequence icon  on Tools toolbar. The Run optimizer once dialog will appear
allowing you to select one of the two embroidery optimizing options or not optimizing the design at all. By
selecting any of the three options and clicking OK, the Auto-sequence will be disabled and all design items
will become separate icons on sequence manager. By clicking and dragging any item you can change its
order. You have the full control of the embroidery sequence and all the intelligent mechanisms have been
disabled. 

If the design is coming from a clear vector artwork the objects will be few and you will not have problem re-
sequencing the design. On the other hand if the design is coming from a traced bitmap the number of objects
will vary from few, up to thousands that will be difficult to manage and handle. Therefore, you must be
cautious on how to use the manual sequencing tool and you must always be prepared to manage large
numbers of objects. For this purpose Creative DRAWings has many tools that allow you to select objects by
color (outline, fill, or both) or by stitch type and make re-sequencing easier.
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To Re-sequence objects from Sequence manager bar is very easy. The only thing you have to do is to
select the object(s) you want to re-sequence by using any of the numerous selection methods that Creative
DRAWings includes and then by clicking and dragging on the sequence manager move the object(s) to its
new position. The result of the re-sequence will be visible directly on the working area. If you do not like the
results or you think that you made a mistake, you can Undo (Ctrl+Z) the last action you made and try to re-
sequence the objects once more. 

It is important to remember that while re-sequencing, some objects might change as a result of the Remove
overlap functionality that is applied automatically. The Remove overlap option that is located on the object
properties toolbar removes unneeded parts of the design that are positioned underneath of other objects in
order to reduce the embroidery stitch count and thickness. It does not remove them permanently like the 
Trim tool does, but it holds the artwork information until you save the design to stitch file (.dst, .pes, etc.) or
export it to Wings’ modular. Therefore, you might move a large object from the bottom of the design (that
looks like a border/outline because of the Remove overlap functionality) and place it on top, but once you do
that you find out that it changes to a large fill object that covers all the other objects. To overcome that you
have to use the Trim tool first from the standard toolbar, in order to trim the bottom object and then re-order
it. All these are automatically calculated when you are enabling the Auto-sequence functionality. 
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Settings

Chapter XIX

In this chapter we will analyze all the options that Creative DRAWings have and how you can adjust 3D
settings. In addition, you will learn about the Security key and how you can customize your working area. 

Options

There are several adjustments that can be made in Creative DRAWings. Most of them are in the Options
dialog box which can be opened from the menu Tools > Options or from the shortcut key Ctrl+T. In the
dialog box that appears you can adjust the properties in each menu tab. 

Click on each tab, on the above image, to view their options.

General

General options 
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In the General options tab you can adjust the Undo levels the Measurement system and select the
Language you want to Creative DRAWings menus. 

You can increase or decrease the programs Undo level according to your needs. Note that high undo levels
acquire more systems memory. 

In addition you can change the Measurement system of the program from Metric (mm) to U.S. (inches) and
vice versa. 

With the Autobackup steps option you can set after how many of your actions an autobackup will occur. For
example, if Autobackup steps is set to 5, the software will take a backup every 5 changes you are making to
your design.

Tools

g

Tools options 

In the Tools tab you can change some options of the lasso selection tool, the movement step of object and
the item focus on the sequence manager.

If you check the Allow polygon selection with lasso you will activate and extra feature of lasso tool. This
feature lets you draw straight-edged segments of a selection border. To draw a straight-edged selection
border in your design, click with the lasso tool active where segments should begin and end, by trying to draw
a polygon. When your last straight-edge of your selection reaches the beginning point then your selection
polygon will be created activating all the design objects that surrounds. 

If you check the Make lasso default selection tool option the lasso tool will become your default selection
tool.
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In the Selection movement step field you can specify the distance you want an object to be moved each
time you press the arrow keys from the keyboard. The default step movement is 1mm.

At the Sequence Manager area you can set the Focus on item option. 

Focus on item options

This option allows you to specify when the objects on the working area will become focused when you work
with the Sequence manager.

· On Hover: By selecting this option whenever you hover over an object at the Sequence manager it will
become focused(highlighted and centralized in the software's view port) immediately. 

· On Click: By selecting this option whenever you click over an object at the Sequence manager it will
become focused(highlighted and centralized in the software's view port) immediately.

· Never: By selecting this option the focus option will be disabled.

To apply this option click OK  on the dialog and restart the software.

The Adv.Scanner options button includes special settings for scanner. Please do not make changes on
these options. These options must be edited only in special occasions from experienced personnel.
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Monitor

Monitor Options

In the Monitor tab you can define the actual width of your monitor. This is important if you want to view your
stitch designs in their actual size when 100% zoom selection is clicked from the standard toolbar. In order to
find your monitor’s width you can measure the visible area with a ruler. The result of your measurement must
be entered in the text field Visible area at the right metric format. Another way to define your monitor’s width
is by knowing the size of your monitor in inches, and simply clicking on the respective monitor preset size
button. The program will automatically set your monitor’s width. Finally using Auto Detect option the program
will try to detect automatically the size of your monitor. In order to activate your changes you have to click Ok
at the Options dialog box. 

The next time you try to view your stitch design in 100% zoom, the size of your design will be the actual one.
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View

View Options

In the View tab you can adjust the way that you are viewing toolbars in Creative DRAWings. In the View tab
you can change the Stitch type icons from the object properties toolbar and the List icons of styles, patterns
and standard toolbar. 

Stitch type

· Icons: From this drop down menu you can select if you want view the stitch type icons of the object

properties toolbar small or large. In order to activate it you have to click on the drop down menu and

select one the two options. 

· Text: From this drop down menu you can select Show text labels, Selective text on right and No

text labels. If you select the Show text labels option you will view the name of each stitch type under

their icons in the object properties toolbar. If you select the Selective text on right option you will

view the name of each stitch type at the right side of their icons. Finally, if you select the No text

labels option each stitch type name will be removed. Therefore by making the preferred adjustments

you can view the icons and their labels in the way you prefer.

Lists

· Styles icon size: In this numeric field you can specify the size of the Styles icons of the Object

properties toolbar. The number of this field shows the pixel size of the icons. You can enter the exact

size you want or you can adjust size by clicking the arrows next to the value or by clicking on the

value and rotating the mouse wheel  if there is one. The size of the Styles icon cannot be more

than 64 pixels.
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· Patterns icon size: In this numeric field you can specify the size of the Pattern icons of the Object

properties toolbar. The number of this field shows the pixel size of the icons. You can enter the exact

size you want or you can adjust the size by clicking the arrows next to the value or by clicking on the

value and rotating the mouse wheel if there is one. The size of the Styles icon cannot be more

than 128 pixels.

· Other icons: From this drop down menu you can view the other icons of the object properties toolbar

Small or Large. In order to activate it you have to click on the drop down menu and select one the two

options, click OK and restart Creative DRAWings. 

Finally, there is the Defaults button that restores the default values in the View tab.

To apply all the adjustments you have made in the View in Creative DRAWings workspace, you have to click
on the OK button of the Options dialog and restart Creative DRAWings. The next time that you will start
Creative DRAWings all the changes you have made will take effect immediately. 

3D properties

3D properties

In the 3D properties tab you can adjust the 3D preview of your stitch design. You can define 3D acceleration
Driver, 3D graphics parameters and 3D graphics quality. The options of this tab are very technical. The best
way to adjust your 3D graphics is from the three preset buttons in the Quality functions section. You can
choose between three 3D quality options: Fast, Quality and Safe.

· If you click the Fast button, your 3D quality will be set automatically to minimum. This means that you

lose 3D quality but gain in program’s speed.
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· If you click the Quality button, your 3D quality will be set automatically to maximum. This means that

you gain in 3D quality but lose in program’s speed.

· If you click the Safe button, your 3D quality will be set automatically in the most reliable way. This

means that you lose 3D quality but gain in program’s speed and reduce compatibility problems with

your graphics card.

Make your selection and click OK to confirm your changes. The changes will be applied the next time that the
program will start. 

Printing

Printing Options 

In the Printing tab you can adjust the Printout fonts, the Size of text and Printout parameters. 

In the Printout fonts option you can define which True Type font the printer will use for printing and which
Vector font the plotter for printing.

Also in the Size of text option you can specify the size of the fonts in the printout. Click on the drop down
menu and select a size.

In the Printout parameters you can define the DPI (Dots Per Inch) of your design’s bitmap and the
Company’s name. Defining the DPI of the design bitmap is important for the printout’s quality. The DPI’s
value that must be placed in the Design bitmap DPI field should be around half the printers DPI. For example,
on a printer with 360 dpi, you can set the value from 120 to 180 dpi. 

In the Company’s name field you can add the name of the company you want to view in the printout.
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Palette order

Using this tab of Options dialog we can select which Thread manufucturer palettes will be visible and change
the order that they appear in color management dialog. 

Use the checkbox that exists next to each of available
thread manufucturer palettes in order to select which of
them will appear on color management dialog. Only the
checked palettes will appear.

Select any of the available palettes
Click and Drag to moveany palette into another position. 
Just like that we can move the most used palettes in the
handiest position. 

Colors-Sizes

Inside the design area, there are various visual assistance tools, guidelines, grids, highlight rectangles,
selections outlines. All these tools use a color to help you recognize the object you want to focus on and
make more accurate editing. 

These tools exist to help you focus on your task. For many users it is very useful to be able to modify the
colors that these marks use, because they can recognize them easier. In order to be able to personalize
these visual assistance marks and make them match your personal preferences we have created a color
customization window. 
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Generally you can adjust many options of the application by selecting from the Tools menu, Options
submenu item. From Options dialog select Colors/Sizes tab. In this tab you can customize the color
schemes of editing tools.

At the left side of the tab there is a list Display item colors, containing the items that is possible to change
their color scheme. By selecting each item on the list you can see on the right side of the dialog the colors
that are currently set for the selected tool. As you have noticed there are 2 colors selected. The one is for
dark background and the other for light. The software automatically enables, according to the selected
background, the color that is selected for the tool based on the luminosity of the background. Let’s take a
closer look at the tools that can be customized and the available ways to select and customize their color.

Display item colors
1) Selection rectangle:

When selecting an object (Object editor, Node Editor), in order to be easier to recognize the selected
object it gets a light blue selection rectangle. When the background is light the rectangle color is dark blue
and when the background is dark the color is light blue. You can select another color for the outline of the
selected object by selecting from Display item colors the Selection rectangle option and then use
Color drop down menu to select a color for dark and light backgrounds. Click Apply button if you want to
preview the changes on any selected object behind the dialog.

2) Focused shape:

When selecting multiple objects (Object editor) the last selected (focused) object it gets a purple border.
When the background is light the border color is dark purple and when the background is dark the color is
light purple. You can select another color for the border of the selected (focused) object by selecting from 
Display item colors the Focused shape option and then use Color drop down menu to select a color for
dark and light backgrounds. Click Apply button if you want to preview the changes on any selected object
behind the dialog.

3) Selected shape: 

When selecting multiple objects (Object editor) all objects except the last selected (focused) object get a
green border. When the background is light the border color is dark green and when the background is
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dark the color is light green. You can select another color for the border of the selected (focused) object by
selecting from Display item colors the Selected shape option and then use Color drop down menu to
select a color for dark and light backgrounds. Click Apply button if you want to preview the changes on any
selected object behind the dialog.

4) Directions: 

When you are using the Directions tool  the direction lines that you are adding have a red color. When
the background color (the object stitches where the direction tool is applied) is light, the direction color will
be dark red and when the background color is dark the color will be light red. You can select another color
for the direction tool by selecting from Display item colors the Directions option and then use Color drop
down menu to select a color for dark and light backgrounds. Click Apply button if you want to preview the
changes on any selected object behind the dialog.

5) Divide:

When you are using the Divide tool  the divide lines that you are adding have a green color. When the
background color (the object stitches where the divide tool is applied) is light, the divide color will be dark
green and when the background color is dark the color will be light green. You can select another color for
the divide tool by selecting from Display item colors the Divide option and then use Color drop down
menu to select a color for dark and light backgrounds. Click Apply button if you want to preview the
changes on any selected object behind the dialog.

6) Grid: 

When you are using the Grid tool the Grid lines that will appear have blue color. When the background
color is light, the Grid color will be dark Blue and when the background color is dark the color will be light
blue. You can select another color for the Grid tool by selecting from Display item colors the Grid option
and then use Color drop down menu to select a color for dark and light backgrounds. Click Apply button if
you want to preview the changes on any selected object behind the dialog.

7) Normal guidelines: 

When you are adding Guidelines inside the software, they will appear with blue color. When the
background color is light, the Guideline's color will be dark Blue and when the background color is dark the
color will be light blue. You can select another color for the Guidelines by selecting from Display item
colors the Normal guidelines option and then use Color drop down menu to select a color for dark and
light backgrounds. This option is for the guidelines that are active and not locked. Click Apply button if you
want to preview the changes on any selected object behind the dialog.

8) Locked guidelines: 

If you have locked the Guidelines that you have added inside the software, its color will turn to red color.
When the background color is light, the Locked guideline's color will be dark red and when the background
color is dark the color will be light red. You can select another color for the locked guidelines by selecting
from Display item colors the Locked guidelines option and then use Color drop down menu to select a
color for dark and light backgrounds. Click Apply button if you want to preview the changes on any selected
object behind the dialog.

Display item Sizes

1) UI elements scale:
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By adjusting this value you can change the width of all Display items (globally) at once. By increasing the
value of UI elements scale you will get thicker lines the opposite if you decrease the value. Click Apply
button if you want to preview the changes on any selected object behind the dialog.

2) Selection rectangle: 

By changing this value you can change the width of the Selection Rectangle line and handles. By
increasing the value of Selection Rectangle you will get thicker selection rectangle line/handles and the
opposite if you decrease the value.  Click Apply button if you want to preview the changes on any selected
object behind the dialog.

3) Shape outline: 

By changing this value you can change the width of the Shape's outline like monogram's container
rectangles, array object etc. By increasing the value of Shape outline you will get thicker shape outlines
and the opposite if you decrease the value.  Click Apply button if you want to preview the changes on any
selected object behind the dialog.

4) Guidelines: 

By changing this value you can change the width of the inserted guidelines. By increasing the value of 
Guidelines you will get thicker shape outlines and the opposite if you decrease the value.  Click Apply
button if you want to preview the changes on any selected object behind the dialog.

5) Digitize outline: 

By changing this value you can change the width of the designing tools that the software includes. By
increasing the value of Digitize outline you will get thicker lines to the designing tools and the opposite if
you decrease the value.  Click Apply button if you want to preview the changes on any selected object
behind the dialog.

6) Node size: 

By changing this value you can change the size of the nodes that each shape has. The nodes are visible in

Edit nodes mode. By increasing the value of Node size you will increase the node's size and the
opposite if you decrease the value.  Click Apply button if you want to preview the changes on any selected
object behind the dialog.

Selecting Colors

In this section we will present in more detail the usage of color selector tool that is included in Color tab of
Tools > Options and acts as a selector for the colors that the user desires. You can select colors for any
item include in display items. Click on the arrow that is next to the already used color. A color selection dialog
appears. On the top area of this dialog you can select to have the default color, in case you have already
changed it. You can also select one of the colors that are ready to be selected with one click. You can also
press Custom color in order to choose or create one color that is not included among these Basic colors. 
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Custom color selection window consists of 2 tabs. The standard tab contains a wider range of ready made
colors. There is also on the left bottom corner a preview area where you can see your old color in

comparison with the new. You can also select a color using color picker tool   to select any color
that is used on any place on your screen. 

Custom color tab, gives you the ability to select any color from the rainbow color container by a single click.
Use the arrow next horizontal line in order to light up the color or make it heavier. You can also type the exact
code number of the color you want on the Red – Green – Blue / Hue – Sat – Lum fields and produce the color
you want. Color pick tool, also exists in custom color tab. Finally you can view the new color in comparison to
the older at the bottom right corner of the window. When you have selected a color just press Ok button. 
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Creative DRAWings 3D setup

Creative DRAWings uses advanced 3D graphics to preview the embroidery designs that is why a good
graphics card is a prerequisite for running it. Before you start working with Creative DRAWings you can
adjust the 3D properties, to be optimized for your system. Setting the 3D of the software is really important
because there might be a case that Creative DRAWings would not start because of the current 3D settings. 

Creative DRAWings 3D config can be found under Start>All programs>Creative DRAWings startup folder.
The following dialog box will appear. 

Creative DRAWings 3D setup 

From the dialog you can select the Technology you want to use, optimize the 3D settings and view
useful technical information about your graphics card. 

· Select Technology: From this part of the dialog you can select between the two technologies that

Creative DRAWings supports. DirectX 9.0C or newer option is the default 3D technology that

Creative DRAWings uses and requires DirectX 9.0c or newer to be installed to your PC in order to

work properly. In most of the cases this is the option that must be selected in order Creative

DRAWings to produce high quality 3D preview. 

The other option you have is OpenGL that can be used only in graphics cards that supports it. In
order to find out you have to select the OpenGL option and from the Info list that appears when you
click on the Advanced button, check if the “Supports OpenGL” option from the “Property” list, has the
“Value” Yes. OpenGL option can be used as alternative way of viewing 3D in Creative DRAWings. It
is an option that we suggest to use it in case that your graphics card has problems with Direct3D
graphics. In both cases you have to keep always the drivers of your graphics card up to date, by
downloading them from the official site of their manufacturer. If you have a laptop computer you have
to download the drivers for your graphics card from the official site of the laptop manufacturer.

· Optimize settings for: The options that are listed in this area has to do with the quality of the 3D

preview of stitches in the stitch part of Creative DRAWings. The options are Stability, Speed,
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Quality and High Quality. By selecting Stability, the 3D preview of the software will be set at the

lowest level of quality giving priority to performance. By selecting Speed the 3D preview of the

software will be set at medium level of quality together with good performance. By selecting Quality

the 3D preview of the stitch part of Creative DRAWings will be set at good level of quality without

affecting its performance. Finally, by selecting High Quality the 3D preview will be set to the best

possible according to your graphics card.

The 3D settings that Creative DRAWings will select depend on the power of the graphics card you
have installed in your computer. All the features of your graphics card are listed in the Info area that
appears when you click on the Advanced button.

· I usually open: In this section of the dialog you can define how many instances of Creative DRAWings

you are usually create. The instances of Creative DRAWings that you have open are connected

directly with the power of your graphics card. If you have a good graphics card, you can have many

instances of Creative DRAWings with High quality 3D preview. On the other hand, if you do not have

a good graphics card you can open fewer Creative DRAWings instances. 

The Few concurrent Creative DRAWings windows option will keep the quality of 3D preview high
in a way to allow you to open fewer Creative DRAWings instances. In contrast, the Many concurrent
Creative DRAWings windows option will set an average quality to the 3D preview but will allow you
to open many instances of Creative DRAWings. Select the one that fits to your everyday use of the
software and let it choose your 3D settings.

When you finish setting 3D you have to click on the Save User settings button to confirm the changes you
have made. By clicking on the Save User settings button, the 3D settings that you have selected will be
applied only on the current Windows® user. If you click on the Save Global Settings button, the 3D settings
that you have selected will be applied to all Windows® users. The next time that Creative DRAWings will
start will have the new 3D settings running. If the software does not start you have to reduce the quality of 3D
in Creative DRAWings 3D setup, save the settings and try again. 

When you click the Advanced button the Info will appear where the “Video card capabilities” are listed. 
Those are technical information about the graphics card that is installed in your computer. The list with all the
information can be sent via email by clicking on the Send via e-mail button.

If your graphics card has 128 Mb RAM and above with the latest drivers and the DirectX 9.0C or later
installed, there will be no problem in working with Creative DRAWings.  

Security keys

Security Keys dialog
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Creative DRAWings need a USB security key to run for copyright and security reasons. The key contains a
serial number that allows the program to run in different levels and be upgraded to newer versions. More
details about the level of the program can be found in the Security Keys dialog box. This shows the level of
the program, the program’s code and includes some functionality, which can be used for changing levels and
upgrading to newer versions. 

 In the Old code text field the security key code is displayed and in the New code text field a new code can
be added, which will upgrade Creative DRAWings to a newer version. More specifically, if you want to
upgrade Creative DRAWings, you can purchase an upgrade code, enter it in the field and Update your
program by clicking on the respective button. The software will be upgraded after restarting the software. 

The Key form button displays all the information you will need to upgrade your software. If you decide to
upgrade your software to a newer version you might be asked to send the Key form to your reseller.
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Appendix

Chapter XX

A: Creative DRAWings Tips
In this section of the help file we will give you some tips about DRAWings.

 Quality hints

 Printing and embroidering

Quality hints

Creative DRAWings is a vector and embroidery designing software. It has many tools and gives you the
ability to create the designs you want to embroider. Also, you can import readymade vector designs that were
not designed for embroidering purposes but for printing purposes. Those graphic designs might include
graphics and visual effects that cannot be converted to stitches and produce various problems during their
conversion. Those designs need some editing inside the Create mode, to become proper for embroidering
purposes. Creative DRAWings users must always have in mind that the designs they are creating will be
embroidered with threads on a fabric. 

Take into consideration the following guideline that will help you create high quality embroidery designs using
Creative DRAWings.

v First of all embroidery machines cannot embroider in every position. The minimum distance between

two stitches is 1/10 mm horizontal and 1/10 of mm vertical.

v Small designs that have too many nodes in their border do not help in embroidery. Therefore, try to

delete the nodes that do not affect the shape of the design. 

v Too small objects will not be filled with stitches and will be ignored from the software. If you want them

to be embroidered try to enlarge them in order the software to be able to place stitches on them.

v Another thing that you should avoid in your designs is to cross curves in the same objects. Even if we

have implemented special algorithms with Artificial Intelligence for these cases, we cannot cover all

the possible combinations.

v Moreover, if there are borders in a design and especially in areas that are covered with stitches from

another object, it is possible unneeded overlapping to be created that will decrease the quality of the

embroidery. The Remove overlaps tool of Creative DRAWings takes care of such situations, and

decides if the object below must be trimmed or not. Sometime decides not to trim object that are
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completely over other object because it believes that it will be embroidered better that way. If you do

not want that you can force the tool to remove the stitches underneath. 

v Finally, if you want to create borders with satin serial, avoid acute (>15o) angles (hard changes of line

directions), prefer to have a curve break node on the top of each angle and always check the distance

between the nodes near the angle to be greater from the width of the border line. This will help Satin

serial to flow better on the border and will increase satin serial quality.

To summarize and add some more, the things you have to do are:

1. Convert unnecessary Cusp Nodes to Smooth nodes. 

2. Delete unnecessary Smooth nodes. Do not put nodes very close to the other. 

3. Avoid having too small objects

4. Avoid double outlines 

5. Avoid crossing curves in the same object. 

6. Avoid hard changes of direction for Satin Serial outlines 

7. Use Remove overlaps function to avoid overlapping and reduce number of stitches.

Those are some hints that will help you to increase even more the embroidery quality that Creative
DRAWings produces. The produced quality is based on the quality of the used vector design. 

Printing and embroidering

The procedure you have to follow in order to embroider your design correctly by using the information that are
included in the printout are the following:

In the following figure we have a printout of a design.

Figure A.1: Printout

In the header of the printout you can view the size, the number of color changes, the number of stitches on
the design, the needed yarn for the current design, the colors that the current design is using and in which
needle carrier should be.
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Figure A.2: Header

If you try to embroider the specific design that has 12 colors, set each color to each needle carrier as they

are numbered. For example, in the first needle carrier you will set the yellow color , in the
second the Black and so forth.  If you have set thread manufacturer’s color palette like Gunold, you can find
the colors that you want the design to have from the number next to the color. 

If you have an embroidering machine with fewer needle carriers than 12 you can either reduce the colors of
the design or while embroidering, you have to change threads on the embroidering machine after stopping it
each time a color change occurs, to a color that is not on the next needle carrier. 

When you finish setting the threads on the needle carriers you can continue by setting the embroidering
sequence on the embroidering machine. This is not needed in all embroidery file formats. There are file
formats that adjust color changes automatically to the embroidery machine. Those are: .”dsb”, “.dsz”, “.tap”,
“.exp”, “.ksm”, “.hus”, “.vip”, “.pec”, “. Pes”, “.jef”, “sew”.

On the other hand there are embroidering file formats that do not adjust the color changes automatically. To
those (.dst, .sst) you have to insert them manually as the printout shows. The embroidering sequence it is
shown from the color changes option and the Sequence icons.

Figure A.3: Color changes

Color changes

The color changes list shows the number of color changes that the machine will make in order to embroider
the design and not the number of colors that will be used. To be more specific, the above list shows that the
machine will start [(“01)”] embroidering using the color of the first needle carrier (N:01 (Gunold, 502));
therefore for embroidery files that do not support color changes you have to manually set the embroidering
machine to have as first color the one that is in the first needle carrier. 

Continuing, from the above list you can see that the first color change ( ’02)’ ) must be set to change the
needle carrier from the “N:01” to “N:07”. The second color change from “N:07” to “N:04” and so forth. 
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We continue setting the machine until ready. As we mentioned before, the design has 12 colors but 14 color
changes. This means that Creative DRAWings, while producing the embroidery design, decided that in order
to embroider some objects with the same color better, it must be embroidered in two or more phases. That is
why we have more color changes than colors. 

It is more obvious from the Sequence icons below. 

Figure A.4: Sequence icons

Here you can view exactly which object will be embroidered with which color. As you can see the Red objects
of the design will be embroidered at the 7th and 13th color change.   

In addition, most of the time more color changes produce better embroidery results, but less color changes
are preferable for embroidering many copies of the same design. There is a way in Creative DRAWings that
you can adjust the color changes in the designs that you are creating. 

This option can be accessed from File > Design properties in the Optimizer mode, and is called Minimizing
color changes. 

· Minimizing color changes: This option is important for limiting color changes in the embroidery

production process. Color changes have to do with thread changes that the embroidery machine

makes in order to embroider each stitch design object. With more color changes the embroidery

design sequence is followed more accurately but the production process is longer. On the other hand

with less color changes the embroidery design sequence changes to fit the Minimizing color changes

settings but gives shorter production process. The alterations in the embroidery design’s sequence

might produce inaccurate embroidery results or might not. This depends on the embroidery design,

embroidery machine and the fabric. You can adjust color changes through the use of the track bar. 

B: Standard - Tools toolbar

Standard toolbar

Create New design.

Load an existing design.

Save an existing design or Save as any unsaved design.

Print a design

Copy selected objects.
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Paste copied objects

Undo, cancels the latest action that was made.

Redo, cancel the latest undo that was performed.

Select a fabric for the design.

Opens the Edit palette dialog box. 

Select a Hoop for the design.

Clicking on this button in the standard toolbar, you can view the current
design in actual size. Also by clicking on the arrow at the right of this icon,
you can select one of the zoom presets.

The Weld tool welds two or more overlapping objects.

The Trim tool can create wholes inside objects or reshape them by removing
parts of their shape.

The Intersection tool creates an object from the area where the objects
overlap.

Activates the show help on help tool.

Tools toolbar

Activates rectangle selection.

Activates lasso selection.

Activates Node editor where you can edit the shape of objects.

Using this tool you can zoom-in your view to a part of a design. 

Zoom out.

Zoom to actual size.

This tool Lets you move a design around in the viewable window like you would
move a paper around on a desk with your hand.

The measure tool calculates the distance between any two points in the work
area. When you measure from one point to another, a ruler is drawn that shows
the exact distance between the two points.

Add directions.

Divide satin or Row fill objects.
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Start embroidery simulation.

With the Freehand tool you can design simple lines or complete shapes.

With the Bezier designing tool you can create shapes where you can handle
better the curvature of each segment easier by adjusting the control handles of
each inserted node.

With the Outline tool you can draw lines and curves by specifying their nodes
and altering the curvature of their segments by adjusting their control handles.

With Magic Wand tool you can create any shape that consists of the
intersection of two or more other shapes.

With the Insert crystal shapes designing tool you can insert crystals anywhere
in the design.

The Create Ellipse tool allows you to design ellipses that will be filled with
stitches.

The Create Pie tool allows you to design ellipses and pie shapes that will be
filled with stitches.

The Create rectangle tool allows you to draw rectangle shapes that will be
filled with stitches.

Create Trapezoid shapes.

Create polygon shapes.

Add Star shapes.

Add Text 

Create monogram design

Create Rectangular array.

Create Circular array.

Create automatic borders around any object.

Enable - disable automatic sequence. 

C: Quick reference card

General

New document Ctrl+N

Open document Ctrl+O
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Save document Ctrl+S

Save As document Ctrl+Shift+S

Print document Ctrl+P

Export to image Ctrl+Shift+E

Export to SVG Ctrl+Alt+E

Help F1

Show Help on… Shift+F1

To Editor… Ctrl+E

To Dropbox Ctrl+D

Selection

Select all Ctrl+A

Invert selection Ctrl+Shift+I

Default selection tool Space

Top object Ctrl+Home

Bottom object Ctrl+End

Next object Tab

Previous object Shift+Tab

Modifications

Undo Ctrl+Z

Redo Ctrl+Shift+Z

Select fabric Ctrl+F

Edit palette Ctrl+Shift+L

Options Ctrl+T

Change Hoop Ctrl+H

Optimizer options Ctrl+Shift+J

Divide Shift+D
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Directions D

Repeat last transform Ctrl+R

Group Ctrl+G

Ungroup Ctrl+U

Combine Ctrl+L

Break apart Ctrl+K

Convert to curves Ctrl+Q

Order

To front one PgUp

To back one PgDn

To front of design End

To back of design Home

Designing

Insert symbol Ctrl+F11

Delete objects Delete

Edit shape nodes F10

Freehand F5

Bezier Shift+F5

Outline Ctrl+F5

Rectangle F6

Trapezoid Shift+F6

Ellipse F7

Pie Shift+F7

Polygon Y

Star S

Text F8

Align bar
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Align Left L

Align Right R

Align Top T

Align Bottom B

Align centers
Horizontally 

C

Align centers
Vertically

E

Same width  Shift+W

Same height Shift+H

Same Size Shift+S

Horizontal Spacing Shift+C

Vertical Spacing Shift+E

View

Properties Alt+Enter

Zoom in Z

Zoom previous F3

Zoom all F4

100% zoom Shift+1

Hand tool (pan) H

Measure F9

Ruler Ctrl+Shift+R

Grid Ctrl+Shift+G

Overlapping crystals O

Backdrop

Hide Alt+1

Below Embroidery Alt+2
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Washed-out Alt+3

After Embroidery Alt+4

D: Troubleshooting

Installation problems

Sometimes problems appear during installation procedure. If any problem appear you have to try the
following. 

v Make sure that you have administrative right on your PC in order to be able to install the software.

v Disable your antivirus or any other security software ONLY during the installation and turn them back

on, once it is finished. Creative DRAWings installation does not include any malicious software. 

v Make sure that you graphics card meets system requirements, because otherwise Creative

DRAWings might not work properly.

CBU Failure When Launching DRAWings®

When launching Creative DRAWings after installation or re-insertion of the USB Dongle, a screen displays
for a brief moment, followed by this error message:

This error is a result of a loose or improperly connected Dongle:

1. Close the error message.

2. Remove the Dongle, wait 10 seconds, and re-insert it, ensuring that it is securely connected.

3. Load Creative DRAWings once more.

Creative DRAWings Quits and Generates a Visual C++ Runtime Error

If the Dongle is removed when using Creative DRAWings, the application will shut down and the following
error message is generated:

“Visual C++ Runtime Error”

Re-insert the Dongle securely and re-start Creative DRAWings.

Unhandled Exception

Creative DRAWings has an extra security feature that handles exceptions that might occur while working
with complex designs. This feature allows you to undo your last change in the design that made the system
unstable and continue from that point. 
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Whenever the above image appears an Unhandled Exception was occurred in the system. In order to
continue working in Creative DRAWings you have to click on ‘Yes’ button. The system will become stable
again. It is proposed, when an Exception occurs, to save changes in the current design and then continue
working with the design. 

If you click the ‘No’ button the System will crash! 

Creative DRAWings fails to launch

Creative DRAWings is a demanding software in 3D graphics card. If the PC you have installed the software
does not meet the Minimum System requirements, the software might not work properly. 

If the following error appears when you try to start the software, then the problem is located on the Graphics
card of your system or to the 3D settings of the software.

To overcome this issue please try the following:

1. Download and install the latest drivers of the Graphics card and try to start Creative DRAWings. 

2. Try to re-install the DirectX 9.0C from the Directx9 folder that you will find inside the installation CD

of Creative DRAWings. Run dxsetup.exe and follow the installation. Once it is finished try once more

to open Creative DRAWings. 

3. Open Setup 3D from Start>All Programs>Creative DRAWings, set the options as they are shown

in the screen capture below and select Save settings button. 
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Start Creative DRAWings and check if it is working properly. If this does not work open the Setup 3D
and set the options as they were initially (as it shown in the screen capture below), and select Save
settings.
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Try to open Creative DRAWings once more. 

4. If none of the above worked the problem is located in your Graphics card. It might have less than

64MB of Ram, or have poor 3D capabilities (usually onboard graphics cards). To fix that you will have

to change it with any NVIDIA or ATI graphics card is available on the market. The software requires a

good graphics card to work properly. 

Information on how to proceed with checking the Video memory of the card, updating video drivers or another
way to install the latest DirectX, you will find below.

Verifying Video Card Memory

To verify the amount of RAM on the video card, do the following:

1. Right-click on the Desktop and select Properties.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the Adapter tab.

Memory Size should read at least 64MB.  If it is less than 64MB, you will need to upgrade the video card to
meet or exceed the Creative DRAWings system requirements.
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Updating the Video Driver

The two most common video chipsets are ATI and NVIDIA.  Please visit one of the following web sites and
obtain the latest driver for your card.

http://www.ati.com/
http://www.nvidia.com/

If your video card does not use either of these chipsets, visit the video card manufacturer's web site for the
latest driver. 

If you have a laptop you need to search for video card drivers from the laptop manufacturer’s web site. 

Installing DirectX

DirectX can be downloaded from the Windows Update site, or from http://www.microsoft.com/directx.  After
installing DirectX, make sure that acceleration is enabled.  To verify this, do the following:

1. Click Start, Run.

2. Type dxdiag and click OK.

3. Click on the Display tab.

All three DirectX Features should indicate Enabled beside each feature.  If not, click the Enable button beside
the ones that are disabled.  If the buttons are disabled, there is a problem with DirectX.  Consult the Microsoft
knowledge base for assistance in troubleshooting DirectX, or click on the More Help tab and click on the
Troubleshoot button.
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Show help on

Chapter XXI

The Show help on function can be activated from menu Help -> Show help on or from the shortcut key

Shift+F1 and from the standard toolbar by clicking on the  icon. It is a useful tool any time you need quick
help without searching. When it is active a question mark appears next to the mouse pointer. You can click
anywhere in Creative DRAWings® window and instantly retrieve help for the object you clicked.
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Index
- 3 -
3D preview     211

3D setup    

I usually open     623

Optimize settings for     623

Select Technology     623

- A -
Abbreviations     348

Create abbreviations     349

Edit abbreviations     349

Actual size Zoom     210

Add a node     336

Add Guidelines     221

Add new color     322, 516

Add New Hoop     601

Add new objects as clones     313

Add object to a Group     306

add text     346

Align bar     183, 186

Align Bottom     284

Align Centers Horizontally     284

Align Centers Vertically     284

Align Left     284

Align Right     284

Align Top     284

Aligning     283

Aligning objects     284

Applique     557

Sequence     557

Appliqué  frame out distance     591

Array     373

Circular     255

Cloned objects (Fill)     398

Cloned objects (Outline)     399

Clones     265

Edit outline     392

Nested array     401

On object fill     373

On pbject outline     393

Rectangular     255

Array and clones     398

Array circular     266

Array fill     569

Circular     574

Contour     576

Line fit     580

Rectangle     571

Shape fit     578

single line     577

array fill edit     377

Array fill pattern     379

Circular     384

Contour     387

Line fit     391

Rectangle     380

Shape fit     390

single line     389

Artistic edge     146

Artwork sources     105

Auto remove overlaps     341

Auto-backup     180

Auto-backup mechanism     180

Autoborder     277

Automatic embroidery sequence    
605

Automatic outlines     277

auto-sizing     283

Auto-sizing objects     286

available colors     319, 512

- B -
Backdrop     161

Backdrop properties     161

Background     564

backup     180

Basic customizations     271

Bezier     231

Bitmap     101, 105, 161

Bold     347

Break apart     307

brush     86

- C -
camera     37

Capture from camera     158

capture from camera and cut     459

CBU failure     635

Cell size     564

Center design to hoop     600

change brush width     518

Change colors     320, 514

Change hoop     599

change view     370

Circular     266

Circular Array    

Clones     276

Mirror copies     275

Rotate copies     275

using circular array     269

Clear path     355

clear transform     305

clear transformations     305

Clipart library     367

add to library     371

change view     370

filter clipart     368

Insert clipart     367

Clipart names and Tags     370

Clones     313

Close outline     338

Color / Sizes    

Selecting colors     621

color changes     628

Color management     317, 511

Color reduction area     329

color selection     324, 517

colors     319, 512

Combine     307

Contents     14

control handles     335

Convert outline to Object     312,
536

Convert to curves     171

Convert to Vector design     172

Copy     297

Create a monogram design     54

Create automatic shapes     235

Create crystal design     76

create cut design     60, 445

create cut design from scratch    
468

create designs with crystals     409

Create Ellipses     237

Create from scratch     94

Create monogram     54

Create monogram design     112

Create paint design     86

Create Parallelograms     241

Create Pies     239
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Create Polygons     248

Create Rectangles     251

Create Stars     244

Create stencil design     65

Create Trapeziums     241

create your first cut design     445

Create your first paint design     502

Creating designs     102

Cross     564

Cross-stitch     166, 564

Background     564

Cell size     564

Cross     564

Cross-stitch design colors     324

Cross-stitch stitch type     538

Crystal    

Edit outline     440

Fill patterns     420

Crystal design     76

crystal designs     409

crystal fill     406

parameters     416

crystal fill edit     414

crystal fill parameters     416

Crystal fill patterns    

circular     426

Contour     431

Line fit     439

rectangle     421

Shape fit     435

Single line     434

Crystal outline/pen fill     442

crystal outlline fill     442

crystal pen fill     442

crystals     404

Insert Crystal shapes     404

item rotation     419

Select color / shape     417

Select offset     419

Select palette     416

Select size     418

Separate to crystals     420

crystals overlapping     415

currently used colors     319, 512

Curve objects     333

Cusp nodes     333

Customize workspace     189

Cut     60, 297, 445

Break apart     476

Cutting offset     476

Discard part     476

Netfill     476

Outline     476

Running     476

Running before     476

Satin serial     476

cut design     60, 445

cut design from scratch     468

cut properties     476

Cutting mat     217

- D -
default color palette     322, 516

Default Fill color     320, 514

Default Outline color     320, 514

Delete a node     336

Delete and object form a Group    
307

Delete color     322, 516

Delete object     298

Deleting     296

Design modes    

Create mode     20

DRAW mode     20

Stitch mode     20

Design properties     589

Design properties optimizer    
591

general     590

Design tabs     102

Designing tools     227

Diagonal Guideline     222

Digitizing tool     233

Directions tool     529, 588

disable auto sequence     608

Display as icon     297

distributing     283

Distributing objects     287

Divide tool     529, 588

Double pass     581

Drawing tools     228

DRAWings Tips     626

DrawStitch bar     186

Dropbox     123

Duplicate design     298

Duplicating     296

DXF     132, 138

- E -
Edit an object form a Group     307

Edit array fill    

array fill     377

edit caption     356

Edit color     322, 516

edit crystal fill     414

Edit existing color     322, 516

Edit hoop     603

Edit Hoop Bracing arms     603

Edit Hoop Corner curviness     603

Edit Hoop Height     603

Edit Hoop Name     603

Edit Hoop Type     603

Edit Hoop Unit     603

Edit Hoop Width     603

edit monogram template     358

Edit nodes     334

Edit Palette     324

Edit shape nodes     332, 333

Edit Text shape     351

Ellipses     237

embroider it     20

Embroidery artwork     108

Embroidery Heavy     543

Embroidery Light     543

Embroidery Normal     543

Embroidery Normal Light     543

Embroidery sequence     605

Embroidery smooth     543

Embroidery to vector     172

Embroidery transformations     538

Embroidery Ultra Light     543

Enable auto sequence     605

End points at closest connection,
even on trims     591

Equal horizontal spacing     287

Equal Vertical spacing     287

Export    

to Dropbox     123

to Happy lan machine     133

to Janome MC12000/MC15000
    134

Export crystals    

to DXF     138

to HPGL     138

to SVG     138

Export design     123
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Export design     123

crystals/ cutters     136

Embroidery image     129

Quilt     132

To editor     123

Vector file     131

Export embroidery image     129

Export to crystal - cutter     136

Export to cutter     139

Export to Cutters    

Artistic Edge     146

Export to Dropbox     123

Export to dxf     132

Export to editor     14, 123

Export to Happy lan machine     133

Export to Janome
MC12000/MC15000     134

Export to quilt     132

Export to vector file     131

- F -
Fabric selection     543

Failure Recovery     180

File formats     119

file manager     121

Fill     320, 514, 520, 546

first embroidery     20

Font name     347

Font size     347

Freehand     229

From camera     111, 158

From embroidery     108

From scanner     109

- G -
General     589

general - Design properties     590

Get image from camera     37, 111

Graphic objects color     320, 514

Grid     216

Group objects     306

Grouping objects     306

Guideline Diagonal     222

Guideline editor     223

Guideline Horizontal     221

Guideline options     222

Guideline Vertical     222

guidelines     221, 224

- H -
Hand tool     211

Happy lan machine     133

Height     254

help     640

Hoop     216

Hoop Bracing arms     601

Hoop Corner curviness     601

Hoop Height     601

Hoop Name     601

Hoop Preview     605

Hoop Type     601

Hoop Unit     601

Hoop Width     601

Horizontal Guideline     221

horizontal spacing     287

HPGL     138

- I -
Image from camera     111

image to cut     450

Import bitmap    

Convert to outlines     164

Open as Cross-stitch     166

Open as Photo paint     169

Open as Photo stitch     167

Trace     164

Import bitmap artwork     105

Import bitmap from scanner     109

Import embroidery files     171

Import from camera     37

import from camera and cut     459

Import from scanner and cut     450

Import ngs     174

Import stitch file     46

Import vector artwork     105

Importing bitmaps     161

Index     14

Insert crystals     236

Insert shapes     237

Insert symbol     365

installation problems     635

Intersection     308

Intersection Preview     308

Invert selection     198

Italic     347

- J -
Jamome     121

Janome file manager     121

Join nodes     338

- K -
Keep sequence of overlapped
objects, even if trimmed     591

Key     624

- L -
Lasso selection     197

Length     581

Light source     215

Load design     115

- M -
Magic Wand shapes     235

Main menu     183

Make same height     286

Make same size     286

Make same width     286

Manual embroidery sequence    
608

Measure tool     211

Minimizing color changes     591

Mirror Height     303

Mirror Width     303

mirroring     301

Mirroring objects     303

Monogram     54, 112

Monograming     355

edit caption     356

edit monogram template     358

Overlapping areas     363

Transform monogram area    
361

Move     342

Move a shape while drawing     282

Move an object     281

Move node     334

Move on X and Y     283

Move rectangular array     260
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Move with arrow keys     282

- N -
Netfill     567

new color     322, 516

New design from scratch     115

New monogram     112

New objects as clones     313

ngs     174

No thread trims inside combined
objects     591

Node editor     332

None     199

None color     319, 512

None Fill     546

Number of rays Star     244

Number of sides Polygon     248

- O -
Object properties     183, 546

Applique     557

Cross     564

Fill     520, 546

Fill none     546

Outline     525, 580

Outline none     581

Row fill     554

Running     581

Satin     547

Satin serial     583

Step     550

Online resources     13

Open as backdrop     161

Open as Cross-stitch     166

Open as Photo paint     169

Open as Photo stitch     167

Open as Photostitch     531

Open design     115

Open DRAW file     115

Open existing design     117

Optimization strategy     591

Bottom to top     591

Inside to outside     591

Large to small     591

Left to right     591

Outside to inside     591

Right to Left     591

Small to large     591

Top to bottom     591

Optimizer     589

Optimizer Options     591

Options     611

3d properties     616

Color / Sizes     618

General     611

Monitor     614

Palette order     618

printing     617

Tools     612

View     615

Outline     233, 320, 514, 525, 580

Satin serial     583

Outline array     396

Outline array options     396

Outline design     212

Outline none     581

Outline properties    

Array     586

Outline thickness     254

outline to Object     312, 536
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